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Welcome to This Guide

This guide explains how to configure and work with an IT model that 
enables you to build a topology of your system. You populate the model 
with configuration items and their relationships, and then use the model to 
measure and manage critical business processes. 

This chapter includes:

 ➤  How This Guide Is Organized on page 11

 ➤  Who Should Read This Guide on page 13

 ➤  Getting More Information on page 13

How This Guide Is Organized

The guide contains the following chapters:

 Part I Modeling

Describes the main concepts, tasks, and reference information for CMDB; 
describes how to model your business environment by defining views and 
by building TQL queries that retrieve the required information from the 
CMDB. The TQL query results populate the views with CIs and 
relationships.

Furthermore, describes how to work with the topology of the views defined 
in the Modeling Managers. You can edit CI properties, define new CIs, and 
attach existing CIs to each other to reflect changes in your IT infrastructure.
11
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 Part II Model Management Settings

Describes how to create or edit a package out of existing resources to suit 
your IT management needs using the Package Manager; how to define 
schedules for tasks that are activated on a periodic basis using the Scheduler; 
how to define attribute states using the State Manager; how to perform 
federation over several data sources using Federated CMDB. 

 Part III Application

Describes how to view the CIs of the currently selected view in graphical 
format in Topology View, how to view a list of CIs and relationships that are 
candidates for deletion by the aging mechanism, how to compare two 
snapshots of a specific view taken at different times, how to compare the 
hierarchies of two compound CIs, and how to create a Gold Master report 
definition. In addition, this part describes the pages and dialog boxes that 
you use to work with Asset report, Host Dependency report, Change report, 
System report, and Gold Master report, and the Overview reports.

 Part IV View Explorer

Explains how View Explorer presents the elements of the IT universe model 
in HP Business Availability Center through the medium of views. 

 Part V Topology Map

Explains Topology Map concepts and describes how to work with the 
Topology Map that shows the CIs and relationships defined in a view. 

 Part VI Source Manager

Describes how to work with the default source adapters and how to work 
with generic custom source adapters used to communicate with third-party 
sources. Source adapters map source data to objects used by HP Business 
Availability Center. They are automatically preconfigured and activated 
when HP Business Availability Center starts. 
12
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Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center data collector administrators

Readers of this guide should be knowledgeable about enterprise system 
administration, have familiarity with ITIL concepts, and be knowledgeable 
about HP Business Availability Center in general and HP Universal CMDB 
technology specifically.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Business Availability Center Deployment Guide PDF.
13
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Configuration Management Database 
(CMDB)

This chapter provides information on CMDB.

This chapter includes:

Concepts

 ➤  CMDB Overview on page 18

 ➤  Configuration Items (CI) on page 19

 ➤  Nodes and Relationships on page 19

Reference

 ➤  CMDB Log Files on page 20

 ➤  Log Severity Levels on page 27

 ➤  CMDB Configuration Parameters on page 29
Concepts
17



Chapter 1 • Configuration Management Database (CMDB)
CMDB Overview

The CMDB is the central repository for the configuration information that is 
gathered from the Discovery and Dependency Mapping (DDM) process and 
the various third-party applications and tools.

The CMDB contains all the configuration items (CIs) and relationships 
created in HP Business Availability Center, whether created automatically 
from the DDM process or source adapters, or manually using IT Universe 
Manager. The CIs and relationships together represent a model of all the 
components of the IT Universe in which your business functions. The 
CMDB stores and handles the infrastructure data collected and updated by 
the DDM process. For more information about the DDM process, see 
Discovery and Dependency Mapping Guide.

The IT Universe model can be very large, containing millions of CIs. To 
facilitate their management, you work with the CIs in a view that provides a 
subset of the overall components in the IT Universe world.

You use factory views or views defined in View Manager to display and 
manage the CIs and relationships in the CMDB. The views enable you to 
focus on specific IT areas and are available via View Explorer in different 
HP Business Availability Center applications, such as Dashboard and Service 
Level Management. An example of a view is shown in the following figure:

The CMDB also contains the TQL query definitions that are used to query 
and retrieve data from the CMDB, for presentation in the pattern views 
(views based on TQLs); and the configuration item type (CIT) model, a 
repository for the CI types used to define the CIs and relationships. For 
information on TQL queries, see “Topology Query Language” on page 263.
18
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In addition, the CMDB contains the object repositories for the various 
additional data added to CIs in Dashboard and Service Level Management, 
such as KPIs, context menus, and tooltips. For more information on these 
repositories, see “Repositories – Overview” in CI Attribute Customization.

Configuration Items (CI)

A configuration item (CI) is a component of the CMDB that represents a 
physical or logical entity in the system, for example, hardware, software, 
services, business processes, customers, and so on. The CIs are part of the 
IT Universe model in the CMDB, where they are organized into a 
hierarchical format based on the interdependencies in your organization’s 
IT environment. The interdependencies in HP Business Availability Center 
are called relationships.

Each CI belongs to a configuration item type (CIT). The CIT defines a 
category of CIs used in HP Business Availability Center. The CITs provide 
templates for creating the CIs and associated properties in each category.

You view and manage the CIs in the CMDB using views. Each view shines a 
spotlight on part of the IT Universe model. Furthermore, changes that you 
make in the view are actually changes to the IT Universe model.

Nodes and Relationships

Nodes are the components from which TQL queries are built in Enrichment 
Manager, View Manager, Correlation Manager, Report Manager, and Query 
Manager.

Relationships are connections defined between CIs. Relationships are 
defined one at a time for each pair of nodes in a TQL query.

Reference
19
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CMDB Log Files

CMDB log files enable you to perform basic troubleshooting of CMDB 
runtime problems. Additionally, by tracking CMDB behavior in the log files, 
you can examine the effects of changes made in the system. CMDB is 
composed of subsystems and each subsystem records to several log files. 

Log files are located in the <HP Business Availability Center root 
directory>\log folders.

CMDB Server Parameters
This section contains definitions for CMDB server parameter log files. For 
details on changing log levels, see “Changing Log Levels” on page 28.

This section includes the following topics:

➤ “Lifecycle Log” on page 20

➤ “General CMDB Log” on page 21

➤ “Quota Log” on page 21

Lifecycle Log

The log name is cmdb.info.log. 

Log File Description

Purpose CMDB server lifecycle: 

➤ all server tasks

➤ customer loading and unloading 

➤ startup and shutdown of Task manager

Contains information about any application that does not 
start up correctly.

Information 
Level

All lifecycle details.

Error Level Startup errors of CMDB subsystems, primarily in the data 
access layer.
20
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General CMDB Log

The log name is cmdb.log.

Quota Log

The log name is cmdb.quota.log.

Debug Level Not applicable

Basic 
Troubleshooting

➤ If the CMDB client receives an exception that the customer 
does not exist, check that the customer is properly loaded. 

➤ If the CMDB client receives an exception that it cannot find 
CMDB in a JNDI lookup, check that the CMDB server is 
bound in the JNDI tree.

➤ If the HA Controller does not load the CMDB customers, 
check that the CMDB server is registered in the HA 
controller.

Log File Description

Purpose Errors of all CMDB subsystems and CMDB CITs that do not 
have their own log file.

Information 
Level

Information from the CMDB server not directed to any 
specific log.

Error Level All errors in the CMDB server.

Debug Level Debug information in the CMDB server that is not directed to 
a specific log.

Basic 
Troubleshooting

CMDB server errors during CMDB deployment.

Log File Description

Purpose Quota names, quota values, and current quota levels. 

Information 
Level

Quota names and values set in the server and customer levels 
during a customer load.

Log File Description
21
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CI Type Model Log
The log name is cmdb.classmodel.log.

Error Level CMDB operations that fail because they exceed quota limits.

Debug Level A count collector runs every n minutes and gathers current 
counts for all quotas. Collected counts are logged.

Basic 
Troubleshooting

If operations fail because of quota limits, check the count 
growth and quota values.

Log File Description

Purpose CI Type Model errors and debug messages.

Information 
Level

When a CI Type Model is loaded, incorrect definitions are 
logged as informational messages. An example of an incorrect 
definition is duplicate attributes.

Error Level Not available.

Debug Level Every CI Type update includes the following:

➤ original CIT in XML format

➤ new CIT in XML format

➤ differences between the CITs 

If the CI Type Model update is rejected, the reason is logged.

Basic 
Troubleshooting

Compares the differences that the server finds between the 
original CIT and the new CIT. This is useful to understand the 
following scenarios:

➤ a CIT in a package failed 

➤ an action in the CIT browser applet failed

➤ an action in the CIT browser applet succeeded when it 
should have failed

Log File Description
22
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CMDB Notification Log
The log name is cmdb.notification.log.

Log File Description

Purpose Notification messages from the time of the component’s 
creation in CMDB until the client’s listener receives a message.

Most components receive configuration changes from CMDB 
in push mode, by the notification mechanism, rather than in 
pull mode.

Information 
Level

➤ startup and shutdown of publishers

➤ register and unregister remote and internal listeners

Error Level ➤ errors when messages are published

➤ errors when messages are received 

Debug Level ➤ unique message ID 

➤ number of changes that a message includes as well as more 
details according to the type of the message (for example, 
the TQL result version) 

➤ JMS header properties

Basic 
Troubleshooting

If an application does not receive a notification, check the 
following:

➤ a listener is registered with the appropriate notification 
filter

➤ a message is published with data that matches this filter

➤ a message is received by the listener (use the unique 
message ID to verify)
23
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CMDB Model Audit Short Log
The log name is cmdb.model.audit.short.log.

History Database Log
The log name is cmdb.history.log.

Log File Description

Purpose Information about a CI Type operation: type of operation, 
data received as input, and what happened to the data in each 
CIT. 

Also contains information about the caller application, 
execution times, and persistency time.

Information 
Level

Operation details

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

If there are no changes when there should be, check the 
following:

➤ the operation exists

➤ the input is correct 

➤ what happened to the data. There may have been a false 
update. 

This is especially useful when running DDM to trace the 
input. 

Log File Description

Purpose ➤ Records which CITs are found by the History database when 
the database is initialized from an existing topology. 

➤ Records what is to be saved in the History database.

➤ Tracks events saved in the History database.

➤ Records when the History database was purged.

Information 
Level

➤ When the last purge was carried out.

➤ Information about initialization of the History database.
24
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CMDB Enrichment Log
The log name is cmdb.enrichment.log.

Error Level Lists errors that occur when event information is inserted in 
the History database.

Debug Level ➤ Details about CITs inserted during initialization of the 
History database.

➤ Details about changes in the TQL results saved in the 
History database.

Log File Description

Purpose Enrichment definitions: adding, updating, removing, and 
calculating. 

Calculation results such as how many CIs were added, how 
many relationships were removed, and so forth. 

Supplies the reason for a calculation failure. Failure in a model 
update, however, is not included since it is an asynchronous 
execution.

Information 
Level

➤ Add, update, and remove enrichment definitions.

➤ Add, update, and remove CIs or relationships to or from a 
model.

Error Level Calculation failure.

Debug Level Traces the enrichment calculation process.

Basic 
Troubleshooting

➤ If no calculation was carried out, check the definition of 
add enrichment.

➤ If there are no results, check the finish calculate entry.

Log File Description
25
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CMDB Plug-in Log
The log name is cmdb.plugins.log.

CMDB Dal Log
The log name is cmdb.dal.log.

Log File Description

Purpose Plug-in input and output notification.

Information 
Level

Lifecycle of publisher.

Error Level ➤ no customer name exists in the customer ID 

➤ publisher failure 

Debug Level Receive or send a change.

Basic 
Troubleshooting

If notification did not reach the destination, check that the 
plug-in received the input. 

Log File Description

Purpose Information about activity that occurred in the data access 
layer, the layer that works with CMDB.

Information 
Level

Not available.

Error Level ➤ connection pool errors

➤ database errors

➤ command execution errors

Debug Level ➤ all DAL commands executed

➤ all SQL commands executed

Basic 
Troubleshooting

If you suspect that CMDB actions are taking too long, check 
the time spent on queries and updates in the DAL logs and 
operation logs.

Exception details and ID are entered into the log. The 
exception ID appears in the exception itself.
26
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CMDB Operation Statistics Log
The log name is cmdb.operation.statistics.log.

Log Severity Levels

Each log is set so that the information it records corresponds to a certain 
severity threshold. Because the various logs are used to keep track of 
different information, each is pre-set to an appropriate default level. For 
details on changing the log level, see “Changing Log Levels” below.

Typical log levels are listed below from narrowest to widest scope:

➤ Error. The log records only events that adversely affect the immediate 
functioning of HP Universal CMDB. When a malfunction occurs, you can 
check if Error messages were logged and inspect their content to trace the 
source of the failure.

➤ Warning. The log’s scope includes, in addition to Error-level events, 
problems for which HP Universal CMDB is currently able to compensate 
and incidents that should be noted to prevent possible future malfunctions.

➤ Info. The log records all activity. Most of the information is normally 
routine and of little use and the log file quickly fills up.

➤ Debug. This level is used by HP Software Support when troubleshooting 
problems.

Log File Description

Purpose Statistics for all operations performed in the past 15 minutes 
including worst operation instances.

Information 
Level

Statistics per operation including operation class name, caller 
application, and customer ID.

Default of 10 worst operation instances.

Error Level Disables the statistics feature.

Debug Level Not available.

Basic 
Troubleshooting

Check when there is a performance slow down.
27
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Note: The names of the different log levels may vary slightly on different 
servers and for different procedures. For example, Info may be referred to as 
Always logged or Flow.

Changing Log Levels
If requested by HP Software Support, you may have to change the severity 
threshold level in a log, for example, to a debug level.

To change the severity threshold level:

 1 Open the log properties file in a text editor. Log file properties are defined in 
files in the following directory: <HP Business Availability Center root 
directory>\HPBAC\conf\core\Tools\log4j.

 2 Locate the loglevel parameter. For example,

 3 Change the level to the required level. For example, 

For a description of the log levels, see “Log Severity Levels” on page 27.

 4 Save the file.

loglevel=ERROR

loglevel=DEBUG
28
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CMDB Configuration Parameters

This section describes the parameters needed for configuring the CMDB. By 
changing the values of CMDB parameters, the administrator can change the 
runtime behavior of CMDB.

This section includes the following topics:

➤ “Overview” on page 29

➤ “Aging Parameters” on page 30

➤ “Configuration Item Type Parameters” on page 31

➤ “Configuration Item Type Setting Parameters” on page 33

➤ “Data Model Parameters” on page 33

➤ “General Server Parameters” on page 34

➤ “History Database Parameters” on page 37

➤ “History Database Purging Parameters” on page 39

➤ “Monitoring Parameters” on page 40

➤ “Notification Parameters” on page 41

➤ “Other Parameters” on page 42

➤ “Plug-in Parameters” on page 45

➤ “Quota Parameters” on page 45

➤ “System TQL Parameters” on page 48

Overview

Note: Changed parameters may impact the entire system and not just the 
CMDB. Parameters that can be changed by users are marked Y in the Change 
Value? (Y/N) column of each table. All other parameters should be changed 
by HP Software Support only.
29
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To modify a parameter, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Foundations, select cmdb and locate the 
parameter in the appropriate table. Click the Edit button and modify the 
parameter with the required value.

Aging Parameters 
This section describes the aging parameters: 

 

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

model.aging.i
s.aging.enable
d

Defines whether the 
aging mechanism is 
enabled.

boolean ➤ true. Aging is 
enabled. The 
scheduler runs and 
marks candidates 
(objects/links) for 
deletion.

➤ false. Aging is 
disabled. The 
scheduler does not 
run but the dates 
when candidates 
must be deleted and 
the actual deletion 
are set. This is the 
default.  

Y

model.aging.s
cheduler.hour
.of.first.run

The time when the 
aging parameter 
runs after startup.

integer Default: 2:00 AM N

model.aging.s
cheduler.inter
val.in.hours 

The interval in 
hours between aging 
parameter runs.

integer Default: 24 hours N

model.aging.t
ime.unit=day
s

30
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Configuration Item Type Parameters
This section describes the CIT parameters: 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

dal.classmodel.dao.type Defines the 
storage type of the 
CI Type Model.

string ➤ jdbc. Storage in 
the database.

➤ xml. Storage in 
an XML file.

N

dal.classmodel.filesystem.
file.name

Defines the 
relative directory 
path where a CI 
Type is saved 
when the storage 
type is xml.

string The path is relative 
to the HP Business 
Availability Center 
home directory. 

N

dal.classmodel.deployme
nt.dao.type

Defines the 
storage type of a 
CI Type definition 
for initial 
deployment.

string xml. CMDB reads 
from the XML files 
and deploys the CI 
Type in CMDB.

N

dal.classmodel.deployme
nt.file.name

Defines the 
relative directory 
path to the CI 
Type XML files. 
These files are 
needed for CI 
Type deployment.

string All XML files must 
have the suffix 
_deployment.xml. 

N

dal.classmodel.db.name Defines the name 
of the schema for 
CMDB 
management. 
CMDB 
management 
includes two 
tables: ID gen and 
CMDB versions. 

string Relevant for 
Microsoft SQL 
Servers only. 

Y
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dal.classmodel.host.name The IP address of 
the CMDB 
management 
database host.

string Y

dal.classmodel.user.name User name to log 
into the CMDB 
management 
database. 

string In Oracle, it is also 
the schema name.

Y

dal.classmodel.password Password to log 
into the CMDB 
management 
database.

string Y

dal.classmodel.server The same as 
dal.classmodel.hos
t.name. 

string Defined for DB 
context only. DB 
context is the name 
of a parameter in 
the connection 
pool.

Y

dal.classmodel.sid The sid of a CI 
Type Model.

string Relevant for Oracle 
database.

Y

dal.classmodel.port Defines a TCP port 
of database host.

integer Y

dal.classmodel.db.type The type of 
CMDB.

string ➤ ORACLE Server

➤ SQL Server

Y

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)
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Configuration Item Type Setting Parameters
This section describes the CI Type settings parameters:

 

Data Model Parameters
This section describes the data model parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

classmodel.persistenc
y.file=/cmdb/classmo
del/persistency/class
model.xml

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.datamodel.
dao.type

Defines the type 
of continuous 
storage of a data 
model.

string ➤ jdbc. Continuous 
storage in the 
database.

➤ mock.  

N

dal.datamodel.
db.name

Defines the name 
of the schema.

string Relevant for Microsoft 
SQL Servers only.

Y

dal.datamodel.
host.name

The IP address of 
the CMDB 
database host.

Note: CMDB 
database includes 
CI Type Model 
and data model 
database.

string Y

dal.datamodel.
user.name

User name to log 
into the CMDB 
database. 

string In Oracle, it also denotes 
the schema name.

Y

dal.datamodel.
password

Password to log 
into the CMDB 
database.

string Y
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General Server Parameters
This section describes the general server parameters: 

 

dal.datamodel.s
erver

The same as 
dal.datamodel.host
.name. 

string Defined for DB context 
only. DB context is the 
name of a parameter in 
the connection pool.

Y

dal.datamodel.s
id

If the CMDB 
database is Oracle, 
this parameter 
defines the sid of 
the CI Type 
Model.

string Y

dal.datamodel.
port

The TCP port of 
the database host.

integer Y

dal.datamodel.
db.type

The type of CMDB 
database.

string ➤ ORACLE Server

➤ SQL Server

Y

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)

server.sync.sessio
n.timeout

The default time-out for 
executing synchronous 
CMDB operations. 

Does not affect 
asynchronous 
operations.

integer ➤ Value is in seconds. 

➤ If the CMDB 
operation runs longer 
than the defined 
value, a request time-
out exception is sent 
to the client.

N

upgrade.enabled Defines whether CMDB 
should perform an 
upgrade on startup.

boolean ➤ true. Perform an 
upgrade.

➤ false. Do not perform 
an upgrade.

N

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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upgrade.file=/cm
db/upgrade.dat

The file containing the 
date of the last upgrade 
for each customer.

/cmdb/upgrade.dat

task.threads.pool
.size.process

For internal HP use only. integer 20

task.threads.pool
.size.modeltopol
ogy

The number of threads 
dedicated to the CMDB 
model topology.

integer 10

task.threads.pool
.size.tqlcalculator

The number of threads 
dedicated to the TQL 
calculator.

integer 15

task.threads.pool
.size.tqlresultrep
ository

The number of threads 
dedicated to the TQL 
result repository.

integer 8

task.threads.pool
.size.modelquery

The number of threads 
dedicated to the CMDB 
model query.

integer 20

task.threads.pool
.size.tqlnotificati
on

The number of threads 
dedicated to TQL 
notification.

integer 8

task.threads.pool
.size.tqlresultsutil
s

The number of threads 
dedicated to TQL results 
utilities.

integer 20

task.threads.pool
.size.tqlpatternsc
ache

The number of threads 
dedicated to the TQL 
query cache.

integer 6

task.threads.pool
.size.tqlpatterns
manager

The number of threads 
dedicated to the TQL 
query manager.

integer 2

task.threads.pool
.size.plugins

The number of threads 
dedicated to plug-ins

integer 1

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)
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task.threads.pool
.size.raw.event

The number of threads 
dedicated to raw events.

integer 1

task.threads.pool
.size.enrichment
admin

The number of threads 
dedicated to enrichment 
administration.

integer 1

task.threads.pool
.size.enrichment
definition

The number of threads 
dedicated to enrichment 
definitions.

integer 4

task.threads.pool
.size.enrichment
calculation

The number of threads 
dedicated to the 
enrichment calculation.

integer 4

task.threads.pool
.size.classmodel

The number of threads 
dedicated to the CIT 
model.

integer 1

task.threads.pool
.size.deployment

The number of threads 
dedicated to 
deployment.

integer 1

task.threads.pool
.size.modelupdat
e

The number of threads 
dedicated to updating 
the CMDB model.

integer 1

task.threads.pool
.size.tqlresultrep
ositorycache

The number of threads 
dedicated to the TQL 
results repository cache.

integer 1

task.threads.pool
.size.tqlscheduler

The number of threads 
dedicated to the TQL 
scheduler.

integer 1

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)
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History Database Parameters
This section describes the History database parameters: 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.history.db.nam
e

Defines the 
name of the 
History schema.

string Relevant for Microsoft 
SQL Servers only. 

Y

dal.history.host.na
me

The IP address 
of the database 
host.

string Y

dal.history.user.na
me

User name to 
log into History 
database. 

string In Oracle, it also 
denotes the schema 
name.

Y

dal.history.passwor
d

Password to log 
into the data 
model database.

string Y

dal.history.server Defined for DB 
context only. 
DB context is 
the name of a 
parameter in 
the connection 
pool.

string The value must be the 
same as 
dal.history.host.name. 

Y

dal.history.sid If the CI Type 
database is 
Oracle, this 
parameter 
defines the SID 
of the CI Type.

string Y

dal.history.port The TCP port of 
the database 
host.

integer Y

dal.history.db.type The type of 
History 
database.

string ➤ ORACLE Server

➤ SQL Server 

Y

37



Chapter 1 • Configuration Management Database (CMDB)
dal.history.data.tab
lespace.name

This parameter 
is relevant for 
the Oracle 
database only. 
The DBA can 
define the 
tablespace for 
the History 
data.

cmdbhistorydata

dal.history.index.ta
blespace.name

This parameter 
is relevant for 
the Oracle 
database only. 
The DBA can 
define the 
tablespace for 
indexes.

cmdbhistoryindex

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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History Database Purging Parameters
This section describes the History database purging parameters: 

 

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

history.purging.
days.to.save.bac
k

The minimum 
number of days 
to keep update 
and last create 
changes in the 
CMDB before 
purging those 
changes from 
the History 
database. 

Note: The last 
change of an 
attribute is not 
purged until a 
newer one 
overrides it. 

integer For example, if the value is 
90, changes that occur 
today remain in the 
History database for at 
least 90 days.

Y

history.purging.
scheduler.interv
al.in.hours

The interval of 
time between 
purges of the 
History 
database.

integer Value is in hours.

For example, if the value is 
24, the History database is 
purged every 24 hours.

Y

history.purging.
scheduler.hour.
of.first.run

The hour of the 
day, using a 24 
hour format, to 
begin purging. 
Purging is 
generally 
performed 
during the 
night hours.

integer For example, if the value is 
01, purging begins at 01:00 
every day.

Y
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Monitoring Parameters
This section describes the monitoring parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

monitor.scheduler.lo
ad.customer.number

Defines the number 
of customers to be 
monitored.

Relevant only for the 
Self-Alert Monitor of 
HP Business 
Availability Center 
with one customer 
installation.

integer If the value is -1, no 
customer is 
monitored. 

Values other than -1 
define the number 
of monitored 
customers.

N

monitor.performance
.warning

The minimum 
threshold to define 
CMDB performance 
as Warning.

The maximum 
threshold to define 
CMDB performance 
as Good.

long Value is in 
milliseconds.

N

monitor.performance
.error

The minimum 
threshold to define 
CMDB performance 
as Error. 

The maximum 
threshold to define 
CMDB performance 
as Warning.

long Value is in 
milliseconds.

N

monitor.scheduler.ti
mer.time

The interval of time 
to run a performance 
check.

long Value is in 
milliseconds.

N

monitor.scheduler.de
lay.time

The delay between 
system startup and 
the first performance 
check run.

long Value is in 
milliseconds.

N
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Notification Parameters
This section describes the notification parameters: 

 

task.threads.pool.size
.monitorQuery

The number of 
threads dedicated to 
the pool size monitor 
query.

1

task.threads.pool.size
.monitorCollector

The number of 
threads dedicated to 
the pool size monitor 
collector.

1

task.threads.pool.size
.customer.load

1

Parameter Name Parameter Description Type Value 
Description

Change 
Value? 
(Y/N)

notification.number.of.
publish.tasks

Number of single-
threaded tasks that 
publish CMDB changes 
to internal listeners.

integer N

notification.jms.connection.
factory

The JMS connection 
used for receiving 
notification.

N/A N/A N

notification.topic.jndi.name The JNDI name of the 
topic selected for 
notification.

N/A N/A N

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)
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Other Parameters
This section describes other data parameters: 

notification.sessions.
applications=DASHBOARD=3
;MAM_Viewing_system=3;
MAM_=10;CmdbExt=3;
AdaptersFramework=3;
MAM_AutoDiscovery=3;
sap=2;siebel=2;MAM_
Correlation_system=3

Defines a number of 
topic sessions for JMS 
subscribers per caller 
application.

string Definitions 
are 
separated by 
a semicolon 
(;).

N

notification.queue.size.max Maximum number of 
messages that can 
accumulate in the 
internal queue when 
the JMS server is down. 

integer N

notification.queue.flush.
interval

Interval of time to send 
any JMS messages 
accumulated in the 
queue.

integer Value is in 
seconds.

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.datamodel.da
ta.tablespace.na
me

The tablespace name 
for the data model. 

string Relevant for Oracle 
database only.

Y

dal.datamodel.in
dex.tablespace.n
ame

The tablespace name 
for indexes.

string Relevant for Oracle 
database only.

Y

dal.in.clause.thre
shold

The maximum 
number of values in 
a SQL IN clause.

integer N

Parameter Name Parameter Description Type Value 
Description

Change 
Value? 
(Y/N)
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dal.num.of.in.ch
unks

The maximum 
number of chunks 
to be performed by 
an SQL IN clause.

integer For example: an SQL 
WHERE clause 
generates n number 
of values. If 
(dal.in.clause.
threshold * dal.num.of.
in.chunks) > n, a 
temporary table is 
used. If, however, n is 
larger, several SQL 
statements are 
executed with the 
SQL IN clause. 

N

dal.use.dirty.read Defines whether the 
database queries use 
dirty read. 

boolean Relevant only for 
certain queries.

➤ true. Queries use 
dirty read.

➤ false. Queries do 
not use dirty read.

N

dal.update.class.
model.enabled

Defines whether CI 
Type Model updates 
are permitted. This 
parameter is 
currently used for 
consolidated tables 
in HP Software-as-a-
Service. 

boolean ➤ false. Tables are 
consolidated and 
an update of CI 
Type Model is not 
allowed.

➤ true. Tables are not 
consolidated and 
an update of CI 
Type Model is 
allowed.

N

dal.use.memory.i
nstead.temp.tabl
e.low.threshold=

 

dal.use.memory.i
nstead.temp.tabl
e.high.threshold
=

 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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dal.datamodel.m
ax.name.length.
allow

Maximum length of 
table and column 
names in database.

integer N

dal.classmodel.u
se.idgen

Defines whether to 
use the HP sequence 
ID generator for the 
database.

boolean ➤ true. Use ID 
generator.

➤ false. Do not use 
ID generator.

N

dal.datamodel.cr
eatetime.attribut
e.name

Name of the 
attribute with the 
creation time of the 
CI or relationship.

string N

dal.datamodel.u
pdatetime.attrib
ute.name

Name of the 
attribute with the 
last update time of 
the CI or 
relationship.

string N

dal.handle.statist
ics.on.startup=tr
ue

dal.statistics.start
up.percentage.th
reshold=5

dal.statistics.start
up.aging.thresho
ld.hours=36

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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Plug-in Parameters
This section describes the plug-in parameters: 

 

Quota Parameters
This section describes the quota parameters:

 

Parameter Name Parameter Description Type Value Description Change Value? 
(Y/N)

plugins.raw.event.
qualifiers

The list of attribute 
qualifiers relevant for 
raw events. If an 
attribute has one of the 
qualifiers in the list, this 
qualifier is sent as a raw 
event to the 
HP Universal CMDB 
server, to the event 
system.

string Names of attribute 
qualifiers must be 
separated by a 
semicolon (;). 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

quota.name.custome
r.model.objects

The maximum 
number of CIs in a 
CIT. Every customer 
in HP Software-as-a-
Service mode has a 
maximum number.

integer For example, if 
the value is 100 
and the CIT 
already includes 
100 CIs, no 
additional CIs 
can be added.

N

quota.name.custome
r.tql.active

The maximum 
number of active 
TQLs that can be 
run concurrently.

integer When the quota 
limit is reached, 
no further TQLs 
can be added.

N
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quota.name.server.m
odel.objects

The maximum 
number of CIs that 
the CMDB server 
can hold in a CIT for 
all customers 
combined.

integer ➤ In HP Business 
Availability 
Center, the 
value must be 
the same as 
quota.name.cu
stomer.model.o
bjects. 

➤ In 
HP Software-
as-a-Service, 
the value must 
be greater than 
quota.name.cu
stomer.model.o
bjects. 

N

quota.name.server.tq
l.active

The maximum 
number of active 
TQLs that can run in 
the entire CMDB 
Server. 

integer ➤ In HP Business 
Availability 
Center, the 
value must be 
the same as 
quota.name.cu
stomer.tql.activ
e. 

➤ In 
HP Software-
as-a-Service, 
the value must 
be greater than 
quota.name.cu
stomer.tql.activ
e. 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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quota.scheduler.inter
val.sec

The frequency in 
which the actual 
customer and server 
counts are checked 
against their defined 
quota value.

integer Value is in 
seconds.

N

quota.statistics.enabl
ed

Defines if quota 
counts should be 
returned to the Self-
Alert Monitor. This 
is relevant for 
HP Business 
Availability Center.

boolean ➤ false. Do not 
return the 
quota count. 
This value is 
relevant for 
HP Universal 
CMDB.

➤ true. Return 
the quota 
count to the 
Self-Alert 
Monitor. This 
value is 
relevant for 
HP Business 
Availability 
Center.

N

quota.check.enabled Defines whether to 
enforce quota 
checking.

boolean ➤ true. Perform 
quota 
checking.

➤ false. Do not 
perform quota 
checking.

N

quota.loader.name Defines where to 
load quota values.

string settings. Read 
from the 
HP Business 
Availability 
Center 
configuration 
file. 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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System TQL Parameters
This section describes the threshold parameters that determine whether or 
not node conditions are stored in the system TQL. 

 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

System TQL Cache 
Clean Frequency

Defines the 
frequency in which 
the system TQLs 
that are not used, 
and their results, are 
removed from the 
system.

integer The value is 
measured in 
hours.

N

System TQL Enabled Defines whether the 
system TQL 
component is 
enabled or not. 

boolean ➤ true. System 
TQL is 
enabled.

➤ false. System 
TQL is not 
enabled.

N

System TQL’s Life 
Time

Defines the time 
after which a system 
TQL's results are 
deleted from the 
system if not used.

integer The value is in 
hours.

N

System TQL's Max 
Result Size 

Defines the 
maximum number 
of CIs returned for 
the node condition 
for the results to be 
held in the system 
TQL.

integer If the number 
exceeds the 
maximum, the 
node condition 
results are not 
held in the 
system TQL.

N
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System TQL's Min DB 
Query Time 

The minimum 
amount of time it 
takes for the 
database to calculate 
the node condition 
results above which 
a system TQL can be 
created to hold the 
results.

integer For example, if 
calculation time 
is less than 10 
seconds, then the 
node condition 
results are not 
stored in the 
system TQL.

The value is 
measured in 
milliseconds.

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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2
IT Universe Manager

This chapter provides information on IT Universe Manager.

This chapter includes:

Concepts

 ➤  IT Universe Manager Overview on page 52

 ➤  Working with Pattern and Instance Views in IT Universe Manager on page 53

 ➤  View Tree Structure on page 56

 ➤  Working with CIs on page 57

 ➤  Working with Relationships on page 62

Tasks

 ➤  Populate an Instance View on page 69

Reference

 ➤  IT Universe Manager User Interface on page 70
Concepts
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IT Universe Manager Overview

IT Universe Manager offers a number of possibilities for managing your view 
content. The following tasks represent the basic functionality of the 
application:

➤ Creating CIs without creating relationships. You can define new CIs that are 
added at the root level of the view, so that no new relationships are created. 
For details, see “Creating a Non-Related CI” on page 57.

➤ Creating CIs with relationships for them. You can define new CIs and attach 
them to existing CIs in the view, so defining a new CI and a new 
relationship in the CMDB. For details, see “Creating a Related CI” on 
page 58.

➤ Adding existing CIs and creating relationships for them. You can copy CIs 
and CI subtrees from another view to the current view, and attach them to 
an existing CI in the view, so creating new relationships for existing CIs. For 
details, see “Attaching Existing CIs” on page 66.

Populating the IT Universe Model
The IT Universe model in the CMDB contains the CIs and relationships 
produced by the CI-generating tools that operate within HP Business 
Availability Center. Most CIs and relationships originate from one of the 
following sources:

➤ Source adapters. Automatically creates CIs and relationships for the 
monitor objects in End User Management Administration and System 
Availability Management Administration. For details, see “Source Manager” 
on page 665.

➤ Discovery and Dependency Mapping (DDM). Automatically creates CIs and 
relationships based on the discovered IT resources and topology in your 
company’s infrastructure. For details, see “Discovery and Dependency 
Mapping – Overview” in Discovery and Dependency Mapping Guide.

➤ Dynamic Node Factory tool. Automatically creates CIs and relationships 
based on data from incoming samples. For details, see “IT Universe Manager 
– Dynamic Node Factory” on page 105.
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➤ IT Universe Manager. Enables you to manually create CIs and relationships 
that represent logical and physical elements of the business. For details, see 
“Working with CIs” on page 57.

➤ End User Management Administration and System Availability 
Management Administration. Enables you to manually create relationships 
between the CIs for monitor objects and CIs in the CMDB. For details, see 
“SiteScope Monitors and HP Business Availability Center  Configuration 
Items” in Using System Availability Management.

➤ Enrichment Manager. Enables you to add CIs and relationships to the 
CMDB by receiving data from the attributes of Enrichment nodes as defined 
in the Enrichment TQL query. For details, see “Enrichment Manager” on 
page 239.

Working with Pattern and Instance Views in IT Universe 
Manager

There are two types of service views: pattern and instance.

➤ Pattern views are built from a TQL (Topology Query Language) query that 
defines the structure of the view. The view displays only those CIs and 
relationships that satisfy the query definition.

➤ Instance views are built by manually defining individual CIs and 
relationships directly in the new view and/or by adding CIs that exist in 
other views in the CMDB.

The functionality for working with the two view types in IT Universe 
Manager differs somewhat, as described in the following sections.

For information on the different view types and how they function, see 
“Instance Views and Pattern Views” on page 124.

Note: You must have Change permissions for a view to edit a view. If you do 
not have the necessary permissions, contact your HP Business Availability 
Center Administrator.
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This section includes the following topics:

➤ “Working in Instance Views” on page 54

➤ “Working in Pattern Views” on page 54

➤ “View Lifecycle” on page 55

Working in Instance Views
One default, empty instance view, the First Service View, is provided. Any 
further instance views you create are also empty until you manually add CIs 
to the view.

You can add any type of CI or relationship to an instance view, either by 
adding existing CIs or by creating new CIs within the view. When you 
define a new CI in the view, the CI (and any associated relationship) is also 
created in the CMDB, and is automatically added to any other view where 
the new CI is relevant. For example, if the parent of the created CI appears 
in another instance view and is set to show its child CIs, then the new child 
CI is automatically added to the parent in that view; or if the new CI fits the 
requirements of the TQL query in a pattern view, then it automatically 
appears in the pattern view.

Working in Pattern Views
CIs created by DDM or by Source Manager are automatically added to each 
pattern view where the CIs (and their relationships) fit the TQL definition 
for the view. When you open a pattern view in View Explorer, the TQL 
query for the view queries the CMDB for CIs that match the defined pattern. 
If there are no matches (for example, in the case of a view for a DDM process 
where the process has not yet run) then the view remains empty.

When you define a new CI while working in any view in IT Universe 
Manager, the CI (and any associated relationship) is created in the CMDB. 
The CI is also added to your current view if you are working in an instance 
view. However, if you are working in a pattern view, the new CI (and 
relationship) is visible in the view only if it meets the view’s TQL 
specifications.
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If the created CI and relationship do not meet the TQL requirements, then 
the CI and relationship are created in the CMDB but are not visible in the 
view. Similarly, if you attach an existing CI to a CI in the view, and the new 
pattern does not meet the TQL requirements, then the attached CIs do not 
appear in the view, but the relationship is still created.

View Lifecycle
If you do not access a view from View Explorer for a specified period of time, 
the view is cleared out, to save memory in the system. It is not deleted from 
the CMDB; the view can be retrieved by clicking on it. The default time 
period for clearing out unused views is one hour. You can set the time period 
using the MAM Server configuration parameter Views Usage Untouched 
Time Before Empty View in Infrastructure Settings Manager. After changing 
the parameter’s value, you must execute the JMX command: Core 
manager\reloadSystemParamaters() for the change to take effect.

You can also modify the frequency with which the system checks whether a 
view has been accessed. The default frequency is for the system to check 
every 15 minutes. To change this value, select the Views Usage Check Time 
Interval parameter in Infrastructure Settings Manager. After you change the 
value, restart the server service for the change to take effect.

For details regarding Infrastructure Settings Manager, see “Infrastructure 
Settings Manager - Overview” in Platform Administration.

Note: Views defined as persistent are not cleared out and always remain in 
the memory.
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View Tree Structure

Views are organized in a hierarchical tree format in the left pane of 
IT Universe Manager, which is known as View Explorer (it is also called CI 
Selector). The view name appears in the View box above the tree and acts as 
the containing folder for the CIs in the view. 

The first level of the View Explorer tree consists of the nodes for the root 
CIs. A root CI is the starting point for a view subtree. A view may contain 
any number of subtrees. Under the root CIs come the branch CIs, expanding 
down to the leaf CIs as the last nodes at the ends of each branch.

The CIs at each level in a subtree are considered to be attached to the CI on 
the branch directly above. This attachment generally depicts a dependent 
relationship, so that the higher branch (closer to the root CI) represents a 
component of your business that depends on the CIs on the next branch 
down (closer to the leaf CIs) in the business process. For example, an 
application depends on the servers running the application.

The attachment between a higher node and lower node is referred to as a 
parent-child relationship. The parent CI may have many attached child CIs, 
and the child CIs pass operational status to the parent. The status at each 
level is viewed in Dashboard. 

When defining an instance view, you build your own topology for the 
subtrees, according to the business structure or process you want 
represented. For more information, see “Working in Instance Views” on 
page 54.
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When working with pattern views, the tree topology is determined by the 
pattern defined for the view. For more information on defining pattern 
views, see “Working in Pattern Views” on page 54.

Working with CIs

In IT Universe Manager, you can create related and non-related CIs, edit the 
CI properties, and remove out-of-date CIs using the Aging Mechanism.

This section includes the following topics:

➤ “Creating a Non-Related CI” on page 57

➤ “Creating a Related CI” on page 58

➤ “General Properties for CIs” on page 60

➤ “CIT-Specific Properties” on page 60

➤ “Removing Out of Date CIs Using the Aging Mechanism” on page 61

➤ “Deleting CIs” on page 62

Creating a Non-Related CI
When you build a new subtree in your view, you generally start by creating a 
root CI representing a high-level logical element in your business. When 
working at the top level of the view, you can add a root CI by clicking the 
Insert CI button in the toolbar. 

The New CI Wizard opens, which enables you to define the properties for 
the new CI. The wizard creates the CI in the CMDB and adds the created CI 
as a root CI in your view. For details, see “New CI Wizard” on page 85. 

Note: If you are working in a pattern view, the CI is added to the view only 
if it meets the pattern specifications. 
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A CI created in this way is added as an independent entity without any 
current relationship to any other CI existing in the CMDB. After creating 
the first CI, you can then create or add related CIs below the first CI.

For example, if you are building an instance view to show your lines of 
business (LOB), you can add root CIs representing different LOBs within 
your organizational structure, as shown in the following figure:

Each LOB CI in the example is an independent entity, with no relationships, 
ready to become the root CI for a subtree. To build the subtree, you attach 
existing or new CIs. For details on attaching existing CIs, see “Attaching 
Existing CIs” on page 66.

Creating a Related CI
You can define a new CI to be added to your view as a parent, child, or 
sibling of an existing CI. Both the new CI and its relationship are created in 
the CMDB.

To define a new related CI:

 1 Select the CI in your view to which you want to attach the new CI.

 2 Click the Insert CI and Relate button in the toolbar.

 3 In the New CI Wizard, define the properties and relationship for the CI. For 
details, see “New CI Wizard” on page 85.

The wizard creates the CI in the CMDB, and adds the new CI as a related CI 
in your view.
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Note: If you are working in a pattern view, the CI is added to the view only 
if it meets the pattern specifications. 

In an instance view, the new child CI is included in other instances of the 
parent CI, on condition that the subtree is configured to use the Include All 
Child CIs rule. For information on the relationships between CIs, see 
“Working with Relationships” on page 62.

For example, if you are building an instance view to show your lines of 
business, under the LOB CIs at the root of the subtrees you can add logical 
CIs representing different locations dealing with that business line within 
your organizational structure. Each location is added as a child of the LOB 
CI, so that the LOB CI depends on the Location CI:

You can continue to build the branches of each LOB subtree by creating 
more related CIs to attach under the locations, and/or by attaching CIs or 
whole CI subtrees that already exist in the CMDB. For details on attaching 
existing CIs and CI subtrees, see “Attaching Existing CIs” on page 66.
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General Properties for CIs
The general properties of a CI are common to all CIs. Some general 
properties are defined automatically during CI creation; others can only be 
defined manually in the General Properties page of the wizard. You can 
access the Properties page to view the CI properties from IT Universe 
Manager by right-clicking the CI in View Explorer and selecting Properties 
from the context menu or by clicking the Properties tab. You can edit the CI 
properties as well if you have the necessary permissions for editing CIs. For 
details on CI properties, see “Properties Dialog Box” on page 96.

CIT-Specific Properties
CIT-specific properties are created as part of the CIT definition in the CI 
Type Manager. The values for the CIT-specific properties are taken from the 
data samples for the source adapter CIs, or from the CIs discovered during 
DDM. The values can also be entered manually, when you manually create 
CIs to represent entities in your infrastructure. For details, see “CI Type 
Manager” in CI Attribute Customization.

The CIT-specific properties are displayed in the Specific Properties section of 
the Properties dialog box when you sort the properties using the 
Categorized button. Some properties for the automatically created CIs can 
be edited; however, if the CI is configured to Allow CI Update (in the 
General Properties), then DDM may override your changes when it updates 
the CI. A description of the selected property can be found in the 
Description area at the bottom of the Properties dialog box.

For CIs generated by the source adapters, the only editable CIT-specific 
property is the Selector Expression for the monitor-type CIs. To edit the 
selector, click Edit Selector Expression. For details on editing selectors, see 
“Selectors for KPIs” in Using Dashboard. 

When the Siebel DDM process is run, the CIs that appear in the Siebel 
Enterprises view have most of their properties’ values automatically entered 
in the CMDB. Some of the properties relating to the location of packages or 
logs must be entered manually for data to be inserted correctly in the Siebel 
Enterprises view. For details, see “Change the Default Timeout for the 
Execution of a SiteScope Monitor” in Solutions and Integrations. 
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After the selector is modified, the current CI is updated according to the new 
selector definition, and a new CI is generated by the source adapters from 
the incoming samples based on the original selector.

Some of the CIT-specific properties for DDM CIs are set by default to be 
monitored for changes. When one of these properties has been modified, 
information on the change can be viewed in a change report, and in some 
cases, an icon is displayed in Dashboard. For more information, see “Change 
Report” on page 573.

Removing Out of Date CIs Using the Aging Mechanism
If a CI or relationship is not updated or refreshed over a period of time (for 
example, a CI is not rediscovered by DDM and no manual update occurs), 
an aging mechanism deletes the CI from the CMDB.

When the aging mechanism is enabled, the CI is marked for deletion if the 
CI has not been accessed for a specified period of time (by default, 14 days). 
The Last Access Time parameter (displayed in the General Properties area), is 
used to make the calculations. By default, the CI is deleted 28 days after the 
last access time. These default values are set per CIT and can be changed in 
the CI Type Manager.  

The aging mechanism for the CMDB is enabled or disabled from 
Infrastructure Settings Manager: Select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Foundations, select CMDB, 
and locate the Is Aging Enabled entry in the Aging Settings table. Change 
the value to true or false, as required.

When the aging mechanism is enabled for the CMDB in Infrastructure 
Settings, you can enable or disable aging and automatic deletion for 
individual CIs by selecting or clearing the Enable Aging box in the CI 
General Properties (the box is selected by default for DDM CIs). If the aging 
mechanism is disabled for the CMDB, the Enable Aging box is ignored and 
no CIs are deleted.

Note: The default setting of the aging mechanism is disabled.
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Deleting CIs
You can delete a CI by selecting Delete from CMDB from the context menu 
in IT Universe Manager. The CI is deleted from the CMDB and from all 
views. If a CI has children, they are not automatically deleted when you 
delete the parent CI. If you delete a CI without first deleting the relationship 
between the CI and any child CIs that were added within the view, the child 
CIs are not removed from the view, and they move up to the root level. This 
does not apply when deleting CIs from the view when working in the 
Instance View Editor in View Manager.

If the child CIs do not appear in any other view, they remain in the CMDB 
without appearing in a view. The child CIs might appear in the future in 
pattern views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and 
parent CI is a Container link; in that case, when the parent CI is deleted, the 
contained CI is also removed from the CMDB and the view. For example, if a 
host CI is the container for a child CPU CI, then when the host CI is deleted, 
the CPU is also removed from the CMDB.

When you delete a CI that was created by the source adapters or the DDM 
process, the CI is restored the next time that DDM runs or that the CMDB is 
updated by that source (if the CI is still valid), and it reappears in all relevant 
pattern views.

Working with Relationships

Many of the relationships between CIs in the CMDB are created 
automatically, for example, by DDM, the source adapters, and the Dynamic 
Node Factory. In addition, you can manually create relationships in 
IT Universe Manager, in Enrichment Manager, or in the Instance View 
Editor in View Manager. You can also create relationships in System 
Availability Management and End User Management Administration. 

This section includes the following topics:

➤ “Creating Relationships” on page 63

➤ “Creating Hierarchical Relationships” on page 64
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➤ “Automatically-Created Relationships” on page 65

➤ “Parent and Child Relationships” on page 65

➤ “Available Relationship Types” on page 66

➤ “Attaching Existing CIs” on page 66

➤ “Adding Folding Rules to Relationships” on page 68

➤ “Deleting Relationships” on page 68

Creating Relationships
You can create relationships in IT Universe Manager by right-clicking a CI or 
multiple CIs in the View Explorer pane or the Topology Map and selecting 
Relate to CI from the context menu. In the Topology Map, you can define a 
relationship between two CIs in the view by drawing a line between the two, 
using the Create Relationship button from the toolbar. Either of these 
actions opens the Attach Related CIs wizard. For details, see “Attach Related 
CIs Wizard” on page 72.
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You can create as many relationships as necessary between a CI in the 
CMDB and other CIs. Each new relationship exists as its own entity in the 
CMDB, and has its own properties that can be edited in IT Universe 
Manager (as described in “Properties Dialog Box” on page 96). You can also 
create more than one relationship between the same two CIs, when each 
relationship is based on a different relationship type. In the following 
example, host7 has both a Backbone and a Talk relationship with host8.

Creating Hierarchical Relationships
By attaching one CI to another in IT Universe Manager or System 
Availability Management or End User Management Administration you 
create a hierarchical relationship (parent-child) between them, so that one 
CI is influenced by the other. 
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Certain relationships defined in this way can be only of relationship type 
Depends On (if the relationship is between two non-monitoring CIs), or of 
relationship type Monitored By (if the child CI in the relationship is a 
monitor type CI); however, other relationship types are used between 
specific types of CIs. For example, if a relationship is defined between two 
Host CIs, there are several possible relationship types.  

 

Automatically-Created Relationships
When a CI is added to your view under another CI using the Instance View 
Editor in View Manager, a relationship is automatically created between the 
two CIs, using the default relationship for the two CI types. This can be a 
Depends On relationship (for example, between two logical CIs) or a 
Monitored By relationship (between a logical CI and a monitor CI). If there 
is no valid relationship between the two CIs (for example, between two 
monitor CIs), a message is displayed saying that no valid link was found 
between the two items.

Parent and Child Relationships
When you attach a child CI to a parent CI in your view, you are also creating 
that relationship in the CMDB. The child therefore impacts on the parent CI 
in every view where the relationship exists, and is displayed in every 
instance view where the parent CI is set to display all CMDB children (and 
for pattern views, where the child and relationship matches the TQL). For 
more information, see “Using the Instance View Editor” on page 128.
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Available Relationship Types
The following lists the relationship types available in the CI Type Manager 
(and used in TQLs) that the Business Logic Engine recognizes when 
performing status calculations:

➤ member

➤ applicationLink

➤ monitored_by_for_sap

➤ monitored_by_for_siebel

➤ contained

➤ business_unitlink

➤ contains

➤ container_f

➤ depends_on

➤ monitored_by

➤ eum_links

➤ system_monitor_links

➤ monitor_links

Attaching Existing CIs
You attach existing CIs using the Attach Related CIs wizard. The wizard has 
two main stages:

➤ Selecting the CIs that you want to attach.

➤ Defining the relationship between the original CI and the CIs to attach. For 
information on relationships, see “Working with Relationships” on page 62.

When selecting the CIs to attach, you can select multiple CIs from a view to 
attach to the original CI. However, all CIs that you want to attach in one 
operation must have the same relationship type. For example, you cannot 
attach a CI that uses the relationship Depends On in the same operation as a 
CI that uses the relationship Monitored By.
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You cannot create an identical relationship between the same CIs twice 
within a view. For example, if parent CI Italy depends on child CI Rome, 
Rome appears under the CI Italy in the view. If you then again attach Rome 
to Italy with a Depends On relationship, Rome still appears once only under 
that parent CI. This is true even if you attach each instance of the child with 
different settings, for example, one instance set to display child CIs, and one 
instance set to not display them.

Attaching CIs in Instance Views

When attaching CIs to a parent CI in an instance view, you can choose to 
set the CIs to display all CMDB children, by using the Add CIs and Their 
Children button. For more information, see “Child CI Rule Functionality” 
on page 130.

When CIs are added under a CI that is already set to display all CMDB 
children, the child CIs are displayed, regardless of which child rule the CIs 
in the subtree are using. The CIs are added to the list in the right pane, with 
the Include Child CIs column selected as relevant.

If there is a compatibility problem with the relationship types for the 
different CIs that you select, an error message is displayed saying that no 
valid relationships were found. In this case, select the CIs that you think are 
causing the problem from the list in the right pane, and remove them using 
the Remove CIs arrow button.

If, when attaching multiple CIs to a CI, you define all of the attached CIs as 
parents to the original CI (for example, so that the relationship direction 
reads CI X, CI Y, CI Z Depends On CI 1), a separate subtree is created in the 
view for each parent, with the original CI appearing as a child in each 
subtree.

When you add an existing CI to an instance view as a child CI, there may 
already exist relationships in the CMDB between that CI and other CIs in 
your view. Now that the CI is displayed in the view in the new location, it 
also appears under other CIs in the view to which it is related.
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Attaching CIs in Pattern Views

When working in pattern views, the Add CIs and Their Children option is 
not available. Both the added CI and its child CIs appear in the view only if 
the CIs and the relationships conform to the requirements of the TQL for 
the view. For more information, see “Working in Pattern Views” on page 54.

Note: When copying a CI from a DDM process pattern view to an instance 
view, if you choose to display the child CIs, be aware that you may be 
adding hundreds of hidden child CIs that do not appear in the pattern view.

Adding Folding Rules to Relationships
After setting the node and relationship definitions of a pattern view, you 
can add folding rules to selected relationships in View Manager. This enables 
you to define the organizational structure of CIs in the Topology Map by 
displaying selected CIs at different levels. When no folding rules are defined, 
the Topology Map displays all CIs included in the query results on one level 
by default. For example, if the query results include hosts and networks, 
both CI types are displayed on the same level in the Topology Map.

Note: The maximum number of CIs that can be displayed in a single layer is 
900. If a view contains a layer with more than 900 CIs, the view is not 
displayed in the Topology Map until the folding rules are changed.

For details on adding folding rules, see “Add Rule” on page 272.

Deleting Relationships
The Topology Map shows only the relationships for the CIs that are part of 
the current view; however, the same relationships may also be part of other 
views. When you delete a relationship from the current view, it is also 
deleted from the other views.
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When a relationship is deleted, CIs that were added to the view are not 
removed. Following the deletion of the relationship, the CI is no longer 
related to any other CI in the view, and the CI is shown at the top level of 
the view. To remove the CI completely from the view (without deleting it 
from the CMDB), use the Delete Relationship to Parent CI option in the 
Instance View Editor.

When you delete a relationship that was created by the source adapters or 
the DDM process, the relationship is restored the next time that DDM runs 
or that the CMDB is updated by that source (if the relationship is still valid), 
and it reappears in all relevant pattern views.

It can take a few minutes to delete subtrees, or multiple CIs and 
relationships, from a view.

Tasks

Populate an Instance View

This task describes how to populate an instance view with CIs.

This task includes the following steps:

➤ “Prerequisites” on page 69

➤ “Add CIs to the View” on page 69

➤ “Set Permissions” on page 70

 1 Prerequisites
You can create a new instance view from within View Manager. For details, 
see “Create New View/View Properties Dialog Box” on page 143.

 2 Add CIs to the View
To populate an instance view with CIs, you can add existing CIs from the 
CMDB to your view or you can define new CIs to appear in your view. The 
new CI and relationship are created in the CMDB and the created CI is 
added at the specified point in the view tree. For details, see “Instance View 
Editor” on page 149.
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Tip: If the CI does not appear in the view, try refreshing the view using the 
Refresh button in View Explorer.

Adding Existing CIs

You can add existing CIs from the CMDB to your view using the Attach 
Related CIs Wizard. Select the CIs you want to add to your view in the Select 
Related CIs dialog box of the wizard. Then define the relationships in the 
Relationship Properties dialog box of the wizard. For details, see “Attach 
Related CIs Wizard” on page 72.

Adding New CIs

To define a new CI in IT Universe Manager, select Insert CI and Relate to 
access the New CI Wizard. For details, see “New CI Wizard” on page 85. 

 3 Set Permissions
You should apply viewing and editing permissions to users and user groups 
for that view. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, see 
“Assign Permissions” in Platform Administration.

Reference

IT Universe Manager User Interface

This section describes:

 ➤  Add Background Image Dialog Box on page 71

 ➤  Attach Related CIs Wizard on page 72

 ➤  CI/Relationship History Dialog Box on page 77

 ➤  Get Related CIs Report on page 78

 ➤  IT Universe Manager Window on page 79

 ➤  New CI Wizard on page 85
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 ➤  Properties Dialog Box on page 96

 ➤  Select Configuration Item Type Dialog Box on page 100

 ➤  Selector Expression Dialog Box on page 100

 ➤  View Discovery Wizard on page 101

Add Background Image Dialog Box

Description Enables you to add an image as a background to a view as a 
navigational aid.

To access: In IT Universe Manager, select Layout > Add 
Background Image from the toolbar.

Important 
Information

You can add an image file (of .gif type) as the background 
image of a view. This can be used as a navigational aid, for 
example, for global networks containing different networks 
in different countries. 

You can add additional background images to the existing 
list by inserting image files (of .gif type) to the following 
location: 

<HP Business Availability Center root directory>
\AppServer\webapps\site.war\images\gui\mam_images
\gui\images\backgrounds.

Tip: Before copying this URL to a browser, copy to a text 
editor and remove the break markups (<br />).

Note: This option is only active when Manual Layout is 
selected as the layout for the view.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Attach Related CIs Wizard

GUI Element (A–Z) Description

Background 
Image

Displays the selected image.

File Name Contains a list of the available image files. Select the file 
name of the image you want to appear in the view and click 
OK. To remove an image from a view, select None in the File 
Name list and click OK. Click Save Layout in the toolbar to 
save your changes.

Description Enables you to attach CIs to the CI you selected in View 
Explorer.

To access: In IT Universe Manager, right-click a CI in the 
Topology Map, and select Relate to CI from the context 
menu.

Important 
Information

The left pane of the Select Related CIs dialog box 
functionality follows the standard View Explorer 
functionality. For details, see “View Explorer” on page 615.

To create a relationship between two CIs, select the CIs in 
View Explorer or the Topology Map and then select Relate 
to CI from the context menu.

Included in Tasks “Populate an Instance View” on page 69

Useful Links “View Explorer” on page 615

Wizard Map The Attach Related CIs wizard contains:

Select Related CIs Dialog Box > Relationship Properties 
Dialog Box
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Select Related CIs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the CIs to be attached to the CI you 
selected in View Explorer.

Important 
Information

The left pane of the Select Related CIs dialog box 
functionality follows the standard View Explorer 
functionality. For details, see “View Explorer” on page 615.

For general information about the Attach Related CIs 
Wizard, see “Attach Related CIs Wizard” on page 72.

Wizard Map The Attach Related CIs wizard contains:

Select Related CIs Dialog Box > Relationship Properties 
Dialog Box

GUI Element (A–Z) Description

Click Add CIs to add the selected CIs in the left pane to the 
Edit pane without adding the children of the CI.

Click the Add CIs and their Children button to add the 
selected CIs in the left pane to the edit pane together with 
all the children of the selected CIs in the CMDB.

Note: This option appears for instance views only.

Click Remove CIs to remove selected CIs in the Edit pane 
(this does not delete the CIs from the CMDB).

CI Name column Shows the names of the selected CIs.

CI Type column Shows the types of the selected CIs.

Include child CIs 
column

Indicates whether the selected CI was added together with 
its child CIs.

Note: This column appears for instance views only.
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Relationship Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the relationship to be created between 
your CI and the CIs selected in the previous step.

Important 
Information

When defining multiple relationships, you can define 
different descriptions and property values for each 
relationship: Skip the property definitions here and edit 
each relationship individually after it is created.

Wizard Map The Attach Related CIs wizard contains:

Select Related CIs Dialog Box > Relationship Properties 
Dialog Box

GUI Element (A–Z) Description

Allow CI Update When the check box is selected, the DDM process 
automatically updates the relationship.

CI 1 Displays the name of the CI on the first end of the 
relationship. This is the CI that you selected in the view.

CI 2 Displays the name of the CI on the second end of the 
relationship, that is attached to the original CI.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Description A detailed description of the relationship.

Destination 
Network Address

Defined only for route links. Indicates the destination 
network address to which this route is configured.
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Direction Enables you to define the direction of the relationship, by 
selecting the appropriate radio button. For example, if [CI 1] 
Depends On [CI 2] (generally the default option), then the 
new CI is created as child CIs of the originally selected CI. If 
[CI 2] Depends On [CI 1], then the new CI is created as a 
parent to the originally selected CI.

For some relationship types (for example, Container link, or 
between a group CI and a monitor CI), only one direction is 
enabled. 

Enable Aging (Only displayed for certain CIs.) When this option is 
selected, the aging mechanism is enabled for this 
relationship. It is selected by default for DDM CIs. For 
details, see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.

Last Access Time The time that the CI or relationship was last accessed, 
whether when being updated or being discovered by DDM. 
This field is displayed only for certain CIs.

Must When the check box is selected, the child CI is dominant 
when the percentage rule is used to calculate status for the 
parent CI. If the CI has low status, the parent must take the 
child CI status, if necessary overriding the percentage rule 
calculation. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The must status defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
of the child CI. For details, see “Percentage Rule” in 
CI Attribute Customization.

Name A brief description of the relationship. If no value is entered, 
the relationship type is used in place of the name.

Note Enables you to enter other information about the 
relationship.

GUI Element (A–Z) Description
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Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Relationship Type Enables you to define the type of relationship created 
between the original CI and the CIs being attached. Select 
an option from the list. For most relationships, only the 
Depends On option or the Monitored By option is available, 
depending on the type of CIs for which you are creating a 
relationship.

Updated By The user name of the administrator who updated the CI 
properties.

Update Time The date and time when the relationship properties were 
last updated.

User Label Enables you to define a display label for the relationship. If 
no value is entered, the relationship name appears as the 
default label.

Weight When a weight value is entered in the box, the child CI is 
given more weight in percentage calculations, when 
percentage rule is used to calculate status for the parent CI. 
For example, if a child CI is given a weight of 3, then it has 
three times more impact on the parent status calculation 
than its unweighted siblings.

The weight defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
the child CI may have. For more details, see “Percentage 
Rule” in CI Attribute Customization.

GUI Element (A–Z) Description
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CI/Relationship History Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a list of attributes in which changes have 
occurred as well as the difference between two 
configuration files.

To access: In IT Universe Manager, right-click the selected 
CI or relationship in View Explorer or the Topology Map 
and select CI History from the context menu.

GUI Element (A–Z) Description

View the difference between two configuration files. 
Select two CIs of type configfile and click the Show 
difference button to open the Visualdiff report, which 
displays a comparison of the two files. Text added to the 
second file appears highlighted in yellow. Text removed 
from the first file appears highlighted in red. Differences 
between the files appear highlighted in green. 

Attribute The name of the attribute.

Change Date The date when the last change occurred.

Changer Indicates the cause of the change. For example, the field 
can contain the name of a user or a DDM pattern.

Filter by Select an attribute type from the drop–down list to reduce 
the number of attributes appearing in the list.

New Value The new value of the attribute.
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Get Related CIs Report

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the CIs related to a specified CI in a 
tree format.

To access: In IT Universe Manager, click Generate Report 
 from the toolbar.

Important 
Information

➤ For information about limitations on the size of reports 
produced in .pdf format, see “Troubleshooting and 
Limitations” in Reports. 

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reports.

GUI Element (A–Z) Description

<Related CIs data> The report data consists of the CIs related to the selected 
CI, arranged in tree format with the selected CI as the 
root. The child CIs are arranged by CIT.

Generate Click the Generate button to generate the data for the 
selected period.
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IT Universe Manager Window

Description Enables you to define and manage the CIs and 
relationships in your views.

The IT Universe Manager window contains the following 
panes:

➤ View Explorer (CI Selector). Displays the CIs of a 
selected view. You can select the view from a 
drop–down list. For details, see “View Explorer” on 
page 615.

➤ Topology Map. Displays the CIs of a selected view.

➤ Information Pane. Displays properties and history for 
the selected CI.

To access: Select Admin > Universal CMDB > Modeling > 
IT Universe Manager.

Important 
Information

When working in a view in IT Universe Manager, you can 
create new CIs, modify existing CIs, or delete CIs. All of 
these actions have a direct effect on the entire IT Universe 
model. For example, if you delete a CI in your view, that 
CI is deleted from the IT Universe model and no longer 
appears in any view.

Useful Links “Save Snapshot Dialog Box” on page 527

“Set View Parameters/Set View Element Parameters Dialog 
Box” on page 155
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Topology Map

Description Displays the CIs of the currently selected view in 
graphical format.

To access: Select Admin > Universal CMDB > Modeling > 
IT Universe Manager.

Important 
Information

When you select a CI in View Explorer or the Topology 
Map, the Configuration Items drop-down in the Main 
Menu becomes active. The options available under that 
drop-down are the same as those available by right-
clicking the CI.

You can customize the Topology Map context menu to 
include other commands (for example, ping, run a 
program, open a URL) from within CI Type Manager. For 
details, see “Create Configuration Item Type Wizard” in 
CI Attribute Customization.

Note: For grouped CIs and the relationships between 
them, not all of the context menu options are active. 
Grouped CIs appear in parentheses in View Explorer and 
in the Topology Map. You can double-click a link to a 
grouped CI to open the Link Map, which displays the 
individual CIs and relationships. Right-click a CI or 
relationship in the Link Map to display the regular 
context menu. For details about grouping CIs, see “Group 
By Dialog Box” on page 146.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Select the topology map mode from the Show window in 
the toolbar.

The following modes are available:

➤ View Results. Displays an entire layer within a view.

➤ Related in View. Displays the interdependencies of the 
selected CI within the current view.

➤ Related in DB. Displays the interdependencies of the 
selected CI within the entire CMDB.

Note: The modes can also be selected from the 
Operations drop-down in the Main Menu.

<Main Menu> For details, see “Main Menu” on page 650.

<Node> The nodes in the topology map represent CIs.

Hold the pointer over a node to display its tooltip which 
describes the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, 
which describes the type of the relationship.

<Toolbar> For details, see “Toolbar Options” on page 654
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IT Universe Manager Context Menu

The IT Universe Manager window includes the following elements (listed 
alphabetically) available by right-clicking a CI or relationship in the View 
Explorer pane or Topology Map:

Menu Item Description

Actions Select one of the following options:

➤ Add CI to Discovery Job. Displays the Add CI to 
Discovery Job dialog box, which enables you to 
manually invoke a DDM job for the selected CI. You 
can use this option to discover additional information 
about the CI through one of the available DDM jobs.

➤ Remove CI from Discovery Job. Displays the Remove 
CI from Discovery Job dialog box, which enables you 
to manually remove a CI from the DDM job.

CI/Relationship 
History

Displays the CI History dialog box. For details, see 
“CI/Relationship History Dialog Box” on page 77.

Delete from CMDB Enables you to delete the selected CI or relationship from 
the view and from the CMDB.

Note: When you delete a parent CI, the selected CI and 
its children are removed from the view, but only the 
selected CI is removed from the database.

Detach from Instance 
View

Enables you to delete a CI from an instance view (the CI 
remains in the CMDB).

Note: This options only appears in the context menu for 
instance views.
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Get Related CIs The following options are available:

➤ From View. Opens a window displaying the selected CI 
and its immediate neighbors within the current view.

➤ From Database without Filter. Opens a window 
displaying the selected CI and its immediate neighbors 
in the CMDB.

➤ From Database with Filter. Opens a dialog box that 
displays the number of related CIs by type. Select the 
CI type you want to display in the Topology Map 
results and click OK.

➤ Reveal From Database without Filter. Adds to the 
existing map the immediate neighbors of the selected 
CI in the CMDB. This option is only active within the 
Related in DB mode of the Topology Map.

➤ Reveal From Database with Filter. Opens a dialog box 
which displays the number of related CIs by type. 
Select the CI type you want to display in the Topology 
Map results. Adds to the existing map the immediate 
neighbors of the selected CI that match the CI type 
selected. This option is only active within the Related 
in DB mode of the Topology Map.

➤ Reveal from View. Adds to the existing map the 
immediate neighbors of the selected CI in the view. 
This option is only active within the Related in View 
mode of the Topology Map.

Label Select one of the following options:

➤ Edit Label. Opens the Edit Label dialog box which 
enables you to edit the name of the CI.

➤ Reset Label. Resets the CI name to its default value 
from the CMDB.

Note Select one of the following options:

➤ Add Note. Opens an editing box where you can add a 
note to the CI.

➤ Delete Note. Deletes all text saved in a note for the 
selected CI.

Menu Item Description
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Information Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Open Appears only for configuration file CIs. Opens the 
configuration file in a popup window.

Properties Displays the Properties page for the selected CI or 
relationship. For details, see “Properties Dialog Box” on 
page 96.

Relate to CI Opens the Attach Related CI Wizard. For details, see 
“Attach Related CIs Wizard” on page 72.

Show Compound 
Path

Appears only for compound relationships. Displays the 
Link Map for the selected relationship, which shows the 
CIs involved in the compound relationship.

Show Differences Appears only for configuration file CIs. When two such 
CIs are selected, the option is active. Displays the 
differences between the two configuration files in a 
popup window. For details, see “CI/Relationship History 
Dialog Box” on page 77.

Straighten Straightens the relationship between two nodes. This 
option is only available for relationships that have angles.

View Sublayer Displays a popup window showing the CIs in the layer 
beneath the selected CI.

Note: This option is only active for CIs with children.

GUI Element (A–Z) Description

Edit Click Edit to open the Properties dialog box for the 
selected CI.

History Tab  Displays the history for the selected CI. For details, see 
“CI/Relationship History Dialog Box” on page 77.

Properties Tab Displays the selected CI’s properties. For details, see 
“Properties Dialog Box” on page 96.

Menu Item Description
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New CI Wizard

Description Enables you to enter basic information to define a new CI.

To access: In IT Universe Manager, click the Insert CI icon in 
the toolbar to create a non-related CI. Click the Insert CI 
and Relate icon to create a new related CI.

Important 
Information

The first step of the wizard is the Define General Properties 
dialog box. The next step depends on the selected CI type. 
For some CI types, the Next button takes you to the Define 
CIT-Specific Properties dialog box, followed by the Define 
CI Relationship dialog box for related CIs. For others, it 
takes you directly to the Define CI Relationship dialog box. 
For non-related CIs, the wizard does not take you to the CI 
Relationship dialog box.

Included in Tasks “Populate an Instance View” on page 69, “Create and 
Populate an Instance View” on page 139

Useful Links “View Explorer” on page 615

Wizard Map The New CI wizard contains:

Define General Properties Dialog Box > (Define CIT-Specific 
Properties Dialog Box) > (Define Configuration Item 
Relationship Dialog Box)
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Define General Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to enter basic information to define a new CI.

Important 
Information

This is the first step of the New CI Wizard. Mandatory fields 
are denoted by a red asterisk.

The general properties are common to all CI types. There are 
additional properties which may appear under general 
properties for specific CI types when they are defined as key 
properties of those CI types. For example, the Container 
field is defined as a key property for all CI types grouped 
under Host Resources.

For general information on the New CI Wizard, see “New CI 
Wizard” on page 85.

Wizard Map The New CI wizard contains:

Define General Properties Dialog Box > (Define CIT-Specific 
Properties Dialog Box) > (Define Configuration Item 
Relationship Dialog Box)

GUI Element (A–Z) Description

Allow CI Update When selected, this option enables the DDM process to 
automatically update the CI properties with information 
that it discovers. If you change the value of a property 
supplied by the DDM process, the value is overridden by the 
discovered value.

When this option is cleared, the CI properties are not 
overridden by the DDM process.

City The name of the city. The list is automatically updated 
when you select a country (or state, when applicable). Select 
an option from the list.
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CI Type Enables you to select the CI type for the new CI. The CI type 
property is context sensitive, permitting you to select only 
the CI types that are appropriate for the selected CI or view.

You can select the CI type from the drop–down list by 
clicking the down arrow to the right of the CI Type box. 
This contains an abbreviated list of the most commonly 
used CI types as well as CI types that you have previously 
used. 

Alternatively, you can select from the CI Types Tree or CI 
Types Table by clicking the ellipsis button  next to the CI 
Type box. For details, see “Select Configuration Item Type 
Dialog Box” on page 100.

These display all the available CITs that are appropriate for 
the context. You can toggle the display between the CI 
Types Tree and the CI Types Table using the button in the 
bottom left of the box.

Country The country in which the CI is located. Select an option 
from the list. You must define a geographical location – 
country, state (if applicable), and city – if you want the CI to 
appear on the Geographical Map in Dashboard. For more 
information, see “Geographical Map” in Using Dashboard.

Created By The user name of the administrator who manually created 
the CI, where applicable.

Create Time The date and time when the CI was created.

Description A description of the CI.

Enable Aging When this option is selected, the aging mechanism is 
enabled for this CI. It is selected by default for DDM CIs. For 
details, see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.

Note: This field is only displayed for certain CIs.

GUI Element (A–Z) Description
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Include Related 
CIs

This feature is only enabled for instance views. 

If the check box is selected, the CI is set to recursively 
display in the view all child CIs from the CMDB, and all CIs 
in the subtree for the CI are also displayed in the view.

If the check box is not selected, the CI is set to display only 
child CIs that are manually added within the view.

Last Access Time The time that the CI was last accessed, whether when being 
updated or being discovered by DDM. This field is displayed 
only for certain CIs.

This parameter is used by the aging mechanism. For details, 
see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.

Name The name of the CI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the CI, or 
the application where the CI was created.

State The name of the state – when applicable for the selected 
country. The list is automatically updated when you select a 
country. Select an option from the list.

Tooltip 
Descriptions

To display tooltips for the fields on the page, select the 
Tooltip Descriptions check box and hold the pointer over 
the field names.

Updated By The user name of the administrator who updated the CI 
properties.

Update Time The date and time when the CI properties were last updated.

User Label Enables you to define a display label for the CI. If no value is 
entered, the CI name appears as the default label.

GUI Element (A–Z) Description
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Define CIT-Specific Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to enter CIT-specific properties for certain CIs.

Important 
Information

Each CIT has fields for the specific properties relevant to 
that CIT. Click the Tooltip Descriptions box and hold the 
pointer over a selected property field for more information 
on the property. Mandatory fields are denoted by a red 
asterisk.

The Define CIT-Specific Properties dialog box for a CI of 
type Dynamic Node Factory is described in a separate table 
below. 

Wizard Map The New CI wizard contains:

Define General Properties Dialog Box > Define CIT-Specific 
Properties Dialog Box > (Define Configuration Item 
Relationship Dialog Box)

GUI Element (A–Z) Description

<Properties> Enter the relevant information for the properties specific to 
the selected CIT. Fields designated with a red asterisk are 
mandatory.

Note: Certain CITs have ID fields in the CIT-Specific 
Properties page which are automatically generated 
randomly and cannot be edited. These are indicated on the 
page as Auto-generated.

Tooltip 
Descriptions

To display tooltips for the fields on the page, select the 
Tooltip Descriptions check box and hold the pointer over 
the field names.
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CIT-Specific Properties for Dynamic Node Factory

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Create CI if 
groupBy value 
missing

Defines how to handle samples that are missing the 
grouping (groupBy) key. When the check box is selected a 
CI is still created for the sample.

Default value: selected

DNode definition 
key

Defines how the received data samples are processed to 
generate the hierarchy. For details, see “DNode Definition 
Key Property” on page 110.

The default DNode definition key is for a Business Process 
Monitor source.

DNode ID Appears only in the Other Properties pane of the CI 
Properties screen. The DNode ID is automatically assigned 
and cannot be edited.

Enable DNode When the check box is selected, the Dynamic Node Factory 
hierarchy is updated as required based on the incoming 
samples. If the check box is deselected, the hierarchy is not 
updated (but the KPIs for the CIs still receive status updates 
in Dashboard).

Default value: selected
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KPI status for 
removal

Defines at which KPI status the generated CIs can be 
considered for removal from the CMDB (default is Nodata). 
If all KPIs for a CI have held this status for at least 24 hours 
(default period), the CI is eligible to be removed from the 
CMDB, if it was created by this Dynamic Node Factory. 
Once an hour, the Dynamic Node Factory cleaner removes 
the CIs that are marked as removable.

This option enables automatic cleaning of CIs that have not 
received corresponding data samples for 24 hours. You can 
select a different status from the KPI status for removal list 
according to the characteristics of the generated CIs. For 
example, you may have generated ticket CIs that change to 
status green (OK) when the ticket is closed; after 24 hours at 
OK status these CIs are considered no longer relevant for 
your views.

Note: This applies to monitor (leaf) CIs. When a leaf CI is 
removed, the CIs above it in the hierarchy are also removed 
if they have no other children.

Max number of 
CIs to create

Defines the limit for creating CIs in the Dynamic Node 
Factory hierarchy, default is 1000. When a sample is 
received and the number of CIs in the hierarchy is below 
1000, then the Dynamic Node Factory adds new CIs to the 
hierarchy as required by the sample, even if the number of 
CIs then exceeds 1000. However, if the hierarchy already 
has more than 1000 CIs when a sample is received, no new 
CIs are created.

If you think that the number of CIs might be close to or 
exceeding the defined limit, check the<HP Business 
Availability Center root 
directory>\log\EJBContainer\Trinity.log file. If there is a 
problem, either change the limit in the Max number of CIs 
to create property, or modify the selector expression to 
narrow down the definition. (Also take into consideration 
the overall CI limit for the IT Universe Manager tab.)

GUI Element (A–Z) Description
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Selector 
expression

Defines the filter that catches the samples on the bus that 
are required for the Dynamic Node Factory. These samples 
are processed according to the generator definitions in the 
DNode definition key property. For example, if you want 
the generators to be applied against all Business Process 
Monitor samples, you would define a selector for 
sampleType "trans_t". If you want to narrow the catchment 
area, narrow the filter by adding additional selector 
expression rows.

To define or edit the selector, click Edit Selector 
Expression. For details on defining selector expressions, see 
“Selectors for KPIs” in Using Dashboard.

Time period for 
removal status

Defines the time period during which all KPIs for a CI must 
have the status defined in KPI status for removal, before the 
CI can be marked as removable (default is 24 hours). If you 
want to change the value, enter a number followed by one 
of the following suffixes: s - for seconds, m - for minutes, h -
for hours, d - for days.

Note: The Dynamic Node Factory cleaner is set to review 
Dynamic Node Factory content and remove expired CIs 
once an hour. If the value set for the Time period for 
removal status is less than an hour, then the actual removal 
time may still be up to an hour, when the next cleaner 
review takes place. 

If required, you can change the default value for the 
Dynamic Node Factory clean interval parameter on the 
Infrastructure Settings page. Select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, select 
Foundations and select Online Business Logic Engine from 
the drop-down menu. However, the cleaning values should 
be changed with care, to avoid disrupting the sensitive 
balance of the cleaning mechanism.

Tooltip 
Descriptions

To display tooltips for the fields on the page, select the 
Tooltip Descriptions check box and hold the pointer over 
the field names.

GUI Element (A–Z) Description
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Define Configuration Item Relationship Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the relationship between the new CI 
and the CI selected in the view, as well as the properties of 
the relationship.

Important 
Information

This is the final step of the New CI Wizard, when creating a 
related CI.

Wizard Map The New CI wizard contains:

Define General Properties Dialog Box > (Define CIT-Specific 
Properties Dialog Box) > Define Configuration Item 
Relationship Dialog Box

GUI Element (A–Z) Description

Allow CI Update When the check box is selected, the DDM process 
automatically updates the relationship.

CI 1 The name of the CI on the first side of the relationship. This 
is the CI that you selected in the view.

CI 2 The name of the CI on the second side of the relationship. 
This is the new CI that you are creating.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Description A description of the relationship.

Enable Aging Enables the aging mechanism for the CI being created. It is 
selected by default for DDM CIs.

Last Access Time The time that the CI was last accessed, whether when being 
updated or being discovered by DDM. This field is only 
displayed for certain CIs.
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Must When the check box is selected, the child CI is dominant 
when the percentage rule is used to calculate status for the 
parent CI. If the CI has low status, the parent must take the 
child CI status, overriding the percentage rule calculation if 
necessary. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The Must status defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI.

Name The name of the CI.

Network Address Defined only for route links. Indicates the destination 
network address to which this route is configured.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Relationship Type Enables you to define the type of relationship that is created 
between the two CIs. For most relationships, only the 
Depends On option is available.

Tooltip 
Descriptions

To display tooltips for the fields on the page, select the 
Tooltip Descriptions check box and hold the pointer over 
the field names.

Updated By The user name of the administrator who updated the 
relationship properties.

Update Time The date and time when the CI properties were last updated.

GUI Element (A–Z) Description
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User Label Enables you to define a display label for the relationship.

Weight When a weight value is entered in the box, the child CI is 
given more weight in percentage calculations, when the 
percentage rule is used to calculate status for the parent CI. 
For example, if a child CI is given a weight of 3, then it has 
three times more impact on the parent status calculation 
than its unweighted siblings.

The weight defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI.

GUI Element (A–Z) Description
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Properties Dialog Box

Description Enables you to view and edit basic information for an 
existing CI or relationship.

To access: Select Admin > Universal CMDB > Modeling > 
IT Universe Manager and use one of the following:

➤ Select a CI in the topology map or View Explorer. In the 
Information Pane, select the Properties tab and click Edit. 

➤ Right-click a CI in View Explorer or the Topology map 
and select Properties.

Important 
Information

The Properties dialog box contains two types of properties: 

➤ General properties, which include general information 
about the CI or relationship. These properties are 
common to all CITs and are documented below.

➤ CIT-specific properties, which include properties specific 
to that CI. These properties vary according to the type of 
CI or relationship and are not documented except in the 
case of Dynamic Node Factory CIs. For details about CIT-
specific properties for Dynamic Node Factory, see “CIT-
Specific Properties for Dynamic Node Factory” on 
page 90.

When you sort the properties by category, the CIT-specific 
properties appear at the top of the list and the general 
properties appear at the bottom.

You can view a description of the selected property in the 
Description Area at the bottom of the Properties dialog box. 
Click the Show/Hide Description Area button to display the 
Description Area.

When accessing the Properties dialog box from within 
certain applications, the fields are not editable.

Mandatory fields are denoted by an asterisk.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click to display the properties by category.

Click to display the properties alphabetically.

Toggles between showing and hiding the description area at 
the bottom of the Properties window.

Click Expand to expand the properties tree when the 
properties are displayed by category.

Click Collapse to collapse the properties tree when the 
properties are displayed by category.

Actual Deletion 
Period

The number of days after which the CI or relationship is 
deleted.

Allow CI Update When selected, this option allows the DDM process to 
automatically update the CI or relationship properties with 
information that it discovers. If you change the value of a 
property supplied by the DDM process, the value is 
overridden by the discovered value.

When this option is cleared, the CI or relationship 
properties are not overridden by the DDM process.

Apply Click Apply to save the changes made to the CI or 
relationship properties.

Change State Indicates whether the CI or relationship has been changed 
(read-only value).

City The name of the city. The list is automatically updated 
when you select a country (or state, when applicable). Select 
an option from the list.

Note: This field does not appear for relationships.

CI Type The type of the CI or relationship (read-only value). For 
information about CITs in HP Business Availability Center, 
see CI Attribute Customization.
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Country The country in which the CI is located. Select an option 
from the list. You must define a geographical location—
country, state (if applicable), and city—if you want the CI to 
appear on the Geographical Map in Dashboard. For more 
information, see “Geographical Map” in Using Dashboard.

Note: This field does not appear for relationships.

Created By The user name of the administrator who manually created 
the CI or relationship, where applicable (read-only value).

Create Time The date and time when the CI or relationship was created.

Deletion 
Candidate Period

The number of days after which the CI or relationship 
becomes a candidate for deletion.

Description A brief description of the CI or relationship.

Display Label The name of the CI or relationship as it appears in View 
Explorer.

Enable Aging Enables the aging mechanism for this CI or relationship. It 
is selected by default for DDM CIs. This field is only 
displayed for certain CIs. For details, see “Removing Out of 
Date CIs Using the Aging Mechanism” on page 61.

ID The internal ID of the CI or relationship in the CMDB (read-
only value).

Include Related 
CIs

This feature is only enabled for instance views. 

If the check box is selected, the CI is set to recursively 
display in the view all child CIs from the CMDB, and all CIs 
in the subtree for the CI are also displayed in the view.

If the check box is not selected, the CI is set to display only 
child CIs that are manually added within the view. For 
details, see “Include Related CIs” on page 132.

This element appears only in the CI Properties page, not in 
the Edit CI dialog box.

GUI Element (A–Z) Description
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Last Access Time The time that the CI or relationship was last accessed, 
whether when being updated or being discovered by DDM. 
This field is only displayed for certain CIs.

This parameter is used by the aging mechanism – for details, 
see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.

Name The name of the CI or relationship.

Note Enables you to enter other information about the CI or 
relationship.

Origin An ID for the source that automatically created the CI or 
relationship, or the application where the CI or relationship 
was created (read-only value).

Reset Click the Reset button to restore the original property 
settings of the CI or relationship.

State The name of the state – when applicable for the selected 
country. The list is automatically updated when you select a 
country. Select an option from the list.

Note: This field does not appear for relationships.

Updated by The user name of the administrator who updated the CI or 
relationship properties.

Update Time The date and time when the CI or relationship properties 
were last updated.

User Label Enables you to define a display label for the CI or 
relationship. If no value is entered, the CI name appears as 
the default label.

GUI Element (A–Z) Description
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Select Configuration Item Type Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Selector Expression Dialog Box

Description Enables you to select a CI type for a new CI from a table 
or tree.

To access: In IT Universe Manager, click the ellipsis 
button  from the Define General Properties page of the 
New CI Wizard.

GUI Element (A–Z) Description

<CI types> The list of available CI types to select from when creating 
a new CI.

CI Types Tree/Table Toggles between the tree view and table view of the 
available CI types.

Display all possible 
CITs

Select this option to display all possible CI types in the 
tree or table.

Display only CITs that 
match the current 
view

Select this option to display in the tree or table only those 
CI types matching the current view.

Note: This option is only available for pattern views.

Description Enables you to edit a selector expression for a Monitor 
or Dynamic Node Factory CIT.

To access: Click Edit Selector Expression from the 
Define CIT Specific Properties page of the New CI 
Wizard.

Important 
Information

For details on choosing a selector for a specific KPI, see 
“KPIs” in Using Dashboard.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

View Discovery Wizard

GUI Element (A–Z) Description

Click to delete the row of the filter.

<Sample field 
window>

From the sample field drop-down list, select the 
appropriate sample field or select Custom to enter a 
custom field.

Add ‘OR’ Expression Click to add a row for a new ‘or’ condition in the filter.

And Click to add a row for a new ‘and’ condition in the 
filter.

Field Select a field from the drop-down list or, if Custom is 
selected in the Sample field window, enter a field 
name.

Operator Select an operator from the drop-down list.

Value Enter a value for the filter condition.

Description Enables you to find recent changes in a configuration, by 
manually running an ad-hoc DDM that rediscovers the 
CIs in a view. The DDM Probe immediately runs the jobs 
that originally discovered the CIs.

To access: In IT Universe Manager, select the CIs to 
be rediscovered and click the Rediscover View 

Content button in the toolbar or select Operations > 
Rediscover View Content.

Important 
Information

This wizard is displayed on condition that at least one 
Probe is connected to the server.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Choose Jobs for View Dialog Box

Included in Tasks “Run an Ad-Hoc Discovery to Rediscover CIs” in 
Discovery and Dependency Mapping Guide.

Wizard Map The View Discovery wizard contains:

View Discovery Wizard (this page) > Choose Jobs for View 
Dialog Box > View Discovery Dialog Box > Discovered 
Changes Details Dialog Box

GUI Element (A–Z) Description

<Text box> ➤ Includes an explanation of the wizard.

➤ Probes that are defined on the server but are not 
connected are listed; they are not included in the 
rediscovery of the CIs.

➤ Scheduling is ignored, that is, the job is run 
immediately, even if it is scheduled to run at a later 
time. 

➤ Any DDM policies connected to the job are also 
ignored.

Description Enables you to choose the jobs that need to be run again.

To access: Click the Next button in the View Discovery 
Wizard dialog box.

Included in Tasks “Run an Ad-Hoc Discovery to Rediscover CIs” in Discovery 
and Dependency Mapping Guide.

Wizard Map The View Discovery wizard contains:

View Discovery Wizard > Choose Jobs for View Dialog 
Box > View Discovery Dialog Box > Discovered Changes 
Details Dialog Box
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

View Discovery Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Enable Select to enable the DDM job.

Job Name The DDM job name.

Relevant Probe The probe which the DDM job runs on. Click the ellipsis 
button  to open the Choose Probes dialog box and 
select the probe on which you want the Ad-Hoc view to 
run.

Triggered CIs Count The number of CIs triggered by the DDM job.

Description Enables you to view the progress of the rediscover process.

To access: Click the Finish button in the Choose Jobs for 
View dialog box.

Included in Tasks “Run an Ad-Hoc Discovery to Rediscover CIs” in Discovery 
and Dependency Mapping Guide.

Wizard Map The View Discovery wizard contains:

View Discovery Wizard > Choose Jobs for View Dialog 
Box > View Discovery Dialog Box > Discovered Changes 
Details Dialog Box

GUI Element (A–Z) Description

Discovered Changes The number of changes that occurred to CITs since the 
last run.

Probe Name The name of the probe on which the job is running.

Progress The progress of the CI rediscovery.
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Discovered Changes Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the changes that have occurred to 
the CITs in the selected jobs.

To access: Click the Details button in the View Discovery 
dialog box.

Included in Tasks “Run an Ad-Hoc Discovery to Rediscover CIs” in Discovery 
and Dependency Mapping Guide.

Wizard Map The View Discovery wizard contains:

View Discovery Wizard > Choose Jobs for View Dialog 
Box > View Discovery Dialog Box > Discovered Changes 
Details Dialog Box

GUI Element (A–Z) Description

CIT The name of the CI type that changed.

Deleted Count The number of CIs that have been deleted since the 
previous DDM run.

Insert/Update Count The number of new or updated CIs since the previous 
DDM.
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IT Universe Manager – Dynamic Node 
Factory

This chapter provides information on Dynamic Node Factory CIs in 
IT Universe Manager.

This chapter includes:

Concepts

 ➤  Working with Dynamic Node Factory Overview on page 105

 ➤  DNode Definition Key Property on page 110

Tasks

 ➤  Define a Dynamic Node Factory CI on page 121
Concepts

Working with Dynamic Node Factory Overview

The Business Logic Engine is able to dynamically create CI hierarchies in the 
CMDB at run time, based on incoming data samples on the HP Business 
Availability Center bus. These hierarchies are created using the Dynamic 
Node Factory CI. 

This section includes the following topics:

➤ “Understanding Dynamic Node Factory” on page 106

➤ “How Dynamic Node Factory Works” on page 107

➤ “When to Use Dynamic Node Factory” on page 108
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Understanding Dynamic Node Factory
The Dynamic Node Factory CI includes a template that defines the rules for 
creating and managing the generated hierarchy, and a selector that defines 
which data samples are relevant.

When a Dynamic Node Factory CI is added to a view, it can immediately 
start generating CIs from the incoming data samples. The generated CIs are 
added to the IT universe model in the CMDB, and to the subtree under the 
Dynamic Node Factory CI in the view. These generated CIs are then 
available to add to other views like any other CI in the CMDB. 

A Dynamic Node Factory CI is added to a view and the IT universe model in 
one of the following ways:

➤ Automatically, by a source adapter. Some of the HP Business Availability 
Center custom source adapters, for example, Real User Monitor, include a 
Dynamic Node Factory definition. When the source is added in Source 
Manager, the Dynamic Node Factory CI is added to the out-of-the-box view 
for Real User Monitor. 

For details on adding source adapters, see Chapter 26, “Source Manager.”

➤ Manually, in IT Universe Manager. You can create a new CI of type Dynamic 
Node Factory when building your view in IT Universe Manager.

After a Dynamic Node Factory CI is added to a view, the CI properties can be 
edited in IT Universe Manager. For details on creating a Dynamic Node 
Factory CI and editing its properties, see “CIT-Specific Properties for 
Dynamic Node Factory” on page 90.
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You can view KPI status for the CIs in the Dynamic Node Factory hierarchy 
in the Dashboard application as soon as the CIs are created.

How Dynamic Node Factory Works
The XML definition file generated by the Dynamic Node Factory CI defines 
rules for listening to the samples that reach the system, using selectors to 
define areas of interest. The XML file guides the Business Logic Engine on 
how to build the topology in the CMDB based on the incoming data, and 
produces its own definitions for the generated CIs.

Dynamic Node Factory CIs use the DNode definition key property, which 
defines how the samples are processed by providing example values for the 
XML file. These values are used as the template for the dynamic hierarchy in 
the CMDB. When required, you can customize the DNode definition key to 
produce a hierarchy that displays the information you need. For details, see 
“DNode Definition Key Property” on page 110. 

If there is no existing CI for a received sample in the CMDB, the Business 
Logic Engine creates the CI and adds it to the subtree for the Dynamic Node 
Factory CI. If the CI already exists in the CMDB (for example, if a BPM 
Transaction CI that corresponds to the sample was already created by the 
Business Process Monitoring source adapter), the existing CI is added to the 
Dynamic Node Factory subtree, creating a new relationship for that CI.
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Once a CI is created, the CI definitions are stored as for any other CI, and it 
receives update samples from the Dashboard matcher based on the selector 
for the Dynamic Node Factory CI. The Dynamic Node Factory hierarchy is 
rebuilt only as necessitated by the sample contents. (You can also define 
additional composite selectors for the Dynamic Node Factory XML 
definitions, so that the generated CI is updated independently from the 
Dynamic Node Factory generators. For details, see “Defining Composite 
Selectors in the DNode Definition Key” on page 119.)

You can add the generated CIs to other views, modify the CI properties, and 
delete the generated CIs from the CMDB. (However, after deleting a CI, it 
may be recreated by the Dynamic Node Factory based on incoming data 
samples.)

When to Use Dynamic Node Factory
Dynamic Node Factory hierarchies are useful for the integration and 
mapping of samples from external systems (generally EMS systems), where 
the database structure for the source is unknown, and HP Business 
Availability Center does not have a predefined source adapter for handling 
the data. However, the decision of whether to set up a Dynamic Node 
Factory hierarchy or a new source adapter to import the information 
depends on the particular situation and your data requirements.

The Dynamic Node Factory CI may also be used to bring alternative 
hierarchies from adapter sources.

You should take into consideration the following points:

➤ The adapter provides more precise results.

➤ Implementation of a Dynamic Node Factory template to import the 
information is usually simpler than setting up a new adapter for the source. 

➤ The Dynamic Node Factory is dynamic, reflecting changes that generate 
new CIs in run time, while the adapters reflect the changes only after 
synchronization. For example, if you create a Dynamic Node Factory CI for 
alerts, you can generate a hierarchy that displays alerts with event children, 
without knowing in advance what type of alert is received. The Dynamic 
Node Factory hierarchy displays a new alert when it occurs, while an adapter 
for alerts displays a new alert only after synchronization occurs (by default, 
once an hour).
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However, if an alert is removed at the source, the adapter reflects this change 
at synchronization, while the Dynamic Node Factory may take up to 24 
hours to reflect the change (depending on the Dynamic Node Factory 
cleaning definitions). Similarly, if a transaction name is changed or moved 
to a new profile in End User Management Administration, then the 
Dynamic Node Factory creates a new CI for it, but the old CI remains in the 
hierarchy until it has not had any corresponding samples for 24 hours 
(default value, can be changed to a different value). 

Keep in mind that you affect two levels of CIs when you modify properties 
for a Dynamic Node Factory CI:

➤ The general properties for the Dynamic Node Factory CI, for example, 
location and context menu, apply only to that CI. Also, when you attach 
KPIs to the Dynamic Node Factory CI in Dashboard Administration, they 
are defined only for that CI. Modifying these properties has no influence on 
the generated hierarchy.

➤ The CIT-specific properties for the Dynamic Node Factory CI, for example, 
selector expression and KPI status for removal, define information relating 
to the CIs in the generated hierarchy under the Dynamic Node Factory CI. 
Modifying these properties changes the templates and handling rules for the 
hierarchy.

Changes to these properties should be correlated with the definitions within 
the DNode definition key. For example, the selector expression must 
identify samples that contain the keys defined in the generators, otherwise 
the Dynamic Node Factory hierarchy remains empty.

Note: If you change the DNode definition key or selector expression for an 
active (enabled) Dynamic Node Factory CI, the previous Dynamic Node 
Factory hierarchy is deleted from the view and the hierarchy is recreated.

If the catchment area for a Dynamic Node Factory hierarchy is too wide, you 
can modify the selector expression for the Dynamic Node Factory CI to 
narrow down the definition, for example, to include only samples coming 
from a particular machine.
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If you require additional help with creating a Dynamic Node Factory 
hierarchy, contact HP Software Support.

Note: There are no default KPIs defined for the Dynamic Node Factory CI; 
you must manually attach KPIs after creating the CI, or no status is 
displayed in Dashboard.

DNode Definition Key Property

The DNode definition key property defines how the received data samples 
are processed to generate the hierarchy under the Dynamic Node Factory CI. 
This section describes the DNode definition key structure and contents, and 
how to customize the property.

This section contains the following topics:

➤ “About the DNode Definition Key” on page 110 

➤ “Components of the DNode Definition Key” on page 111

➤ “Defining Composite Selectors in the DNode Definition Key” on page 119

Important: Only users with an advanced knowledge of Business Availability 
Center should make changes to templates. An incorrect definition may lead 
to loss of data, the wrong hierarchy build, and redundancy in the CMDB.

About the DNode Definition Key
The DNode definition key defines the properties for the CIs created by the 
received samples. This includes generators to determine how to group the 
incoming samples, how many CI levels to create, and which templates to 
use when creating each CI (KPIs, business rules, and so forth). Each different 
data type needs an appropriate definition in the Dynamic Node Factory file.
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You can customize the definitions in the DNode definition key to make 
them relevant for a specific data source and to build the hierarchy structure 
you require. This customization can be done by:

➤ Editing the Dynamic Node Factory CI in IT Universe Manager 
(recommended method). For information on editing a Dynamic Node 
Factory CI, see “CIT-Specific Properties for Dynamic Node Factory” on 
page 90.

➤ Editing the template for the source adapter in Source Manager (only relevant 
for predefined Dynamic Node Factory CIs). For information on editing 
adapter templates, see “Source Adapter Templates” on page 667.

The default DNode definition key property (used when you create a new 
Dynamic Node Factory CI in IT Universe Manager) contains definitions for a 
Business Process Monitor hierarchy:

If you are adding a Dynamic Node Factory CI for a different data source, for 
example, SiteScope, you must replace the definitions with ones appropriate 
for the source.

For explanations of the data samples and their fields, see “Data Samples” in 
Reference Information.

For descriptions of the definitions contained in the DNode Definition Key, 
see the following section.

Components of the DNode Definition Key
This section describes the components needed to customize a DNode 
Definition Key.

All changes to the parameters in the DNode definition key property must be 
logical and relevant for the source. 
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Generators

The first part of the DNode definition key contains the Generators defining 
the hierarchy for the CIs. Each generator in the DNode definition key 
defines a level to be built in the Dynamic Node Factory hierarchy (the XML 
provides for definitions of up to three levels). For example, for Business 
Process Monitor, the Dynamic Node Factory may build levels for profile, 
transaction, and location. 

For example, the generators in the default DNode definition key for Business 
Process Monitor are as follows:

➤ groupBy. Defines the property to look for in the samples, to see if the sample 
is relevant for building this level of the hierarchy. A CI is created for each 
unique value of this key. For example, all samples with a unique value for 
szSessionName create a CI at the profile level of the hierarchy.

Note: If samples are missing this key, a CI is still created for the sample if the 
Create CI if groupBy value missing is selected for the parent Dynamic Node 
Factory CI. For more information, see “CIT-Specific Properties for Dynamic 
Node Factory” on page 90.

➤ itemTemplate. Defines the name of the CI template to be used for creating 
each CI at this level. The CI templates are defined in the DNode definition 
key after the generators.

➤ linkTemplate. Defines the name of the relationship template to be used for 
each CI created at this level. The relationship template defines the 
relationship between the created CI and its parent CI. The relationship 
templates are defined in the DNode definition key after the CI templates.

<Generator groupBy="szSessionName" itemTemplate="profile" 
linkTemplate="depends_on">
<Generator groupBy="szTransactionName" itemTemplate="transaction" 
linkTemplate="depends_on">
<Generator groupBy="szLocationName" itemTemplate="tx_location" 
linkTemplate="monitored_by"/>
</Generator>

</Generator>
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Note: It is possible to use the DNode definition key property to build more 
complex dynamic hierarchies, for example, by using more than one 
generator at the same level. For more information, contact HP Software 
Support.

CI Templates

The second part of the DNode definition key contains the ItemTemplates, 
the templates for creating the CIs. Each template defines attributes, KPIs, 
and business rules to be used for each generated CI. (If required, you can 
also add a composite selector to a monitor ItemTemplate. For details, see 
“Defining Composite Selectors in the DNode Definition Key” on page 119.) 

For example, the following ItemTemplate creates Business Process Group CIs 
for the profiles in the default Business Process Monitor hierarchy:

<ItemTemplate template="profile" namespace="Mercury" class-name="bp_group">
<Attributes>

<Attribute name="data_name" ref_value="szSessionName"/>
<Attribute name="id" ref_value="u_iSessionId"/>
<Attribute name="app_id" value="-1"/>

</Attributes>
<KPI>

<Attributes>
<Attribute name="type" value="6"/>
<Attribute name="rule" value="1"/>

</Attributes>
</KPI>
<KPI>

<Attributes>
<Attribute name="type" value="7"/>
<Attribute name="rule" value="1"/>

</Attributes>
</KPI>
<!--Specify objectives only if you want to override the default values for objectives-

->
</ItemTemplate>
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Item Template Line

The first line of the ItemTemplate defines the following parameters:

➤ template. Defines the name of the template.

➤ namespace. Defines the context for the class-name: Mercury is used for all 
CIs.

➤ class-name. Defines the configuration item type (CIT) name for the CIs 
generated by this template. This must be a valid CMDB CIT. The attributes 
for the created CIs are taken from the CIT definition. 

This is the internal name used for the CIT, not the display name. For 
example, the internal name for Business Process Group CIs is bp_group.

To view the internal name for each CIT: select Admin > Universal CMDB > 
Modeling > CIT Manager and select the Details tab for a CIT. The internal 
name is displayed in the Name field.

Attributes Section

Most of the CITs have mandatory attributes. These attributes must be 
included in the Attributes section of the ItemTemplate (in the following 
example, the id and app_id are mandatory attributes). 

The Attributes section defines the following parameters:

➤ name. Defines the internal name of an attribute included in the attributes 
list for the relevant CIT. For example, data_name is the internal attribute 
name corresponding to the Name property for the created CI. 

To view the list of attributes defined for a CIT: select Admin > Universal 
CMDB > Modeling > CIT Manager and select the Attributes tab. The Name 
column lists the attributes by their internal name.

<ItemTemplate template="profile" namespace="Mercury" class-name="bp_group">

<Attributes>
<Attribute name="data_name" ref_value="szSessionName"/>
<Attribute name="id" ref_value="u_iSessionId"/>
<Attribute name="app_id" value="-1"/>

</Attributes>
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➤ ref_value. Defines a key in the data sample that provides the value for the 
attribute. In the example <Attribute name="id" ref_value="u_iSessionId"/>, the 
id attribute for each CI is given the value from the property u_iSessionId in 
the incoming samples.

➤ value. Defines a static value for the attribute. This enables you to use a 
predefined value for all CIs generated by this ItemTemplate. For example, 
you can define a static value attribute for data_name, where you know that 
there is only one CI at this level: <Attribute name="data_name" 
value="my_BPM_profile"/>

Note: The Business Process Group CI template includes the static value 
attribute <Attribute name="app_id" value="-1"/>. This app_id attribute 
corresponds to the Business Process Monitor source adapter, and is only 
required for Business Process Monitor hierarchies.

Every ItemTemplate should contain attributes defining a unique name and 
an appropriate ID for each generated CI (otherwise the CIs are created on 
top of each other). You can define additional attribute keys for the template, 
as required. 

If you want to define a context menu in the ItemTemplate, so that it applies 
for all CIs generated by the template, you need to use a special string format. 
The value for the context menu attribute is presented as XML, and so must 
be "escaped" from the DNode definition key XML, as in the following 
example:

The value in bold shows the internal context menu name. (You can find the 
internal context names in: <HP Business Availability Center 
server>\AppServer\webapps\site.war\bam\conf\
repositories\contextMenu\def.xml)

<Attribute name="contextmenu" 
value="&lt;Values&gt;&lt;Value&gt;groupMenu&lt;/Value&gt;&lt;/Values&gt;"/>
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KPI Section

The KPI section of the ItemTemplate defines the following parameters:

➤ name="type" Defines the KPI to be attached to the CIs generated by this 
ItemTemplate. The value corresponds to the ID number for a KPI, for 
example, 6 is the ID number for the Performance KPI. The ID numbers for 
the KPIs are listed in the Admin > Dashboard > Repositories > KPIs page, 
under the ID column.

Each ItemTemplate in the DNode definition key should specify the same 
KPIs, and these should correlate with the KPIs defined for the Dynamic 
Node Factory CI itself.

➤ name="rule" Defines the business rule to be used with the KPI for the 
generated CIs. The value corresponds to the ID number for a rule, for 
example, 1 is the ID number for the Worst Child Rule. The ID numbers for 
the business rules are listed in the Admin > Dashboard > Repositories > 
Business Rules page, under the ID column.

The specified business rule should be a monitor rule if the ItemTemplate is 
defining leaf CIs, and a group rule if the ItemTemplate is defining 
non-leaf CIs. For more information on rule types, see “Business Rules 
Repository Overview” in CI Attribute Customization.

If required, you can define additional parameters in the KPI section. 
Attributes can use value or ref_value, as described in the “Attributes Section” 
on page 114.

The following additional parameters are relevant for leaf monitor CIs 
defined in the DNode definition key, and should be declared as part of the 
KPI:

<KPI>
<Attributes>

<Attribute name="type" value="6"/>
<Attribute name="rule" value="1"/>

</Attributes>
</KPI>
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➤ RuleArguments. Defines parameters used by the business rule. When you 
add a rule argument to a KPI definition in the DNode definition key, it 
overrides the default value for the parameter defined in the Rules 
Repository. For example, the following definition overrides the default value 
for the No data timeout parameter (used with, for example, the Transaction 
Availability Rule), and the generated CIs use the new value for the KPI:

For details on the parameters used by the business rules, see “List of 
Dashboard Business Rules” in CI Attribute Customization.

Note: If you add definitions for RuleArguments, make sure to define the 
exact key name and to use the correct format for the value.

➤ Objective. Defines objective values that override the default objective 
parameter values declared in the Rules Repository. The objective values 
should be relevant for the rule.

For example, the following definition overrides the default value for the 
Critical (red) objective level (Objectives section shown in bold):

<RuleArguments><parameter name="No data timeout" type="Integer" 
value="1200"/></RuleArguments>

<KPI>
<Attributes>

<Attribute name="type" value="6"/>
<Attribute name="rule" value="13"/>

</Attributes>
<RuleArguments/>
<Objective>

<Attributes>
<Attribute name="critical" value="12"/>

</Attributes>
</Objective>

</KPI>
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Note: The KPI definitions should be in the order shown above: KPI, business 
rule, rule arguments, objectives.

Relationship Templates

The final part of the DNode definition file contains the LinkTemplates, the 
templates for creating the relationships between the nodes.

For example, the LinkTemplates in the default DNode definition key for 
Business Process Monitor are as follows:

➤ template. Defines the name of the template.

➤ namespace. Defines the context for the class-name: Mercury is used for all 
CIs.

➤ class-name. Defines the internal name for the relationship generated by this 
template, for example, depends_on. The attributes for the created 
relationship are taken from the definitions in the CI Type Manager. 

To view the internal name for each relationship: select Admin > Universal 
CMDB > Modeling > CIT Manager and select the Details tab for a CIT. The 
internal name is displayed in the Name field.

If required, you can define attributes for the relationships; the values 
defined override the default values for the relationship properties. The 
attribute format for LinkTemplates is the same as that for ItemTemplates.

<LinkTemplate template="depends_on" namespace="Mercury" class-
name="depends_on"/>
</LinkTemplate>
<LinkTemplate template="monitored_by" namespace="Mercury" class-

name="monitored_by">
</LinkTemplate>
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Defining Composite Selectors in the DNode Definition Key
The Dynamic Node Factory uses the selector expression defined for the 
Dynamic Node Factory CI to receive samples from the bus and create the CIs 
in the hierarchy. If required, you can define a composite selector for the 
monitor ItemTemplate (leaf level) in the DNode definition key, so that the 
new selector is used to receive update samples for KPI status, rather than the 
original selector that generated the CI.

Composite selectors are used when you want the created CI to be 
independent from the Dynamic Node Factory generators. This may be 
required when the original selector expression information is not included 
in later samples. 

For information on defining selector expressions, see “Selectors for KPIs” in 
Using Dashboard.

You can use static or dynamic attributes in composite selector expressions. 
When using static attributes, you define a known value for a known 
referenced property, for example:

Note: The attributes in a selector are case sensitive, so take care to define the 
attributes exactly as in the samples.

If you do not know the value of a selector attribute in advance, you can use 
a dynamic selector expression. The value for the dynamic attribute is 
defined only when the sample is received. 

You make an attribute dynamic by using the prefix ref_ with the attribute 
name. For example: 

<Selector key="sampleType" op="EQ" type="String" value="ss_t" /> 

<Selector key="u_iSessionId" op="EQ" type="Long" ref_value="u_iSessionId" />
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In this example, the value attribute is dynamic, so the value for the 
referenced property is taken from the u_iSessionId field in the received 
sample.

Note: The dynamic selector expression option is not relevant when working 
with custom data (fully descriptive samples are received from the source, so 
there is no problem of insufficient information).

The following example shows part of the ItemTemplate for a SiteScope 
monitor with an added composite selector (shown in bold), including 
dynamic selector expressions:

Note: If necessary, you can define a different composite selector for a KPI in 
the ItemTemplate, if the KPI requires a different selector from the default for 
the monitor. 

Tasks

<ItemTemplate template="monitor" namespace="Mercury" class-
name="sitescope_monitor">
<Attributes>

…
</Attributes>
<CompositeSelector logicalOp="AND">

<Selector key="sampleType" op="EQ" type="String" value="ss_t" /> 
<Selector key="u_iSessionId" op="EQ" type="Long"
ref_value="u_iSessionId" /> 
<Selector key="u_iMonitorId" op="EQ" ref_value="u_iMonitorId" /> 

</CompositeSelector>            
<KPI>

…
</KPI>

</ItemTemplate>
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Define a Dynamic Node Factory CI

You can edit the properties for a predefined Dynamic Node Factory CI in 
your view, or define a new Dynamic Node Factory CI to add to your view, in 
order to generate a hierarchy that fits your organization’s needs. You can 
modify the mapping to the samples that create the hierarchy, and the rules 
and logic used to import the data and present it in Dashboard.

(It is also possible to customize the template for a predefined Dynamic Node 
Factory CI in the custom source adapter, but it is recommended that you 
customize the CI in the view, rather than in the adapter.)

This task includes the following steps:

➤ “Create a Dynamic Node Factory CI” on page 121

➤ “Define Selectors for the Dynamic Node Factory” on page 121

➤ “Define KPIs for the Dynamic Node Factory CI” on page 121

 1 Create a Dynamic Node Factory CI
Open the New CI Wizard in IT Universe Manager and select Dynamic Node 
Factory as the Configuration Item type. Define properties in the Define 
General Properties page, as required. These properties apply only to the 
Dynamic Node Factory CI, not to the CIs that are created in the hierarchy. 
For details, see “Define General Properties Dialog Box” on page 86.

 2 Define Selectors for the Dynamic Node Factory
Define properties in the Define CIT-Specific Properties page, including the 
selector expression. For details, see “CIT-Specific Properties for Dynamic 
Node Factory” on page 90.

 3 Define KPIs for the Dynamic Node Factory CI
To define KPIs for the Dynamic Node Factory CI, select Admin > 
Dashboard > KPIs. Define KPIs and business rules for the Dynamic Node 
Factory that are logical for the data source, for example, Availability and 
Performance for a Business Process Monitor source. You should select a 
group-type business rule for each KPI. 
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For details on defining KPIs, see “KPI Configuration Overview” in Using 
Dashboard.

Note: The dimensions defined for a parent Dynamic Node Factory CI should 
correlate with the dimensions defined within the DNode definition key 
property.
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View Manager

This chapter includes the main concepts, tasks and reference information 
for View Manager.

This chapter includes:

Concepts

 ➤  View Manager Overview on page 124

 ➤  Instance Views and Pattern Views on page 124

 ➤  Predefined Folders and Views on page 125

 ➤  Building a Business View on page 127

 ➤  Using the Instance View Editor on page 128

 ➤  Link Nodes to Application CI on page 134

 ➤  The Role of Monitor CIs in a View on page 136

 ➤  Grouping By Attribute Properties on page 137

 ➤  Merge Identical Instances on page 138

Tasks

 ➤  Create and Populate an Instance View on page 139

 ➤  Pattern View Workflow on page 141

Reference

 ➤  View Manager User Interface on page 142

Troubleshooting and Limitations on page 165
Concepts
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View Manager Overview

View Manager is a tool for creating and managing views. You can create 
your own views, or work with the out-of-the-box (factory) views provided 
with your HP Business Availability Center installation.

The IT universe model in the configuration management database can be 
very large, holding thousands of configuration items (CIs). A view enables 
you to build a subset of the overall IT universe model, containing only those 
CIs relating to a specific area of interest. You can define your own views to 
display only the information that is relevant to your organization’s business 
needs.

The views are used to display performance status in Dashboard, and for 
setting up SLAs in Service Level Management. HP Business Availability 
Center supports two view formats, pattern and instance views, which are 
populated through different processes. For details, see “Instance Views and 
Pattern Views” on page 124.

Instance Views and Pattern Views

HP Business Availability Center supports two view formats, pattern and 
instance views, by which to populate your view:

➤ Pattern views are built from a Topology Query Language (TQL) query that 
defines the structure of the view. You can create the TQL query as you build 
the view from within View Manager (or build the view based on an existing 
query). The view displays only those CIs and relationships that satisfy the 
query definition. When the view is opened up or refreshed, View Manager 
queries the CMDB for all elements that fit the query, and automatically 
updates the view with those elements.

All out-of-the-box views are pattern views, with the exception of the First 
Service View. For more information on pattern views, see “Working in 
Pattern Views” on page 54.

➤ Instance views are built by manually defining individual CIs and 
relationships directly in the view and/or by adding CIs that exist in the 
CMDB in the view. View Manager includes one out-of-the-box, empty 
instance view, the First Service View.
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For more information on instance views, see “Working in Instance Views” 
on page 54.

You can also create new views (both instance and pattern views) by cloning 
an existing view, and editing the view contents. You can then select Save As 
from the context menu and give the new view a unique name.

Predefined Folders and Views

The file folder system in View Manager includes predefined folders and 
views, as described in the following sections:

➤ “About Predefined Folders” on page 125

➤ “About Factory Views” on page 125

About Predefined Folders
View Manager contains a hierarchical file folder system to help you organize 
your views, displayed in the Folders pane. Predefined folders are provided 
for the out-of-the-box views; you can modify these folders, or add additional 
folders according to your organization’s requirements.

About Factory Views
Your HP Business Availability Center installation includes out-of-the-box 
pattern views. These views provide a quick start for working with the CMDB 
and for setting up SLAs, and for viewing system performance information in 
Dashboard.

The out-of-the-box views are initially empty. As soon as CIs are added to the 
CMDB by one of the CI generators, the TQL query built into each pattern 
view is able to identify the CIs that meet the pattern requirements, and add 
them to the view.
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Pattern views for CIs are created when a Discovery and Dependency 
Mapping (DDM) process is run; the out-of-the-box views that are provided 
correspond to the relevant DDM packages. For example, the Oracle view 
(Root > Database > Oracle > Oracle) is populated with CIs that are created 
when Discovery and Dependency Mapping activates the Database - Oracle 
module. For details on running DDM, see “Run Discovery – Advanced Mode 
Workflow” in Discovery and Dependency Mapping Guide.

For details on the cross-application processes for setting up the Siebel and 
SAP views, see “HP Business Availability Center for SAP Applications” and 
“HP Business Availability Center for Siebel Applications” in Solutions and 
Integrations.

Another type of pattern view is a view for CIs created by source adapters, 
which correspond to the source adapters in Source Manager and the EMS 
Integrations tool. HP Business Availability Center provides various 
out-of-the-box monitor views for CIs from all the default sources (SiteScope, 
Business Process Monitor, Real User Monitor) and out-of-the-box 
Integrations views that each receive CIs from the relevant integrations. For 
example, the HP OVO view corresponds to the HP OVO integration. 

For details on source adapters, see “Source Manager” on page 665.

Other out-of-the-box views for CIs are created for internal HP Business 
Availability Center data, for example, the BAC Self-Alert View and the UDX 
Measurement Filters View.

The First Service View is an out-of-the-box instance view included with your 
HP Business Availability Center package. This is an empty view, supplied as a 
quick start for creating your own instance view.

The First Service View and many out-of-the-box monitor views are set by 
default to display in all relevant HP Business Availability Center 
applications; other out-of-the-box views are hidden by default.

Some of the out-of-the-box pattern views are considered basic to the system 
and cannot be deleted from the folders. 
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Building a Business View

You can define your own views in View Manager to model your business 
environment. These views should provide the business users with logical 
representations of your company’s structure, processes, and goals.

To meet these requirements, you generally build multiple instance views 
representing different aspects of your business; for example, you could build 
business views that revolve around any of the following:

➤ Company structure, so that data is organized by the geographical location of 
branches, or by data centers

➤ Business processes, so that data is organized by line of business, or by 
applications

➤ Business goals, so that data is organized by sales, or by key customers

The views you create depend on the particular demands of your 
organization and the actual hierarchical structure of the views should reflect 
those demands.

The usual hierarchical format of a view is as follows:

➤ Top level. The highest levels of the view, consisting of the root CI and the 
branches below it, are normally built from logical Business CI types such as 
Location, Line of Business, Customer, Application, and so on.

➤ Intermediate level. The intermediate branches of the view normally consist 
of System CI types, representing actual hardware and software and/or 
monitoring group CI types, representing groups containing monitors.

➤ Bottom level. The lowest level of the view, consisting of leaf CIs at the ends 
of the subtrees, is built from the Monitor CI types. These CIs receive the 
actual data from the data sources, used to determine KPI status all the way 
up the view subtrees, and so provide business context to the view.

In some cases, you can choose to use the Dynamic Node Factory CI type to 
dynamically build a hierarchy for you. For details, see “Working with 
Dynamic Node Factory Overview” on page 105.
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Note: The bottom level is only relevant when a monitoring solution such as 
HP Business Availability Center is connected and modeled in the CMDB. 

Using the Instance View Editor

The Instance View Editor contains two panes. In the View Explorer pane on 
the left, you can survey the existing views in HP Business Availability 
Center, and view information for CIs, such as CI properties. In the edit pane 
on the right, you can build and modify the contents of your view.
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You access the Instance View Editor by selecting an Instance View in the 
Views pane in View Manager. For details, see “Instance View Editor” on 
page 149.

Note: If you navigate away from the Instance View Editor without clicking 
Save, your changes are not updated to the CMDB.

The following functionality is available from the edit pane of the Instance 
View Editor:

➤ Create a CI in your view and in the CMDB, as described in “New CI Wizard” 
on page 85.

➤ Edit the properties for a CI, as described in “Properties Dialog Box” on 
page 96.
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➤ Change the display/hide all child CIs status for a CI, as described in “Add All 
CMDB Children” on page 152.

➤ Disconnect a CI from the parent CI, so removing the relationship between 
the two CIs in the IT universe, as described in “Delete Relationship to Parent 
CI” on page 153.

Child CI Rule Functionality
The child CI rule assigned to a parent CI determines which child CIs are 
displayed for the parent CI in the view. 

When KPI status is calculated for a CI and displayed in Dashboard, the 
status is based on all child CIs that exist in the CMDB for the parent CI; 
however, to restrict the number of CIs displayed in the view, you can hide 
all child CIs, or display selected children only. This has no effect on KPI 
status – status is still calculated based on all child CIs, whether they are 
displayed in the view or hidden.

A child CI is displayed or hidden depending on the child CI rule that is 
applied to the parent:

➤ A CI defined as Display all CMDB children, by clicking the Add all CMDB 
children button recursively displays in the view all child CIs that exist in the 
CMDB. The subtree is dynamically updated with every added child CI, 
whether it is added within the current view or in a different view. Once a 
parent CI is set to display all CMDB children, the child rule used for the CIs 
on the next branches in the subtree is irrelevant–all child CIs are displayed 
all the way down the subtree.

In the edit pane of the Instance View Editor, all child CIs that are included 
recursively are displayed in italic text and with a faded icon.
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Note: The recursively-included child CIs are all marked in their tooltips as 
Display only manually added children, but they dynamically display all 
child CIs in the CMDB.

➤ If you define a CI as Display only manually added children by clicking the 
Remove manually added children button, it displays only those child CIs 
that were created or added to that CI within the current view. The child CIs 
themselves may be set to display or hide their children.

In the edit pane of the Instance View Editor, these child CIs are shown in 
the standard format used for CIs. In the following figure, CI app1 is set as 
Display only manually added children:

However, the child CI of a parent with this rule can itself be set to use either 
rule. In the following picture, the rule for tx_yellow2 has been changed to 
Display all CMDB children:

Note: In Dashboard, you can view the hidden children for a CI. For details, 
see “Find Visible and Hidden Child CIs Dialog Box” in Using Dashboard.
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You can toggle the rule used by a parent CI, as described in “Add All CMDB 
Children” on page 152.

Include Related CIs
You can set the child CI rule when creating CIs using the New CI wizard or 
when attaching CIs using the Attach Related CIs wizard.

You can set CIs to display or hide child CIs as follows:

➤ Creating or editing the CI. Select the Include Related CIs check box in the CI 
properties to set the child CI rule to display all CMDB children. Clear the 
check box to set the child CI rule to display only future manually added 
children. (This option may be non-editable, depending on the definitions 
for the parent CI.) For details on editing properties, see “Properties Dialog 
Box” on page 96.

➤ Adding an existing CI to a view. Use the Add CIs and their children 
(recursive) button to set the child CI rule to display all CMDB children. Use 
the Add CIs (single arrow) button to set the child CI rule to display only 
future manually added children. For details, see “Attaching Existing CIs” on 
page 66.

➤ Working in the Instance View Editor. Use the recursive arrow button or 
select the Add all CMDB children option to set the child CI rule to display all 
CMDB children. Use the single arrow button or select the Remove manually 
added children option to set the child CI rule to display only future 
manually added children. For details, see “Instance View Editor” on 
page 149.

Whether or not all child CIs are displayed in the view does not influence the 
status calculations made for the parent CI and the status displayed in 
Dashboard. The Business Logic Engine calculates status from all child CIs 
attached to that parent CI, across all views. The calculation is based on all 
the relationships for the CI in the CMDB, without connection to the child 
CIs displayed in any particular view.
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For example, the following pictures show status in Dashboard for the same 
CI, Group1, in two views: In the first view, the CI is set to display all child 
CIs, and in the second, to hide all child CIs. The same status result is shown 
for the CI in both views, regardless of the child rule in use.

When a CI is set to hide some or all child CIs, the KPI tooltip in Dashboard 
shows the number of hidden child CIs with KPIs attached, to indicate that 
the KPI status of the parent is based on CIs that are not in the view.

You can use the Find Visible and Hidden Child CIs option to view 
information on hidden children. For details, see “Find Visible and Hidden 
Child CIs Dialog Box” in Using Dashboard.
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Link Nodes to Application CI

HP Business Availability Center enables you to define a node in a view to be 
linked to all the instances of that CIT in your IT universe. You can use this 
feature, for example, to show which hosts are serving a specific business 
service or to create correlation rules that reflect problems at the business 
level.

When you select Add to Applications from the context menu for a node in 
View Manager, a new CI of type application is created. All instances of the 
selected node in any corresponding view are then linked to the new CI with 
Depends On links.

If you make a change to the existing nodes of a view, such as selecting 
another node to be linked to the application CI or removing the link from a 
node to the application CI, the enrichment recalculation is performed 
immediately. However, if you add a node to the view, the enrichment 
recalculation is performed at the next scheduled enrichment update.

This functionality can be applied to any CI type except for: IT Universe, 
Business, Application, and all extended CI types (from running CMDB 
federation functionality).  

Linking a Node to an Application CI
To link a node to an application CI, select a node in the TQL in the Editing 
pane of View Manager. Right-click the node and select Add to Applications. 
A dialog box opens with a default name for the new application CI, which is 
the name of the view from which you defined it followed by "_Application." 
You can accept the default name or assign it a name of your choice. The new 
CI is connected by Depends On links to all the instances of the node.

A small black briefcase icon appears to the right of the node. The creation of 
the application CI and the links occurs when you save the view.

If you select a different node and repeat the process, the dialog box does not 
open (only one application CI is created per view), but Depends On links are 
created between that CI and the instances of the second node.
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Example

In a view called Oracle, you select a host and click Add to Applications from 
the context menu. A new CI of type application named Oracle_Application 
is created and all the hosts queried in this TQL are linked to the 
Oracle_Application CI by Depends On links.
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Removing the Link between a Node and the 
Application CI
To remove the link between a node and the application CI, right-click the 
node you selected as Add to Applications, and select Remove from 
Applications. The briefcase icon disappears and the relationships to the 
application CI are removed. If there are no remaining nodes in the view 
selected for linking to the application CI, the application CI itself is deleted. 
The change takes effect when you save the view. When you delete a view, 
the application CI created from within the view is also deleted.

The Role of Monitor CIs in a View

In various HP Business Availability Center applications, the CIs display 
colored indicators (KPIs) to show operational status information for the 
components of your IT universe. To give color status to a KPI, it needs to 
have a dependency on one or more of the leaf CIs that receive actual 
monitoring information, for example, a SiteScope monitor or Business 
Process Monitor transaction. (For information on KPIs, see “KPIs” in Using 
Dashboard.)

The dependency can be direct (in which case the parent CI has a monitored 
by relationship with the monitor child CI), or through the branches of a 
subtree. For example, a logical CI for location could receive KPI status from 
either one of the following hierarchies:

➤ Location CI -> monitor leaf CI

➤ Location CI -> group CI -> group CI -> monitor leaf CI

HP Business Availability Center automatically creates a dependency 
connection to a monitor CI for all CIs added using the source templates in 
the Source Manager, or added using the Dynamic Node Factory template. 
However, CIs added by the DDM process, or that you created manually, are 
not automatically associated with monitor CIs; you must manually define 
the appropriate connections.
136



Chapter 4 • View Manager
You can manually create a monitor dependency for a CI in one of the 
following ways:

➤ By attaching a monitor CI (or a subtree containing a monitor CI) to the 
parent CI in IT Universe Manager. For details, see “Attaching Existing CIs” 
on page 66.

➤ By making an association between a monitor object and an existing CI. The 
monitor CI created for the monitor object is automatically attached to the 
selected CI. For details, see “SiteScope Monitors and HP Business Availability 
Center  Configuration Items” in Using System Availability Management.

➤ By using the Monitor Deployment Wizard to create a new SiteScope monitor 
for a specific CI. The created monitor generates a new monitor CI in the 
CMDB, with an automatic attachment to the selected CI. For details, see 
“Monitor Deployment Wizard User Interface” in Using System Availability 
Management.

Grouping By Attribute Properties

When grouping CIs in View Manager by attribute using Node Definition, 
you can group CIs of different types in the Topology Map by using a regular 
expression as described in “Grouping Dialog Box” on page 148. You should 
enter the expression in the Mask to group by field. For details about regular 
expressions, see “Regular Expression Examples” in Reference Information.

Nested Groups
You can create nested groups (a node group inside another node group) to 
help fine-tune the TQL results that are displayed in the Topology Map.

For example, after grouping host nodes by their CIT, you can use their 
operation state attribute to create more focused groups.
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Merge Identical Instances

When defining a view, you can have identical instances that appear on the 
same layer in the view automatically merged into one symbol on the editing 
pane. This helps you remove redundant information and sharpen the view’s 
focus.

For example, if you want to discover and display hosts that are connected to 
other hosts in a server-client relationship, you can create the following TQL:

However, if both the server and the client are installed on the same host, 
one host appears twice.
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To overcome the redundant host display, you define that identical instances 
should be merged by selecting Merge Identical Instances in the Advanced 
area of the Create New View dialog box:

Tasks

Create and Populate an Instance View

This task describes how to define a new instance view and populate it with 
CIs.

This task includes the following steps:

➤ “Create a New Instance View” on page 139

➤ “Add CIs to the View” on page 140

➤ “Set Permissions” on page 140

 1 Create a New Instance View
You can define a new instance view from the Create View – View Properties 
dialog box. Select Instance View and enter a name for the view. For details, 
see “Create New View/View Properties Dialog Box” on page 143.
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Note: The view is created in the same folder as the view currently displayed 
in View Explorer.

 2 Add CIs to the View
You can add existing CIs from the CMDB to your view or you can define 
new CIs to appear in your view.

Using the Instance View Editor

The Instance View Editor enables you to add any CIs in the CMDB to your 
view, by adding them from other views in the system. When a CI is added to 
your view under another CI, a relationship is automatically created between 
the two CIs, using the default relationship for the two CI types. For details, 
see “Using the Instance View Editor” on page 128.

You can also define a new CI from within the Instance View Editor using the 
New CI Wizard. The new CI and relationship are created in the CMDB and 
the created CI is added at the specified point in the view tree, if the created 
CI is appropriate for the current view. For details, see “Instance View Editor” 
on page 149.

Tip: If the CI does not appear in the view, try refreshing the view using the 
Refresh button in View Explorer.

 3 Set Permissions
You should apply viewing and editing permissions to users and user groups 
for that view. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, see 
“Assign Permissions” in Platform Administration.
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Pattern View Workflow

This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

➤ “Prerequisites” on page 141

➤ “Create a Pattern View” on page 141

➤ “Add Nodes and Relationships to a TQL Query” on page 141

➤ “Add Folding Rules to Relationships” on page 141

➤ “Define Multiple Relationship Rules” on page 141

 1 Prerequisites
In View Manager, select New from the context menu to open the Create 
New View dialog box.

 2 Create a Pattern View
Set the name and properties of the managed view in which you want to 
define the TQL query. For details on defining the properties to create the 
view, see “Create New View/View Properties Dialog Box” on page 143.

 3 Add Nodes and Relationships to a TQL Query
Add the nodes and relationships that define the query. For details on how to 
add nodes and relationships to a TQL query, see “Add Nodes and 
Relationships to a TQL Query” on page 268.

 4 Add Folding Rules to Relationships
You can add folding rules to selected relationships by right-clicking the 
relationship you want and selecting Add Rule. For details, see Add Rule in 
“Context Menu Options” on page 271.

 5 Define Multiple Relationship Rules
You can define multiple relationship rules to define the structure between 
CITs in a view using the Relationship Rules dialog box. For details, see 
“Relationship Folding Rules Dialog Box” on page 154.
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Reference

View Manager User Interface

This section describes:

 ➤  Add Rule/Edit Rule Dialog Box on page 142

 ➤  Create New View/View Properties Dialog Box on page 143

 ➤  Group By Dialog Box on page 146

 ➤  Grouping Dialog Box on page 148

 ➤  Instance View Editor on page 149

 ➤  Relationship Folding Rules Dialog Box on page 154

 ➤  Set View Parameters/Set View Element Parameters Dialog Box on page 155

 ➤  View Manager Window on page 156

Add Rule/Edit Rule Dialog Box

Description Enables you to add a new folding rule or edit an existing 
folding rule.

To access: In View Manager, click Add or Edit from the 
Relationship Rules dialog box.

Important 
Information

You can define sibling and child rules for the same 
relationship between two CITs. However, you cannot 
define parent and child rules for the same relationship, 
or left sibling and right sibling rules.

Included in Tasks “Pattern View Workflow” on page 141

Useful Links “Relationship Folding Rules Dialog Box” on page 154
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Create New View/View Properties Dialog Box

GUI Element (A-Z) Description

Node 1 Select the required Node1 node in the Node1 list.

Node 2 Select the required Node2 node in the Node2 list.

Relationship From the Relationship list, select an available 
relationship connecting the Node1 node to the Node2 
node. (Enabled only after you define both CITs.)

Rule From the Rule list, select a folding rule: Parent, Right 
Sibling, Left Sibling, or Child. For details, see “Adding 
Folding Rules to Relationships” on page 68.

Description Enables you to define a new view or edit the properties of an 
existing view.

To access: In View Manager, click the New or Properties 
icon from the toolbar or select New or Properties from the 
context menu available in the Views pane.

Important 
Information

TQL queries should only be created by administrators with 
an advanced knowledge of the TQL system.

Included in Tasks “Create and Populate an Instance View” on page 139
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Advanced Click to open the Advanced area of the dialog box.

Based on TQL Select the check box to base the view on an existing TQL. 
Select the TQL query from the drop–down list. Only queries 
of type view appear in the list. If the query you want does 
not appear in the list, go to Query Manager and save it as a 
type view query. For details, see “Query Manager User 
Interface” on page 228.

Clear the check box to define a new TQL with the same 
name as the view. The TQL name appears in the Based on 
TQL window when you enter it in the View Name window.

Note: This field is only relevant for pattern views.

Description Enter a description of the view.

Note: This field is optional.

Instance View Select to create an instance view. (Not relevant in edit 
mode.)

Pattern View Select to create a pattern view. (Not relevant in edit mode.)

View Name Enter a unique name for the view. The name can contain all 
characters except the following: " \ / : | < > %.
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Advanced Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Ad Hoc View When the check box is selected, the view is defined as an 
Ad-hoc view. An Ad-hoc view is not updated automatically 
as changes occur in the system. The view is updated only 
when you schedule an update using the Scheduler.

For details, see “Scheduler User Interface” on page 378

Assign View to Select the check boxes for the applications in which you 
want the view you are creating to be visible:

➤ IT Universe. The view is visible in IT Universe Manager. 
Selected by default.

➤ Dashboard. The view is visible in Dashboard and 
Dashboard Administration. Selected by default.

➤ Service Level Management. The view is visible in Service 
Level Management.

➤ Service Level Management Administration. The view is 
visible in Service Level Management Administration.

➤ SOA. The view is visible in Business Availability Center 
for SOA. Selected by default only for views in the SOA 
folder.

Merge Identical 
Instances

When the check box is selected, identical instances that 
appear on the same layer in this view are automatically 
merged into one symbol in the editing pane. This helps you 
remove redundant information and sharpen the view’s 
focus. For details, see “Merge Identical Instances” on 
page 138.

Organization 
Name

The name of the organization related to the query.

Persistent View Defines whether you want the selected view to always 
remain in the system memory. You should use this option 
only for views that are used frequently.

Service Name The name of the service related to the query.
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Group By Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Simple Click to collapse the Advanced area of the dialog box.

Track Changes Select to be notified when CIs are added or removed. The 
changes are tracked in the system by creating daily 
snapshots of the view.

TQL Description A description of the query. 

Note: This field is only relevant for pattern views.

TQL Priority From the TQL Priority list, select a priority level for the new 
query (Low, Medium, High, Express). This setting 
determines how often the query should be rerun 
automatically by the system to include updated information 
from the CMDB.

Note: This field is only relevant for pattern views.

Description Enables you to define a new grouping of CIs or to edit an 
existing one.

To access: In View Manager, click Add or Edit from the 
Grouping dialog box.

Important 
Information

Grouped CIs appear in the View Explorer pane in 
IT Universe Manager in parentheses. 

GUI Element (A-Z) Description

Attribute Select to group CIs of multiple CI types in the Topology 
Map, according to the attribute selected from the list. A 
CI can be a member of multiple groups. 

Attribute Name If you are grouping by attribute, select the appropriate 
Attribute Name.

GUI Element (A-Z) Description
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Configuration Item 
Type

Select to group CIs in the Topology Map by their CI type.

Group Label Enter the label of the group.

Note: This field is optional.

Group List If you are grouping by attribute, define the specific 
groups of the selected attribute to be created. For 
example, to display two groups of IP addresses that end 
between 0 and 100, enter 0-50, 51-100. Any IPs that fall 
outside this group are placed automatically into the 
Others group.

Mask to group by If you are grouping by attribute, enter a regular 
expression, as follows:

➤ In the first field, enter the regular expression pattern. 
This is the structure of the selected attribute.

➤ In the second field, enter the group number. This is 
the part of the regular expression pattern to focus on 
when creating the group.

For details, see “Grouping By Attribute Properties” on 
page 137.

Minimum in group Enter the minimum number of matching CIs required to 
create the group. By default there must be at least one CI 
in the group.

Note: This field is optional.

TQL Node Select to group all CIs of the same CI type that fulfill the 
node definition criteria. By default, these CIs appear in 
the Topology Map under a folder containing the name 
of the selected TQL node and an automatically added 
identification number.

GUI Element (A-Z) Description
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Grouping Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the different CI groupings you have defined for 
the Topology Map.

To access: In View Manager, select Node Definition or 
Relationship Definition from the context menu in the 
Editing pane.

GUI Element (A-Z) Description

Opens the Group By dialog box which enables you to 
define a new CI group. For details, see “Group By Dialog 
Box” on page 146.

Opens the Group By dialog box which enables you to 
edit the selected CI group. For details, see “Group By 
Dialog Box” on page 146.

Deletes the selected CI group.

Moves selected row up.

Moves selected row down.

Click to open the online Help for this dialog box.

Data Displays the attribute used to define the group, for a 
group defined by attribute.

Group By The criteria by which the CI group is defined.

Label The label of the CI group.

Minimum The minimum number of matching CIs required to 
create the group.
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Instance View Editor

Left Pane

Description Enables you to add or remove existing CIs from instance 
views and to define new CIs to be added to the view.

To access: In the Views pane of View Manager, select the 
instance view you want to edit. The Instance View Editor 
opens in the Editing pane. You can also select Go To View 
Definition from within the view in IT Universe Manager.

Important 
Information

In the editing pane, a context menu is available for views 
and CIs. The menu for views includes the Create New CI 
option only. The context menu for CIs includes the 
following options:

➤ Create New CI

➤ Edit CI

➤ Display All CMDB Children

➤ Hide All CMDB Children

➤ Delete Relationship to Parent CI

When you make a change in the Instance View Editor, it 
affects the entire CMDB. For example, if you create a 
relationship between two CIs, they are now related and this 
is reflected in other views that match the new pattern. All 
changes made in the Instance View Editor only take effect 
when the view is saved.

Included in Tasks “Create and Populate an Instance View” on page 139

Description The left pane of the Instance View Editor provides the list of 
CIs that can be selected to add to your view using the 
buttons described below. You can select multiple CIs using 
the CTRL key. The left pane functionality follows the 
standard View Explorer functionality. For details, see “View 
Explorer User Interface” on page 615.
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Right Pane

Description In the edit pane (the right pane of the Instance View 
Editor), select the CI to which you want to add the selected 
CIs. You can select multiple CIs using the CTRL key – the 
added CIs are repeated under each selected CI.

Important 
Information

The Instance View Editor enables you to add the selected 
CIs to the view being edited:

➤ Add the CIs with Display all CMDB children status, so 
that the CIs are added to the edited view together with all 
recursive child CIs from the CMDB.

➤ Add the CIs to the edited view together with all recursive 
child CIs from the selected view only.

➤ Add the CIs with Display only manually added children 
status, so that the CIs are added to the edited view 
without any child CIs.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to add the selected CIs in the left pane to the CIs in 
the edit pane along with all the children of the selected CIs 
in the current view. In this case, CIs added to the view later 
do not appear in the Instance View Editor. However, if a 
child CI is deleted from the view, it is deleted from the 
entire universe and no longer appears in the Instance View 
Editor. Similarly, if the relationship between a parent and 
child CI is deleted, it is also updated in the Instance View 
Editor (the child CI appears on the same level as the parent 
CI).

Note: This option is only active when the View Explorer 
pane of the Instance View Editor is in Browse mode. In 
Search mode, the option is disabled.

Click to add the selected CIs in the left pane to the CIs in 
the edit pane along with all the children of the selected CIs 
in the CMDB. In this case, the view is dynamically updated 
whenever any change is made in the CMDB (addition of 
CIs, deletion of CIs or deletion of relationships).

Click to add the selected CIs in the left pane to the CIs in 
the edit pane without adding the children of the CI.

The View name is the root of the CI tree in the right pane. 
You can expand the tree to see all the CIs in the view. 

Hold the pointer over the Tip button to display a tooltip 
with useful information about the Instance View Editor.
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<CIs> The CIs listed under the view name represent the CIs 
appearing in that view. Select the relevant CI in order to 
perform the selected action for that CI by clicking the 
buttons or selecting from the context menu.

Each CI in the edit pane has a tooltip showing:

➤ the CI type, for example, Application.

➤ the child CI rule in effect for the CI. This states Display all 
CMDB children if the CI is set to include all its child CIs, 
or Display only manually added children if the CI is set to 
exclude all child CIs apart from those added to it within 
the current view. For more information, see “Child CI 
Rule Functionality” on page 130.

➤ the total number of CIs in the subtree under the CI, 
within the current view (the total is recalculated when 
the view is saved).

Add All CMDB 
Children

Select Add all CMDB children from the CI context menu or 
click the Add all CMDB children button to display all the 
child CIs of the selected CI. All child CIs that exist in the 
CMDB under the parent CI are added to the view. (If the 
parent CI is then deleted from the view, all the child CIs are 
deleted as well.)

All the child CIs are shown with faded icons and in 
italicized text, including any that were manually added to 
the parent before its status changed.

Create New CI Select the Create New CI option from the CI context menu 
or click the Create New CI button to create a new CI. The 
Define General Properties dialog box opens.

GUI Element (A-Z) Description
152



Chapter 4 • View Manager
Delete 
Relationship to 
Parent CI

Select the Delete Relationship to Parent CI option from the 
CI context menu or click the Delete Relationship to Parent 
CI button to delete the relationship to the parent CI. Using 
this option disconnects the child CI from the parent and 
removes the CI from the view (unless it appears elsewhere in 
the view). When you save your changes in the Instance 
View Editor, the relationship is deleted from the CMDB, so 
the CI no longer appears as a child of the parent CI in any 
view.

Any child CIs in the subtree under the disconnected CI are 
also removed from the view, (without affecting their 
relationship with the disconnected CI). If there are other 
instances of the disconnected CI (or any of its children) 
anywhere else in the view, these other instances are not 
affected, they remain in the view.

If you create a CI during the current Instance View Editor 
session, but then use the Delete Relationship to Parent CI 
option to remove it before saving it to the CMDB, the new 
CI is never created in the CMDB.

Edit CI Select the Edit CI option from the CI context menu or click 
the Edit CI button to edit the selected CI. The Edit CI 
Properties dialog box opens.

Remove Manually 
Added Children

Select Remove manually added children from the CI context 
menu or click the Remove manually added children button 
to hide all child CIs of the selected CI. All child CIs in the 
subtree under the parent CI are hidden, whether they were 
added manually or recursively. If the subtree includes a CI 
created during the current Instance View Editor session and 
not yet saved, that CI is removed completely and is never 
created in the CMDB.

GUI Element (A-Z) Description
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Relationship Folding Rules Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define multiple relationship rules.

To access: In View Manager, select Relationship Folding 
Rules from the context menu in the Views pane.

Important 
Information

As an alternative to adding folding rules, you can choose 
to define multiple relationship rules. 

You define relationship rules to define the structure 
between CITs in a view. This is in contrast to folding rules 
where you define the structure of two nodes connected to 
a specific relationship. For example, if one of the view’s 
nodes is a host, you can specify different relationships for 
Windows, UNIX, router, and so on. By assigning different 
folding rules to different CITs, views can encompass and 
represent additional query data.

Note: If both folding and relationship rules are defined, 
the definitions for the folding rules override the 
definitions for relationship rules.

Included in Tasks “Pattern View Workflow” on page 141

Useful Links “Add Rule/Edit Rule Dialog Box” on page 142

GUI Element (A-Z) Description

Opens the Add Rule dialog box where you can add a rule. 
For details, see “Add Rule/Edit Rule Dialog Box” on 
page 142.

Opens the Edit Rule dialog box where you can edit the 
selected rule. “Add Rule/Edit Rule Dialog Box” on 
page 142.

Deletes the selected rule.

Moves selected row up.
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Set View Parameters/Set View Element Parameters 
Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Moves selected row down.

Node 1 The node at one end of the relationship. 

Node 2 The node at the other end of the relationship.

Relationship The type of relationship.

Rule The relevant folding rule.

Description Enables you to edit the predefined parameters of 
conditions of nodes in a view.

To access: In View Manager, right-click a view in the 
Views pane and select Set View Parameters from the 
context menu or right-click a node in the Editing pane 
and select Set View Element Parameters from the context 
menu.

Important 
Information

When you select Set View Element Parameters from the 
right-click menu for a node in the editing pane, the 
dialog box displays only the conditions for the selected 
node. When you select Set View Parameters from the 
right-click menu in the Views pane, the dialog box 
displays any conditions that are defined for all nodes in 
the view.

GUI Element (A-Z) Description

<Element name> For each element, every condition appears on a separate 
line. You can edit the parameter by clicking on it to open 
the editing window.

GUI Element (A-Z) Description
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View Manager Window

Views Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create, edit, and save a view.

The View Manager window contains the following panes:

➤ Views pane. Displays a hierarchical tree structure of 
the views that you defined.

➤ Editing pane. Displays the currently selected view, 
which consists of nodes and the relationships between 
them.

➤ CI Type Selector. Displays a hierarchical tree structure 
of the available CI types.

➤ Information Pane. Displays properties, conditions, and 
cardinality for the selected node or relationship.

To access: Select Admin > Universal CMDB > Modeling > 
View Manager.

Description Enables you to select a view to edit.

Important 
Information

The Views Pane contains a hierarchical file folder system 
to help you organize your views, displayed in the Folders 
pane. Predefined folders are provided for the 
out-of-the-box views; you can modify these folders, or 
add additional folders according to your organization’s 
requirements.

GUI Element (A-Z) Description

Create a new folder.

Define a new view. For details, see “Create New 
View/View Properties Dialog Box” on page 143.

Delete the selected folder or view.
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Context Menu Options

The View Manager Window includes the following elements (listed 
alphabetically) available by right-clicking a folder or view in the Views pane:

Refresh the data content of the hierarchical tree structure 
that may have been modified by other users.

Save the view to the CMDB.

Open the View Properties dialog box. For details, see 
“Create New View/View Properties Dialog Box” on 
page 143.

Generate a preview of the existing views in the CMDB 
that match the pattern of the current view.

Go directly to IT Universe Manager for the current view.

Denotes a view folder. Double-click the icon to expand 
the folder.

Denotes a pattern view. When you select a pattern view, 
the Editing pane displays a Topology Map of the selected 
view.

Denotes an instance view. When you select an instance 
view, the Editing pane displays the Instance View Editor.

Root Denotes the top level folder, containing all other view 
folders and the First Service View.

Menu Item Description

Activate/Deactivate 
View

If the view is active, you can select Deactivate View to 
make it inactive. If the view is inactive, you can select 
Activate View to activate it. When you deactivate a view, 
a red X appears on it. Inactive views are not recalculated 
and cannot be selected in IT Universe Manager.

Delete Deletes a selected folder or view.

GUI Element (A-Z) Description
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Export Displays a standard Save As dialog box, enabling you to 
save the view as an XML script.

Go to IT Universe Takes you to IT Universe Manager and opens the selected 
view.

Import Opens the Import dialog box which enables you to 
import XML files containing views.

New Displays the Create New View dialog box which enables 
you to define a new view. For details, see “Create New 
View/View Properties Dialog Box” on page 143. 

New Folder Creates a new view folder.

Preview Generates a preview of the existing views in the CMDB 
that match the pattern of the current view.

Properties Displays the View Properties dialog box which enables 
you to change the description of the view, the TQL 
priority, the TQL description and other details. For 
details, see “Create New View/View Properties Dialog 
Box” on page 143.

Relationship Folding 
Rules

Displays the Relationship Rules dialog box which enables 
you to define multiple relationship rules. For details, see 
“Relationship Folding Rules Dialog Box” on page 154.

Rename Folder Enables you to rename the view folder.

Save/Save As Saves the view to the CMDB after you have modified it.

Note: If you exit View Manager without saving, a 
confirmation dialog box is displayed, requesting that you 
save your view.

Set View Parameters Appears if at least one node in the view has a 
parameterized node condition. Displays the Set View 
Parameters dialog box where you can edit the parameter 
of each condition. For details, see “Set View 
Parameters/Set View Element Parameters Dialog Box” on 
page 155.

Menu Item Description
158



Chapter 4 • View Manager
Editing Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the selected view, which consists of nodes and 
the relationships between them.

➤ When you select a folder in the Views pane, the 
Editing pane is empty.

➤ When you select a view in the Views pane, the Editing 
pane displays the selected view. The name of the view 
appears at the top of the pane.

Important 
Information

After defining a view in the Editing pane, you save it by 
clicking the Save button in the Views pane or by 
selecting Save from the context menu in the Views 
pane.

Useful Links For information on defining a TQL query, see “Add 
Nodes and Relationships to a TQL Query” on page 268.

GUI Element (A-Z) Description

<Context menu 
options>

For details, see “Context Menu Options” on page 271.

<Main menu> For details, see “Main Menu” on page 650.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two 
nodes.
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CI Type Selector

<Toolbar> For details, see “Toolbar Options” on page 654 

<Tooltip> Hold the cursor over a node or relationship to view its 
tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the CI as defined in the CI Type 
Manager. For details, see “CI Type Manager User 
Interface” in CI Attribute Customization.

➤ Visible. Indicates whether the selected node is visible 
in the Topology map.

➤ Cardinality. Relevant for nodes with relationships. 
Defines how many nodes you expect to have at the 
other end of the relationship. For example, in a 
relationship between host and IP, if the cardinality is 
1:3, the TQL retrieves only the hosts that are 
connected 1 to 3 IPs.

➤ Folding Rule. Relevant for relationships. Indicates the 
folding rule defined for the relationship.

➤ Condition. Appears only if a condition has been 
defined for the node or relationship.

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” in CI Attribute Customization.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Report Manager, and Trigger TQL 
Editor. 

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

<Search window> Enter the name or part of a name of a CI type for which 
to search.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Information Pane

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Report Manager, Enrichment Manager, Discovery Input 
TQL Editor, and Discovery Trigger TQL Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Show List button to display a list of the available 
tabs for the current manager. You can select a tab from the 
list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 176.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 318.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 320.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 257.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 68.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 220.

Note: This tab appears only in Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 324.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 213.

Note: This tab appears only when a relationship is selected 
in Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 326.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

If a known folder does not appear in the Views pane in View Manager, or if a 
folder appears which should not be there, execute the following JMX 
command to refresh the folders:

MAM / Service=MAM New Folders Services / refresh()
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Correlation Manager

This chapter provides information on Correlation Manager.

This chapter includes:

Concepts

 ➤  Correlation Manager Overview on page 167

Tasks

 ➤  Define a Correlation Rule - Scenario on page 169

Reference

 ➤  Correlation Manager User Interface on page 175
Concepts

Correlation Manager Overview

Correlation Manager enables you to define the interdependencies between 
components in your IT infrastructure to simulate how infrastructure 
changes (for example, a new software installation or upgrade) can impact 
your system.

By creating Correlation rules based on TQL queries, you can determine the 
true origin of a problem and its business impact. Each Correlation rule you 
define is attached to a specific Correlation TQL query. For more information 
about TQL queries, see “Topology Query Language” on page 263.
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You define Correlation rules to specify a causal relationship between two or 
more Correlation nodes. Define one node as the trigger, or the node that 
represents the changes you want to make to the system, and another node 
as the one that is affected. After the causal relationship is established, the 
Correlation Manager enables you to determine the effect of the changes 
occurring in root cause nodes.

You then run the Correlation rules in the Topology View tab (go to 
Applications > Universal CMDB > Topology View) to simulate how the 
changes impact your system and discover the root causes of the changes (for 
details, see “Run Correlation Dialog Box” on page 524). This enables you to 
evaluate and handle accordingly, the possible implications of any action, 
update, new deployment, or a failure of the service delivery.

A simulated change in an affected CI can alter the CI’s map status, which is 
manifested through an addition of a status icon to the CI’s symbol. The 
Topology Map displays the statuses of the trigger CIs as well as all statuses of 
the CIs that are affected by it. Each color represents a different status.

For details about the status icons and the colors that represent them, see 
“Correlation Rules Window” on page 523.

You can then generate a report displaying the following:

➤ CIs in the system that are impacted by the changes.

➤ Trigger CIs (the CIs that represent the changes you want to make to the 
system).

➤ CIs that belong to a specific business service. For details, see “Link Nodes to 
Application CI” on page 134.

Tasks
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Define a Correlation Rule - Scenario

This task describes how to define a Correlation rule.

Note: To retrieve the required Correlation results, you must follow each step 
in this task.

This task includes the following steps:

➤ “Create an Enumeration Definition” on page 170

➤ “Define a State” on page 172

➤ “Create a Correlation TQL Query” on page 173

➤ “Create a Correlation Rule” on page 173
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 1 Create an Enumeration Definition

Note: This step is optional. You can use the default Enumeration definitions 
that appear in the System Type Manager.

To retrieve Correlation results, you must create a Correlation rule in the 
Correlation Manager. A Correlation rule is based on a state that exists in the 
State Manager. For details, see “State Manager” on page 505. 

A state is based on an Enumeration definition. Enumerations are designed to 
be used as severity value lists by states. You can either base a state on an 
existing Enumeration definition in the State Manager or, if required, create 
one by clicking the New Enumeration button. For details on creating 
Enumeration definitions, see “Create/Update List/Enumeration Definition 
Dialog Box” in CI Attribute Customization.

Note: Alternatively, you can create an Enumeration definition in the System 
Type Manager. For details, see “System Type Manager” in CI Attribute 
Customization. The Enumeration definition you create appears in the State 
Manager.
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Example

Select Admin > Universal CMDB > Settings > State Manager to open the 
State Manager. In the bottom-right corner, click the New Enumeration 
button to open the Create Enumeration Definition dialog box.

The following Enumeration definition creates a severity list that represents 
CPU usage of 10%, 20%, and 50%.
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 2 Define a State

Note: This step is optional. You can use the default States that appear in the 
State Manager.

When you create a Correlation Rule, you select the state on which the 
Correlation condition is based. The State Manager contains two default 
states — Change and Operation. Each one is based on its own severity list. 
You can use a default state, or if required, create one based on a severity list 
(Enumeration definition) that is more relevant to your needs.

To define a new state, select Admin > Universal CMDB > Settings > State 
Manager to open the State Manager. For details on defining a new state, see 
“State Manager Dialog Box” on page 507.

Example

A new state called cpu_usage is defined in the State Manager. Its Type 
Definition is based on the Enumeration definition called cpu_usage defined 
in the previous task.
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 3 Create a Correlation TQL Query
To create a Correlation TQL query, you need to define a Correlation rule and 
then add the TQL nodes and relationships that define the query. 

Select Admin > Universal CMDB > Modeling > Correlation Manager to open 
the Correlation Manager. For details about how to create a Correlation TQL 
query, see “Create New Correlation Rule/Properties Dialog Box” on 
page 188. For details about how to add nodes and relationships to a query, 
see “Add Nodes and Relationships to a TQL Query” on page 268.

Example

In this Correlation TQL query, a CPU and a Host node are linked by a 
Container Link relationship. The TQL results must comply with the 
direction of the arrows.

Note: A Correlation TQL query is subject to certain validation restrictions. 
For details, see “Troubleshooting and Limitations” on page 340.

 4 Create a Correlation Rule
When you create a Correlation rule, you must specify the required causal 
relationship between the nodes. Define one node as the trigger, or the node 
that represents the changes you want to make to the system, and another 
node as the one that is affected.
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Right-click the node you want to define as the trigger node and select Define 
Affected to open the Affected Nodes dialog box. In the Affected Nodes 
dialog box, select the node you want the trigger node to affect. Then click 
the Add button to open the Correlation Definition dialog box to set 
conditions for defining affected nodes. For details about how to define a 
Correlation rule, see “Correlation Definition Dialog Box” on page 177. 

Example

The Conditions area in the Correlation Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Affected Severity area defines the severity of the Correlation impact on 
the affected node.

The Correlation rule in this example states that when the CPU usage of the 
Host node to which the CPU node is connected does not equal 10%, the 
Host node is automatically assigned the 50% load status, which in this case, 
is the color red according to the severity list.
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In the resulting TQL query, an upward arrow appears next to the node 
defined as the trigger node and a downward arrow appears next to the node 
defined as the affected node.

Note: To retrieve the Correlation results, you must run the Correlation rule 
in the Topology View tab. For details, see “Retrieve Correlation Results - 
Scenario” on page 512.

Reference

Correlation Manager User Interface

This section describes:

 ➤  Affected Nodes Dialog Box on page 176

 ➤  Correlation Definition Dialog Box on page 177

 ➤  Correlation Manager Window on page 180

 ➤  Create New Correlation Rule/Properties Dialog Box on page 188

 ➤  Details Dialog Box on page 190
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Affected Nodes Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Define which node in the TQL query is the trigger 
Correlation node and which nodes are affected by the 
changes that occurred in the system.

Note: This information should be known beforehand, 
when first creating the TQL query, but the definition is 
performed here.

To access: Right-click the node or relationship that 
functions as a trigger and select Define Affected. The 
Affected Nodes dialog box opens to display the nodes in 
the TQL.

Included in Tasks “Define a Correlation Rule - Scenario” on page 169.

GUI Element (A-Z) Description

Affected Nodes pane Contains a list of the Correlation nodes in the 
Correlation rule. Select the nodes to be affected by the 
trigger node.
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Correlation Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

The Correlation Definition dialog box also includes the following areas:

➤ “Conditions Area” on page 177

➤ “Scope Area” on page 178

➤ “Affected Severity Area” on page 179

Conditions Area

Description Set conditions for defining affected nodes.

To access: Click Add in the Details dialog box.

Included in Tasks “Define a Correlation Rule - Scenario” on page 169

GUI Element (A-Z) Description

Description A description of the Correlation rule you are defining.

Description Define a condition for the node’s attributes. When this 
condition is met, the simulated change in the system is 
triggered.

For example, you can define a Correlation condition that 
states that the operational state of the node is other than 
Normal. When the operational state of the node instance 
changes and is no longer Normal, the condition is met 
and the simulated changes in the system are triggered.

To access: Click Add in the Details dialog box. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Scope Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

GUI Element (A-Z) Description

State Choose the required state. The states that appear in the 
list are the states that are defined in the State Manager. 
For details, see “State Manager” on page 505.

Operator Select the required operator. For a list of the operators you 
can use for defining an attribute condition, see “Attribute 
Operator Definitions” on page 276.

Value Comparison Select the required attribute.

Description Define how many instances of the trigger node should 
fulfill the conditions for triggering the changes in the 
system.

You can apply the trigger conditions not only to one of 
the instances of a trigger node, but also to a certain 
percentage of the trigger instances, or to all of them. 

For example, you can define that impact is calculated 
when at least 10% of the system’s hosts are down.

To access: Click Add in the Details dialog box.

GUI Element (A-Z) Description

All All instances should fulfill the conditions.

Any One instance or more should fulfill the conditions.

Range A certain percentage of all instances should fulfill the 
conditions. For example, if you enter a range of 50% to 
100%, the changes are triggered when 50% or more of the 
instances meet the conditions.
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Affected Severity Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Define the severity of the Correlation impact.

To access: Click Add in the Details dialog box.

GUI Element (A-Z) Description

Fixed severity Define a fixed severity level for every system change 
generated. Then, select the required severity level from 
the list.

Function Select Function (displayed when you selected the All and 
Range options in the Scope area) to define a severity level 
for the system changes, as a function of the severity levels 
of all the trigger node instances that are included in the 
range. From the list, select either Average or Max.

For example, if you select Average, the severity level of 
the system changes is the average severity of all the trigger 
instances.

Severity relative to 
trigger severity (%)

Select Severity relative to trigger severity (%) (displayed 
when you selected the Any option in the Scope area) to 
define a severity level for each system change that is 
relative (as a percentage) to the severity of the trigger 
event.

Enter the percentage in the box provided.
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Correlation Manager Window

The Correlation Manager window includes the following panes:

➤ “Correlation Rules Pane” on page 180

➤ “Editing Pane” on page 182

➤ “CI Type Selector” on page 184

➤ “Information Pane” on page 185

Correlation Rules Pane

Description Define Correlation rules.

To access: Select Admin > Universal CMDB > Modeling > 
Correlation Manager.

Important 
Information

When selecting nodes to function as Correlation triggers, 
they must comply with certain restrictions. For details, 
see “Troubleshooting and Limitations” on page 340.

Included in Tasks “Define a Correlation Rule - Scenario” on page 169

Useful Links “Correlation Manager Overview” on page 167

Description Displays a hierarchical tree structure of predefined 
folders and Correlation rules. Each Correlation rule is 
associated with a TQL query.

You can create your own query, or work with the 
default queries provided with your HP Business 
Availability Center installation.

The predefined folders are provided for the default 
queries; you can modify these folders, or add 
additional folders according to your organization’s 
requirements.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

The following elements are available by right-clicking a folder or Correlation 
rule:

 

GUI Element (A-Z) Description

Create a new folder.

Creates a Correlation rule. Opens the Create New 
Correlation Rule/Properties dialog box.

(Enabled only when a new Correlation rule is created or 
when changes are made to an existing one.) Saves the 
Correlation rule to the CMDB.

Deletes the selected folder or Correlation rule.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

Opens the Properties dialog box. Enables you to change 
the description of the rule.

Generates  a preview of the results of the selected 
Correlation rule.

Represents a folder.

Represents a Correlation rule.

GUI Element (A-Z) Description

Delete Delete the selected folder or Correlation rule.

Export Displays a standard Save As dialog box, enabling you to 
save the Correlation rule as an XML script. This option 
can be used to move a Correlation rule from one 
workstation to another, provided the related TQL query is 
also relocated.

Import Imports XML files that contain saved Correlation rules to 
the Correlation Manager.
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Editing Pane

New Creates a Correlation rule. Opens the Create New 
Correlation Rule/Properties dialog box.

New Folder Creates a new folder.

Properties Opens the Create New Correlation Rule/Properties dialog 
box. Enables you to change the description of the rule.

Rename Folder Rename the folder.

Save (Enabled only when a new Correlation rule is created or 
when changes are made to an existing one.) Saves the 
Correlation rule to the CMDB.

Save As Displays the Save As dialog box, enabling you to define a 
new name and description for a query. This option can be 
used for creating new Correlation rules based on an 
existing one.

Description Displays the selected Correlation rule, which consists of 
nodes that are defined in the TQL query and the 
relationships between them.

➤ When you select a folder in the Correlation Rules pane, 
the Editing pane is empty. 

➤ When you select a Correlation rule in the Correlation 
Rules pane, the Editing pane displays the selected rule, 
which consists of TQL nodes that are defined in the 
TQL query and the relationships between them.

Useful Links  “Add Nodes and Relationships to a TQL Query” on 
page 268

Important 
Information

When selecting nodes to function as Correlation triggers, 
they must comply with certain restrictions. For details, 
see “Troubleshooting and Limitations” on page 340.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Indicates a trigger node. Located to the right of the trigger 
node's icon. 

Indicates an affected node. Located to the right of the 
affected node’s icon.

Indicates nodes that are both affected and trigger nodes.

<Main Menu> For details, see “Main Menu” on page 650.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two 
nodes.

<Context menu 
options>

For details, see “Context Menu Options” on page 271.

<Toolbar> For details, see “Toolbar Options” on page 654.

<Tooltip> Hold the cursor over a node or relationship to view its 
tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the node as defined in the CI Type 
Manager. For details, see CI Attribute Customization.

➤ Definitions of the selected nodes and relationships. 
The attribute conditions, as described in 
“Node/Relationship Properties Dialog Box” on 
page 316.

➤ Names of the trigger and the affected nodes. This is 
only relevant if the node over which the cursor is 
hovering is the trigger node.

Define Affected Displays the Affected Nodes dialog box.
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CI Type Selector

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” in CI Attribute Customization.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Report Manager, and Trigger TQL 
Editor. 

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

<Search window> Enter the name or part of a name of a CI type for which 
to search.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Information Pane

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Report Manager, Enrichment Manager, Discovery Input 
TQL Editor, and Discovery Trigger TQL Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Show List button to display a list of the available 
tabs for the current manager. You can select a tab from the 
list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 176.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 318.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 320.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 257.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 68.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 220.

Note: This tab appears only in Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 324.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 213.

Note: This tab appears only when a relationship is selected 
in Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 326.

GUI Element (A-Z) Description
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Create New Correlation Rule/Properties Dialog Box

Description Create or modify a Correlation rule.

To access: 

➤ Right-click anywhere in the Correlation Rules pane 
and click New or click the New  button.

or

➤ Right-click a Correlation rule and select Properties.

Important 
Information

➤ Any major changes made to the TQL query after 
creating a Correlation rule causes the system to delete 
the rule. These changes include deleting a root cause 
or affected node or changing the Min and Max 
relationship definitions (for details, see “Cardinality 
Tab” on page 320).

➤ Minor changes, such as adding a node to the TQL, do 
not cause the deletion of the rule.

➤ The Correlation TQL that serves as the basis of the 
Correlation rule, must comply with the restrictions 
described in “Troubleshooting and Limitations” on 
page 340. If the TQL is not valid, it cannot be used for 
the creation of a Correlation rule.

Included in Tasks “Define a Correlation Rule - Scenario” on page 169

Useful Links  “Add Nodes and Relationships to a TQL Query” on 
page 268.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Includes the following elements:

➤ TQL Priority list. From the Priority list, select a priority 
level for the new TQL query (Low, Medium, High, 
Express). This setting determines how often the query 
is rerun automatically by the system to include 
updated information from the CMDB.

➤ TQL Description. (Optional) Enter a description of the 
TQL query.

➤ UCMDB. Enables you to run a Correlation rule in the 
Topology View Application tab in Universal CMDB. 
For details, see “Topology View Overview” on 
page 512.

➤ PI. Enables you to run correlation rules, which are used 
by the on-demand monitors in Problem Isolation. For 
details, see “On-demand Monitors” in Using Problem 
Isolation.

➤ Others. Currently not supported.

Hide the options that appear when you click the 
Advanced button.

Based on TQL Select this check box if you want to link a Correlation 
rule to an existing TQL query. From the Attach TQL list, 
select the Correlation TQL to which you want to link the 
rule.

Description (Optional) Enter a description of the rule.

Rule Name Enter a unique name for the Correlation rule.
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Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the new Correlation rule you created in the 
Correlation Definition dialog box.

To access: Click Next in the Affected Nodes dialog box.

Included in Tasks “Define a Correlation Rule - Scenario” on page 169

GUI Element (A-Z) Description

Description The description of the new Correlation rule.

State The category you chose from the Category list in the 
Correlation Definition dialog box.
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Report Manager

This chapter provides information on Report Manager.

This chapter includes:

Concepts

 ➤  Report Manager Overview on page 192

Tasks

 ➤  Define a Report Rule - Scenario on page 192

 ➤  Compare a CI Configuration to a Gold Master Template on page 202

Reference

 ➤  Report Manager User Interface on page 202
Concepts
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Report Manager Overview

Report Manager enables you to define the following reports:

➤ System reports. Contains information about selected Report nodes in the 
managed world. Each report is based on a specific Report TQL query, which 
is created especially for it. (If required, you can define multiple reports for 
each query.) For more information about TQL queries, see “Topology Query 
Language” on page 263. The Report Manager enables you to define exactly 
which information appears in each report, including the order in which 
nodes are listed and their placement relative to other nodes, and how the 
information within each Report is sorted. For details, see “Report Manager 
Window” on page 210.

➤ Gold Master reports. Compares the configuration of a Gold Master CI to 
other CIs of the same CI type. Select the CI you want to use as the Gold 
Master CI, and then the CIs whose configuration you want to compare to 
the Gold Master template. You can choose the CIs from existing views or 
from the CMDB. The report that is generated specifies which of the selected 
CIs are configured differently. For details, see “Gold Master Report Pane” on 
page 208.

Tasks

Define a Report Rule - Scenario

This task describes how to create a Report TQL definition whose query 
results retrieve hosts that run on a Windows operating system. Then, by 
changing a report’s parametized values, you can generate a report from that 
same TQL query displaying hosts that run on a Linux operating system.

Note: To retrieve the required query results, you must follow each step in 
this task.
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This task includes the following steps:

➤ “Create a Report TQL Query” on page 193

➤ “Set TQL Node Definitions” on page 194

➤ “Define the Column Content of the Selected Node” on page 195

➤ “Sort the Column Information” on page 196

➤ “Set the Node Order” on page 197

➤ “Refine the Report Layout” on page 198

➤ “View a System Report Displaying Hosts that Run on a Windows Operating 
System” on page 200

➤ “View a System Report Displaying Hosts that Run on a Linux Operating 
System” on page 201

 1 Create a Report TQL Query
To create a Report TQL query, you need to define a Report rule and then add 
the TQL nodes and relationships that define the query. 

Select Admin > Universal CMDB > Modeling > Report Manager to open the 
Report Manager. For details about how to create a Report TQL query, see 
“Create New Report Definition/Properties Dialog Box” on page 205. For 
details about how to add nodes and relationships to a query, see “Add Nodes 
and Relationships to a TQL Query”.
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Example

In this Report TQL query, a Network and a Host node are linked by a 
Member relationship and the Host node is linked to an IP node by a 
Contained relationship. The TQL results must comply with the direction of 
the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see “Troubleshooting and Limitations” on page 340.

 2 Set TQL Node Definitions
You can set attribute definitions for the nodes and relationships you added 
to the TQL query. In the Editing pane, right-click the required node, and 
select Node Properties to open the Node Properties dialog box. Then click 
the Attribute tab. For details on how to define node and relationship 
definitions, see “Node/Relationship Properties Dialog Box” on page 316.

Example

In the Report Manager, the attribute condition of the Host node are defined 
in the Attribute tab in the Node Properties dialog box to retrieve only hosts 
that run on a Windows operating system.
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To do this, in the Attribute tab, select the following:

➤ Attribute name — Host Operating System

➤ Operator — Like ignore casel

➤ Parameterized Value

➤ Value — %windows%

When the Parameterized Value equals %windows%, all hosts that that run 
on a Windows operating system are displayed in the query results.

 3 Define the Column Content of the Selected Node
Define which nodes to include in the report, and which attributes and 
functions to display for each node. In the Editing pane, right-click the 
required node, and select Report Node Definition to open the Report Node 
Definition dialog box. Click the Add Attributes button to select the required 
attributes. For details, see “Report Node Definition Dialog Box” on page 220.

Example

➤ The attributes Network Address and Network Class are selected for the 
Network node.

➤ The attributes Host DNS Name and Host Operating System are selected for 
the Host node.
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➤ The attributes IP Network Address, IP Network Mask, and Last Access Time 
are selected for the IP node.

 4 Sort the Column Information
Determine the order of the information displayed for each node, and the 
method by which the data is sorted in each column. In the Editing pane, 
right-click the appropriate node and select Report Node Definition to open 
the Report Node Definition dialog box. Then click Sort to open the 
Attribute Column dialog box to define the order in which the node’s 
attributes appear in the System report. For details, see “Attribute Columns 
Dialog Box” on page 205.

Example

In the Attribute Columns dialog box, the attributes for the Network node 
are defined to appear in the System report in the following order:
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In the Attribute Columns dialog box, the attributes for the Host node are 
defined to appear in the System report in the following order:

In the Attribute Columns dialog box, the attributes for the IP node are 
defined to appear in the System report in the following order:

 5 Set the Node Order
Determine the order of the nodes in the report. Right-click any node from 
the query and select Node Order to open the Set Node Order dialog box. 
The Set Node Order dialog box displays a row for each node that is included 
in the report. Use the up and down arrows to move the nodes to the 
required location in the report. For details, see “Set Node Order Dialog Box” 
on page 222.
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Example

Use the up and down arrows to move the Network node to the beginning of 
the list and the IP node to the bottom. The Network node is the parent 
node, so it should appear at the beginning of the report. The data of the 
Host node is displayed next, followed by the IP node. 

 6 Refine the Report Layout
You can display nodes dependent on other nodes either aligned underneath 
or indented underneath the parent node a generated report. Displaying 
nodes indented beneath one another enables you to better distinguish 
between parent nodes and their children. 

The Editing pane enables you to define how nodes are displayed in a 
generated report in relation to one another. For details about the Editing 
pane, see “Report Manager Window” on page 210.
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Example

➤ In this report, the IP CI is defined as the child of the Host CI, and the Host 
CI is defined as the child of the Network CI. As a result, the IP CI is indented 
underneath the Host CI and the Host CI is indented under the Network CI 
in the generated report.

➤ In this report, the Network, Host, and Network CIs are defined as siblings, 
so all the CIs are displayed aligned with one another.
199



Chapter 6 • Report Manager
 7 View a System Report Displaying Hosts that Run on a Windows 
Operating System
In the Reports pane, right-click the Hosts report definition and select 
Generate.

This report displays an instance of a host CI that runs on a Windows 2003 
operating system.
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 8 View a System Report Displaying Hosts that Run on a Linux 
Operating System
In the Reports pane, right-click the Hosts report and select Set Report 
Parameters to open the Set Report Parameters dialog box. Click 
%windows%, and in the Editing window that opens, enter %linux%. Save 
the new definition. Then right-click the Hosts report definition and select 
Generate.

This report displays an instance of a host CI that runs on a Linux operating 
system.
201



Chapter 6 • Report Manager
Compare a CI Configuration to a Gold Master Template

This task describes how to create a Gold Master report definition and then 
generate a Gold Master report.

 1 Create a Gold Master Report Definition
Define a Gold Master report that compares the configuration of a Gold 
Master CI to other CIs of the same CI type, or a child of the CI type. Select 
the CI you want to use as the Gold Master CI and then the CIs whose 
configuration you want to compare to the Gold Master template. You can 
select the CIs from existing views or from the CMDB. For details, see “Gold 
Master Report Pane” on page 208.

 2 Generate a Gold Master Report
Generate a report that specifies which of the selected CIs are configured 
differently. For details, see “Gold Master Report Pane” on page 208.

Reference

Report Manager User Interface

This section describes:

 ➤  Add Attributes Dialog Box on page 203

 ➤  Add/Edit Function Dialog Box on page 204

 ➤  Attribute Columns Dialog Box on page 205

 ➤  Create New Report Definition/Properties Dialog Box on page 205

 ➤  Edit Attribute Dialog Box on page 207

 ➤  Filter CIs Dialog Box on page 207

 ➤  Gold Master Report Pane on page 208

 ➤  Report Manager Window on page 210

 ➤  Report Node Definition Dialog Box on page 220

 ➤  Set Node Order Dialog Box on page 222

 ➤  Set Report Parameter Dialog Box on page 223
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 ➤  Set View-specific Report Dialog Box on page 224

Add Attributes Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the content of the selected Report 
node’s columns.

To access: Click the Add Attributes  button in the 
Report Node Definition dialog box.

Included in Tasks “Define a Report Rule - Scenario” on page 192

Important 
Information

Attributes that have already been selected in the Report 
Node Definition dialog box do not appear on the list.

GUI Element (A-Z) Description

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Add Select the check box of the attributes you want to appear 
in the report. The selected attributes appear in the Report 
Node Definition dialog box. Each attribute you add 
represents a column in the report.

Attribute The name of the attribute.

Column Title The column title, by default, takes the same name as the 
selected attribute. You can change the title of the column 
in the Edit Attribute dialog box.
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Add/Edit Function Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define which of the node’s functions and 
parameters you want to include in the report.

To access: Click the Add Function  button in the 
Report Node Definition dialog box.

Included in Tasks “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Attribute Define the necessary parameters.

Function From the Function list, select the function you want to 
use to calculate the results on these columns. 

Following are the available options:

➤ average. The average value of all the attributes of the 
connected nodes.

➤ count. Calculate the number of node instances 
connected to the selected node.

➤ max. The maximum value of all the attributes of the 
connected nodes.

➤ min. The minimum value of all the attributes of the 
connected nodes.

➤ sum. The sum of all the attributes of the connected 
nodes.

Related The node on which you want to perform the function.

Title The name of the function attribute displayed in the 
report.
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Attribute Columns Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Create New Report Definition/Properties Dialog Box

Description Determine the order of the information displayed for 
each Report node, and the method by which the data is 
sorted in each column.

To access: Click Sort in the Report Node Definition dialog 
box.

Included in Tasks “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Ascending Sort the information in ascending order.

Descending Sort the information in descending order.

Sort Items by Select the primary sort column from the Sort Item by list.

Then by Define up to three secondary sort columns from the Then 
by lists.

Description Create or modify a System or Gold Master report 
definition.

To access: 

➤ To create a System or Gold Master report definition, 
right-click anywhere in the Reports pane and click 
New or click the New  button.

or

➤ To modify a System or Gold Master report definition, 
right-click a Report definition and select Properties.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks “Define a Report Rule - Scenario” on page 192

Important 
Information

For information on how to add nodes and relationships 
to a query, see “Add Nodes and Relationships to a TQL 
Query” on page 268.

GUI Element (A-Z) Description

TQL Description. (Optional) Enter a description of the 
Report TQL query.

Hide the TQL Description box that appears when you 
click the Advanced button.

Based on TQL Select this check box if you want to link a report to an 
existing TQL query. From the Attach TQL list, select the 
required TQL to which you want to link the report.

Description (Optional) Enter a description of the report.

Gold Master Create a Gold Master report. For details on how to define 
a Gold Master report, see “Gold Master Report Pane” on 
page 208.

Name The name of the System report or the Gold Master report.

Sub Title Enter the subtitle of the report. This title appears 
underneath the title at the head of the report.

Title Enter the title of the report. This title appears at the head 
of the report.

Topology Create a System report.
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Edit Attribute Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Filter CIs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Modify the name of the column title.

To access: Select the required attribute in the Report Node 
Definition dialog box and click the Edit/Attribute 
Function  button.

Included in Tasks “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Attribute Displays the node’s selected attribute. This box cannot be 
edited.

Column Title Modify the column title as required. The name that 
appears in the Column Title box is, by default, the same 
name as the attribute. The modified column title appears 
in the Field column in the Report Node Definition dialog 
box.

Description Enables you to exclude the CI types you do not want to 
appear in the Gold Master report.

To access: Click the Filter CI Types  button in the Gold 
Master Report pane.

GUI Element (A-Z) Description

<List of CI types> The CI types you select are excluded from the report.
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Gold Master Report Pane

Description Define a Gold Master report definition that compares the 
configuration of a Gold Master CI to other CIs of the 
same CI type or a child of the CI type. You choose the 
CI you want to use as the Gold Master CI and then the 
CIs whose configuration you want to compare to the 
Gold Master template. You can choose the CIs from 
existing views or from the CMDB. The report that is 
generated specifies which of the selected CIs are 
configured differently.

To access: 

1  Select Admin > Universal CMDB > Modeling > Report 
Manager.

2  Right-click anywhere in the Reports pane and click 
New or click the New  button to open the Create 
New Report Definition dialog box.

3  Define the report and select Gold Master.

Important 
Information

➤ You can also define a schedule that generates and 
saves Gold Master reports on a periodic basis. For 
details, see “Scheduler” on page 375.

➤ The CIs appear in this report under the following 
circumstances:

➤ Their attributes are marked as Comparable in the 
Add Attribute dialog box in the CI Type Manager.

➤ The CIs have descendants that are defined as 
Comparable.

For details, see “Add/Edit Attribute Dialog Box” in 
CI Attribute Customization.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Compared CIs Pane

Master CI Pane

Left Pane

GUI Element (A-Z) Description

Determines which CI types are not included in the Gold 
Master report. Opens the Filter CITs dialog box.

Generates a Gold Master report. For details, see “Gold 
Master Report” on page 589.

Moves the required CIs back and forth between the left 
pane and the Master CIs pane and the Compared CIs 
panes.

Include Similar Items Select this check box if you want to include the compared 
CIs whose configuration is identical to that of the Gold 
Master CI.

Description Contains the CIs that you want to compare to the Gold 
Master CI.

Important 
Information

You can select multiple CIs.

Description Contains the CI you want to use as a Gold Master CI.

Description The left pane contains the following tabs:

➤ Browse. Select the required CI from different levels of 
the view hierarchy. For details, see “Browse Tab” on 
page 585.

➤ Search. Search for a specific CI in existing views or in 
the entire CMDB. For details, see “Search Tab” on 
page 586.
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Report Manager Window

The Report Manager window includes the following panes:

➤ “Reports Pane” on page 211

➤ “Editing Pane” on page 213

➤ “CI Type Selector” on page 215

➤ “Information Pane” on page 217

Description The Report Manager enables you to:

➤ Define System reports about specific Report nodes. 
Each report is based on a specific Report TQL query, 
which is created especially for it. You can define 
exactly what information appears in each report, 
including the order in which Report nodes are listed 
and their placement relative to other Report nodes, 
and how the information within each report is sorted.

➤ Define a report that compares the configuration of a 
Gold Master CI to other CIs of the same CI type or a 
child of the CI type. For details, see “Gold Master 
Report Pane” on page 208.

To access: Select Admin > Universal CMDB > Modeling > 
Report Manager.

Important 
Information

You can also define a schedule that creates system reports 
based on a specific Report query, on a periodic basis. For 
details, see “Scheduler” on page 375.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Compare a CI Configuration to a Gold Master 
Template” on page 202
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Reports Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of predefined folders 
containing report definitions. Each report is associated 
with a TQL query.

You can create your own TQL query, or work with the 
default queries provided with your HP Business 
Availability Center installation.

The predefined folders are provided for the default 
queries. You can modify these folders, or add additional 
folders according to your organization’s requirements.

GUI Element (A-Z) Description

Create a new folder.

Create a TQL Report or Gold Master report definition. 
Opens the Create New Report Definition/Properties 
dialog box.

(Enabled only when a report is created or when changes 
are made to an existing one.) Save the Gold Master or 
System report to the CMDB.

Delete the selected folder or report.

Refresh the data content of the hierarchical tree structure 
that may have been modified by other users.

Open the Create New Report Definition/Properties dialog 
box. Enables you to change the description and 
activation state of the report.

Generates  a preview of the results of the selected Report 
TQL.

Represents a folder.
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The following elements are available by right-clicking a folder or report:

Represents a Gold Master report definition.

Represents a System report definition.

GUI Element (A-Z) Description

Delete Delete the selected folder or report definition from the 
CMDB.

Export Displays a standard Save As dialog box, enabling you to 
save the report as an XML script. This option can be used 
to move a report from one workstation to another, 
provided the related TQL Report query is also relocated.

Note: Only relevant for System reports and not Gold 
Master reports.

Generate Generate the selected report.

Import Import XML files that contain saved Report queries to the 
Report Manager.

New Create a TQL Report or Gold Master report definition. 
Opens the Create New Report Definition/Properties 
dialog box.

New Folder Create a new folder.

Properties Open the Create New Report Definition/Properties dialog 
box. Enables you to change the description and 
activation state of the report.

Rename Folder Rename the folder.

Save (Enabled only when a new TQL Report or Gold Master 
report definition is created or when changes are made to 
an existing one.) Save the TQL Report or Gold Master 
report definition to the CMDB.

GUI Element (A-Z) Description
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Editing Pane

Save As Displays the Save As dialog box, enabling you to define a 
new name and description for a TQL Report or Gold 
Master report definition. This option can be used for 
creating a new report based on an existing one.

Set Report 
Parameters

Enables you to generate a report using values different 
than the ones you defined in the Attribute tab in the 
Node/Relationship dialog box. Opens the Set Report 
Parameters dialog box.

Note: This option only appears if you defined a 
parameterized value in the Attribute tab in the 
Node/Relationship dialog box.

Set view-specific 
report

(Optional) Enables you to generate a report of the 
selected Report TQL query based on a certain view rather 
than the entire CMDB. Select the view on which you 
want to base the report.

Description Create and define Report nodes and relationships.

➤ When you select a folder in the Reports pane, the 
Editing pane is empty.

➤ When you select a report in the Reports pane, the 
Editing pane displays the TQL Report query, which 
consists of TQL nodes that are defined in the TQL 
query and the relationships between them, or the Gold 
Master report.

Useful Links “Add Nodes and Relationships to a TQL Query” on 
page 268

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Main Menu> For details, see “Main Menu” on page 650.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between 
two nodes.

<Right click> options For details, see “Context Menu Options” on 
page 271.

<Toolbar> For details, see “Toolbar Options” on page 654.

<Tooltips> Hold the cursor over a node or relationship to 
view its tooltip.

The tooltips contain the following information:

➤ Node Report Order: The order in which the 
Report node appears in the report.

➤ Node Report Label: A title for the selected 
Report node definition. For details, see Report 
Node Definition dialog box.

➤ Column Title: The title of each column for that 
node. For details, see Edit Attribute dialog box.
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The following elements are available by right-clicking a relationship. These 
options define how nodes are displayed in a generated report in relation to 
one another.

CI Type Selector

GUI Element (A-Z) Description

Add Relationship 
Folding Rule

Enables you to define how nodes are displayed in a 
generated report in relation to one another. 

You can use one of the following options:

Child. Define one Report node as a child of the Report 
node to which it is linked. In the report, the child Report 
nodes are displayed indented beneath the parent nodes.

None. Does not define any rules for this relationship. In 
the system report, the Report nodes appear in different 
tables.

Sibling. Define one Report node as a sibling of the Report 
node to which it is linked. In the report, the two Report 
nodes appear aligned with one another.

SonGrid. Groups all the leaf instances in a table under 
their parent’s node. This option applies to leaf nodes 
only.

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” in CI Attribute Customization.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Report Manager, and Trigger TQL 
Editor. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT 
Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.
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Information Pane

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Report Manager, Enrichment Manager, Discovery Input 
TQL Editor, and Discovery Trigger TQL Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Show List button to display a list of the available 
tabs for the current manager. You can select a tab from the 
list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 176.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 318.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 320.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 257.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 68.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 220.

Note: This tab appears only in Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 324.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 213.

Note: This tab appears only when a relationship is selected 
in Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 326.

GUI Element (A-Z) Description
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Report Node Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the node attributes that are included in the 
report, that is, the report’s columns. Each row in the table 
represents a column that appears in the report.

You select the required attributes from the Add Attributes 
dialog box.

To access: Right-click a node and select Report Node 
Definition.

Included in Tasks “Define a Report Rule - Scenario” on page 192

Important 
Information

Only defined nodes are included in the final report. 
However, other nodes are included in the report 
calculations, since they are part of the TQL that the 
report reflects, and they can influence the data that is 
displayed in it. For example, in a Report TQL, which 
consists of a linked Host and IP, the IP has an attribute 
condition that states that only IPs that are in a critical 
state are included in the query results. Consequently, the 
report includes only hosts that are connected to IPs in a 
critical state, even if the IPs themselves are not included 
in the report.

Note: The nodes to be included in the reports must be 
connected to each other through the TQL scenario. You 
cannot define nodes that are not linked to at least one 
other node that is included in the report.

GUI Element (A-Z) Description

Select the attributes you want to appear in the report 
template. Opens the Add Attributes dialog box.

Define the function you want to perform on the Report 
node. Opens the Add Function dialog box.
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Modify the attributes, functions and parameters, defined 
for each Report node.

Enables you to:

➤ Modify the name of the column title for that attribute. 
Select an attribute that displays attribute in the 
Function column. Opens the Edit Attribute dialog box. 
For more details, see the Add Attributes dialog box.

➤ Modify the functions and parameters you defined for 
the selected report node. Select an attribute that 
displays the parameters included for each node and 
the function (such as sum or max) performed on them 
in the Function and Parameter columns. Opens the 
Add/Edit Function dialog box.

Delete the selected report node definition. A column for 
the node definition you deleted does not appear in the 
report.

Use the up and down arrows to determine the order of 
each node included in the report.

Define the sort order of the information reported for each 
Report node. Opens the Attribute Columns dialog box. 

<click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Field Displays the nodes that are included in the report, that is, 
the report’s columns.

The title of the column as displayed in the Field box is 
the way the column title appears in the report template. 
By default, column titles take the same name as the 
selected attribute. You can change the title of the column 
in the Edit Attribute dialog box.

Parameters Displays the parameters you defined for the Report node. 
For details, see the Add/Edit Function dialog box.

GUI Element (A-Z) Description
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Set Node Order Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Title A title for the selected Report node definition.

Type Displays the functions you defined for the Report node. 
For details, see the Add/Edit Function dialog box.

Description Determine the order in which the Report nodes appear in 
the report.

To access: Right-click any node displayed in the Editing 
pane and select Node Order to open the Set Node Order 
dialog box.

The Set Node Order dialog box displays a row for each 
node that is included in the report.

Included in Tasks “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Use the up and down arrows to determine the order of 
each node included in the report.

Nodes The list of nodes contained in the selected Report query.

GUI Element (A-Z) Description
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Set Report Parameter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a list of all the parameterized values defined for 
the nodes in the TQL in the Attribute tab in the 
Node/Relationship dialog box.

Enables you to modify the value and then generate a 
report based on the changed value.

To access: In the Reports pane, right-click a Report 
definition whose report was defined with parameterized 
values from the Attribute tab in the Node/Relationship 
dialog box.

Important 
Information

➤ Changing the value in the Set Report Parameter dialog 
box changes what is displayed in the generated report 
and not the TQL query results.

➤ This dialog box is available only if you defined 
parameterized values in the Attribute tab in the 
Node/Relationship dialog box.

Included in Tasks “Define a Report Rule - Scenario” on page 192

Useful Links “System Report” on page 599

GUI Element (A-Z) Description

Attribute name The attribute used in the attribute condition.

Operator The operator used in the attribute condition. 

Value The value of the attribute.
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Set View-specific Report Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to generate a report of the selected Report 
TQL query based on a specific view rather than the entire 
CMDB.

Included in Tasks “Define a Report Rule - Scenario” on page 192

Useful Links “System Report” on page 599

GUI Element (A-Z) Description

Click to open the Select View dialog box. Select the view 
on which you want to base the report.

View Opens the View tree. Select the view on which you want 
to base the report.
224



7
Query Manager

This chapter provides information on Query Manager.

This chapter includes:

Concepts

 ➤  Query Manager Overview on page 225

Tasks

 ➤  Define a TQL Query on page 227

Reference

 ➤  Query Manager User Interface on page 228
Concepts

Query Manager Overview

Query Manager enables you to create TQL queries that can be used in other 
managers.

It is recommended to use the relevant managers (Correlation Manager, 
Enrichment Manager, View Manager, Report Manager, Trigger TQL Editor) 
to create your TQL queries, rather than the Query Manager. All TQL queries 
that are created in the other managers automatically appear in the Query 
Manager.

You can use the Save As option in the Query Manager to change the type of 
a TQL, so you do not have to recreate it. For details, see “TQLs Pane” on 
page 231. Then, to see the query results in the Topology Map, you can 
create, in View Manager, a view based on the TQL query created in Query 
Manager.
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Once you create and save a TQL query of the types View, Correlation, 
Enrichment, and Report, you cannot edit it. To edit a TQL of these types, 
you can go to the relevant manager, for example, the View Manager, and 
create a new view based on the TQL query that you created in the Query 
Manager. Then you can edit the TQL query which was created in the Query 
Manager, in the View Manager. Any changes you make to the query in the 
View Manager appear in the TQL query in the Query Manager. You can only 
edit queries of the types Integration or Discovery in the Query Manager.

You can display the retrieved data of the view’s TQLs in a topology map 
where you can monitor the data. For details, see “Topology View 
Application” on page 511. The TQL resides in the system’s memory and 
generates updated results automatically. For more information about 
Topology Query Language, see “Topology Query Language” on page 263.

Tasks
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Define a TQL Query

This task describes how to define a TQL query and add the required nodes 
and relationships.

 1 Create a TQL Query
Create a TQL rule. Select Admin > Universal CMDB > Modeling > Query 
Manager to open the Query Manager. For details about how to create a TQL 
query, see “Create New TQL/TQL Properties Dialog Box” on page 228.

 2 Add Nodes and Relationships to the Query
After you have created the TQL query, add the TQL nodes and relationships 
that define the query. The TQL nodes represent the CITs, as defined in the 
CI Type Manager (for details, see CI Attribute Customization), and the 
relationships represent the connections between them. Relationships are 
defined one at a time for each pair of TQL nodes in the query. For details 
about how to add nodes and relationships to a query, see “Add Nodes and 
Relationships to a TQL Query” on page 268.

Example

In this TQL query, a Host and an IP node are linked by a Contained 
relationship. The TQL results must comply with the direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see “Troubleshooting and Limitations” on page 340.

Reference
227



Chapter 7 • Query Manager
Query Manager User Interface

This section describes:

 ➤  Create New TQL/TQL Properties Dialog Box on page 228

 ➤  Query Manager Window on page 230

Create New TQL/TQL Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Create or modify a TQL query.

To access: 

➤ Right-click anywhere in the TQLs pane and click New 
or click the New  button.

or

➤ Right-click a TQL query and select Properties.

Important 
Information

TQL queries are subject to certain validation restrictions. 
For details, see “Troubleshooting and Limitations” on 
page 340. 

If the TQL is not valid, you cannot save it.

Included in Tasks “Define a TQL Query” on page 227

GUI Element (A-Z) Description

Description (Optional) Enter a description of the TQL query.

Persistent (Optional) Define whether the selected TQL should 
always remain in the system memory. Use this option 
only for frequently used TQLs.
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Priority Select a priority level for the new TQL query (Low, 
Medium, High, or Express). This setting determines how 
often the query should be rerun automatically by the 
system to include updated information from the CMDB.

Note: If you are creating a TQL of the type Enrichment, 
you can choose a priority of either Low or Medium only.

TQL Name Enter a unique name for the TQL query.

Type You can create a TQL query of the following types:

➤ View. Creates pattern and instance views whose results 
are displayed in IT Universe. For details, see “View 
Manager” on page 123.

➤ Correlation. Creates queries containing Correlation 
nodes that influence other Correlation nodes in the 
system, as defined using the Correlation Manager. For 
details, see “Correlation Manager” on page 167.

➤ Enrichment. Creates queries containing Enrichment 
nodes and relationships. For details, see “Enrichment 
Manager” on page 239.

➤ Report. Creates queries whose results are compiled into 
reports using the Report Manager. For details, see 
“Report Manager” on page 191.

➤ Discovery. Creates queries for use by the Discovery and 
Dependency Mapping (DDM) system. For details, see, 
“Trigger TQL Editor” in Discovery and Dependency 
Mapping Guide.

➤ Integration. Creates queries for use with the CMDB 
API. For details, see “Working with the HP Universal 
CMDB API” on page 101 in Solutions and Integrations.

Note: Discovery TQLs should be created only by users 
who are thoroughly familiar with the DDM patterns used 
by the DDM system. For details, contact HP Software 
Support. 

GUI Element (A-Z) Description
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Query Manager Window

The Query Manager window includes the following panes:

➤ “TQLs Pane” on page 231

➤ “Editing Pane” on page 233

➤ “CI Type Selector” on page 234

Description Enables you to query the CMDB by defining TQL queries 
or to change the type of an existing TQL. 

To access: Click Admin > Universal CMDB > Modeling > 
Query Manager.

Important 
Information

➤ It is recommended to use the relevant Managers 
(Correlation Manager, Enrichment Manager, View 
Manager, Report Manager, Trigger TQL Editor) to 
create your TQL queries, rather than the Query 
Manager. All TQLs that are created in the other 
managers automatically appear in the Query Manager. 
You can use the Save As option in the Query Manager 
to change the type of TQL, so you do not have to 
recreate it. For details, see “TQLs Pane” on page 231.

➤ Once you create and save a TQL query of the types 
View, Correlation, Enrichment, and Report, you 
cannot edit it. To edit a TQL of these types, you can go 
to the relevant manager, for example, the View 
Manager, and create a new view based on the TQL 
query that you created in the Query Manager. You can 
then can edit the TQL query (which was created in the 
Query Manager) in the View Manager. Any changes 
you make to the query in the View Manager appear in 
the TQL query in the Query Manager. 

You can only edit queries of the Integration or 
Discovery types in the Query Manager.

➤ For TQL queries to be valid, they must comply with 
the restrictions described in “Troubleshooting and 
Limitations” on page 340.

Useful Links “Topology Query Language (TQL) Overview” on page 264
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➤ “Information Pane” on page 236

TQLs Pane
 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of predefined folders 
and TQL queries.

You can create your own query, or work with the default 
queries provided with your HP Business Availability 
Center installation.

Predefined folders are provided for the out-of-the-box 
queries; you can modify these folders, or add additional 
folders according to your organization’s requirements.

GUI Element (A-Z) Description

Creates a new folder.

Enables you to:

➤ Create a TQL query of the types View, Correlation, 
Enrichment, Report, Discovery, or Integration. You 
can only edit queries of the types Integration or 
Discovery in the Query Manager.

➤ Open the Create New TQL/TQL Properties dialog box.

(Enabled only when a TQL query is created or when 
changes are made to an existing one.) Save the TQL query 
to the CMDB.

Deletes the selected folder or TQL query.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.  

Opens the TQL Properties dialog box. For a description, 
see “Properties” below.

Generates  a preview of the results of the selected TQL 
query.
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The following elements are available by right-clicking a folder or a TQL 
query:

Represents a folder.

Represents a TQL query.

GUI Element (A-Z) Description

Delete Delete the selected folder or TQL query.

Export Displays a standard Save As dialog box, enabling you to 
save the TQL query in XML script format. This option 
can be used to move TQL queries from one workstation 
to another.

Import Imports XML files that contain saved TQL queries to the 
Query Manager.

New Create a TQL query. For details, see “Create New 
TQL/TQL Properties Dialog Box” on page 228.

New Folder Create a new folder.

Properties Opens the TQL Properties dialog box. Enables you to 
change the priority and description of the selected TQL 
query, and define whether the TQL should always remain 
in the system memory (Persistent).

Rename Folder Rename the folder.

GUI Element (A-Z) Description
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Editing Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Save (Enabled only when a new TQL is created or when 
changes are made to an existing TQL) Save the query to 
the CMDB after you have defined the specific attribute 
conditions of the nodes and relationships in the query.

Note: If you exit the TQL Builder without saving, a 
confirmation dialog box is displayed, requesting that you 
save your query.

Save As Displays the Save TQL As dialog box, enabling you to 
create a query by copying an existing one.

You can change the type of the query. For a description of 
the available query types, see “Type” on page 229.

Description Displays the currently selected TQL.

➤ When you select a folder in the TQLs pane, the Editing 
pane is empty.

➤ When you select a TQL query in the TQLs pane, the 
Editing pane displays the selected query, which 
consists of TQL nodes that are defined in the TQL 
query and the relationships between them.

Useful Links “Add Nodes and Relationships to a TQL Query” on 
page 268.

GUI Element (A-Z) Description

<Main Menu> For details, see “Main Menu” on page 650.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between 
two nodes.

GUI Element (A-Z) Description
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CI Type Selector

<Right click> options For details, see “Context Menu Options” on 
page 271.

<toolbar> For details, see “Toolbar Options” on page 654.

<tooltips> Hold the cursor over a node or relationship to 
view its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the node as defined in the 
CI Type Manager. For details, see CI Attribute 
Customization.

➤ Definitions of the selected nodes and 
relationships. The attribute conditions, as 
described in “Node/Relationship Properties 
Dialog Box” on page 316.

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” in CI Attribute Customization.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Report Manager, and Trigger TQL 
Editor. 

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.
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Information Pane

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Report Manager, Enrichment Manager, Discovery Input 
TQL Editor, and Discovery Trigger TQL Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Show List button to display a list of the available 
tabs for the current manager. You can select a tab from the 
list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 176.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 318.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 320.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 257.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 68.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 220.

Note: This tab appears only in Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 324.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 213.

Note: This tab appears only when a relationship is selected 
in Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 326.

GUI Element (A-Z) Description
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Enrichment Manager

This chapter provides information on Enrichment Manager.

This chapter includes:

Concepts

 ➤  Enrichment Manager Overview on page 239

Tasks

 ➤  Define an Enrichment Rule - Scenario on page 242

Reference

 ➤  Enrichment Manager User Interface on page 245
Concepts

Enrichment Manager Overview

Enrichment rules can be used for several purposes:

➤ Adding new CIs and relationships to the CMDB.

➤ Deleting specific CI instances from the CMDB.

➤ Updating the attribute values of specific CI instances in the CMDB.

Enrichment nodes and relationships differ from other nodes and 
relationships in that they are conceptual deductions that represent real 
relationships and CIs that cannot be discovered automatically by the 
Discovery and Dependency Mapping (DDM) process.
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Enrichment nodes and relationships are created as part of a TQL, whose 
other TQL nodes are regular ones, meaning TQL nodes that already exist in 
the CMDB. For more information about TQL queries, see “Topology Query 
Language” on page 263 in Model Management.

The following example displays a regular Host node linked to an IBM 
Websphere MQ Enrichment node by an Enrichment Container link 
relationship.

By placing an Enrichment node within a TQL query context, the query 
receives data from its attributes, and uses it to insert new information into 
the CMDB.
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When you create Enrichment rules, the following results can occur:

➤ The CMDB is enlarged. Add Enrichment nodes and relationships that are 
currently not included in the CMDB.

The following Enrichment rule example displays a regular Windows node 
(that already exists in the CMDB) connected to a File Enrichment node by 
an Enrichment Container link relationship.

This Enrichment rule states that for every Windows CI instance that is 
found in the CMDB, a new File CI instance is created, and linked to the 
Windows CI with a Container link relationship.

➤ Specific CI instances are deleted from the CMDB. For an example, see 
“Define an Enrichment Rule - Scenario” on page 242.

➤ The values of CI attributes are updated. Use an Enrichment rule to update 
the attributes of a CI that already exists in the CMDB.

The following Enrichment rule example illustrates that a regular Disk node 
(that already exists in the CMDB) has been updated with an Enrichment 
rule.

This Enrichment rule states that every Disk CI found in the CMDB is 
updated with the attribute value defined in the Enrichment rule.

Tasks
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Define an Enrichment Rule - Scenario

This task describes how to create an Enrichment rule where, for every 
instance in the CMDB in which an IP CI is connected to two identical Host 
CIs, but one Host CI is identified by its IP address and the other host is 
identified by its lowest MAC address, the Host CI that is identified by its IP 
address is deleted from the CMDB.

Note: To reach the required result, you must implement each one of the 
following steps.

This task includes the following steps:

➤ “Create an Enrichment TQL Query” on page 242

➤ “Define the Host Node that Is Identified by its Lowest MAC Address” on 
page 244

➤ “Define the Host Node that is Identified by its IP Address” on page 244

➤ “Define the Enrichment Rule” on page 245

 1 Create an Enrichment TQL Query
To create an Enrichment TQL query, you need to define an Enrichment rule 
and then add the regular TQL nodes and relationships that define the query.

Note: You can add Enrichment nodes and relationships only after at least 
one regular node has been added to the query. In this task then, you must 
first add regular nodes and relationships.

Select Admin > Universal CMDB > Modeling > Enrichment Manager. For 
details about how to create an Enrichment TQL query, see “Create New 
Enrichment Rule/Properties Dialog Box” on page 246. For details about how 
to add nodes and relationships to a query, see “Add Nodes and Relationships 
to a TQL Query” on page 268.
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Example

A new Enrichment TQL query called doubleHosts is created in the 
Enrichment Manager.

The doubleHosts Enrichment rule is displayed in the Enrichment Rules 
pane.

a

In this Enrichment TQL query, an IP node is linked to two Host nodes by a 
Contained relationship. The TQL results must comply with the direction of 
the arrows.
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Note: A TQL query is subject to certain validation restrictions. For details, 
see “Troubleshooting and Limitations” on page 340.

 2 Define the Host Node that Is Identified by its Lowest MAC 
Address
At the top of the Enrichment Manager window, select TQL mode. In the 
Editing pane, right-click the required Host node, select Node Properties to 
open the Node Properties dialog box. Then define an attribute condition in 
the Attribute tab. For details on how to define an attribute condition, see 
“Attribute Tab” on page 318.

Example

In the Attribute tab, this attribute condition definition identifies the 
required Host by its lowest MAC address.

➤ Attribute name — Host is Complete

➤ Operator — Equal

➤ Value — Fixed value (= true)

 3 Define the Host Node that is Identified by its IP Address
At the top of the Enrichment Manager window, select TQL mode. In the 
Editing pane, right-click the required Host node, and select Node Properties 
to open the Node Properties dialog box. Then define two attribute 
conditions in the Attribute tab. For details on how to define an attribute 
condition, see “Attribute Tab” on page 318.

Example

This attribute condition is the first attribute condition you need to define in 
the Attribute tab to enable the Host node to be identified by its IP address.

➤ Attribute name — Host is Complete

➤ Operator — Equal

➤ Value — Fixed value (= false)
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This is the second attribute condition you need to define in the Attribute tab 
to enable the Host node to be identified by its IP address.

➤ Attribute name — Host is Complete

➤ Operator — Is null

➤ Value — Fixed value (Value canot be changed)

 4 Define the Enrichment Rule
Define the Enrichment rule that deletes all instances of the Host node that 
are identified by their IP address. At the top of the Enrichment Manager 
window, select Enrichment mode. In the Enrichment Rules pane, select the 
doubleHosts Enrichment rule. Then right-click the Host node that is 
identified by its IP address and select Delete Relationship/Node Item.

Example

The Host node now has a removed indicator to denote that all host 
instances that have identical attribute and cardinality settings are removed 
from the CMDB. The Enrichment query now looks like this.

Reference

Enrichment Manager User Interface

This section describes:

 ➤  Create New Enrichment Rule/Properties Dialog Box on page 246

 ➤  Enrichment Manager Window on page 248

 ➤  Node/Relationship Definition Dialog Box on page 257

 ➤  Node Definition – Advanced Attribute Dialog Box on page 259
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Create New Enrichment Rule/Properties Dialog Box

Description Create or modify an Enrichment rule.

To access: 

➤ Right-click anywhere in the Enrichment Rules pane 
and click New or clicking the New  button.

or

➤ Right-click an Enrichment rule and select Properties. 

Included in Tasks “Define an Enrichment Rule - Scenario” on page 242

Important 
Information

When creating a new Enrichment rule, bear in mind that 
the application does not allow you to make any changes 
in the TQL that are necessary for the rule. These changes 
include the following:

➤ Deleting, from the Enrichment TQL, the nodes or 
relationships connected to the Enrichment node, 
causing a node to become unattached to any 
relationship.

➤ You cannot change the cardinality definition to 0 (not 
required) of a node or relationship that is used in an 
Enrichment rule. For details on relationship 
cardinality, see “Node/Relationship Properties Dialog 
Box” on page 316.

Note: Enrichment TQLs that serves as the basis for 
Enrichment rules, are subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 340. If the TQL is not valid, you 
cannot save it.

Useful links “Add Nodes and Relationships to a TQL Query” on 
page 268.
246



Chapter 8 • Enrichment Manager
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Includes the following elements:

➤ TQL Priority list. From the Priority list, select a priority 
level for the new TQL query (Low, Medium, High, 
Express). This setting determines how often the query 
is rerun automatically by the system to include 
updated information from the CMDB.

➤ TQL Description. (Optional) Enter a description of the 
TQL query.

Hide the TQL Priority list and TQL Description box that 
appear when you click the Advanced button.

Active (Optional) Verify that Active is selected to activate the 
rule in the system as soon as it is saved.

Notes: 

➤ If an active Enrichment rule is deactivated (by clearing 
Active in the Properties dialog box), all changes that 
occurred in the CMDB relating to the rule are deleted 
from the system. When you deactivate an Enrichment 
rule, a red X appears next to the Enrichment rule in 
the Enrichment Rules pane.

➤ To reactivate the rule, right-click the rule in the 
Enrichment Rules pane and select Properties. In the 
Properties dialog box, select Active.

Based on TQL Select this check box if you want to link an Enrichment 
rule to an existing TQL query.

From the Attach TQL list, select the Enrichment TQL to 
which you want to link the rule.

Description (Optional) Enter a description of the rule.

Name Enter a unique name for the Enrichment rule. The name 
you enter automatically appears in the box to the right of 
the Based on TQL check box if you do not select the 
Based on TQL check box.
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Enrichment Manager Window

The Enrichment Manager window includes the following panes:

➤ “Enrichment Rules Pane” on page 248

➤ “Editing Pane” on page 251

➤ “CI Type Selector” on page 253

➤ “Information Pane” on page 254

Enrichment Rules Pane

Description Define Enrichment rules. These rules, which are based 
on a specific TQL query, can be used for several 
purposes:

➤ Adding new CIs and relationships to the CMDB.

➤ Deleting specific CI instances from the CMDB.

➤ Updating the attribute values of specific CI instances 
in the CMDB.

To access: Select Admin > Universal CMDB > Modeling 
> Enrichment Manager.

Important 
Information

Enrichment Manager has two modes in which you can 
work. Always check the Enrichment/TQL mode list in 
the toolbar to verify the currently selected mode.

Included in Tasks “Define an Enrichment Rule - Scenario” on page 242

Description Displays a hierarchical tree structure of predefined folders 
and Enrichment rules. Each Enrichment rule is associated 
with a TQL query.

You can create your own query, or work with the out-of-
the-box (factory) queries provided with your HP Business 
Availability Center installation.

The default folders are provided for the out-of-the-box 
queries. You can modify these folders, or add additional 
folders according to your organization’s requirements.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

The following elements are available by right-clicking a folder or 
Enrichment rule:

GUI Element (A-Z) Description

Creates a new folder.

Creates an Enrichment rule. Opens the Create New 
Enrichment Rule/Properties dialog box.

(Enabled only when an Enrichment rule is created or 
when changes are made to an existing one.) Saves the 
Enrichment rule to the CMDB.

Deletes the selected folder or Enrichment rule.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

Opens the Create New Enrichment Rule/Properties dialog 
box. Enables you to change the description and the 
activation state of the Enrichment rule.

Generates  a preview of the results of the selected 
Enrichment rule.

Represents a folder.

Represents an Enrichment rule.

GUI Element (A-Z) Description

Delete Deletes the selected folder or Enrichment rule.

Export Displays a standard Save As dialog box, enabling you to 
save the Enrichment rule as an XML script. This option 
can be used to move an Enrichment rule from one 
workstation to another, provided the related TQL query is 
also relocated.
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Import Imports XML files that contain saved Enrichment queries 
to the Enrichment Manager.

New Creates an Enrichment rule. Opens the Create New 
Enrichment Rule dialog box.

New Folder Creates a new folder.

Properties Opens the Create New Enrichment Rule/Properties dialog 
box. Enables you to change the description and the 
activation state of the rule.

Rename Folder Renames the folder

Save (Enabled only when a new Enrichment query is created 
or when changes are made to an existing one.) Saves the 
Enrichment rule to the CMDB.

Save As Displays the Save As dialog box, enabling you to define a 
new name and description for a query. This option can be 
used for creating a new Enrichment rule based on an 
existing one.

GUI Element (A-Z) Description
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Editing Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Create and define Enrichment nodes and relationships.

➤ When you select a folder in the Enrichment Rules 
pane, the Editing pane is empty.

➤ When you select an Enrichment rule in the 
Enrichment Rules pane, the Editing pane displays the 
selected rule, which consists of TQL nodes that are 
defined in the TQL query and the relationships 
between them, and the Enrichment nodes and 
relationships that are created and added to the rule.

Important 
Information

➤ The Enrichment Manager has two modes in which 
you can work: Enrichment mode and TQL mode.

The right-click options that appear when you click a 
node or relationship depends on the which mode in 
which you are working. For details, see the Editing 
pane description below.

➤ You can calculate the number of instances that were 
created as a result of an Enrichment rule and remove 
the instances created from an Enrichment rule from 
the CMDB. For details, see “Additions Count” on 
page 655 and “Remove Enrichment Results” on 
page 660.

Included in Tasks “Define an Enrichment Rule - Scenario” on page 242

Useful Links For details on how to create a TQL query, see “Add Nodes 
and Relationships to a TQL Query” on page 268.

GUI Element (A-Z) Description

Indicates an added Enrichment node or 
relationship.

Indicates a node or relationship that has been 
deleted from the CMDB.

Indicates an updated node or relationship.
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TQL and Enrichment mode

The Enrichment Manager has two modes in 
which you can work: Enrichment mode and TQL 
mode.

Working in:

➤ TQL mode enables you to define regular 
(non-Enrichment) relationships and nodes and 
add them to the TQL query you defined.

➤ Enrichment mode enables you to define 
Enrichment relationships and nodes and add 
them to the TQL query you defined.

<Main Menu> For details, see “Main Menu” on page 650.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between 
two nodes.

<Context menu> options For details, see “Context Menu Options” on 
page 271.

<Toolbar> For details, see “Toolbar Options” on page 654

<Tooltips> Hold the cursor over a node or relationship to 
view its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the node as defined in the 
CI Type Manager. For details, see CI Attribute 
Customization.

➤ Definitions of the selected nodes and 
relationships. The attribute conditions, as 
described in “Node/Relationship Properties 
Dialog Box” on page 316.

GUI Element (A-Z) Description
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CI Type Selector

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” in CI Attribute Customization.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Report Manager, and Trigger TQL 
Editor. 

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

<Search window> Enter the name or part of a name of a CI type for which 
to search.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Information Pane

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Report Manager, Enrichment Manager, Discovery Input 
TQL Editor, and Discovery Trigger TQL Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 267

➤ “Pattern View Workflow” on page 141

➤ “Define a Report Rule - Scenario” on page 192
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Show List button to display a list of the available 
tabs for the current manager. You can select a tab from the 
list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 176.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 318.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 320.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 257.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 68.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 220.

Note: This tab appears only in Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 324.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 213.

Note: This tab appears only when a relationship is selected 
in Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 326.

GUI Element (A-Z) Description
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Node/Relationship Definition Dialog Box

This dialog box contains the following areas:

➤ “Attributes Area” on page 258

➤ “Set Attributes Area” on page 258

Description Displays the attributes of the selected node/relationship. 
The key attributes and the required attributes of the 
selected node appear in bold. 

Use an Enrichment rule to update the value of CI 
attributes in the CMDB, or to add data to attributes that 
currently do not have values. You can use this option, for 
example, for adding a note simultaneously to all CI 
instances.

To access: Right-click a node or relationship when in 
Enrichment mode (select Enrichment from the 
TQL/Enrichment list at the top of the Enrichment 
Manager window) and select Update Relationship/Node.

Important 
Information

You must fill in the value of the key attributes and the 
required attributes of the Enrichment node. The method 
you use to define these values determines the number of 
instances created.

If you enter a dynamic value, you can create numerous 
instances. For example, entering the dynamic value of a 
host_key for the CIT Host or an IP address attribute for 
the CIT IP.

Included in Tasks “Define an Enrichment Rule - Scenario” on page 242
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Attributes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Set Attributes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Name The attribute name.

Type The field type of the selected attribute.

Value The value as defined in one of the following:

➤ The Value box in the Set Attributes area.

➤ The combination of the values in the By Attribute 
boxes in the Set Attributes area.

➤ The Value column if you selected Simple in the Type 
column in the Node Definition - Advanced Attribute 
dialog box.

➤ The combination of the values in the Value column 
and the column to the right of the Value column if you 
selected By Attribute in the Type column in the Node 
Definition - Advanced Attribute dialog box.

GUI Element (A-Z) Description

(Appears only if you selected an attribute of the field type 
string.) Opens the Node Definition - Advanced Attribute 
dialog box.

Define node and relationship attributes of the type string 
using simple or complex expressions. You can also create 
complex expressions using regular expression format.

Advanced (Appears only if you selected an attribute of the field type 
string.) Displays the attribute value you defined in the 
Node Definition - Advanced Attribute dialog box.
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Node Definition – Advanced Attribute Dialog Box

By Attribute Define an attribute using attributes from other nodes in 
the TQL query.

➤ In the box to the left, select the required node.

➤ In the box to the right, select the node’s required 
attribute.

The attribute definition appears in the Value column in 
the Attributes area.

Group (Appears only when you select an attribute of the field 
type string.) Enter the group number only if you are 
adding a regular expression using regular expression 
syntax. This is the part of the regular expression pattern 
to focus on when creating the attribute. A set of 
parentheses ( ) constitutes a group.

Regular Expression (Appears only when you select an attribute of the field 
type string.) Add a regular expression using regular 
expression syntax. Enter the regular expression pattern.

Value (in the Set 
Attributes area)

Define a constant value. Enter the required value in the 
Value box or select a value from the Value list.

Note: The value definition appears in the Value column 
in the Attributes area.

Description Define node and relationship attributes of the type String 
using simple or complex expressions. You can also create 
complex expressions using regular expression format.

To access: 

1  Select an attribute of the type string in the Attributes 
area of the Node Definition dialog box.

2  In the Set Attributes area, select Advanced and then 
click the Advanced button.

Included in Tasks “Define an Enrichment Rule - Scenario” on page 242

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Define an attribute value using simple or complex 
expressions. Creates a new entry in the Type column. 
Click the new entry and select either Simple or By 
Attribute. For details, see the description for the Type 
column below.

Delete an attribute value.

Move a selected row up.

Move a selected row down.

<The column that 
appears between the 
Value and Regular 
Expression columns>

(This list is only available if you select By Attribute in the 
Type column.) Click the entry inside the box and select 
the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp Group (This list is only available if you select By Attribute in the 
Type column.) Click the entry inside the RegExp Group 
column, click the  button, and enter the group number. 
This is the part of the regular expression pattern to focus 
on when creating the attribute. A set of parentheses ( ) 
constitutes a group.

Regular Expression (This list is only available if you select By Attribute in the 
Type column.) Click the entry inside the Regular 
Expression column, click the  button, and enter the 
regular expression pattern in the Editing Regular 
Expression dialog box that opens.
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Type Click the entry inside the Type column and select one of 
the following options:

➤ Simple. Define a constant value using a simple 
expression.

➤ By Attribute. Define an attribute using attributes from 
other nodes in the TQL.

Default is: Simple.

Use first attribute 
with value

Use the first attribute value listed in this dialog box that is 
not empty.

Value ➤ If you select Simple in the Type column, click the entry 
inside the Value column, click the Add Value  
button, and enter the required value in the Editing 
Simple dialog box.

➤ If you select By Attribute in the Type column, click the 
entry inside the Value column, and select the required 
element from the list.

GUI Element (A-Z) Description
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9
Topology Query Language

This chapter provides information on Topology Query Language (TQL).

This chapter includes:

Concepts

 ➤  Topology Query Language (TQL) Overview on page 264

 ➤  Topology Query Language on page 264

 ➤  The Roles of TQL on page 265

 ➤  Where TQL Queries Are Created on page 265

 ➤  Viewing TQL Query Results on page 266

 ➤  The Join Relationship on page 266

Tasks

 ➤  Define a TQL Query on page 267

 ➤  Add Nodes and Relationships to a TQL Query on page 268

 ➤  Add Enrichment Nodes and Relationships to an Enrichment TQL Query 
on page 269

Reference

 ➤  Context Menu Options on page 271

 ➤  Attribute Operator Definitions on page 276

 ➤  TQL Logs on page 278

 ➤  TQL Parameters on page 283

 ➤  Topology Query Language User Interface on page 291

Troubleshooting and Limitations on page 340
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Concepts

Topology Query Language (TQL) Overview

Topology Query Language (TQL) is a language and tool for discovering, 
organizing, and managing IT infrastructure data. It enables you to create 
TQL queries that retrieve business service data from the configuration 
management database (CMDB) and displays the data in a visual 
representation that facilitates data monitoring and managing. For details on 
CMDB, see “Configuration Management Database (CMDB)” on page 17.

Topology Query Language

TQL extends the standard SQL language by adding two important 
capabilities:

➤ TQL enables you to draw conceptual relationships between configuration 
items (CIs), which represent their actual interdependencies. Using 
predefined operators, the different types of interconnections (relationships) 
that exist between CIs can be established, and consequently the 
infrastructure design and performance are more accurately represented. This 
representation serves as a basis and a model for the discovery, arrangement, 
query, and management of complex infrastructures.

➤ TQL includes a graphical aspect, consisting of visual symbols and syntax, 
that represents the resources and their interconnections. This visualization 
of an IT infrastructure simplifies the understanding, monitoring, and 
managing of the IT business operations.
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The Roles of TQL

TQL plays several roles:

➤ Builds a business service model that defines and delineates the 
interconnection between IT assets that function together as business 
services. The business service model guides the discovery and identification 
of these business services, from the ever-increasing number and complexity 
of infrastructure resources. After the resources that comprise the business 
services are discovered, the business service model structures the way they 
are organized and managed in the CMDB.

➤ Constantly searches the CMDB for changes that occur in the state of 
managed resources. When such changes are detected, the relevant 
subsystems are informed and updated. 

➤ Creates queries that retrieve business service data from the CMDB, and 
displays the data in a visual representation that facilitates data monitoring 
and managing.

Where TQL Queries Are Created

The following managers use TQL:

➤ Correlation Manager. Create a Correlation TQL query to simulate how 
infrastructure changes can impact your system. A Correlation rule is based 
on either a Correlation TQL query created from within the Correlation 
Manager, or on an existing query. By creating Correlation rules based on 
TQL queries, you can determine the true origin of a problem and its business 
impact. For details, see “Correlation Manager” on page 167.

➤ Enrichment Manager. Create an Enrichment rule based on either an 
Enrichment TQL query from within the Enrichment Manager, or on an 
existing query. An Enrichment rule enables you to either enlarge the CMDB, 
delete CI instances from the CMDB, or update the attributes of a CI that 
already exists in the CMDB. For details, see “Enrichment Manager” on 
page 239.

➤ Query Manager. Create TQL queries that can be used in other managers. For 
details, see “Query Manager” on page 225.
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➤ Report Manager. Create a report definition based on either a Report TQL 
query from within the Report Manager, or on an existing query. You can 
define exactly which information appears in each report, including the 
order in which nodes are listed and their placement relative to other nodes, 
and how the information within each Report is sorted. For details, see 
“Report Manager” on page 191.

➤ View Manager. Create a pattern view either based on a TQL query from 
within the View Manager, or on an existing query. For details, see “View 
Manager” on page 123. 

Viewing TQL Query Results

You view the resulting data in a visual representation in the Topology View 
application. The queries define the structure of the resulting topology view. 
The view displays only those CIs and relationships that meet the query 
definition. For more details about Topology View application, see “Topology 
View Application” on page 511.

The Join Relationship

A join relationship is a logical connection, which appears only in the 
topology view containing the TQL query results, and represents the 
relationship between two CIs. It does not exist in the CMDB. A join 
relationship is created by defining an attribute for each node, whose values 
are used for comparison.

The TQL results retrieve all CIs whose attribute values meet the conditions 
defined in the join definition.

For example, you can create a join definition that links all Host CIs 
connected to IP CIs whose Created by attribute values are equal (see the 
example below).
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Each join definition represents one condition defined for the join 
relationship.

Note: You can define multiple conditions.

For an example of a join definition, see “Sample Join Relationship” on 
page 305. For details on working with joins, see “Add Join Relationship 
Dialog Box” on page 302.

Tasks

Define a TQL Query

This task describes how to create a TQL query.

 1 Create a TQL Query
Create a new query by giving the query a unique name in the relevant 
manager. For details about in which managers you can create a TQL query, 
see “Where TQL Queries Are Created” on page 265. In this task, you create a 
TQL query in the Query Manager. For details, see “Create New TQL/TQL 
Properties Dialog Box” on page 228. 

 2 Add Nodes and Relationships to the Query
Add the TQL nodes and relationships that define the query. The TQL nodes 
represent the CITs, as defined in the CI Type Manager, and the relationships 
represent the connections between them. Relationships are defined one at a 
time for each pair of TQL nodes in the query. For details, see “Add Nodes 
and Relationships to a TQL Query” on page 268. For details on the CI Type 
Manager, see “CI Type Manager” in CI Attribute Customization.
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Example

The direction of the relationship indicates which node is dependent on the 
other. The following example displays two hosts, a Server Port, and a Client 
Port, which are linked to one another via a client/server connection. The 
TQL results must comply with the direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see “Troubleshooting and Limitations” on page 340.

Add Nodes and Relationships to a TQL Query

This section explains how to add nodes and relationships to a TQL query. It 
is relevant for View Manager, Query Manager, Correlation Manager, 
Enrichment Manager, and Report Manager.

Note: For TQL queries to be valid, they must comply with certain 
restrictions. For details, see “Troubleshooting and Limitations” on page 340.
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To add nodes and relationships to a TQL query:

 1 From the tree in the left pane, select the required query or click the New 
button to create a one.

 2 From the tree displayed in the CI Type Selector, click and drag one or more 
required TQL nodes on to the Editing pane. These are the TQL nodes that 
are included in the query.

 3 To add a relationship between two nodes:

➤ Select the required TQL nodes by holding down CTRL and clicking the 
TQL nodes, right-click and select Add Relationship.

or

➤ Click the Create Relationship icon and draw a line between the required 
nodes.

The Add Relationship dialog box opens. For details, see “Add/Edit 
Relationship Dialog Box” on page 306.

 4 Click OK. The selected nodes are linked by the relationship you have 
selected.

Add Enrichment Nodes and Relationships to an 
Enrichment TQL Query

This section describes how to add Enrichment nodes and relationships to an 
Enrichment TQL query in the Enrichment Manager. For more information 
on Enrichment Manager, see “Enrichment Manager” on page 239.

To add Enrichment nodes and relationships to a TQL query:

 1 From the tree in the Enrichment Rules pane, select the Enrichment rule to 
which you want to add Enrichment nodes and relationships or create a new 
one. For details, see “Create New Enrichment Rule/Properties Dialog Box” 
on page 246.
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 2 From the TQL/Enrichment list at the top of the Enrichment Manager 
window, select Enrichment mode.

 3 From the tree displayed in the CI Type Selector, click and drag the nodes 
you want to function as an Enrichment node on to the Editing pane. These 
are the TQL nodes that are included in the query. Added Enrichment nodes 
are displayed by an added indicator.

Note: You can add more than one Enrichment node to a rule.

 4 The next step is to link the Enrichment node to an existing TQL node or 
nodes, to provide the Enrichment node with the needed context for its 
operation.

Following are the Enrichment rule validations:

➤ You must link the new Enrichment node to at least one of the existing 
TQL nodes in the rule.

➤ Enrichment nodes can only be linked to one another with an 
Enrichment relationship.

➤ If the new Enrichment node must be contained (according to its CIT 
definition) in another node, you must use the Container link relationship 
to connect this Enrichment node to an existing TQL node.

➤ You cannot link an Enrichment node to a TQL node that is not visible.

 5 To add a relationship between two nodes:

➤ Select the required nodes by holding down CTRL and clicking the TQL 
nodes, right-click and select Add Relationship.

or

➤ Click the Create Relationship icon and draw a line between the required 
nodes.
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Added Enrichment relationships are displayed by an added indicator. 

The Add Relationship dialog box opens. For details, see “Add/Edit 
Relationship Dialog Box” on page 306.

 6 Click OK. The selected nodes are linked by the relationship you have 
selected.

Reference

Context Menu Options

This section includes a list of TQL context menu options (listed 
alphabetically):

GUI Element (A–Z) Description

Add Compound 
Relationship

Enables you to define the connection between two nodes 
using a compound relationship. 

For details, see “Add Compound Relationship Dialog 
Box” on page 296.

Add Join Relationship Enables you to define join relationships, which is created 
by defining an attribute for each node, whose values are 
used for comparison. 

For details, see “Add Join Relationship Dialog Box” on 
page 302.

Add Relationship Enables you to create a relationship for your nodes by 
selecting it from a predefined list. Displays the Add 
Relationship dialog box.

For details, see “Add/Edit Relationship Dialog Box” on 
page 306.

Note: In Enrichment Manager, this option adds an 
Enrichment relationship to the rule when working in 
Enrichment mode. Applicable for regular and Enrichment 
nodes. For details, see “Enrichment Manager” on 
page 239. Added relationships are displayed by an added 

 indicator.
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Add Rule Enables you to add folding rules to a relationship. Right-
click the relationship for which you want to define a 
folding rule. Select one of the following options to define 
the organizational structure between the two CI types 
connected by the selected relationship:

➤ Parent. Select this option to display Node1 as the 
parent of Node2. That is, double-clicking the Node1 
element on one map level displays a new map level 
with Node2 elements.

➤ Right Sibling. Select this option to display Node1 
elements wherever Node2 elements are displayed. That 
is, both CIs are displayed on the same map level.

➤ Left Sibling. Select this option to display Node2 
elements wherever Node1 elements are displayed. That 
is, both CIs are displayed on the same map level.

➤ Child. Select this option to display Node1 as the child 
of Node2. That is, double-clicking a Node2 element on 
one map level displays a new map level with Node1 
elements.

➤ None. Do not define any folding rules for this 
relationship.

Note: Only relevant for View Manager.

Add to Applications Click to create an application CI and link it to all CIs of 
the type selected. For details, see “Link Nodes to 
Application CI” on page 134.

Note: Only relevant for View Manager.

Clear Available by right-clicking a node or relationship when 
working in Enrichment mode in the Enrichment 
Manager. Clears the node/relationship’s Enrichment rule 
definition. For details, see “Enrichment Manager” on 
page 239.

Appears only if you have updated or deleted a 
node/relationship using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

GUI Element (A–Z) Description
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Clear Node 
Definition

Deletes the report definition for the selected Report node. 
For details, see “Report Manager” on page 191.

Note: Only relevant for Report Manager.

Configure Subgraph Displays the Configure Subgraph dialog box, where you 
can create a graph that represents additional TQL query 
data related to a specific node. For details, see “Configure 
Subgraph Dialog Box” on page 308.

Copy/Paste Copy/paste an existing TQL node/relationship in the 
same query or into another TQL query.

The copied TQL node/relationship includes all TQL 
definitions.

You can copy and paste relationships provided that the 
TQL nodes to which the relationships are connected are 
also selected. A relationship on its own cannot be copied 
without its connecting TQL nodes.

You can select multiple TQL nodes/relationships as well.

Note: This option is available only after using the Copy 
option to copy an existing TQL node/relationship.

Define Affected Define which node in the TQL query is the trigger 
Correlation node and which nodes are affected by the 
changes that occur in the system. For details, see 
“Affected Nodes Dialog Box” on page 176.

Note: Only relevant for Correlation Manager.

Delete Deletes the selected node/relationship/CI.

Delete 
Relationship/Node

Available by right-clicking a node or relationship when 
working in Enrichment mode.

Creates a specific Enrichment rule that is designed to 
delete CIs/relationships from the CMDB. Applicable to 
regular nodes and relationships only. You can use this 
option, for example, for removing unnecessary data from 
the CMDB. For details, see “Enrichment Manager” on 
page 239.

Deleted nodes are displayed by a removed  indicator.

Note: Only relevant for Enrichment Manager.

GUI Element (A–Z) Description
273



Chapter 9 • Topology Query Language
Edit Relationship 
Type

Displays the Edit Relationship Type dialog box. For 
details, see “Add/Edit Relationship Dialog Box” on 
page 306.

Note: This option appears only when the selected 
relationship has descendants.

Node Order Displays the Set Node Order dialog box, enabling you to 
determine the order in which Report node information is 
displayed in the report, that is, the order of the report’s 
columns. For details, see “Set Node Order Dialog Box” on 
page 222.

Note: Only relevant for Report Manager.

Node/Relationship 
Properties

Displays the Node/Relationship Properties dialog box, 
enabling you to define the attribute conditions for the 
selected TQL node/relationship. For details, see 
“Node/Relationship Properties Dialog Box” on page 316.

Node/Relationship 
Definition

Displays the Grouping dialog box which enables you to 
group CIs in the topology map. For details, see “Grouping 
Dialog Box” on page 148.

Note: Only relevant for View Manager.

Refine Node Type Displays the Refine Node Type dialog box. Enables you to 
change the CI type of the node after you have created it. 
For details, see “Refine Node Type Dialog Box” on 
page 328.

Note: This option only appears if a child of the CI type 
exists.

Remove from 
Applications

Click to remove a business service item from a business 
service view. For details, see “Link Nodes to Application 
CI” on page 134.

Note: Only relevant for View Manager.

Remove Subgraph Only appears if you have defined a dependency graph. 
For details, see “Configure Subgraph Dialog Box” on 
page 308.

GUI Element (A–Z) Description
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Report Node 
Definition

Displays the Report Node Definition dialog box, enabling 
you to determine the content of the report. For details, 
see “Report Node Definition Dialog Box” on page 220.

Note: Only relevant for Report Manager.

Reset Affected Removes the Define Affected definition applied to that 
node. For details on the Define Affected definition, see 
“Affected Nodes Dialog Box” on page 176.

Note: Only relevant for Correlation Manager.

Reset Inner 
Relationship

Redraws a self-referential relationship in the Topology 
map as a square for ease of viewing.

Note: Only relevant for self-referential relationships 
which are not square.

Set View Element 
Parameters

Appears only when a parameterized condition is defined 
for the selected CI. 

Displays the Set View Element Parameters dialog box 
where you can edit the parameter of each condition. For 
details, see “Set View Parameters/Set View Element 
Parameters Dialog Box” on page 155.

Note: Only relevant for View Manager and System 
Report.

Show Element’s 
instances

Displays the Element Instances dialog box which displays 
all the instances found for each node in a table. For 
details, see “Element Instances Dialog Box” on page 310.

Straighten Straightens the relationship between two nodes. This 
option is only available for relationships that have angles.

TQL Node Wizard Displays the TQL Node Wizard dialog box which enables 
you to build a TQL query. For details, see “TQL Node 
Wizard” on page 331.

GUI Element (A–Z) Description
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Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions 
in various dialog boxes, such as the Subgraph Condition dialog box, the Add 
Relationship dialog box, Correlation Definition dialog box, or the 
Node/Relationship Properties dialog box.

Update 
Relationship/Node

Use an Enrichment rule to update the value of CI 
attributes in the CMDB, or to add data to attributes that 
currently do not have values. Opens the Node Definition 
- Attributes dialog box. For details, see 
“Node/Relationship Definition Dialog Box” on page 257. 
This is applicable for both regular and Enrichment nodes. 

Updated nodes are displayed by an updated  indicator.

Note: Only relevant for Enrichment Manager.

Operator Description

Changed during (Displayed only when you select the Create Time 
attribute.) Displays only the instances that changed 
during the period specified in the Value comparison 
box.

Equal Checks whether the attribute value is equal to the 
value specified in the Value Comparison box.

Equal ignore case Checks whether the attribute value is equal to the 
value specified in the value box regardless of the 
case.

Great than or equal Checks whether the attribute value is greater than 
or equal to the value specified in the Value 
comparison box.

Greater Checks whether the attribute value is greater than 
the value specified in the Value comparison box.

GUI Element (A–Z) Description
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In Displays only the instances where this attribute 
value equals one of the selected values. For 
example, for CIs that have a Change state that 
equals Plan and New, select the operator In from the 
Operator list and select both Plan and New from 
the Value box.

In list Equals one of the elements that appears in the list. 
For example: 320,4445,3483.

Is null Checks whether the attribute value is null.

Less Checks whether the attribute value is less than the 
value specified in the Value comparison box.

Less than or equal Checks whether the attribute value is less than or 
equal to the value specified in the Value comparison 
box.

Like Uses a wildcard (%). Use Like when you are not sure 
of the complete name for which you are searching.

Like ignore case Uses a wildcard (%). Use Like ignore case when you 
are not sure of the complete name for which you 
are searching. The case of the string is ignored.

Not equal Checks whether the attribute value is not equal to 
the value specified in the Value Comparison box.

Unchanged during (Displayed when you select a date type attribute.) 
Displays only the instances that did not change 
during the period specified in the Value comparison 
box.

Operator Description
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Note: 

➤ For Not equal or Not like operators, query results do not include data 
from the CI instances that are not assigned a value. For example, a 
system contains three hosts: Host1 is assigned the value A, Host2 is 
assigned the value B, and Host3 is not assigned a value. If you create a 
query to retrieve all hosts that are Not equal to A, the results of your 
query include Host2 only, because Host3 is not assigned a value.

➤ HP Business Availability Center supports both Microsoft SQL Server and 
Oracle Server servers. Microsoft SQL Server is not case sensitive by default 
(unlike Oracle Server which is case sensitive). Consequently, if you are 
using Microsoft SQL Server, the Equal operator retrieves the same query 
results as the Equal ignore case operator. For example, if you select the 
attribute City, the operator Equal, and type NEW YORK in the Value 
comparison box, case differences are ignored and query results include 
NEW YORK, New York and new york. 

TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

➤ “Pattern Log” on page 245

➤ “Pattern Statistics Log” on page 246

➤ “Audit Short/Detailed Log (TQL Perspective)” on page 247

➤ “Incremental Statistics Log” on page 247

➤ “Incremental Splitter Log” on page 248

➤ “Incremental Detailed Log” on page 249
278



Chapter 9 • Topology Query Language
Pattern Log
The log name is cmdb.pattern.log.

Log File Description

Purpose Information about the lifecycle of a TQL query that is handled 
and calculated in the CMDB. 

Only TQLs stored in the CMDB are included. Information 
about ad hoc TQLs is not included.

Information 
Level

Not available.

Error Level Not available.

Debug Level Possible actions performed on each TQL query include:

➤ status changes

➤ model changes

➤ query changes

➤ completed calculations

Basic 
Troubleshooting

Check if a TQL query has the same status for a long time:

➤ new – the query is in lazy loading

➤ inactive 

➤ calculation – the calculation may have failed but the 
scheduler was not informed

You can also view the number of notifications that a TQL 
received.
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Pattern Statistics Log
The log name is cmdb.pattern.statistics.log.

Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Log File Description

Purpose General calculation data for each TQL, updated at predefined 
intervals.

Information 
Level

The following information is given for each TQL:

➤ name

➤ average, minimum, and maximum calculation times

➤ number of calculations

➤ last calculation time

➤ result size

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

➤ Verify that a specific TQL was updated.

➤ Evaluate a TQL’s calculation time.

➤ Evaluate a TQL’s result size. 

Log File Description

Purpose CMDB state changes, CI Type changes, and TQL results.

You can use this log to follow the results of TQL queries.

Information 
Level

Not available.

Error Level Not available.
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Incremental Statistics Log
The log name is cmdb.incremental.statistics.log. 

Debug Level ➤ Final calculation for TQLs is logged.

➤ If the final TQL calculation is unchanged from the previous 
calculation, this is noted.

➤ If the final TQL calculation is changed from the previous 
calculation, results of the CIs and relationships are recorded 
in the detailed log. The number of CIs and relationships are 
recorded in the short log.

Basic 
Troubleshooting

➤ Use this log to verify which notifications are published by 
the TQL subsystem.

➤ Check the section at the end of each result. This section 
includes added, removed, and updated CIs and 
relationships.

➤ Track the CIT changes and see if the query results also 
change. You can thus correlate the CIT changes to the 
results of the query calculations.

Log File Description

Purpose Traces the calculation procedure, full or incremental, of every 
query.

Information 
Level

Not available.

Error Level Not available.

Log File Description
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Incremental Splitter Log
The log name is cmdb.incremental.splitter.log.

Debug Level ➤ Gives the date, time, query name, and whether an 
incremental statistic calculation was performed (yes/no). 

➤ If an incremental statistic calculation was not performed, 
states the reason, the number of subcalculations (relevant 
for incremental calculations only), and the complete 
calculation time.

Basic 
Troubleshooting

Monitors the calculation process.

If a specific query calculation takes a long time, check if it is a 
full or incremental calculation:

➤ If full, check whether a full calculation is necessary.

➤ If incremental, check how many subcalculations have been 
performed.

Log File Description

Purpose Monitors the incremental splitter result made during an 
incremental calculation.

Information 
Level

Not available.

Error Level Not available.

Debug Level Gives the set of node numbers of each query graph created by 
the incremental splitter.

Basic 
Troubleshooting

If the TQL result calculated by the incremental calculator is 
wrong, verify that the splitter result is correct.

Log File Description
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Incremental Detailed Log
The log name is cmdb.incremental.detailed.log.

TQL Parameters

This section describes the TQL parameters needed for configuring the 
CMDB. 

 

Log File Description

Purpose Monitors the incremental calculation process. 

Information 
Level

Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

➤ the trigger node 

➤ the number of elements classified to the trigger node 

➤ whether the subcalculation step is driven by new elements 
added to the model or by existing elements

➤ the calculated query graph

Basic 
Troubleshooting

Follows the basic steps of an incremental calculation.

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

tql.threads.pool.size Defines the number 
of threads to limit 
concurrent 
calculation of TQLs. 
This is done to 
prevent high CPU 
consumption.

integer N
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tql.scheduler.timer.t
ime

Defines the interval 
of time to wait 
between wake up 
calls to the TQL 
State Machine 
manager.

long Value is in 
milliseconds. 

N

tql.scheduler.statisti
cs.logupdate.interva
l.time.millisec

The interval 
between updates of 
cmdb.pattern.statistic
s.log.

long Value is in 
milliseconds.

N

tql.resultrepository.
timer.time

The length of time 
the ad hoc TQL 
results reside in 
memory before the 
results are purged 
from memory.

long Value is in 
milliseconds.

N

tql.resultutils.patter
ntakeover.timeout

10000

tql.resultutils.adhoc
.validate

Defines whether to 
perform pattern 
validation of ad hoc 
TQLs.

boolean ➤ true. Perform 
pattern 
validation.

➤ false. Do not 
perform 
pattern 
validation.

N

tql.resultutils.chunk
.maxresultsize

The maximum 
number of CIs and 
relationships in a 
TQL result that can 
be retrieved together 
without dividing 
them into chunks 
for separate 
retrievals.

integer 100000 N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.resultutils.chunk
.maxnotificationsiz
e

The maximum 
number of CIs and 
relationships in a 
TQL result that can 
be sent to external 
clients, the 
applications that get 
notification service 
from CMDB. If this 
number is exceeded, 
a message is sent.

integer 50000 N

tql.resultutils.chunk
.keepingperiod.seco
nds

The length of time 
that a chunk of TQL 
results is resident in 
memory until the 
next chunk is 
received in memory.

integer Value is in 
seconds.

N

tql.conditionstatisti
cs.refresh.seconds

The time interval in 
which the total 
number of objects of 
each type in the 
CMDB is updated.

integer Value is in 
seconds.

N

tql.statemachine.fai
l.retries

Number of times to 
recalculate a TQL 
before the status is 
set to Fail.

integer N

tql.statemachine.fai
l.recover.time

Time interval to 
wait between a 
pattern calculation 
failure and the next 
attempt to 
recalculate. 

integer Value is in 
seconds.

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.scheduler.statisti
cs.maxcalculation

The maximum 
number of a TQL’s 
recent calculations 
stored in the 
Scheduler statistics.

integer N

tql.group.all.active.
count

Maximum number 
of active TQLs 
permitted per 
customer in the 
appropriate group: 
all, collectors, view, 
topology, report, 
server data, path 
manager, and 
internal 
enrichment.

The name of the 
group is found in 
the name of the 
parameter after 
tql.group.

integer N

tql.group.collectors.
active.count

tql.group.view.activ
e.count

tql.group.topology.
active.count

tql.group.report.acti
ve.count

tql.group.serverdata
.active.count

tql.group.pathmana
ger.active.count

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.group.all.result.s
ize

The maximum 
number of CIs held 
in a TQL result 
before the TQL is 
deactivated.

integer Values are 
assigned 
according to TQL 
group: all, 
collectors, view, 
topology, report, 
server data, path 
manager, and 
internal 
enrichment.

N

tql.group.collectors.
result.size

tql.group.view.resul
t.size

tql.group.topology.r
esult.size

tql.group.report.res
ult.size

tql.group.serverdata
.result.size

tql.group.pathmana
ger.result.size

EXPRESS_PRIORITY
.Min.CalculationTi
meInterval

Minimum length of 
time to wait until a 
full calculation is 
performed for some 
TQL query. 

The results are 
updated after 
calculation. 

long ➤ Value is in 
milliseconds.

➤ Value is 
defined for 
each TQL 
priority. 

N

HIGH_PRIORITY.Mi
n.CalculationTimeI
nterval

MED_PRIORITY.Mi
n.CalculationTimeI
nterval

LOW_PRIORITY.Mi
n.CalculationTimeI
nterval

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY
.Max.CalculationTi
meInterval

Maximum length of 
time to wait until a 
full calculation is 
performed for a TQL 
query. 

The results are 
updated after 
calculation. 

long ➤ Value is in 
milliseconds.

➤ Value is 
defined for 
each TQL 
priority.

N

HIGH_PRIORITY.M
ax.CalculationTimeI
nterval

MED_PRIORITY.Ma
x.CalculationTimeI
nterval

LOW_PRIORITY.Ma
x.CalculationTimeI
nterval

EXPRESS_PRIORITY
.Min.EventArrivalTi
meInterval

The minimum 
length of time to 
wait after the last 
event arrives before 
starting a full 
calculation. A full 
calculation is not 
started if the elapsed 
time from the last 
event is less than 
this value.

long ➤ Value is in 
milliseconds.

➤ Value is 
defined for 
each TQL 
priority.

N

HIGH_PRIORITY.Mi
n.EventArrivalTimeI
nterval

MED_PRIORITY.Mi
n.EventArrivalTimeI
nterval

LOW_PRIORITY.Mi
n.EventArrivalTimeI
nterval

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY
.Max.EventArrivalTi
meInterval

The maximum 
length of time to 
wait after the last 
event arrives before 
starting a full 
calculation. A full 
calculation is started 
if this value is 
reached.

long ➤ Value is in 
milliseconds.

➤ Value is 
defined for 
each TQL 
priority.

N

HIGH_PRIORITY.M
ax.EventArrivalTim
eInterval

MED_PRIORITY.Ma
x.EventArrivalTimeI
nterval

LOW_PRIORITY.Ma
x.EventArrivalTimeI
nterval

EXPRESS_PRIORITY
.Max.EventArrivalTi
meIntervalForImme
diate

The maximum 
length of time to 
wait after the last 
event arrives before 
starting an 
immediate 
calculation. An 
immediate 
calculation is started 
no later than this 
value.

long ➤ Value is in 
milliseconds.

➤ Value is 
defined for 
each TQL 
priority.

N

HIGH_PRIORITY.M
ax.EventArrivalTim
eIntervalForImmedi
ate

MED_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

LOW_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY
.Min.PendingEvents
Amount

Minimum number 
of events to 
accumulate to start 
a full calculation. A 
full calculation is 
not started if the 
number of pending 
events for some TQL 
is less than this 
value. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Mi
n.PendingEventsAm
ount

MED_PRIORITY.Mi
n.PendingEventsAm
ount

LOW_PRIORITY.Mi
n.PendingEventsAm
ount

EXPRESS_PRIORITY
.Max.PendingEvent
sAmount

Maximum number 
of events to 
accumulate to start 
a full calculation. 

A full calculation 
starts when the 
number of pending 
events for a TQL 
equals, or is greater 
than, the value 
defined in this 
parameter. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.M
ax.PendingEventsA
mount

MED_PRIORITY.Ma
x.PendingEventsAm
ount

LOW_PRIORITY.Ma
x.PendingEventsAm
ount

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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Topology Query Language User Interface

This section describes:

 ➤  Add Compound Relationship Dependency Dialog Box on page 292

 ➤  Add Dependency Dialog Box on page 295

 ➤  Add Compound Relationship Dialog Box on page 296

 ➤  Add Join Relationship Dialog Box on page 302

 ➤  Add/Edit Relationship Dialog Box on page 306

 ➤  Configure Subgraph Dialog Box on page 308

 ➤  Element Instances Dialog Box on page 310

 ➤  Filter CI Instances Dialog Box on page 313

 ➤  Join Relationship Condition Dialog Box on page 314

 ➤  Layout Settings Dialog Box on page 315

 ➤  Node/Relationship Properties Dialog Box on page 316

EXPRESS_PRIORITY
.Max.PendingEvent
sAmountForImmedi
ate

Maximum number 
of events to 
accumulate to start 
an immediate 
calculation. 

An immediate 
calculation starts 
when the number of 
pending events for a 
TQL equals, or is 
greater than, the 
value defined in this 
parameter. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.M
ax.PendingEventsA
mountForImmediat
e

MED_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

LOW_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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 ➤  Refine Node Type Dialog Box on page 328

 ➤  Subgraph Condition Definition Dialog Box on page 329

 ➤  TQL Node Wizard on page 331

 ➤  User Preferences Dialog Box on page 339

Add Compound Relationship Dependency Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a compound relationship 
definition.

To access: In the Add Compound Relationship dialog 
box, click the Add  button.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Relationship Select an available relationship connecting the two 
nodes. The list of available relationships appears only 
after defining both nodes. 

Relationship 
Direction

Select the required direction. Setting different 
relationship directions can achieve different query 
results. For an example, see “Setting Different 
Relationship Directions for Compound Definitions” on 
page 293 below.

Note: The Relationship list remains empty until you have 
selected a source and target.
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Setting Different Relationship Directions for Compound 
Definitions

You can achieve different TQL results by setting different relationship 
directions. For example, in your business world, as illustrated below, you 
want to create a compound relationship that connects between a node of 
the CIT a and a node of the CIT b. Depth is defined at 5 (for details, see 
“Depth” on page 309). 

Source Select the required source node.

Target Select the required target node.

GUI Element (A-Z) Description
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In the Add Compound Relationship Dependency dialog box, you can create 
compound definitions to link nodes a and b using different relationship 
directions.

➤ Compound definitions 1 and 2 result in the following query:

➤ Compound definitions 1 and 3 result in the following query:

➤ Compound definitions 1, 2, and 3 result in the following query:

Compound 
Definition

Source Target Relationship Relationship 
Direction

#1 node a node c <relationship> source --> target

#2 node c node b <relationship> source --> target

#3 node c node b <relationship> source <-- target
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Add Dependency Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a dependency graph definition. 
Select the nodes and relationships to be included in the 
dependency graph.

To access: In the Configure Subgraph dialog box, click 
 Add. 

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Define attribute conditions for the source and target 
nodes you selected. Opens the Subgraph Condition 
Definition dialog box.

Note: The Condition button is enabled only after you 
select a node from the Source or Target lists.

Relationship Select an available relationship connecting the source 
and target nodes. The list of available relationships 
appears only after defining both the required source and 
target nodes.

Source Select the desired source node.

Target Select the required target node.
295



Chapter 9 • Topology Query Language
Add Compound Relationship Dialog Box

Description Enables you to define the connection between two nodes 
using a compound relationship. A compound 
relationship represents a path in the topological graph. 
You use a compound relationship to define the allowed 
steps in the path between the source and the target CIs.

Each row represents one of the allowed steps in the path 
leading from the source CI to the target CI in the 
topology map.

Note: For an example of a compound definition, see 
“Sample Compound Relationship” on page 299.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:

Right-click the required node in the Editing pane in 
Report Manager, Enrichment Manager, Correlation 
Manager, Query Manager, View Manager and select Add 
Compound Relationship.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Add 
Relationship option.

To access in Manage Discovery Resources in Discovery 
and Dependency Mapping (DDM):
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Add 
Compound Relationship.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Important 
Information

You can create as many compound definitions as 
necessary.

GUI Element (A-Z) Description

Add a compound definition. Opens the Add Compound 
Relationship Dependency dialog box. 

Delete the selected compound definition.

Edit the selected compound definition. Opens the Add 
Compound Relationship Dependency dialog box.

Max steps The longest path allowed between the two CIs in the 
CMDB to be included in the DDM process.

Default is: 5

Min steps The shortest path allowed between the two CIs in the 
CMDB to be included in the DDM process.

Default is: 1

Relationship The relationship connecting the two nodes. 

Relationship 
Direction

The direction of the relationship that indicates which 
node is dependent on the other.
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Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical nodes or self relationships in the query 
results. A self relationship is a relationship that leads from 
a node to itself.

Note: This list appears only when you select one node or 
two identical nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.

Source The required source node.

Stop at first 
compound level

Select this option if you want the system to stop looking 
for TQL results once it reaches the first target in the path. 

In the following sample compound link definition, Depth 
is defined as 10 and Stop at first compound level is 
selected.

The TQL results include the Target 1, Target 3, and 
Target 4 because they are all at level 1 (the first CI found 
in the path). Target 2 is not included in the TQL results 
because it is at level 2 (the second CI found in the path).

GUI Element (A-Z) Description
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Sample Compound Relationship

This section describes how to define the allowed steps that form a 
Compound relationship between a Network and an IP CI.

To define a compound relationship between a Network CI and an IP CI:

 1 Create a TQL query and drag the following nodes from the CI Type Selector 
onto the Editing pane:

➤ Network

➤ IP

 2 Right-click the Network and IP nodes and select Add Compound 
Relationship to open the Add Compound Relationship dialog box.

 3 Click the Add button to open the Add Compound Relationship Dependency 
dialog box and do the following:

➤ From the Source list, select Host.

➤ From the Target list, select IP.

➤ From the Relationship list, select Contained.

Target The required target node.

Visible Select Visible to include query results relating to a join or 
compound relationship. By default, Visible is selected. 
When Visible is cleared, an invisible box  appears to 
the left of the of the relationship’s name in the Editing 
pane. Any query results pertaining to the relationship are 
not displayed in the topology map.

GUI Element (A-Z) Description
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➤ Select the required Relationship direction.

 4 Click OK to save your changes.

 5 Click the Add button to open the Add Compound Relationship Dependency 
dialog box and do the following.

➤ From the Source list, select Network.

➤ From the Target list, select Host.

➤ From the Relationship list, select Member.

➤ Select the required Relationship direction.

 6 Click OK to save your changes.

The definitions in the Compound Relationship dialog box now look like 
this.

 7 Click OK to save your changes.

The TQL query in the Editing pane now looks like this:
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Go to the required view in IT Universe to view the results.

You can double-click the Virtual - Compound relationship in IT Universe to 
open the Link Map, which displays the CIs and relationships that comprise 
the allowed steps used to link the Network and IP CIs.

In this example, the 16.59.42.0 (Network) CI is linked to the 16.59.42.241 
(IP) CI through the Otubman2-il (Host) CI.
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Add Join Relationship Dialog Box

Description Enables you to define join relationships. 

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:

Right-click the required nodes in the Editing pane in 
Report Manager, Enrichment Manager, Correlation 
Manager, Query Manager, View Manager and select Add 
Join Relationship.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Add 
Relationship option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Add Join 
Relationship.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Useful Links “The Join Relationship” on page 266
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Define a join definition. Opens the Join Relationship 
Condition dialog box.

Delete the selected join definition.

Edit the join definition. Opens the Join Relationship 
Condition dialog box.

<Selected node1> A selected node. The first attribute applies to <end_1>. 

<Selected node2> A selected node. The second attribute applies to <end_2>.

And All join definitions are linked by the And operator.

Operator The operator selected in the Join Relationship Condition 
dialog box. For details about operator definitions, see 
“Attribute Operator Definitions” on page 276.

Relationship 
Direction

The direction of the relationship that indicates which 
node is dependent on the other.
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Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical nodes or self relationships in the query 
results. A self relationship is a relationship that leads from 
a node to itself.

Note: This list appears only when you select one node or 
two identical nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships 
do not appear in the query results.

Visible Select Visible to include query results relating to a join or 
compound relationship. By default, Visible is selected. 
When Visible is cleared, an invisible box  appears to 
the left of the of the relationship’s name in the Editing 
pane. Any query results pertaining to the relationship are 
not displayed in the topology map.

GUI Element (A-Z) Description
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Sample Join Relationship

This section explains how to define a join relationship that links Host CIs to 
IP CIs whose Created by attribute values are equal.

To define a join relationship that links all IP and Host CIs whose Created by 
attribute values are equal:

 1 Create a TQL query and drag the following nodes from the CI Type Selector 
onto the Editing pane:

➤ Host

➤ IP

 2 Select the Host and IP nodes and right-click to open the Add Join 
Relationship dialog box.

 3 Click the Add button to open the Join Relationship Condition dialog box 
and do the following:

➤ In the Host Attribute box, select Created by.

➤ In the Operator box, select Equal.

➤ In the IP Attribute box, select Created by.

 4 Click OK to save your changes.

The Join Definition area now looks like this.

 5 Click OK to save your changes.

The TQL query in the Editing pane now looks like this:
305



Chapter 9 • Topology Query Language
Go to the required view in IT Universe to view the results. Double-click the 
Virtual - Join relationship in IT Universe to open the Link Map (as seen 
below), which displays all the Host CIs that are connected to an IP CI whose 
Created by attribute values are equal.

Add/Edit Relationship Dialog Box

Description Enables you to define the connection between two nodes 
in a query.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
➤ Right-click the required node in the Editing pane in 

Report Manager, Enrichment Manager, Correlation 
Manager, Query Manager, View Manager and select 
Add Relationship.

or

➤ Click the Create Relationship  icon and draw a line 
between the required nodes.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Add 
Relationship option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane.

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Add 
Relationship.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Important 
Information

This option does not appear when two selected nodes (or 
a single selected node) do not have a valid relationship 
between them.

GUI Element (A-Z) Description

<List of relationships 
from which to 
choose>

Select the relationship that defines the connection 
between two nodes.

Relationship 
Direction

The direction of the relationship that indicates which 
node is dependent on the other.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical nodes or self relationships in the query 
results. A self relationship is a relationship that leads from 
a node to itself.

Note: This list appears only when you select one node or 
two identical nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.
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Configure Subgraph Dialog Box

Description Enables you to create a graph that represents additional 
TQL query data related to a specific CI. The DDM job 
searches for the results from both the TQL query and the 
dependency graph definitions. The query recursively 
retrieves all the related CIs by a defined depth.

In the graph, you can define the relationship that is 
connected to a specific node. For example, if one of the 
nodes is a host, you can specify different relationships for 
Windows, router, and IP. You can also define attribute 
conditions for nodes. For details, see “Subgraph 
Condition Definition Dialog Box” on page 329.

The DDM job retrieves data that meets the criteria that is 
defined in the dependency graph.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
In the Editing pane, right-click the required node and 
select Configure Subgraph.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the 
Configure Subgraph option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Configure 
Subgraph.

Important 
Information

The following icon is displayed next to the icon for 
which you define a subgraph:
308



Chapter 9 • Topology Query Language
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Add a dependency definition to the Dependencies area. 
Opens the Add Dependency dialog box.

Delete a dependency definition from the Dependencies 
area.

Edit a dependency definition. Opens the Add 
Dependency dialog box.

Depth A number that represents the longest path (that is, the 
most connecting nodes) allowed between two CIs in the 
CMDB that should be included in the DDM process.

Default: 5

Node1 The required node selected in the Add Dependency 
dialog box.

Node2 The required node selected in the Add Dependency 
dialog box.

Relationship The relationship selected in the Add Dependency dialog 
box connecting <node1> to <node2>.
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Element Instances Dialog Box

Description Display all of the CI instances found for the selected TQL 
node in a table.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
In the Editing pane, right-click the required node and 
select Show Element’s Instances.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Show 
Element’s Instances option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane.

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Show 
Element’s Instances.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The columns displayed in the report vary according to the 
CI type selected. 

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the 
CIT Manager are displayed as columns in the dialog box. 
For details, see “Attributes Page” in CI Attribute 
Customization. 

If required, you can click the Display Hidden Columns 
button to display the attributes that are defined as Visible 
but not Static. For details on Static attributes, see 
“Attributes Page” in CI Attribute Customization.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Filter the CI instances you want to display for the 
selected node. Opens the Filter CI Instances dialog box.

Clear the filter definitions you created in the Filter CI 
Instances dialog box.

Hide or display specific columns. Opens the Columns 
dialog box.

Update the table.

Determine the number of CI instances that appear on a 
page. Opens the Set Rows Per Page dialog box.
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Click to navigate through the results page by page or to 
jump to the first or last page.

Toggle between hiding and displaying columns.

<CI type attributes> The attributes of the CIT of the selected CI.

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

CI Type The CIT of the selected CI.

Display Label The name of the CI instance as it appears in the topology 
map.

GUI Element (A-Z) Description
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Filter CI Instances Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to reduce the number of CI instances to be 
displayed in a list by selecting a condition and a value for 
a specific CI.

A description of the filter condition you defined appears 
above the table columns in the Element Instances dialog 
box. For example, the following illustration shows that a 
filter condition was created to display only CI elements 
whose CI type is Windows.

To access: 

➤ Click the Filter  button in the Element Instances 
dialog box.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Condition Select the required operator. For details, see “Attribute 
Operator Definitions” on page 276.

Display Name The display name of the Configuration Item type to 
which the CI belongs.

Value Select or enter the required value.
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Join Relationship Condition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the connection between two nodes 
using a join relationship. The join definition appears in 
the Join Definition area.

To access: Click the Add  button in the Add Join 
Relationship dialog box.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” on page 297

GUI Element (A-Z) Description

<Selected node1> A selected node. The first attribute applies to <end_1>.

<Selected node2> A selected node. The second attribute applies to <end_2>.

Operator Select one of the following operators: 

➤ Equal. The system checks whether two selected 
attributes are equal.

➤ Not equal. The system checks whether two selected 
attributes are not equal.

➤ Sub string. The system checks whether the value of the 
first attribute is a substring of the value of the second 
attribute.

➤ Sub string ignore case. The system checks whether the 
value of the first attribute is a substring of the value of 
the second attribute regardless of the string’s case.

Important: When using the operator Not equal, ensure 
that both sides of the join relationship have a limited 
result size. It is recommended to define more specific 
conditions so as not to overload the system with large 
results.
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Layout Settings Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to determine which attributes are used in the 
calculation of the TQL query when using the UCMDB 
API. For details, see “Working with the HP Universal 
CMDB API” on page 101 in Solutions and Integrations.

To access: Click the Advanced layout settings link in the 
Node/Relationship Properties dialog box.

Important 
Information

➤ Since this option is only relevant when querying the 
CMDB API, the query results in the user interface is not 
impacted by the attributes you select in this dialog 
box.

➤ Once you have selected the required attributes and 
clicked OK, you cannot clear the selections you have 
made.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the 
query’s calculation.
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Node/Relationship Properties Dialog Box

Description Enables you to define the attribute conditions for the 
selected TQL node/relationship.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager: 
In the Editing pane, right-click the required node and 
select Node/Relationship Properties.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Node 
Properties option.

To access in Discovery:
1  To access from the Discovery Resources pane, select a 

pattern. In the Pattern Signature tab, click the  Edit 
Input TQL button to the right of the Input TQL box to 
open the Input TQL Editor. 

2  Right-click the required node/relationship and select 
Node/Relationship Properties.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.
316



Chapter 9 • Topology Query Language
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Advanced layout 
settings

Enables you to determine which attributes are used in the 
calculation of the TQL query when querying the CMDB 
using third-party or custom tools. 

Opens the Layout Settings dialog box.

Element name (Optional) The Element name box contains the name of 
the selected node/relationship. By default, the CIT type is 
assigned as the element’s name. You can rename a TQL 
node in the Element name box giving it a unique label. 
This can be helpful when there is more than one node of 
the same CIT type in the TQL query.

Include subtypes Display both the selected CI and its children in the 
topology map.

Visible Select Visible to display the selected TQL node in the 
Editing pane. When Visible is cleared, an invisible box  
appears to the right of the selected TQL node in the 
Editing pane.

Any query results pertaining to that TQL node are not 
displayed in the topology map. This can be useful when 
certain relationships or TQL nodes are required to build 
the query but are not needed in the results. For example, 
Windows are connected to the network by defining 
specific IPs, but in any query results you may want to 
view the IP elements only and not the Windows 
elements.
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This dialog box contains the following tabs:

➤ “Attribute Tab” on page 299

➤ “Cardinality Tab” on page 303.

➤ “Qualifier Tab” on page 307

➤ “Identity Tab” on page 310

Attribute Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create an expression defining conditions 
that restrict the number of nodes that appear in the 
query.

➤ Add an attribute condition to a node or relationship.

➤ Filter the query results.

To access: 

➤ Click the Attribute tab in the Node/Relationship 
Properties dialog box.

or

➤ Click Next in the New TQL Relationship Page in the 
TQL Node Wizard.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Add the attribute condition you have defined.

Delete an attribute definition.
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Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Fixed value Select one of the following options:

Fixed value. You cannot change the value of the 
parameter.

Parameterized value. Enables you to change the value of 
the parameter.

➤ When a parameterized value is selected in View 
Manager, an option called Set View Element 
Parameters is included in the right-click menu. For 
details on how to change the value when using the 
TQL, see “Layout Settings Dialog Box” on page 315.

Note: If you select this option, you can enter a value 
here that is saved in the view. If you do not enter a 
value here, you are forced to enter one before saving 
the view. 

➤ When a parameterized value is selected in Report 
Manager, a Set parameters values option is displayed 
at the top right of a generated System report, enabling 
you to edit the predefined parameters of node 
conditions in a System report. For details, see “System 
Report” on page 599.

GUI Element (A-Z) Description
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Cardinality Tab

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.

Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 276.

Update Update an attribute condition that has been modified.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

Description Define a relationship cardinality, which enables you to 
define how many CI instances you expect to have at the 
end of a relationship in your query result. 

Select the required relationship to which the selected 
node is attached. Then define the lower and upper limits 
for including the node at the other end of the 
relationship in the query results.

You can define relationship conditions that enable the 
relationship’s connecting node to be included in the TQL 
query results by creating an expression defining that 
condition. For an example, see “Example of a 
Relationship Condition” on page 323.

To access: Click the Cardinality tab in the 
Node/Relationship Properties dialog box.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

This tab appears only when a node is selected.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Add the cardinality definition you have defined.

Delete a cardinality definition from the Cardinality area.

Move a selected row up.

Move a selected row down.

View the cardinality condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Max Enter the value that defines the upper limits for including 
the node at the other end of the relationship in the query 
results. 

Note: You can use an asterisk (*) in the Max box to 
represent an infinite value.
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Min Enter the value that defines the lower limits for including 
the node at the other end of the relationship in the query 
results.

For example, if <end_1> is IP and <end_2> is Windows, 
entering 1 in the Min box and asterisk (*) in the Max box 
instructs the system to retrieve only those IPs that are 
connected to at least one Windows operating system. 
(The asterisk indicates an infinite value.) Entering 3 in 
the Min box and asterisk (*) in the Max box instructs the 
system to retrieve only those Windows operating systems 
that are connected to at least three IPs.

Node Select the required relationship to which the selected 
node is attached. The list contains all the relationships 
that are linked to the selected node.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.

Update Update a cardinality definition that has been modified.

GUI Element (A-Z) Description
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Example of a Relationship Condition

The example of relationship conditions is based on the following TQL 
query:

 

In the Relationship Cardinality dialog box, the following relationship 
conditions are defined for the TQL:

➤ Member – Min: 1, Max: *

➤ Contained – Min: 2, Max: 4

Using the OR operator, the definitions appear in the Cardinality section, as 
follows:

➤ [member (Network, Host)] OR [contained (Host, IP)] means that the host must 
either have between two and four IPs OR be a member of the network.

Using the AND operator, the definitions appear in the Cardinality section, as 
follows:

➤ [member (Network, Host)] AND [contained (Host, IP)] means that the host must 
have between two and four IPs AND also be a member of the network.
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Qualifier Tab

Description Enables you to define qualifier conditions for the selected 
node or relationship. For example, you can use a qualifier 
to define a CIT as abstract, meaning you cannot create 
instances from it.

To access: Click the Qualifier tab in the 
Node/Relationship Properties dialog box.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Qualifiers> Following are the qualifier definitions: 

➤ ABSTRACT_CLASS. You cannot create instances of this 
CIT.

➤ BLE_LINK_CLASS. A relationship that has been 
assigned this qualifier is loaded by an online BLE 
engine TQL and becomes part of the Dashboard status 
calculations.

➤ CONTAINER. This qualifier is assigned to relationships 
that signify a containment relationship, such as 
Member, Container link, Contains, or Contained.

➤ HIDDEN_CLASS. Instances of this CIT do not appear 
anywhere in the application.

➤ ITU_HIDDEN_CLASS. Instances of this CIT do not 
appear in the topology map application.

➤ MAJOR_APP. CI types that are assigned this qualifier 
appear in the Major Application Type Breakdown 
overview report. For details, see “Major Application 
Type Breakdown Report” on page 562.

➤ NETWORK_DEVICES. A qualifier common to all the CI 
types that represent a network device. It can be used 
for TQL queries related to network devices and serves 
as a replacement for CI types in a query.

➤ ProtocolDialog. For internal use only.

➤ READ_ONLY_CLASS. This CIT cannot be edited.

➤ TRACK_LINK_CHANGES. Changes that occur on the 
specified relationship appear in Change reports. For 
details, see “Change Report” on page 573.

Important: Multiple selection links the conditions with 
the Or operator.

Negate Qualifiers Multiple selection links the conditions with the AND 
operator.
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Identity Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to filter the TQL results according to the 
element ID of the instances found for the selected TQL 
node. 

Move the required element from the TQL node instances 
pane on the left to the to the Filtered TQL results pane on 
the right to define what you want included in the TQL 
results using the double right arrows.

To access: Click the Element ID tab in the Node Properties 
dialog box.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Filter the CI instances you want to display for the selected 
node. Opens the Filter CI Instances dialog box.

Clear the filter definitions you created in the Filter CI 
Instances dialog box.

Hide or display specific columns. Opens the Select 
Columns dialog box.

Update the table.

Determine the number of CI instances that appear on a 
page. Opens the Set Rows Per Page dialog box.

Click to navigate through the results page by page or to 
jump to the first or last page.
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<Left Pane>

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

ID Condition Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

<Left pane> Displays all the instances found for the selected TQL 
node. For details, see “<Left Pane>” on page 327.

ID Condition pane Displays the elements that are used to define what should 
be included in the TQL results. For details, see “ID 
Condition Pane” on page 327.

Description Displays all the instances found for the selected TQL 
node in a table.

To access: Click the Element tab in the Node Properties 
dialog box.

GUI Element (A-Z) Description

CI Type The CI type.

Display label The label that is displayed for the node’s instance.

Description Displays the elements that are used to define what should 
be included in the TQL results.

To access: Click the Element tab in the 
Node/Relationship dialog box.

GUI Element (A-Z) Description

CI Type The CI type.

Display label The label that is displayed for the node’s instance.

GUI Element (A-Z) Description
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Refine Node Type Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to change the CI type of the TQL node after 
you have created a TQL query.

To access: Right-click the required node and select Refine 
Node Type.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Refine 
Node Type option.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Important 
Information

You can change the CI type to a type from one of the CI 
type’s children, if one exists. If one does not exist, this 
option does not appear.

GUI Element (A-Z) Description

List of CI types from 
which to choose

Select the required CI type.
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Subgraph Condition Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Creates an expression defining conditions that restrict 
the number of nodes that appear in the query.

Enables you to:

➤ Define attribute conditions for nodes and 
relationships.

➤ Filter the query results. For details, see “Attribute Tab” 
on page 318.

To access: Click Condition  in the Add Dependency 
dialog box.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Add the subgraph condition definition.

Delete the subgraph condition definition.

Move a selected row up.

Move a selected row down.

View the subgraph condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.
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Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

CIT Contains the CIT selected from the Source and Target 
lists.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, let us assume that your system contains three 
hosts. Host1 is assigned the value A, Host2 is assigned the 
value B and Host3 is not assigned a value. If you create a 
query in which you want to retrieve all hosts that are 
equal to A and you select NOT, the results of your query 
only include Host2 because Host3 is not assigned a value.

Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 276.

Update Update an attribute condition that has been modified.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

GUI Element (A-Z) Description
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TQL Node Wizard

Description Enables you to build a TQL query. 

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
In the Editing pane, right-click the required node and 
select TQL Node Wizard.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane.

To access in Job Configuration in Discovery:
1  Select a job in the Discovery Modules pane. 

2  Select a Trigger TQL in the Properties pane. Click the 
Open the TQL Editor  button to open the Trigger 
TQL Editor.

3  Right-click the required node and select TQL Node 
Wizard.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select TQL Node 
Wizard.

Important 
Information

If the TQL query is empty, drag the required TQL nodes 
on to the Editing pane from the tree displayed in the CI 
Type Selector.

Included in Tasks ➤ “Define a Report Rule - Scenario” on page 192

➤ “Define a Correlation Rule - Scenario” on page 169

➤ “Define an Enrichment Rule - Scenario” on page 242

➤ “Define a TQL Query” on page 227

➤ “Pattern View Workflow” on page 141

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.
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New TQL Node Page

Useful Links “Topology Query Language” on page 264

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Properties Page > Element Instances Page

Description Enables you to add a node to the TQL query.

Important 
Information

If the TQL query is empty, drag the required TQL node 
on to the Editing pane from the tree displayed in the 
Configuration Item Types pane.

For general information on the TQL Node Wizard, see 
“TQL Node Wizard” on page 331.

Useful Links “Topology Query Language (TQL) Overview” on 
page 264

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > 
TQL Node Properties Page > Element Instances Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<node> is required Define the relationship cardinality. For details, see 
“Cardinality Tab” on page 320.

➤ Select the <node> is required check box for each node 
to include a minimum of one instance of the node at 
the other end of the relationship in the query results. 
Selecting the check box gives the relationship a 
cardinality value of 1*.

➤ Clear the <node> is required check box to give the 
relationship a cardinality value of 0*.

Element name (Optional) Contains the name of the selected node. By 
default, the CIT type is assigned as the element’s name.

You can rename a TQL node in the Element name box 
giving it a unique label. This can be helpful when there is 
more than one node of the same CIT type in the TQL 
query.

Show only CITs with 
instances

Select this check box to display only the CITs of which 
there are instances in the CMDB.

Note: The Show only CITs with instances check box is 
selected by default.

TQL Node hierarchy 
tree

Select the required node. The node you select appears in 
the Element name box.

This list only includes the nodes of the CIT type that have 
valid relationships to the selected (source) node. 

To the right of each node, the number of CI instances 
that exist in the CMDB for that CI type is displayed. The 
number of instances is only updated after you close the 
TQL Node Wizard and open it again.

Note: The first node in the hierarchy tree is selected by 
default.
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New TQL Relationship Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to add a relationship to a TQL query.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > 
TQL Node Properties Page > Element Instances Page

GUI Element (A-Z) Description

Direction Select the required relationship direction. The direction 
indicates which node is dependent on the other.

Relationship 
direction

Select the required relationship direction. The direction 
indicates which node is dependent on the other.

Relationship Type A valid relationship that defines the connection between 
the selected nodes. The box displays the relationship you 
selected in the relationship hierarchy tree.

Show only 
relationships with 
instances

Display only the relationships of which there are 
instances in the CMDB.

<TQL Relationship 
hierarchy tree>

Select the required relationship. The node you select 
appears in the Relationship Type box.
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TQL Node Properties Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create an expression defining conditions 
that restrict the number of nodes that appear in the 
query.

➤ Add an attribute condition to a node or relationship.

➤ Filter the query results.

Useful Links “Topology Query Language (TQL) Overview” on page 264

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Properties Page > Element Instances Page

GUI Element (A-Z) Description

Add the attribute definition.

Delete an attribute condition.

Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.
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Fixed value Select one of the following options:

Fixed value. You cannot change the value of the 
parameter.

Parameterized value. Enables you to change the value of 
the parameter.

➤ When a parameterized value is selected in View 
Manager, an option called Set View Element 
Parameters is included in the right-click menu. For 
details on how to change the value when using the 
TQL, see “Set View Parameters/Set View Element 
Parameters Dialog Box” on page 155.

Note: If you select this option, you can enter a value 
here that is saved in the view. If you do not enter a 
value here, you are forced to enter one before saving 
the view. 

➤ When a parameterized value is selected in Report 
Manager, a Set parameters values option is displayed 
in a generated System report, enabling you to edit the 
predefined parameters of node conditions in a System 
report. For details, see “System Report” on page 599.

Include subtypes Display both the selected CI and its children in the 
topology map.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.

Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 276.

Update Update an attribute condition that has been modified.

GUI Element (A-Z) Description
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Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

Visible Select Visible to display the selected TQL node in the 
editing pane. When Visible is cleared, an invisible box  
appears to the right of the selected TQL node in the 
Editing pane.

Any query results pertaining to that TQL node are not 
displayed in the topology map. This can be useful when 
certain relationships or TQL nodes are required to build 
the query but are not needed in the results. For example, 
Windows are connected to the network by defining 
specific IPs, but in any query results you may want to 
view the IP elements only and not the Windows 
elements.

GUI Element (A-Z) Description
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Element Instances Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays all the instances found for the selected TQL node 
in a table.

Important 
Information

The columns displayed in the report vary according to 
the CI type selected. 

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the 
CIT Manager are displayed as columns in the dialog box. 
For details, see “Attributes Page” in CI Attribute 
Customization. 

If required, you can click the Display Hidden Columns 
button to display the attributes that are defined as Visible 
but not Static. For details on Static attributes, see 
“Attributes Page” in CI Attribute Customization.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Properties Page > Element Instances Page

GUI Element (A-Z) Description

Update the table.

Determine the number of CI instances that appear on a 
page. Opens the Set Rows Per Page dialog box.

Click to navigate through the results page by page or to 
jump to the first or last page.

<CI type attributes> The attributes of the CIT of the selected CI.

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.
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User Preferences Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

CI Type The CIT of the selected CI.

Display Label The name of the CI instance as it appears in the topology 
map.

Description Enables you to reset system preferences.

To access: Select Edit > User Preferences.

Important 
Information

All the preferences you select (such as whether to display 
certain wizard pages or warning message preferences) are 
stored in the system. This dialog box enables you to reset 
those preferences.

GUI Element (A-Z) Description

Description area A description of the selected warning message.

Preferences list The list of warning messages and their user-selected 
preferences.

Reset Click to reset the selected preference to its default value.

Reset All Click to reset all the preferences to their default values.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

For TQL queries to be valid, they must comply with certain restrictions.

This section includes the following topics:

➤ “Understanding Validation Restrictions” on page 334

➤ “Correlation TQL Validation” on page 336

➤ “Enrichment TQL Validation” on page 337

Understanding Validation Restrictions
For Correlation, Enrichment, and DDM TQL types to be valid, they must 
comply with the following restrictions:

➤ Self Relationships. A TQL must not contain self relationships, that is, a 
relationship must not lead from a node to itself, as the following example 
illustrates:
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➤ Cyclic Graph. The TQL structure cannot be a closed circle, as shown in the 
following example:

➤ Separate Nodes and Groups. All the TQL nodes must be linked to one 
another, that is, the TQL cannot contain separate nodes or groups, as the 
following example illustrates:

Note: This restriction also applies to Report TQLs.
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Correlation TQL Validation
A Correlation TQL must also comply with the following restrictions:

➤ Number of nodes. A Correlation TQL must consist of at least two nodes.

➤ Trigger and affected nodes must be connected. There must be a path of 
relationships from the triggered node to the affected nodes.

➤ Selecting nodes to function as Correlation triggers. When selecting nodes 
to function as Correlation triggers, the nodes must comply with the 
following restrictions:

➤ You can select more than one node as a trigger. However, you cannot 
define a node as affected and as a trigger.

➤ If a node has a relationship whose minimum limit is 0 (meaning that one 
of its ends does not necessarily have a node linked to it), the node that is 
linked to its other end cannot be a root cause node (because it may or 
may not exist in the TQL). For details about minimum limits, see 
“Cardinality Tab” on page 320. For example, IT Universe cannot be either 
a root cause or affected node because it is connected to the host with a 
Min limit of 0. 

Note: A node that is not visible cannot be a root cause or an affected node.
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➤ The connection between trigger and affected nodes. The trigger node and 
affected nodes you define must be connected by a path of relationships 
from the triggered node to the affected nodes.

Enrichment TQL Validation
Enrichment TQL queries must comply with the following restriction:

➤ Required elements. You cannot perform Enrichment on a non-required 
node, that is, a node that does not necessarily appear in the TQL results.

Example 1. In this example, the TQL results can be either A and B or A and 
C. Therefore, you cannot add an Enrichment node to nodes B or C because 
they are not required elements. You can add an Enrichment node to node A 
because it always appears in the TQL results. For details on how to add 
Enrichment nodes and relationships, see “Add Enrichment Nodes and 
Relationships to an Enrichment TQL Query” on page 269.
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Example 2. In this example, both A and B are required elements that always 
appear in the TQL results. Only C is not a required element because it has a 
cardinality of 0. Therefore, you cannot add an Enrichment node to it.
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10
Package Manager

This chapter provides information on Package Manager.

This chapter includes:

Concepts

 ➤  Package Administration Overview on page 348

 ➤  Package Contents and Structure on page 349

Tasks

 ➤  Package Creation on page 350

 ➤  Package Deployment on page 352

 ➤  Package Export on page 352

Reference

 ➤  Package Resources on page 353

 ➤  Using the JMX Console to Perform Package Manager Tasks on page 355

 ➤  Package Manager User Interface on page 359

Troubleshooting and Limitations on page 372
Concepts
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Package Administration Overview

A package is a subset of resources grouped together by certain defined 
criteria. It is intended to enable actions such as the discovery of specific IT 
infrastructure assets, modeling of the infrastructure, and moving groups of 
resources from one system to another.

There are two types of packages:

➤ Factory package. Contains resources that are deployed with the installation 
and are used to initialize HP Business Availability Center.

By default, factory packages are located in: <HP Business Availability Center 
root directory>\mam_lib\factory_packages.

➤ Custom package. A package that is user created. For details, see “Create New 
Package/Edit Package Wizard” on page 360. 

Important: If you want to create custom packages for the resources or tools 
you develop, do not place them in the <HP Business Availability Center root 
directory>\mam_lib\factory_packages folder. This folder is only for factory 
packages.
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Package Contents and Structure

A package is a zip file that contains resources, which are structured in 
subdirectories. See an illustration below.

Most of the files are in XML format. Each XML file describes the attributes, 
parameters, and values of the resources contained in the package.

For example, in the package Network.zip, the router.xml file contains a CIT 
resource for the Router CIT and the Switch.xml file contains a CIT resource 
for the Switch CIT.

Tasks
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Package Creation 

You can create a new package or edit an existing one. For details, see “Create 
New Package/Edit Package Wizard” on page 360.

Example

A package has been created called Service1.zip, as seen in the following 
illustration:

In the Resource Selection page, you select the resources you want to include 
in the package, as shown in the following illustration:
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The summary page displays the resources selected to be included in the 
package, as shown in the illustration below:

The package contains resources from the following resource groups: 

➤ Relationships

➤ Valid Links

➤ Configuration Item Types
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Package Deployment

You can deploy some or all of a package’s resources to the CMDB from your 
local directory. For details, see “Package Manager Window” on page 368.

Example

You want to deploy only some of the resources contained in the package 
called ticket2.zip. Click the  button. In the Deploy Specific Resources 
dialog box, browse to the package’s location and select the resources from 
the package you want to deploy. See the following illustration:

Package Export

You can export some or all of a package’s resources from the Package 
Manager to your local directory. For details, see “Package Manager Window” 
on page 368.

Example

You want to export only some of the resources contained in a package called 
ticket2.zip to your local directory. Click the  button. In the Export 
Package dialog box, select the Export Resources option and select the 
resources you want to export. See the following illustration:

Reference
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Package Resources

Packages can contain any of the following resources:

➤ acl. The definition of a role such as Administrator or Guest. For details, see 
“User Management” in Platform Administration.

➤ adapter. Contains a description and the capabilities of the deployed 
federated adapter.

➤ categories. Contains the State definitions used by Correlation Manager. For 
details on States, see “State Manager” on page 505. For details on 
Correlation Manager, see “Correlation Manager” on page 167.

➤ class. CI type descriptions, such as host, file, switch, and so on. For details, 
see “CI Type Manager” in CI Attribute Customization.

➤ correlation. Correlation rule definitions. For details, see “Correlation 
Manager” on page 167.

➤ datamodel. Used to import CI instances into the system. If the CI does not 
exist in the CMDB, an instance of the CI is created. If a CI type already exists 
in the CMDB, the values of the CI from the package resource overwrites the 
values of the CI in the CMDB.

➤ datamodelcreateonly. Used to import CI instances into the system. If the CI 
does not exist in the CMDB, an instance of the CI is created. If a CI type 
already exists in the CMDB, the values of the CI from the package resource 
does not overwrite the values of the CI in the CMDB.

➤ datamodelgenerateids. Used to import CI instances into the system for CITs 
that require the ID to be calculated dynamically upon deployment (such as 
CITs with no key attributes).

➤ discoveryConfigFiles. Configuration files include properties and parameters 
that are needed to discover components on the system. For details, see 
“Manage Discovery Resources” in Discovery and Dependency Mapping Guide.

➤ discoveryJobs. A Discovery and Dependency Mapping (DDM) job includes 
configuration data, scheduling information, and TQL assignments needed 
to activate discovery of components. For details, see “Run Discovery” in 
Discovery and Dependency Mapping Guide.
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➤ discoveryModules. A DDM module includes all the jobs needed to discover a 
specific component in the system. For details, see “Run Discovery” in 
Discovery and Dependency Mapping Guide.

➤ discoveryPatterns. DDM patterns define what scripts need to be run and in 
which order, declare the input and output CI Types and parameters to be 
configurable on the discovery jobs related to them. For details, see “Manage 
Discovery Resources” in Discovery and Dependency Mapping Guide.

➤ discoveryResources. External resources include all external resources that are 
needed in DDM, for example, a Visual Basic file, a credentials file, and so on. 
For details, see “Manage Discovery Resources” in Discovery and Dependency 
Mapping Guide.

➤ discoveryScripts. DDM scripts enable navigating to, and accessing, 
components that must be discovered. For details, see “Manage Discovery 
Resources” in Discovery and Dependency Mapping Guide.

➤ discoveryWizard. Used to define the Discovery Wizard dialog box contents. 
For details, see “Run Discovery” in Discovery and Dependency Mapping Guide.

➤ enrichment. Enrichment rule definitions. For details, see “Enrichment 
Manager” on page 239.

➤ modelnotification. Contains filter definitions for CMDB model 
notifications. The data model notification system gives notification of 
changes that occurred in the CMDB. For example, items in the CMDB that 
have been removed, updated, or added.

➤ report. Report rule definitions, as described in “Report Manager” on 
page 191.

➤ schedulerJobs. Tasks that have been defined to run in the Scheduler. For 
details, see “Scheduler” on page 375.

➤ tql. TQL query definitions. For details, see “Query Manager” on page 225.

➤ typedef. Predefined Enumeration definitions that relate to attributes of type 
Enumeration, such as severity levels, admin states, and so on. For details, see 
“System Type Manager” on page 37 in CI Attribute Customization.

➤ users. The definition of a user and the user’s role. For details, see “User 
Management” in Platform Administration.

➤ validlinks. All predefined, valid connections (relationships) between CITs. 
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➤ view. View Manager definitions. For details, see “View Manager” on 
page 123.

Using the JMX Console to Perform Package Manager 
Tasks

This section describes the Package Manager tasks you can perform using the 
JMX console.

Note: It is recommended that you use the Package Manager to perform these 
tasks instead of the JMX console. View Package Deployment History cannot 
be performed by the Package Manager.

This section includes the following tasks:

➤ “Deploy a Package” on page 355

➤ “View Package Deployment History” on page 356

➤ “Undeploy a Package” on page 357

➤ “Display Currently Deployed Packages” on page 357

➤ “Export Packages” on page 358

 1 Deploy a Package
Follow these steps to deploy a package using the JMX console.

 a Launch your Web browser and enter the following address: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Business Availability Center is 
installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page. 

 c Locate java.lang.String deployPackages.
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 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter dir, enter the name of the folder 
that contains the package’s zip file. Ensure that you include the full path 
to the folder.

Note: To deploy the package from the factory_packages directory, leave 
this box empty.

 f In the ParamValue box for the parameter packagesNames, enter the 
name of the packages. 

 g The rules for entering a package name are as follows:

 h Wildcard characters (*) are not supported.

 i The package name is case sensitive.

 j The package name must have a .zip extension.

 k Select True to override DDM job configurations changed in the Discovery 
user interface. For details, see the Discovery and Dependency Mapping 
Guide.

 l Click Invoke to deploy the package.

 2 View Package Deployment History
Each time you deploy packages, a report is created displaying the 
deployment status of those packages. Use the JMX console to view the 
deployment status report.

 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Business Availability Center is 
installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.

 c Locate java.lang.String displayResourcesDeploymentHistory.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.
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 e In the ParamValue box for the parameter reportNum, enter the number 
of the report you want to view.

 f Click Invoke to view the deployment status report of the packages.

 3 Undeploy a Package
Follow these steps to undeploy a package using the JMX console.

 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Business Availability Center is 
installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.

 c Locate java.lang.String undeployPackages.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter packagesNames, enter the 
name of the package you want to remove.

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive. 

➤ The package name must have a .zip extension.

 f Click Invoke to undeploy the package.

 4 Display Currently Deployed Packages
Follow these steps to display currently deployed packages using the JMX 
console.

 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Business Availability Center is 
installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.
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 c Locate java.lang.String displayDeployedPackages.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter packagesNames, specify the 
names of the packages you want to display.

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive.

➤ The package name must have a .zip extension.

 f Click Invoke to display the packages that are currently deployed.

 5 Export Packages
Follow these steps to export resources from the CMDB to the server on 
which HP Business Availability Centeris installed using the JMX console.

 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Business Availability Center is 
installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.

 c Locate java.lang.String exportPackages.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter packagesName, enter the name 
of the package you want to export.

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive. 

➤ The package name must have a .zip extension.
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 f In the ParamValue box for the parameter outputDir, enter the name of 
the folder on the HP Business Availability Centerserver to which you 
want to export the package’s zip file. Ensure that you include the full 
path to the folder.

 g In the ParamValue box for the parameter userOnly, select one of the 
following:

➤ True. Export only the custom packages.

➤ False. Export both custom and factory packages.

 h Click Invoke to export the package.

Package Manager User Interface

This section describes:

 ➤  Choose Resources to Export Dialog Box on page 359

 ➤  Create New Package/Edit Package Wizard on page 360

 ➤  Export Package Dialog Box on page 365

 ➤  Filter Dialog Box on page 366

 ➤  Find Dialog Box on page 367

 ➤  Package Manager Window on page 368

 ➤  Undeploy Package Resource Wizard on page 370

Choose Resources to Export Dialog Box

Description Select the resources you want to export to your local 
directory.

To access: Select Export resources in the Export Package 
dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Create New Package/Edit Package Wizard

Package Properties Page

GUI Element (A-Z) Description

<List of resources > Displays the list of resources contained in the package. 
Select the resources you want to export to your local 
directory.

Description Enables you to create a package using existing resources 
or edit an existing package.

To access: Click the Add  button in the Package 
Manager window to create a new package or select a 
package in the Package Manager window and click the 
Edit  button to edit an existing package.

Included in Tasks “Package Creation” on page 350

Wizard Map The Create New Package Wizard contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page

Description Define the properties of the package.

Wizard Map The Create New Package Wizard contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Resource Selection Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Package Category A free text box for any notes you want to associate with 
the package.

Package Description A description of the package.

Package Name The name of the package.

Description Enables you to add the required resources to the package. 
Select the required resources from the various 
subsystems.

Note: You can make multiple selections from each 
subsystem.

Wizard Map The Create New Package Wizard contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page

GUI Element (A-Z) Description

Appears in the left pane. Indicates that a subsystem 
resource has been added to the package.

Appears in the left pane. Indicates that no subsystem 
resource has been added to the package.
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Subsystems

Following is a list of the available subsystems and their descriptions:

➤ Configuration Item Types. The CITs defined in the CI Type Manager. For 
details, see “CI Types Overview” in CI Attribute Customization. 

➤ Correlations. The Correlation rules defined in the Correlation Manager. For 
details, see “Correlation Manager” on page 167.

➤ Discovery Configuration Files. Configuration files include properties and 
parameters that are needed to discover components on the system. For 
details, see “Resource Files” in the Discovery and Dependency Mapping Guide.

➤ Discovery External Resource. External resources include all resources 
external to HP UCMDB/HP BAC that are needed in Discovery, for example, a 
Visual Basic file, a credentials file, and so on. For details, see “Manage 
Discovery Resources” in the Discovery and Dependency Mapping Guide.

<subsystems in the 
left pane>

Contains the subsystems from which you can choose the 
required resources to add to the package.

For details of a list of the available subsystems and their 
descriptions, see “Subsystems” on page 362.

Note: A green dot appears on the subsystem icon when 
one or more of its resources are selected to be included in 
the package.

<resources in the 
right pane>

Select the resources you want to add to the package. You 
can select multiple resources.

Notes: 

➤ A green check appears to the right of a CIT or 
Relationship resource when one or more of its children 
in the resource tree are included in the package.

➤ A folder’s check box has a faded check when some of 
its resources are included in the package. (This does 
not apply to Configuration Item Types and 
Relationships)

➤ A folder’s check box is selected when all its resources 
are included in the package. (This does not apply to 
Configuration Item Types and Relationships).

GUI Element (A-Z) Description
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➤ Discovery Jobs. A DDM job includes configuration data, scheduling 
information, and TQL assignments needed to activate Discovery of 
components. For details, see “Run Discovery” in the Discovery and 
Dependency Mapping Guide.

➤ Discovery Jython Script. DDM Jython Scripts are Jython scripts used by the 
Discovery process to discover and map the various network entities.

➤ Discovery Modules. A DDM module includes all the jobs needed to discover 
a specific component on the system. For details, see “Discovery Modules 
Pane” in the Discovery and Dependency Mapping Guide. 

➤ Discovery Wizard Resource. Used to define the Discovery Wizard dialog box 
contents. For details, see “Basic Mode Window” in the Discovery and 
Dependency Mapping Guide.

➤ Discovery Patterns. DDM patterns define what scripts need to be run and in 
which order, declare the input and output CI Types and the parameters to be 
configurable on the discovery jobs related to them. For details, see “Manage 
Discovery Resources” in the Discovery and Dependency Mapping Guide.

➤ Enrichments. The Enrichment rules defined in the Enrichment Manager. For 
details, see “Enrichment Manager” on page 239.

➤ Job Scheduler. Tasks that have been defined to run in the Scheduler. For 
details, see “Scheduler” on page 375. 

➤ Relationships. The relationships defined in the CI Type Manager. For details, 
see “CI Type Relationships” in CI Attribute Customization.

➤ Reports. Report rules definitions, as described in “Report Manager” on 
page 191.

➤ State Categories. The states defined in the State Manager. For details, see 
“State Manager” on page 505.

➤ TQLs. The TQL queries defined in the Query Manager. For details, see 
“Query Manager” on page 225.

➤ Type Definitions. Predefined Enumeration definitions that relate to 
attributes of enumeration type, such as severity levels, admin states, and so 
on. For details, see “System Type Manager” in CI Attribute Customization.

➤ Users. The definition of a user and the user’s role. For details, see “User 
Management” in Platform Administration.
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➤ Valid Links. All possible predefined valid connections (relationships) 
between the CITs that are defined in the CIT folder.

➤ Views. The views defined in the View Manager. For details, see “View 
Manager” on page 123.

Selection Summary Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the resources to be included in the 
package.

Wizard Map The Create New Package Wizard contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page

GUI Element (A-Z) Description

<Selected resources> Displays the resources that were selected to be part of the 
package.
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Export Package Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Exports the selected package’s resources to your local 
directory. 

To access: Click the Export Package to Local Directory 
button  in the Package Manager window.

Important 
Information

You can choose to export some or all the resources in the 
package.

GUI Element (A-Z) Description

Export to directory Select the directory to which you want to export the 
resources. 

Export resources Export only some of the package’s resources to your local 
directory. Opens the Choose Resources to Export dialog 
box.

Export whole 
package

Export all the resources in the package to your local 
directory.

File name The name of the package. 

Note: The package name cannot be edited.
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Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to display only specific packages in the 
Package Manage window.

A description of the filter condition you defined appears 
above the table columns in the Package Manager window. 
For example, the following illustration shows that a filter 
condition was created to display a package called 
Network.

To access: Click the Filter  button in the Package 
Manager window.

GUI Element (A-Z) Description

<click a column 
header>

For details, see “Working with Tables” in Reference 
Information.

<right-click a column 
header>

For details, see “Working with Tables” in Reference 
Information.

Condition Click inside the box and select the required operator. For 
details, see “Attribute Operator Definitions” on page 276.

Display Name Filter the task list according to one of the following:

➤ Package name

➤ Package Category

➤ Package Description

For details, see “Package Manager Window” on page 368.

Value Click inside the box to open the Edit box. Enter the 
required value.
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Find Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Find a package that contains a specified resource. For 
details, see “Subsystems” on page 362.

To access: Click the Find  button in the Package 
Manager window. 

GUI Element (A-Z) Description

Case sensitive Distinguish between uppercase and lowercase characters. 
When you select Case Sensitive, search results find only 
those instances in which the capitalization matches the 
text you typed in the Resource name box.

Resource name Enter a word or phrase contained in the resource for 
which you are looking.

Search Results The search results. Displays the names of the resources 
containing the text entered in the Resource name box.

Topic The subsysytem containing the resource you want the 
package to contain. For details, see “Subsystems” on 
page 362.
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Package Manager Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Package Manager enables you to:

Create a package out of existing resources or edit an 
existing one to suit your IT management needs.

To access: Select Admin > Universal CMDB > Settings > 
Package Manager.

GUI Element (A-Z) Description

Enables you to create a package out of existing resources. 
Opens the Create New Package Wizard.

Enables you to edit an existing package. Opens the Edit 
Package Wizard. 

Deletes a package from the Package Manager while the 
resources from the package remain in the system. The 
package that is deleted is removed from the list of 
packages in the Package Manager window.

View the resources included in the selected package. 
Opens the View package resources window.

Deletes the resources from the system and removes them 
from the selected package. Opens the Undeploy Package 
Resource Wizard.

Deploys all of a package’s resources to the CMDB from 
your local directory. Opens the Deploy Packages to Server 
dialog box. Browse to the required package.

Note: When deployment is finished and it is not 
successful, a Deploy Package window is displayed 
indicating which resources within the package are not 
successfully deployed.
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Deploys specific resources to the CMDB from your local 
directory. Opens the Deploy Specific Resources dialog 
box. Browse to the required package and select the 
resources you want to deploy.

Note: When deployment is finished and it is not 
successful, a Deploy Package window is displayed 
indicating which resources within the package are not 
successfully deployed.

Exports some or all of the package’s resources to your 
local directory. Opens the Export Package dialog box. 

Finds a package that contains a specified resource. Opens 
the Find dialog box.

Update the contents of the table.

Opens the Filter dialog box. You use the Filter dialog box 
to show only the packages you want displayed in the 
Package Manager window.

Clear the filter definitions you created in the Filter dialog 
box. This is enabled only if filter definitions were created.

Click the Customize Columns button to open the Select 
Columns dialog box and change the display order of the 
columns, hide a column, or display a hidden column.

For details on the Select Columns dialog box, see “Select 
Columns Dialog Box” in Reference Information.

Generate a report displaying a list of the packages that are 
deployed in the system.

Notes: 

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Troubleshooting 
and Limitations” in Reports. 

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reports.

GUI Element (A-Z) Description
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Undeploy Package Resource Wizard

Remove Resources Page

Category The free text you want to associate with the package, as 
displayed in the Package Properties page of the Create 
New Package Wizard.

Description The description of the package, as displayed in the 
Package Properties page of the Create New Package 
Wizard.

Package Name The name of the package.

Description Deletes the resources from the system and removes them 
from the selected package.

To access: Click the Undeploy resources  button in the 
Package Manager window.

Important 
Information

When you undeploy a package, the resources are removed 
from the system, and from the other packages that 
contain that resource. You can restore the resources only 
when a package containing those resources is deployed.

Wizard Map The Undeploy Package Resource Wizard contains:

Remove Resources Page > Summary Selection Page

Description Select the resources you want to delete.

Important 
Information

If you delete all the resources from the package, the 
package is automatically deleted and removed from the 
list of packages in the Package Manager window.

Wizard Map The Undeploy Package Resource Wizard contains:

Remove Resources Page > Summary Selection Page

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Summary Selection Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<List of resources 
contained in the 
selected package>

Displays the resources contained in the selected package.

Description Enables you to view the resources you selected to be 
deleted.

Important 
Information

When undeployment is finished and it is not successful, 
an Undeploy Package window is displayed indicating 
which resources within the package are not successfully 
undeployed.

Wizard Map The Undeploy Package Resource Wizard contains:

Remove Resources Page > Summary Selection Page 

GUI Element (A-Z) Description

<List of deleted 
resources>

Displays the resources that were selected to be deleted 
from the package.
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Troubleshooting and Limitations

This section describes some of the troubleshooting issues that might arise 
when deploying and undeploying packages.

This section includes the following topics:

➤ “Gold Master Reports Cannot be Deployed by Package Manager” on 
page 372

➤ “Additional Information on Package Deployment Failure” on page 372

➤ “Package Creation and Deployment in a Non-English Locale” on page 373

Gold Master Reports Cannot be Deployed by Package 
Manager
If you export a package’s resources from Package Manager that includes a 
Gold Master report definition, and then export those resources again to 
another system, the Gold Master report definition is not deployed.

Additional Information on Package Deployment Failure
If package deployment fails, you can check the following Package Manager 
log files for additional information on why the deployment failure occurred.

➤ The mam.packaging.log file is located in:<HP Business Availability Center 
root directory>\log\mam.

➤ The cmdb.classmodel.log file is located in:<HP Business Availability Center 
root directory>\log\cmdb.

➤ The mam.log file is located in:<HP Business Availability Center root 
directory>\log\mam.

➤ The cmdb.log file is located in:<HP Business Availability Center root 
directory>\log\cmdb.

Note: If a log\mam or a log\cmdb folder does not exist, look for the log 
files under log\EJBContainer.
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Package Creation and Deployment in a Non-English Locale
This section describes the limitations when working in a non-English locale.

➤ You cannot deploy a package if the server locale is different than the client 
locale and the package name contains non-English characters.

➤ You cannot create a package that contains resources (for example, views and 
TQLs) having non-English characters in their names, if the server locale is 
different from the client locale.
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Scheduler

This chapter provides information on Scheduler.

This chapter includes:

Concepts

 ➤  Scheduler Overview on page 375

Tasks

 ➤  Define Tasks that Are Activated on a Periodic Basis on page 376

Reference

 ➤  Cron Expressions on page 377

 ➤  Scheduler User Interface on page 378
Concepts

Scheduler Overview

You can define tasks to run periodically. For example, you can define a 
schedule for automatic backup of generated reports, and determine how 
many backups are saved. 

Tasks
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Define Tasks that Are Activated on a Periodic Basis

This task describes how to run jobs on a periodic basis.

 1 Create a Job Definition
Define a job definition. Add actions to the job you created and define how 
often they run. The Job Definition dialog box displays the tasks that are 
defined. For details, see “Job Definitions Dialog Box” on page 382.

Example

The illustration below shows that two Enrichment rules are set to run — one 
at a set interval and one on a daily basis.

 2 Choose an Action
Select the actions that you want the Scheduler to run. For details, see 
“Action Definition Dialog Box” on page 379.

 3 Schedule a Task
Set the schedule for activating a task in the Scheduler pane. For details, see 
“Job Definitions Dialog Box” on page 382.
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Example

The illustration below shows that the Scheduler is set to take a snapshot of 
the View called Host Resources every day at 1:00 AM.

Reference

Cron Expressions

A Cron Expression is a string composed of six or seven fields separated by 
white space. Six of the fields are mandatory, and one is optional.

The following table contains the fields used in a Cron Expression.

Field Name Allowed Values Allowed Special Characters

Seconds 0-59 , - * /

Minutes 0-59 , - * /

Hours 0-23 , - * /

Day of month 1-31 , - * ? / L W C

Month 1-12 or JAN-DEC , - * /
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The following table contains examples of how to use Cron expressions.

For more details about Cron expressions, go to 
http://quartz.sourceforge.net/javadoc/org/quartz/CronTrigger.html.

Scheduler User Interface

This section describes:

 ➤  Action Definition Dialog Box on page 379

 ➤  Filter Dialog Box on page 381

 ➤  Job Definitions Dialog Box on page 382

 ➤  Job Scheduler Window on page 385

Day of week 1-7 or SUN-SAT , - * ? / L C #

Year (optional) empty, 1970-2099 , - * /

Cron Expression Meaning

0 0 12 * * ? The task runs every Wednesday at 12:00 PM.

0 15 10 ? * * The task runs at 10:15 AM every day.

0 15 10 * * ? 2005 The task runs at 10:15 AM every day during the 
year 2005.

0 0/5 14 * * ? The task runs every 5 minutes starting at 2 PM and 
ending at 2:55 PM, every day.

0 15 10 15 * ? The task runs at 10:15 AM on the 15th day of 
every month.

0 15 10 ? * 6L The task runs at 10:15 AM on the last Friday of 
every month.

0 15 10 ? * 6#3 The task run at 10:15 AM on the third Friday of 
every month. 

Field Name Allowed Values Allowed Special Characters
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 ➤  Select Days Dialog Box on page 387

 ➤  Select Hours Dialog Box on page 387

Action Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select a required action in a list of actions 
that can be run by the Scheduler.

To access: Click the Add  button in the Actions pane 
in the Job Definitions dialog box.

Important 
Information

After selecting the required action, click Next to display a 
list of actions. The list of action details depends on which 
action you choose.

For example, if you select Run TQL, a list of the existing 
TQL queries appears. Select the required TQL query 
names. You can make multiple selections.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 376

GUI Element (A-Z) Description

<click a column 
header>

For details, see “Working with Tables” on page 11.

<right-click a column 
header>

For details, see “Working with Tables” on page 11.

Actions For a list of actions that can be run by the Scheduler, see 
“Scheduler Actions” below.
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Scheduler Actions

This section contains a list of actions that can be run by the Scheduler.

➤ Generate and save a Gold Master report. Generate a Gold Master report and 
save it to the CMDB according to its set schedule. Click Next to display a list 
of the available Gold Master reports and select the required ones. For details, 
see “Gold Master Report Pane” on page 208.

➤ Generate and save a System report. Generate a System report and save it to 
the CMDB according to its set schedule. Click Next to display a list of the 
available System reports and select the required ones. For details, see “Report 
Manager” on page 191.

➤ Run an Enrichment rule. Activate the selected Enrichment rule according to 
its set schedule. Click Next to display a list of the available Enrichment rules 
and select the required ones. For details, see “Enrichment Manager” on 
page 239. 

➤ Run a Replication job. Federate data stores from different sources to a single, 
central database according to its set schedule. Click Next to display a list of 
the data stores and select the required ones. For details, see “Federated 
UCMDB User Interface” on page 488.  

➤ Run a TQL. Run the selected TQL query according to its set schedule. Click 
Next to display a list of the available TQL queries and select the required 
ones. For details, see “Query Manager” on page 225. 

➤ Run a view. Recalculate the selected view according to its set schedule. Click 
Next to display a list of the available views and select the required ones. For 
details, see “View Manager” on page 123. 

➤ Save a snapshot. Save a snapshot of the selected view according to its set 
schedule. Click Next to display a list of the saved snapshots and select the 
required ones. For details, see “Compare Snapshots” on page 541. 
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Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays only specific tasks in the Job Scheduler window.

To access: Click the Filter  button in the Job Scheduler 
window.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 376

GUI Element (A-Z) Description

<click a column 
header>

For details, see “Working with Tables” on page 11.

<right-click a column 
header>

For details, see “Working with Tables” on page 11.

Condition Click inside the box and select the required operator. For 
details, see “Attribute Operator Definitions” on page 276.

Display Name Filters the task list according to one of the following:

➤ Is Active

➤ Job Definition

➤ Last Run Time

➤ Name

➤ Next Run Time

➤ Schedule

For details, see the Job Scheduler window.

Value Click inside the box and either enter or select the 
required value.
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Job Definitions Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Actions Pane
 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to add actions to the job you created and 
define how often they run.

To access: Click the Add  button in the Job Scheduler 
window.

Included in Tasks “Choose an Action” on page 376

“Schedule a Task” on page 376

GUI Element (A-Z) Description

Job Definition (Optional) A description for this job.

Name The name of the job. 

Description Enables you to add the required actions to the task you 
created.

Included in Tasks “Choose an Action” on page 376

GUI Element (A-Z) Description

Adds an action to the task. Opens the Action Definition 
dialog box.

Edits an existing action.

Deletes an action.

Moves a selected row up.
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Scheduler Pane
 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Moves a selected row down.

Action Definition Displays the action details you selected in the Action 
Definition dialog box for the action added.

Name Displays the name of the action that was added to the 
task.

Description Enables you to set the schedule for activating a task.

Included in Tasks “Schedule a Task” on page 376

Useful Links “Cron Expressions” on page 377

GUI Element (A-Z) Description

Opens a calendar. Select the required date and time.

Automatically set the time zone to the correct one for the 
server.

Click to validate the Cron expression you entered.

Cron Use a Cron expression to schedule a job. For a description 
of the fields used in Cron expressions and examples of 
how to use them, see “Cron Expressions” on page 377.

Cron Expression Enter a Cron expression in the proper format. For a 
description of the fields used in Cron expressions and 
examples of how to use them, see “Cron Expressions” on 
page 377.

Daily Runs a task on a daily basis.

GUI Element (A-Z) Description
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Days of month (Appears when you choose Monthly) Click the button  
to the right of the Days of month box to choose the day 
of the month on which you want to run the action.

Opens the Select Days dialog box.

Days of the week 
(Sunday - Saturday)

(Appears when you choose Weekly). Select the day or 
days on which you want the action to run.

End by (Does not appear when you select Once) Choose the date 
and time when you want the action to stop running by 
selecting the End by check box and then clicking the 
Open Calendar  button to the right.

Note: This step is optional. If you do not want to specify 
an ending date, leave the End by check box unselected.

Interval Activates the action at a set time interval.

Invocation Hour Choose the time to activate the action. Click the button 
 to the right of the Invocation Hour box to open the 

Select hours dialog box. For details, see the Select Hours 
dialog box.

Note: You can enter the time manually in the Invocation 
hour box once you have chosen a time using the Select 
hours dialog box. You can assign more than one time. 
Each time is separated by a comma.

The manually entered action times are not restricted to 
the hour and half hour only; they can be assigned any 
hour and minute combination. Use the 24:00 format.

For example:

11:15 AM is 11:15

11:15 PM is 23:15

Note: This box is only available when you want to 
schedule a task to run on a daily, weekly, or monthly 
basis.

Invocation Time (Appears when you choose Once) Choose the date and 
time you want the action to begin running by clicking 
the Open Calendar  button to the right.

GUI Element (A-Z) Description
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Job Scheduler Window

Monthly Runs a task on a monthly basis. 

Months of the year 
(January - December)

(Appears when you choose Monthly). Select the month or 
months in which you want the action to run.

Once Activates the task only once.

Repeat every (Appears only when you select Interval) Type a value for 
the interval between successive runs and then choose the 
required unit of time measurement (seconds, minutes, 
hours, or days).

Start at (Does not appear when you select Once) Choose the date 
and time when you want the action to begin running by 
selecting the Start at check box and then clicking the 
Open Calendar  button to the right.

Note: This step is optional. If you do not want to specify a 
beginning time, leave the Start at check box unselected.

Time Zone Set the required time zone.

Weekly Runs a task on a weekly basis.

Description Enables you to define tasks that are activated on a 
periodic basis. For example, you can define a task that 
generates a System report on a daily basis at 3:00 PM.

To access: Click Admin > Universal CMDB > Settings > 
Scheduler.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 376

GUI Element (A-Z) Description
385



Chapter 11 • Scheduler
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Creates and schedules a task. Opens the Job definitions 
dialog box.

Edits a task. Opens the Job definitions dialog box.

Deletes a task.

Opens the Filter dialog box. You use the Filter dialog box 
to show only the scheduled jobs you want displayed in 
the Job Scheduler window.

Clears the filter definitions you created in the Filter dialog 
box.

Changes the display order of the columns, hide a column, 
or displays a hidden column. Opens the Columns dialog 
box. For details, see “Select Columns Dialog Box” in 
Reference Information.

<click a column 
header>

For details, see “Working with Tables” in Reference 
Information.

<right-click a column 
header>

For details, see “Working with Tables” in Reference 
Information.

Is Active Select the check box to activate the scheduled job.

Job Definition A description of the scheduled job as defined in the 
Definitions box in the Job definitions dialog box.

Last Run Time The last time the job was run.

Name The name of the scheduled job.

Next Run Time The next time the job is scheduled to run.

Schedule How often the job is scheduled to run. For details, see the 
“Scheduler Pane” on page 383.
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Select Days Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select Hours Dialog Box

Description Enables you to choose the day on which to activate the 
action.

To access: Click Monthly in the Job definitions dialog 
box, and then click the  button to the right of the Days 
of month box.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 376

GUI Element (A-Z) Description

<List of days from 1-
31>

Choose the required days by selecting the required check 
boxes. You can select multiple days.

The selected days appear in the Days of month box. For 
details, see Scheduler pane in the Job Definitions dialog 
box.

Description Enables you to choose the time at which to activate the 
action.

To access: Click Daily, Weekly, or Monthly, and then click 
the button  to the right of the Invocation hour box in 
the Job definitions dialog box.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 376
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

List of times by the 
hour and half hour

Choose all the required time by selecting the required 
check box. You can select multiple times.

The selected hours appear in the Invocation hour box. For 
details, see “Invocation Hour” on page 384.
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Federated CMDB

This chapter provides information on the Federated CMDB functionality.

This chapter includes:

Concepts

 ➤  Federated CMDB – Overview on page 390

Tasks

 ➤  Work with Federated Data on page 390

 ➤  The HP ServiceCenter/Service Manager Adapter on page 391

 ➤  The Database Adapter on page 414

 ➤  The Federated Adapter on page 463

 ➤  View KPIs in External Applications on page 487

Reference

 ➤  Federated UCMDB User Interface on page 488

 ➤  Federated CMDB Reference on page 502

Troubleshooting and Limitations on page 503
Concepts
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Federated CMDB – Overview

This section explains how to set up adapters to work with data that is 
federated from different CMDB sources, using the HP Universal CMDB API. 

You use federated CMDB to answer the following questions: Which hosts in 
a specific application (for example, SAP) had more than X changes in a 
certain time period? Which application names had more than X changes in 
a certain time period? Which hosts in the model had more than X changes 
in a certain time period? 

Tasks

Work with Federated Data

This section explains how to set up and work with data that is federated 
from different CMDB sources, using the HP Universal CMDB application. 

 1 Create a Data Store
Access Admin > Universal CMDB > Settings > Federated CMDB > Data 
Stores tab. Click the Add button to open the Data Store dialog box. For 
details, see “Data Store Dialog Box” on page 489. 

 2 Federate the Data Store
Access Admin > Universal CMDB > Settings > Federated CMDB > Replication 
Jobs tab. Click the Add button to open the Replication Job dialog box. For 
details, see “Replication Job Dialog Box” on page 497. 

 3 Build a View
For details, see Chapter 4, “View Manager.”

 4 View Instances in IT Universe Manager
For details, see Chapter 2, “IT Universe Manager.”

 5 View Reports
For details, see Chapter 6, “Report Manager.”
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The HP ServiceCenter/Service Manager Adapter

This section provides information on the HP ServiceCenter/Service Manager 
Adapter, version 1.0. The Adapter is compatible with HP Business 
Availability Center, version 7.0 or later, HP ServiceCenter, version 6.2, and 
HP Service Manager, version 7.0 (following changes to the WSDL 
configuration).

Note: This Adapter is a specific configuration of the ServiceDesk Adapter.

Adapter Usage
The ServiceCenter/Service Manager Adapter supports the retrieval of data 
from HP ServiceCenter and HP Service Manager. This adapter connects to, 
and receives data from, ServiceCenter/Service Manager using the Web 
Service API. Every request to ServiceCenter/Service Manager to calculate a 
federated query is made through this adapter.

The Adapter supports three external CI types: Incident, Problem, and 
Planned Change. The adapter retrieves the CIs of these types from 
ServiceCenter/Service Manager with the required layout and by a given filter 
(using reconciliation and/or a CI filter). Each of these CITs can be related to 
one of the following UCMDB internal CITs: Host, Business Service, 
Application. Each UCMDB internal CIT includes a reconciliation rule in the 
ServiceCenter/Service Manager configuration that can be changed 
dynamically (for details, see “Reconciliation Data Configuration” on 
page 396). Note that there are no internal relationships between Adapter-
supported CITs. 

The modeling of the supported CITs and virtual relationships is supplied 
with the Adapter. You can add attributes to a CIT (for details, see “Add an 
Attribute to the ServiceCenter/Service Manager CIT” on page 406).

The following use cases (that include TQL examples) describe how the 
Adapter can be employed:
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 1 A user needs to display all unplanned changes to all hosts running a specific 
application during the last 24 hours:

 2 A user needs to see all open critical incidents on an application and its hosts:

The Adapter Configuration File
The Adapter configuration file serviceDeskConfiguration.xml is located in 
the following directory: 

<Business Availability Center root directory\fcmdb\CodeBase
\ServiceDeskAdapter
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This file contains three parts:

 1 The first part, which is defined by the ucmdbClassConfigurations element, 
contains the external CIT configuration that the Adapter supports. For 
details, see “External CITs Configuration” on page 393.

 2 The second part, defined by the reconciliationClassConfigurations element, 
contains reconciliation data information for appropriate UCMDB CITs. For 
details, see “Reconciliation Data Configuration” on page 396.

 3 The third part, defined by the globalConnectorConfig element, includes the 
global configuration for a specific connector implementation. For details, 
see “Global Configuration” on page 400.

External CITs Configuration

Each CIT that is supported by the Adapter is defined in the first section of 
the Adapter configuration file. 

This section, ucmdbClassConfiguration, represents the only supported CIT 
configuration. This element contains the CIT name as defined in the 
UCMDB class model (the ucmdbClassName attribute), mapping for all its 
attributes (the attributeMappings element), and a private configuration for a 
specific connector implementation (the classConnectorConfiguration 
element): 

➤ The ucmdbClassName attribute defines the UCMDB class model name.

➤ The attributeMappings element contains attributeMapping elements.

The attributeMapping element defines the mapping between the UCMDB 
model attribute name (the ucmdbAttributeName attribute) to an appropriate 
ServiceCenter/Service Manager attribute name (the 
serviceDeskAttributeName attribute).

For example:

<attributeMapping ucmdbAttributeName="problem_brief_description" 
serviceDeskAttributeName="brief.description"/>
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This element can optionally contain the following converter attributes: 

➤ The converterClassName attribute. This is the converter class name that 
converts the UCMDB attribute value to the ServiceDesk attribute value.

➤ The reversedConverterClassName attribute. This is the converter class 
name that converts the ServiceDesk attribute value to the UCMDB 
attribute value.

➤ The classConnectorConfiguration element contains the configuration for the 
specific connector implementation for the current external CIT. Wrap this 
configuration in CDATA if it contains special XML characters (for example, 
&amp; replacing &).
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The following example shows the ucmdbClassConfiguration section of the 
serviceDeskConfiguration.xml file. The section includes the ucmdbClassName 
element for the Incident CIT with a ServiceCenter connector 
implementation:

 <ucmdbClassConfiguration ucmdbClassName="it_incident">
            <attributeMappings>
                <attributeMapping ucmdbAttributeName="incident_id" 
serviceDeskAttributeName="IncidentID"/>
                <attributeMapping ucmdbAttributeName="incident_brief_description" 
serviceDeskAttributeName="BriefDescription"/>
                <attributeMapping ucmdbAttributeName="incident_category" 
serviceDeskAttributeName="Category"/>
                <attributeMapping ucmdbAttributeName="incident_severity" 
serviceDeskAttributeName="Severity"/>
                <attributeMapping ucmdbAttributeName="incident_open_time" 
serviceDeskAttributeName="OpenTime"/>
                <attributeMapping ucmdbAttributeName="incident_update_time" 
serviceDeskAttributeName="UpdatedTime"/>
                <attributeMapping ucmdbAttributeName="incident_close_time" 
serviceDeskAttributeName="ClosedTime"/>
                <attributeMapping ucmdbAttributeName="incident_status" 
serviceDeskAttributeName="IMTicketStatus"/>
            </attributeMappings>
            <classConnectorConfiguration>
                <![CDATA[ <class_configuration 
connector_class_name="com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.servi
ceCenterConnector.impl.SimpleServiceCenterObjectConnector">
          <device_key_property_names> 
<device_key_property_name>ConfigurationItem</device_key_property_name>
          </device_key_property_names>
          <id_property_name>IncidentID</id_property_name>
          <keys_action_info>
            <request_name>RetrieveIncidentKeysListRequest</request_name>
            <response_name>RetrieveIncidentKeysListResponse</response_name>
          </keys_action_info>
<properties_action_info>
            <request_name>RetrieveIncidentListRequest</request_name>
            <response_name>RetrieveIncidentListResponse</response_name>
          </properties_action_info>
        </class_configuration> ]]>
            </classConnectorConfiguration>
        </ucmdbClassConfiguration>
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Adding an Attribute to a CIT

When adding an attribute to the UCMDB model for a Adapter-supported 
CIT:

 1 In serviceDeskConfiguration.xml, add an attributeMapping element to the 
appropriate ucmdbClassConfiguration element.

 2 Verify that ServiceCenter/Service Manager externalizes this attribute in its 
Web Service API.

 3 Save serviceDeskConfiguration.xml.

 4 Send a call to the JMX to reload the adapter: FCmdb Config Services > 
loadOrReloadCodeBaseForAdapterId, using the appropriate customer ID 
and the ServiceDeskAdapter adapter ID.

Reconciliation Data Configuration

Each UCMDB CIT that can be related to the adapter-supported CIT is 
defined in the second section of the Adapter configuration file. 

This section, reconciliationClassConfigurations, represents the reconciliation 
data configuration for one UCMDB CIT. The element includes two 
attributes: 

➤ The ucmdbClassName attribute. This is the CIT name as defined in the 
UCMDB class model. 

➤ The concreteMappingImplementationClass attribute. This is the class name of 
the concrete implementation for the ConcreteMappingEngine interface. Use 
this attribute to map between instances of UCMDB CITs and external 
Adapter CITs. The default implementation that is used is:

An additional implementation exists that is used only for the host 
reconciliation CIT for reconciliation by the IP of the host: 

com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.mapping.impl.OneNodeMappi
ngEngine

com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.mapping.impl. 
HostIpMappingEngine
396



Chapter 12 • Federated CMDB
The reconciliationClassConfiguration element can contain one of the 
following elements:

➤ The reconciliationById element. This element is used when the reconciliation 
is done by ID. In this case, the text value of this element is the ServiceDesk 
field name that contains the CMDB ID. For example:

In this example, the ServiceDesk field SerialNumber contains the CMDB ID 
of the appropriate host.

➤ The reconciliationData element. Use this element if the reconciliation is done 
by comparing attributes. You can run reconciliation with one attribute or 
several attributes by using the logical operators OR and/or AND. 

If you run reconciliation with one attribute, the reconciliationData child 
element should be a reconciliationAttribute element. The reconciliationAttribute 
element contains an appropriate UCMDB attribute name (the 
ucmdbAttributeName attribute) and an appropriate ServiceDesk attribute 
name (the serviceDeskAttributeName attribute). This element can also 
contain a ucmdbClassName attribute that defines the appropriate UCMDB 
CIT name. By default, the current reconciliation UCMDB CIT name is used. 

You can also use the converterClassName and reversedConverterClassName 
attributes; they should contain the converter class name that converts the 
UCMDB attribute value to the ServiceDesk attribute value, or vice versa.

For example:

For reconciliation to run with two or more attributes, use a logical operator 
between reconciliation attributes.

The logical operator AND can contain several reconciliationAttribute elements 
(the minimum is 2). In this case the reconciliation rule contains an AND 
operator between attribute comparisons. 

<reconciliationById>SerialNumber</reconciliationById>

<reconciliationData>
                <reconciliationAttribute ucmdbAttributeName="host_hostname" 
serviceDeskAttributeName="NetworkName" 
converterClassName="com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.conver
ter.PropertyValueConverterToUpperCase"/>
   </reconciliationData>
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For example:

In this example, the reconciliation rule follows this format: 
host.host_hostname= NetworkName and ip.ip_address= NetworkAddress.

The logical operator OR can contain several reconciliationAttribute and AND 
elements. In this case the reconciliation rule contains an OR operator 
between attributes and AND expressions. Since XML does not assure the 
order of elements, you should provide a priority attribute to each sub-
element of OR element type. The comparison between OR expressions is 
calculated by these priorities. 

For example:

<reconciliationData>
<AND>
                <reconciliationAttribute ucmdbAttributeName="host_hostname" 
serviceDeskAttributeName="NetworkName" 
converterClassName="com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.conver
ter.PropertyValueConverterToUpperCase"/>
                 <reconciliationAttribute ucmdbClassName=”ip” 
ucmdbAttributeName="ip_address" serviceDeskAttributeName="NetworkAddress" />

</AND>
   </reconciliationData>

<reconciliationData>
<OR>
                  <reconciliationAttribute ucmdbAttributeName="host_dnsname" 
serviceDeskAttributeName="NetworkDNSName" priority=”2” />
<AND priority=”1” >
                <reconciliationAttribute ucmdbAttributeName="host_hostname" 
serviceDeskAttributeName="NetworkName" 
converterClassName="com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.conver
ter.PropertyValueConverterToUpperCase"/>
                 <reconciliationAttribute ucmdbClassName=”ip” 
ucmdbAttributeName="ip_address" serviceDeskAttributeName="NetworkAddress" />

</AND>
</OR
   </reconciliationData>
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In this example the reconciliation rule follows this format: 
(host.host_dnsname= NetworkDNSName OR (host.host_hostname= 
NetworkName and ip.ip_address= NetworkAddress)). Since the AND element 
takes a priority attribute of value 1, the (host.host_hostname= 
NetworkName and ip.ip_address= NetworkAddress) condition is checked 
first. If the condition is satisfied, the reconciliation is run. If not, the 
.host_dnsname= NetworkDNSName condition is checked.

The additional sub-element of the reconciliationClassConfiguration element is 
classConnectorConfiguration. The classConnectorConfiguration element 
contains the configuration for a specific connector implementation for the 
current reconciliation CIT. This configuration should be wrapped by CDATA 
if it contains some special XML characters (for example, &amp; replacing &).

Changing the Reconciliation Rule of a CIT

 1 In serviceDeskConfiguration.xml, update the appropriate reconciliationData 
element with the new rule.

 2 Call to the JMX to reload the adapter: FCmdb Config Services > 
loadOrReloadCodeBaseForAdapterId, using the appropriate customer ID 
and ServiceDeskAdapter adapter ID. 

Reconciliation of a Host by ip_address or by host_name

To run reconciliation on a host by ip_address or host_name, place the 
following ReconciliationData element in the Adapter configuration file:

<reconciliationData>
     <OR>
         <reconciliationAttribute priority="1" ucmdbClassName="ip"    
ucmdbAttributeName="ip_address" serviceDeskAttributeName="NetworkAddress"/>
         <reconciliationAttribute priority="2" ucmdbClassName="host" 
ucmdbAttributeName="host_hostname" serviceDeskAttributeName="NetworkName" 
converterClassName="com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.conver
ter.PropertyValueConverterToUpperCase"/>
    </OR>
</reconciliationData>
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You should also change the value of the 
concreteMappingImplementationClass attribute of the 
reconciliationClassConfiguration element to:

Global Configuration

The third section of the Adapter configuration file contains the global 
configuration for the specific connector implementation. 

This configuration, globalConnectorConfig, should be wrapped by CDATA if 
it contains some special XML characters (for example, &amp; replacing &).

Adapter Deployment
This section describes a typical deployment of the Adapter.

This section includes the following topics:

 1 “Deploy the ServiceDesk Adapter” on page 401

 a “Extract the Adapter Implementation Files and Deploy the Package” on 
page 401

 b “Add a ServiceCenter/Service Manager External Data Source” on 
page 401

 c “Configure HP ServiceCenter 6.2” on page 401 (when connecting to 
HP ServiceCenter)

 d “Configure HP Service Manager 7.0” on page 404 (when connecting to 
HP Service Manager)

 2 “Add an Attribute to the ServiceCenter/Service Manager CIT” on page 406

 a “Add an Attribute to the Business Availability Center Model” on page 407

 b “Export Attributes from HP ServiceCenter by Changing the 
Configuration” on page 408 (when connecting to HP ServiceCenter)

 c “Export Attributes from HP Service Manager by Changing the 
Configuration” on page 410 (when connecting to HP Service Manager)

="com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.mapping.impl.HostIpMappin
gEngine"
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 d “Modify the Adapter Configuration File” on page 412

 e “Load the Changes” on page 413

Deploy the ServiceDesk Adapter

This section explains where to place the files needed for deployment.

Extract the Adapter Implementation Files and Deploy the Package

 1 Verify the location of the following folder and file:

➤ ServiceDeskAdapter

➤ serviceDeskAdapter.zip

 2 Move the serviceDeskAdapter.zip package to the following directory: 
<Business Availability Center root directory>\mam_lib\packages.

 3 Deploy the serviceDeskAdapter.zip package: Log in to Business Availability 
Center and access the Package Manager (Admin > Universal CMDB > 
Settings > Package Manager). Select the package and click the Deploy 
button.

For details on deploying packages, see “Deploy a Package” in Model 
Management.

 4 Move the ServiceDeskAdapter folder to the following directory:

<Business Availability Center root directory>\fcmdb\CodeBase

Add a ServiceCenter/Service Manager External Data Source

 1 In Business Availability Center, access the Federated CMDB window: Admin 
> Universal CMDB > Settings > Federated CMDB.

 2 Click the button to add a data store. In the Data Store dialog box that opens, 
choose the ServiceDeskAdapter and fill in the mandatory fields. 

For help with this dialog box, see “Data Store Dialog Box” on page 489.

 3 Continue to “Configure HP ServiceCenter 6.2” on page 401 or “Configure 
HP Service Manager 7.0” on page 404.

Configure HP ServiceCenter 6.2

If you are connecting to HP ServiceCenter, perform the following procedure.
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 1 Open HP ServiceCenter, then the ServiceCenter client.

 2 Display WSDL Configuration in the Navigator (Main Menu > Menu 
navigation > Toolkit):

 3 In the Name field, enter device and press Enter:
402



Chapter 12 • Federated CMDB
 4 Select the Data Policy tab and ensure that the network.name attribute is not 
empty (its value should be NetworkName). Change the value to false. Save 
your changes.

 5 Restart ServiceCenter: Select Start > Programs > ServiceCenter 6.2 > Server > 
Console to open the ServiceCenter Console. 

 6 Click Stop and then Start.

 7 Continue to “Add an Attribute to the Business Availability Center Model” 
on page 407.
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Configure HP Service Manager 7.0

If you are connecting to HP Service Manager, perform the following 
procedure.

 1 Open the HP Service Manager client.

 2 Display WSDL Configuration in the Navigator (Main Menu > Menu 
navigation > Tailoring):

 3 In the Object Name field, enter Device and press ENTER.
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 4 Select the Fields tab and ensure that the network.name attribute appears in 
the Field list with NetworkName as its caption. If this attribute does not 
appear in the Field list, add it and save your changes.

 5 To support Problem federation, access WSDL Configuration in the Navigator 
(Main Menu > Menu navigation > Tailoring) and enter Problem in the 
Object Name field. Press ENTER.
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 6 Click the Fields tab, add the following fields, and save your changes:

 7 Restart the HP Service Manager 7.00 Server service.

 8 Continue to “Add an Attribute to the Business Availability Center Model” 
on page 407.

Add an Attribute to the ServiceCenter/Service Manager CIT

This section explains how to retrieve additional data from 
ServiceCenter/Service Manager by adding an attribute.

Field Caption Type

id id

brief.description brief.description

status status

expected.resolution.time expected.resolution.time DateTimeType

category category

initial.impact initial.impact

severity severity

priority.code priority.code

assignment assignment

logical.name logical.name

affected.ci(ci.device.name) ci.device.name
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Add an Attribute to the Business Availability Center Model

 1 Add the new attribute to Business Availability Center: Edit the Incident CIT: 
Select Admin > Universal CMDB > Modeling > CI Type Manager. In View 
Explorer, select IT Process > IT Incident. Right click and choose Edit CIT.

 2 Select the Attribute tab and add the new attribute:

 3 Continue to “Export Attributes from HP ServiceCenter by Changing the 
Configuration” on page 408 or “Export Attributes from HP Service Manager 
by Changing the Configuration” on page 410.
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Export Attributes from HP ServiceCenter by Changing the 
Configuration

 1 In HP ServiceCenter, open the ServiceCenter client.

 2 Select Window > Open Perspective > Administration:

 3 Select Incident Management > All Open Incidents, and select one of the 
incidents you created.

Note: Verify that the value in the Class field is the one that you want to 
report to Business Availability Center.
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 4 Search for the value you entered in the Class field (that is, myclass), in the 
XML file displayed below. This is the CI name in ServiceCenter.

 5 Display WSDL Configuration in the Navigator (Main Menu > Menu 
navigation > Toolkit). Locate the Object Name field, enter Incident and press 
Enter.

 6 Select the Data Policy tab. Enter a name for the CI mentioned in the XML 
file (that is, class). Change the value to false. Save your changes.

 7 Restart ServiceCenter: Select Start > Programs > ServiceCenter 6.2 > Server > 
Console to open the ServiceCenter Console. 

 8 Click Stop and then Start.

 9 Continue to “Modify the Adapter Configuration File” on page 412.
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Export Attributes from HP Service Manager by Changing the 
Configuration

 1 In the HP Service Manager client, restore the bottom right pane by clicking 
the Restore button. Click the Detail Data tab.
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 2 Open one of the incidents you created: Select Incident Management > 
Search Incidents. Click the search button (you can filter the fields to limit 
the search).

Note: Verify that the value in the Class field is the one that you want to 
report to Business Availability Center.
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 3 Search for the value you entered in the Class field (that is, myclass), in the 
XML file displayed below. This is the CI name in Service Manager.

 4 Display WSDL Configuration in the Navigator (Main Menu > Menu 
Navigation > Tailoring). Locate the Object Name field, enter Incident and 
press ENTER.

 5 Select the Data Policy tab. 

 6 Select the Fields tab and ensure that the CI name mentioned in the XML file 
(that is, class) appears in the Field list with ClassName as its caption. If this 
attribute does not appear in the Field list, add it and save your changes.

 7 Restart the HP Service Manager 7.00 Server service.

 8 Continue to “Modify the Adapter Configuration File” on page 412.

Modify the Adapter Configuration File

 1 Edit the ServiceDeskConfiguration.xml file in

<Business Availability Center root directory\fcmdb\CodeBase
\ServiceDeskAdapter
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 2 Add the new attribute line under the Incident area: Locate the following 
marker:

 3 Add the following line:

where:

➤ ucmdbAttributeName="incident_class" is the value defined in the CI Type 
Manager

➤ ServiceDeskAttributeName="ClassName" is the valued defined in 
ServiceCenter/Service Manager

 4 Continue to “Load the Changes” on page 413.

Load the Changes

 1 Launch the Web browser and enter the following address:

where <machine name or IP address> is the machine on which Business 
Availability Center is installed.

Note: In the case of a distributed deployment, the machine name is the 
machine on which the Data Processing server is installed.

You may have to log in with the administrator’s user name and password.

 2 Click the Topaz > service=Fcmdb Config Services link.

 3 In the JMX MBEAN View page, locate the following operation: 
loadOrReloadCodeBaseForAdapterId().

<ucmdbClassConfiguration ucmdbClassName="it_incident">
<attributeMappings>

<attributeMapping ucmdbAttributeName="incident_class" 
ServiceDeskAttributeName="ClassName"/>

http://<machine name or IP address>:8080/jmx-console/
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 4 In the customerID field, enter 1. In the AdapterId field, enter the name of 
the Adapter folder (ServiceDeskAdapter). Click Invoke. 

The Database Adapter

This section includes the following topics:

➤ “Introduction” on page 414

➤ “Supported TQLs” on page 415

➤ “Reconciliation” on page 415

➤ “Hibernate as JPA Provider” on page 418

➤ “Limitations” on page 419

➤ “How To Verify That the Database Adapter Can Be Used” on page 421

➤ “Deployment” on page 423

➤ “Deployment Example” on page 425

➤ “The Configuration Files” on page 429

➤ “OOB Converters” on page 446

➤ “Configuration Examples” on page 449

➤ “External References” on page 463

Introduction
This section describes the generic database adapter functionality, usages, 
and deployment in HP Universal CMDB.

The purpose of this adapter is to enable integration with any kind of 
relational database and to run a federated TQL against the database.

This version of the database adapter implementation is based on a JPA (Java 
Persistence API) standard with the Hibernate ORM library as a provider.
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Supported TQLs
The TQL calculation (on the federated side) is based on the database TQL 
calculator and therefore several pattern definitions are not supported.  

TQL is supported by every graph as long as all the requested nodes appear in 
its definition.

The following limitations and features exist on the federated CMDB only:

➤ Subgraph is not supported

➤ Compound links are not supported

➤ Cycles or cycle parts on the federated side are not supported (the cycle 
includes the CMDB side)

➤ Function layout is not supported

➤ 0..0 cardinality is not supported

➤ The Joinf link is not supported

➤ Many conditions are supported, except for qualifier conditions

➤ To connect between two CIs, a link in the shape of a table/foreign key must 
exist in the federated database.

Reconciliation
Reconciliation is carried out as part of the TQL calculation on the adapter 
side. For this to occur, the CMDB side is mapped to a federated entity called 
multinode.
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Mapping. Each attribute on the CMDB side is mapped to a column on the 
federated side. 

Although mapping is done directly, transformation functions on the 
mapping data are also supported. You can add new functions through the 
Java code (for example, lowercase, uppercase). The purpose of these 
functions is to enable value conversions (values that are stored in the CMDB 
in one format and in the federated database in another format).

Note: To connect the CMDB and federated sides, an appropriate association 
must exist in the database. For details, see “How To Verify That the Database 
Adapter Can Be Used” on page 421.

Reconciliation with CMDB id is also supported.

Reconciliation rules are in the form of OR and AND conditions. You can 
define these rules on several different nodes (for example, host is identified 
by host_name from host AND/OR ip_address from ip).

The following options find a match:

➤ Ordered match. The reconciliation expression is read from left to right. Two 
OR sub-expressions are considered equal if they have values and they are 
equal. Two OR sub-expressions are considered not equal if both have values 
and they are not equal. For any other case there is no decision, and the next 
OR sub-expression is tested for equality. 

host_name OR ip_address. If both sides (CMDB and federated) have 
host_name and they are equal, the hosts are considered as equal. If both 
have host_name but they are not equal, the hosts are considered not equal 
without testing the ip_address. If one of the sides is missing host_name, the 
ip_address is checked.

➤ Regular match. If there is equality in one of the OR sub-expressions, both 
sides are considered equal.

host_name OR ip_address. If there is no match on host_name, ip_address is 
checked for equality.
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For complex reconciliations, where the reconciliation entity is modeled in 
the class model as several CITs with links (such as host), the mapping of a 
superset node includes all relevant attributes from all modeled CITs.

Note: As a result, there is a limitation that all reconciliation attributes in the 
external side should reside in tables that share the same primary key.

Another limitation states that the reconciliation TQL should have no more 
than two nodes. For example, the host > ticket TQL has a host on the CMDB 
side and a ticket on the federated side.

To reconcile the results, host_name must be retrieved from the host and/or 
ip_address must be retrieved from the IP address. A new mapping is made 
from this federated multinode host towards the database host table and 
from the ticket to the database ticket. In this case, the multinode is the 
superset of all attributes needed for reconciliation (host_name + ip_address).

If the host_name in the CMDB is in the format of *.m.com, a converter can 
be used from CMDB to the federated database, and vice versa, to convert 
these values.

The host_id column in the database ticket table is used to connect between 
the two entities (the defined association can also be made in a host table):

Note: Both tables must be part of the federated database and not the CMDB 
database.
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Hibernate as JPA Provider
Hibernate is an object-relational (OR) mapping tool, which enables 
mapping Java classes to tables over several types of relational databases 
(Oracle, Microsoft SQL Server, and so on). For details, see “Functional 
Limitations” on page 420.

In an elementary mapping, each Java class is mapped to a single table. More 
advanced mapping enables inheritance mapping (as can occur in the CMDB 
database).

Other supported features include mapping a class to several tables, support 
for collections, and associations of types one-to-one, one-to-many, and 
many-to-one. For details, see “Associations” on page 419.

For our purposes, there is no need to create Java classes. The mapping is 
defined from the CMDB class model CITs to the database tables.

Example of OR Mapping

1 CMDB Class to 1 Database Table

Class M1, with attributes A1, A2, and A3, is mapped to table 1 columns c1, 
c2, and c3. This means that any M1 instance has a matching raw in table 1.

1 CMDB Class to 2 Database Tables
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Inheritance

This case is used today in the CMDB, where each class has its own database 
table.

Associations

There are three types of associations: one-to-many, many-to-one and many-
to-many. To connect between the different database objects, one of these 
associations must be defined. These associations are defined by using a 
foreign key column (for the one-to-many case) or a mapping table (for the 
many-to-many case).

Usability

As the JPA schema is very rich, a streamlined XML file is provided to ease 
definitions.

Use case for using this XML file: Federated data is modeled into one 
federated class and this class has many-to-one relations to the non-federated 
CMDB class. In addition, there is only one possible relation type between 
the federated class and the non-federated class.

Limitations
Note the following limitations:

JPA Limitations

➤ All tables must have a primary key column.

➤ CMDB class attribute names must follow the JavaBeans naming convention 
(for example, names must start with lower case letters).
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➤ Two CIs that are connected with one link in the class model must have 
direct association in the database (for example, if host is connected to ticket 
there must be a foreign key or linkage table that connects them).

➤ Several tables that are mapped to the same CIT must share the same primary 
key table.

Functional Limitations

➤ Supported databases: Oracle, Microsoft SQL Server, MySQL.

➤ The creation of a manual link between the CMDB and federated objects is 
not allowed. To be able to define virtual links, a special relation logic must 
be defined (it can be based on properties of the federated class).

➤ Properties from the CI type list are not supported.  

➤ Inheritance on the database side is not supported. To add inheritance, map 
all the attributes for each class you use. For example, if the database is the 
CMDB database, you should map root, data, and CI attributes for each CIT.

➤ Using a class qualifier in a condition is not supported.

➤ Subgraphs are not supported.

➤ Compound links are not supported.

➤ The external CI CMDB id is composed from its primary key and not its key 
attributes.

➤ A column of type bytes cannot be used as a primary key column in 
Microsoft SQL Server.

➤ A discriminator is not supported.
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How To Verify That the Database Adapter Can Be Used
To validate that you can use the database adapter with your database, check 
the following:

➤ The reconciliation classes and their attributes (also known as multinodes) 
exist in the database. For example, if the reconciliation is run by host name, 
verify that there is a table that contains a column with host names. If the 
reconciliation is run according to host cmdb_id, verify that there is a column 
with CMDB IDs that matches the CMDB IDs of the hosts in the CMDB. For 
details on reconciliation, see “Reconciliation” on page 415.

➤ To correlate two CITs with a link, there must be correlation data between the 
CIT tables. The correlation can be either by a foreign key column or by a 
mapping table. For example, to correlate between host and ticket, there 
must be a column in the ticket table that contains the host ID, a column in 
the host table with the ticket ID that is connected to it, or a mapping table 
whose end1 is the host ID and end2 is the ticket ID. For details on 
correlation data, see “Hibernate as JPA Provider” on page 418.

ID HOST_NAME IP_ADDRESS

31 BABA 16.59.33.60

33 ext3.devlab.ad 16.59.59.116

46 LABM1MAM15 16.59.58.188

72 cert-3-j2ee 16.59.57.100

102 labm1sun03.devlab.ad 16.59.58.45

114 LABM2PCOE73 16.59.66.79

116 CUT 16.59.41.214

117 labm1hp4.devlab.ad 16.59.60.182
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The following table shows the foreign key HOST_ID column:

➤ Each CIT can be mapped to one or more tables. To map one CIT to more 
than one table, check that there is a primary table whose primary key exists 
in the other tables, and is a unique value column.

For example, a ticket is mapped to two tables: ticket1 and ticket2. The first 
table has columns c1 and c2 and the second table has columns c3 and c4. To 
enable them to be considered as one table, both must have the same 
primary key. Alternatively, the first table primary key can be a column in the 
second table.

HOST_ID CARD_ID CARD_TYPE CARD_NAME

2015 1 Serial Bus 
Controller

Intel ® 82801EB USB Universal Host 
Controller

3581 2 System Intel ® 631xESB/6321ESB/3100 
Chipset LPC

3581 3 Display ATI ES1000

3581 4 Base System 
Peripheral

HP ProLiant iLO 2 Legacy Support 
Function
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In the following example, the tables share the same primary key called 
CARD_ID:

Deployment

Deploying a New Adapter

 1 Create relevant CITs (to add to the CMDB class model).

 2 Add appropriate valid links (to add to the CMDB class model).

 3 Create an adapter definition XML file. Make sure to change the adapter ID 
to your adapter name. Place it inside a package under the adapter folder and 
deploy it. For details, see “Package Deployment” in Model Management.

 4 Copy the generic database adapter folder under the j2f\fcmdb\codebase 
folder and rename it to the name of your adapter (the adapter ID created in 
step 3).

CARD_ID CARD_TYPE CARD_NAME

1 Serial Bus Controller Intel ® 82801EB USB Universal Host 
Controller

2 System Intel ® 631xESB/6321ESB/3100 Chipset 
LPC

3 Display ATI ES1000

4 Base System 
Peripheral

HP ProLiant iLO 2 Legacy Support Function

CARD_ID CARD_VENDOR

1 Hewlett-Packard Company

2 (Standard USB Host Controller)

3 Hewlett-Packard Company

4 (Standard system devices)

5 Hewlett-Packard Company
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 5 Edit the configuration files under the <HP Universal CMDB root 
directory>\UCMDBServer\j2f\fcmdb\CodeBase\GenericDBAdapter\META
-INF folder (choose between a simplified XML and advanced configuration 
files). 

 6 In HP Universal CMDB, add an adapter: Fill in the database details and mark 
the CITs that you want to associate with the adapter. For details, see “Data 
Store Dialog Box” on page 489.

Note: Make sure that the URL field is in the format of: 
key1=value1;key2=value2;…

 a The keys can be dbtype, dbname, or sid.

 b The value of dbtype can be mysql, oracle, or sqlserver.

 c When defining a generic database adapter, you must add dbtype.

 d If you choose the oracle database type, you must add sid.

 e If you choose mysql and sqlserver, you must add dbname.

Adding CITs to an Existing Adapter

Perform the following procedure:

 1 Create relevant CITs. For details, see “Create a CI Type” in CI Attribute 
Customization.

 2 Add appropriate valid links.

 3 Update the configuration files under the <HP Universal CMDB root 
directory>\UCMDBServer\j2f\fcmdb\CodeBase\GenericDBAdapter\META
-INF folder with the new CITs.

 4 In HP Universal CMDB, edit the adapter: Mark the additional CITs that you 
want to associate with the adapter. For details, see “Data Store Dialog Box” 
on page 489.
424



Chapter 12 • Federated CMDB
Deployment Example
This example shows how to create a new adapter. This procedure is similar 
when updating an existing adapter.

To create an adapter:

 1 Create the relevant CITs: Add the host_card class with the definition:

<?xml version="1.0" encoding="UTF-8"?>
<!-- edited with XMLSPY v5 rel. 3 U (http://www.xmlspy.com) by Mercury (Mercury 
Interactive) -->
<Class class-name="host_card" display-name="Host Card" description="">
<Class-Qualifiers/>
<Class-Type>OBJECT</Class-Type>
<Derived-From class-name="hostresource"/>
<Attributes>

<Attribute name="card_class" display-name="Card Class" description="" 
type="string">

<Attribute-Qualifiers/>
</Attribute>
<Attribute name="card_vendor" display-name="Card Vendor" description="" 

type="string">
<Attribute-Qualifiers/>

</Attribute>
<Attribute name="card_name" display-name="Card Name" description="" 

type="string">
<Attribute-Qualifiers/>

</Attribute>
</Attributes>
<Attribute-Overrides>

<Attribute-Override name="display_label" is-partially-override="true">
<Attribute-Qualifiers>

<Attribute-Qualifier name="CALCULATED_ATTRIBUTE">
<Data-Items>

<Data-Item name="FUNCTION" 
type="string">card_name</Data-Item>

</Data-Items>
</Attribute-Qualifier>

</Attribute-Qualifiers>
</Attribute-Override>

</Attribute-Overrides>
</Class>
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 2 Add an appropriate valid link: the link is a contained CIT and connects the 
new host_card CIT and the other host:

 3 Create an adapter definition XML file. Make sure to change the adapter ID 
to your adapter name. Place it inside a package under the adapter folder and 
deploy it. In the following example, the adapter ID is EDDBAdapter. I put 
this XML file inside a package under adapter folder and deploy it:

<?xml version="1.0" encoding="UTF-8"?>
<!-- edited with XMLSPY v5 rel. 3 U (http://www.xmlspy.com) by Mercury (Mercury 
Interactive) -->
<Valid-Links>
<Valid-Link>

<Class-Ref class-name="contained"/>
<End1 class-name="host"/>
<End2 class-name="host_card"/>

</Valid-Link>
</Valid-Links>

<adapter-config adapter-id="EDDBAdapter">
<class-name>com.mercury.topaz.fcmdb.adapters.dbAdapter.DBAdapter</class-

name>
<adapter-capabilities>

<support-federated-query>
<supported-classes>

            </supported-classes>
<topology>

<pattern-topology>
                </pattern-topology>

</topology>
</support-federated-query>

</adapter-capabilities>
<fields-to-connect>

<field>host</field>
<field>port</field>
<field>url</field>

</fields-to-connect>
<default-mapping-

engine>com.mercury.topaz.fcmdb.adapters.dbAdapter.reconciliation.mapping_engine.
DBMappingEngine</default-mapping-engine>
</adapter-config>
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 4 Copy the generic database adapter folder under the <HP Universal CMDB 
root directory>\UCMDBServer\j2f\fcmdb\codebase folder. Rename the file 
to the name of your adapter (the adapter ID you created in step 3). In this 
case the folder under codebase is named EDDBAdapter.

 5 Edit the configuration files under the <HP Universal CMDB root 
directory>\UCMDBServer\j2f\fcmdb\CodeBase\GenericDBAdapter\META
-INF folder (choose between the simplified XML and advanced 
configuration files). In this case the simplified XML is used:

 6 In HP Universal CMDB, add an adapter: Fill in the database details and mark 
the CITs that you want to associate with the adapter. For details, see “Data 
Store Dialog Box” on page 489.

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xsi:noNamespaceSchemaLocation="../META-
CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-single-node>

<attribute cmdb-attribute-name="host_hostname" column-
name="Device_Name" from-cmdb-
converter="com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericE
numTransformer(generic-enum-transformer-example.xml)" to-cmdb-
converter="com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericE
numTransformer(generic-enum-transformer-example.xml)"/>

</reconciliation-by-single-node>
</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-

cmdb-class-name="host" link-class-name="contained">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-

column="Device_ID"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
</generic-db-adapter-config>
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In the following example, the EDDBAdapter is selected:
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Its supported CITs are associated with the adapter:

The Configuration Files
The following files exist under the <HP Universal CMDB root 
directory>\UCMDBServer\j2f\fcmdb\CodeBase\GenericDBAdapter\META
-INF folder:

General Configuration

➤ adapter.conf. The adapter configuration file. For details, see “The 
adapter.conf File” on page 430.
429



Chapter 12 • Federated CMDB
Advanced Configuration

➤ orm.xml. The OR mapping file in which you map between CMDB classes 
and database tables. For details, see “The orm.xml File” on page 438.

➤ reconciliation_rules.txt. Contains the reconciliation rules. For details, see 
“The reconciliation_rules.txt File” on page 443.

➤ transformations.txt. Transformations file in which you specify the 
converters to apply to convert from the CMDB value to the database value, 
and vice versa. For details, see “The transformations.txt File” on page 444.

Hibernate Configuration

➤ persistence.xml. Used to override out of the box hibernate configurations. 
For details, see “The persistence.xml File” on page 445.

Simple Configuration

➤ simplifiedConfiguration.xml. Configuration file that replaces orm.xml, 
transformations.txt, and reconciliation_rules.txt with less capabilities. For 
details, see “The simplifiedConfiguration.xml File” on page 431.

The adapter.conf File

This file contains the following settings:

➤ use.simplified.xml.config=false. true: uses simplifiedConfiguration.xml. 

Note: Usage of this file means that orm.xml, transformations.txt, and 
reconciliation_rules.txt are replaced with less capabilities.

➤ dal.ids.chunk.size=300. Do not change this value.

➤ dal.use.persistence.xml=false. true: the adapter reads the hibernate 
configuration from persistence.xml

Note: It is not recommended to override the hibernate configuration.
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The simplifiedConfiguration.xml File

This file is used for simple mapping of CMDB classes to database tables. The 
template for editing the file is located under the <HP Universal CMDB root 
directory>\UCMDBServer\j2f\fcmdb\CodeBase\GenericDBAdapter\META
-INF folder.

The XSD File
<?xml version="1.0" encoding="UTF-8"?>
<!-- edited with XMLSPY v5 rel. 3 U (http://www.xmlspy.com) by Nimrod (Mercury Interactive) -->
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" 
attributeFormDefault="unqualified">
<xs:element name="generic-db-adapter-config">

<xs:complexType>
<xs:sequence>

<xs:element ref="cmdb-class" maxOccurs="unbounded"/>
<xs:element ref="class" maxOccurs="unbounded"/>

</xs:sequence>
</xs:complexType>

</xs:element>
<xs:element name="class">

<xs:complexType>
<xs:sequence>

<xs:element ref="foreign-primary-key" maxOccurs="unbounded"/>
<xs:element ref="primary-key" maxOccurs="unbounded"/>
<xs:element ref="attribute" minOccurs="0" maxOccurs="unbounded"/>

</xs:sequence>
<xs:attribute name="cmdb-class-name" type="xs:string" use="required"/>
<xs:attribute name="default-table-name" type="xs:string" use="required"/>
<xs:attribute name="connected-cmdb-class-name" type="xs:string" use="required"/>
<xs:attribute name="link-class-name" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>
<xs:element name="reconciliation-by-single-node">

<xs:complexType>
<xs:choice>

<xs:element ref="attribute"/>
<xs:element name="or">

<xs:complexType>
<xs:choice minOccurs="2" maxOccurs="unbounded">

<xs:element name="and">
<xs:complexType>

<xs:sequence>
<xs:element ref="attribute" minOccurs="2" 

maxOccurs="unbounded"/>
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</xs:sequence>
</xs:complexType>

</xs:element>
<xs:element ref="attribute"/>

</xs:choice>
<xs:attribute name="is-ordered" type="xs:boolean" use="optional" 

default="false"/>
</xs:complexType>

</xs:element>
<xs:element name="and">

<xs:complexType>
<xs:sequence>

<xs:element ref="attribute" minOccurs="2" maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>
</xs:element>

</xs:choice>
</xs:complexType>

</xs:element>
<xs:element name="primary-key">

<xs:complexType>
<xs:attribute name="column-name" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>
<xs:element name="attribute">

<xs:complexType>
<xs:complexContent>

<xs:extension base="attribute-type"/>
</xs:complexContent>

</xs:complexType>
</xs:element>
<xs:complexType name="attribute-type">

<xs:attribute name="table-name" type="xs:string" use="optional"/>
<xs:attribute name="column-name" type="xs:string" use="required"/>
<xs:attribute name="cmdb-attribute-name" type="xs:string" use="required"/>
<xs:attribute name="from-cmdb-converter" type="xs:string" use="optional"/>
<xs:attribute name="to-cmdb-converter" type="xs:string" use="optional"/>
<xs:attribute name="ignore-case" type="xs:boolean" use="optional" default="false"/>

</xs:complexType>
<xs:complexType name="class-type"/>
<xs:element name="or">

<xs:complexType>
<xs:choice minOccurs="2" maxOccurs="unbounded">

<xs:element ref="and"/>
<xs:element ref="attribute"/>
<xs:element ref="connected-node-attribute"/>
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</xs:choice>
<xs:attribute name="is-ordered" type="xs:boolean" use="optional" default="false"/>

</xs:complexType>
</xs:element>
<xs:element name="and">

<xs:complexType>
<xs:choice minOccurs="2" maxOccurs="unbounded">

<xs:element ref="attribute"/>
<xs:element ref="connected-node-attribute"/>

</xs:choice>
</xs:complexType>

</xs:element>
<xs:element name="reconciliation-by-two-nodes">

<xs:complexType>
<xs:sequence>

<xs:choice>
<xs:element ref="attribute"/>
<xs:element ref="connected-node-attribute"/>
<xs:element ref="or"/>
<xs:element ref="and"/>

</xs:choice>
</xs:sequence>
<xs:attribute name="connected-node-cmdb-class-name" type="xs:string" use="required"/>
<xs:attribute name="cmdb-link-type" type="xs:string" use="required"/>
<xs:attribute name="link-direction" use="optional" default="main-to-connected">

<xs:simpleType>
<xs:restriction base="xs:string">

<xs:enumeration value="main-to-connected"/>
<xs:enumeration value="connected-to-main"/>

</xs:restriction>
</xs:simpleType>

</xs:attribute>
</xs:complexType>

</xs:element>
<xs:element name="connected-node-attribute" type="attribute-type"/>
<xs:element name="cmdb-class">

<xs:complexType>
<xs:sequence>

<xs:element ref="primary-key" maxOccurs="unbounded"/>
<xs:choice>

<xs:element ref="reconciliation-by-single-node"/>
<xs:element ref="reconciliation-by-two-nodes"/>

</xs:choice>
</xs:sequence>
<xs:attribute name="cmdb-class-name" type="xs:string" use="required"/>
<xs:attribute name="default-table-name" type="xs:string" use="required"/>
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</xs:complexType>
</xs:element>
<xs:element name="foreign-primary-key">

<xs:complexType>
<xs:attribute name="cmdb-class-primary-key-column" type="xs:string" use="required"/>
<xs:attribute name="column-name" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>

</xs:schema>

The Template

The cmdb-class-name property is the multinode type (the node to which 
federated classes connect in the TQL):

reconciliation-by-two-nodes. Reconciliation can be done using one node or 
two nodes. In this case example, reconciliation uses two nodes.

connected-node-cmdb-class-name. The second class type needed in the 
reconciliation TQL.

cmdb-link-type. The link type needed in the reconciliation TQL.

link-direction. The direction of the link in the reconciliation TQL (from host 
to ip or from ip to host):

The reconciliation expression is in the form of ORs and each OR ANDs. 

is-ordered. Determines if reconciliation is done in order form or by a regular 
OR comparison.

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="[table_name]">

<primary-key column-name="[column_name]"/>

<reconciliation-by-two-nodes connected-node-cmdb-class-name="ip" cmdb-link-
type="contained" link-direction="main-to-connected">

<or is-ordered="true">
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If the reconciliation property is from the main class (the multinode), use the 
attribute tag, otherwise use the connected-node-attribute tag.

ignore-case. true: when values are compared on both sides, case does not 
matter:

The column name is the name of the foreign key column (the column with 
values that point to the multinode primary key column).

If the multinode primary key column is composed of several columns, there 
needs to be several foreign key columns, one for each primary key column.

If there are few primary key columns, duplicate this column.

The from-cmdb-converter and to-cmdb-converter properties are Java classes 
that implement the following interfaces:

➤ com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.FcmdbDalTransfor
merFromExternalDB

➤ com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.FcmdbDalTransfor
merToExternalDB

Use these converters if the value in the CMDB and in the database are not 
the same. For example, the host name in the CMDB has the suffix mer.com.  

<attribute cmdb-attribute-name="host_hostname" column-
name="[column_name]" ignore-case="true"/>

<connected-node-attribute cmdb-attribute-name="ip_address" column-
name="[column_name]"/>

</or>
</reconciliation-by-two-nodes>

</cmdb-class>
<class cmdb-class-name="[cmdb_class_name]" default-table-

name="[default_table_name]" connected-cmdb-class-name="host" link-class-
name="container_f">

<foreign-primary-key column-name="[column_name]" cmdb-class-primary-key-
column="[column_name]"/>

<primary-key column-name="[column_name]"/>
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In this example GenericEnumTransformer is used to convert the enumerator 
according to the XML file that is written inside the parenthesis (generic-
enum-transformer-example.xml):

<attribute cmdb-attribute-name="[cmdb_attribute_name]" column-
name="[column_name]" from-cmdb-
converter="com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericE
numTransformer(generic-enum-transformer-example.xml)" to-cmdb-
converter="com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericE
numTransformer(generic-enum-transformer-example.xml)"/>

<attribute cmdb-attribute-name="[cmdb_attribute_name]" column-
name="[column_name]"/>

<attribute cmdb-attribute-name="[cmdb_attribute_name]" column-
name="[column_name]"/>
</class>

</generic-db-adapter-config>
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Example of Simple Mapping

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-two-nodes connected-node-cmdb-class-name="ip" cmdb-link-

type="contained">
<or>

<attribute cmdb-attribute-name="host_hostname" column-
name="Device_Name"/>

<connected-node-attribute cmdb-attribute-name="ip_address" column-
name="Device_PreferredIPAddress"/>

</or>
</reconciliation-by-two-nodes>

</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-

cmdb-class-name="host" link-class-name="contained">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-

column="Device_ID"/>
<primary-key column-name="Device_ID"/>
<primary-key column-name="hwBusesSupported_Seq"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
<class cmdb-class-name="sw_sub_component" default-table-

name="SWSubComponent" connected-cmdb-class-name="host" link-class-
name="contained">

<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-
column="Device_ID"/>

<primary-key column-name="Device_ID"/>
<primary-key column-name="Version_ID"/>
<attribute cmdb-attribute-name="installed_dir" column-

name="SWSubComponent_InstalledDirectory"/>
<attribute cmdb-attribute-name="license_required" column-

name="SWSubComponent_LicenceRequired"/>
<attribute cmdb-attribute-name="last_access_time" column-

name="SWSubComponent_LastAccessTimeStamp"/>
<attribute cmdb-attribute-name="last_access_time_string" column-

name="SWSubComponent_LastAccessTimeStamp"/>
</class>
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Limitations

➤ Can be used only to map one node TQLs (on the database side). For 
example, you can run a host > ticket and a ticket TQL. To bring the hierarchy 
of nodes from the database, you must use the advanced orm.xml file.

➤ Only one-to-many relations are supported. For example, you can bring one 
or more tickets on each host. You cannot bring tickets that belong to more 
than one host.

➤ You cannot connect the same class to different types of CMDB CITs. For 
example, if you define that ticket is connected to host, it cannot be 
connected to application as well.

The orm.xml File

This file is used for mapping CMDB CITs to database tables. A template to 
use for editing is located in the <HP Universal CMDB root 
directory>\UCMDBServer\j2f\fcmdb\CodeBase\GenericDBAdapter\META
-INF folder.

For details on naming conventions, see “Naming Conventions” on 
page 443.

<class cmdb-class-name="host_scsi_device" default-table-name="hwSCSIDevices" 
connected-cmdb-class-name="host" link-class-name="contained">

<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-
column="Device_ID"/>

<primary-key column-name="Device_ID"/>
<primary-key column-name="hwSCSIDevices_Seq"/>
<attribute cmdb-attribute-name="scsi_device_name" column-

name="hwSCSIDeviceName"/>
<attribute cmdb-attribute-name="scsi_device_vendor" column-

name="hwSCSIDeviceVendor"/>
<attribute cmdb-attribute-name="scsi_device_type" column-

name="hwSCSIDeviceType"/>
</class>

</generic-db-adapter-config>
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The Template

Do not change the package name.

entity. The CMDB CIT name. This is the multinode entity.

Make sure that name is the same as class and that class includes a 
generic_db_adapter. prefix.

Use a secondary table if the entity is mapped to more than one table.

Attributes with tag id are the primary key columns. Make sure that the 
naming convention for these primary key columns are idX (id1, id2, and so 
on) where X is the column index in the primary key.

Change only the column name of the primary key.

<?xml version="1.0" encoding="UTF-8"?>
<entity-mappings xmlns="http://java.sun.com/xml/ns/persistence/orm" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" version="1.0" 
xsi:schemaLocation="http://java.sun.com/xml/ns/persistence/orm 
http://java.sun.com/xml/ns/persistence/orm_1_0.xsd">
<description>Generic db adapter orm</description>

<package>generic_db_adapter</package>

<entity name="host" class="generic_db_adapter.host">
<table name="[table_name]"/>

<secondary-table name=""/>
<attributes>

<id name="id1">

<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>
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basic. Used to declare the CMDB attributes. Make sure to edit only name 
and column_name properties.

Note: The convention for multinode attribute names is 
className_attributeName. In this example, the class name is host and the 
attribute name is host_hostname.

The expression is located in the reconciliation_rules.txt file:

<basic name="host_host_hostname">
<column updatable="false" insertable="false" name="[column_name]"/>

</basic>
<basic name="ip_ip_address">

<column updatable="false" insertable="false" name="[column_name]"/>
</basic>

</attributes>
</entity>
<entity name="[cmdb_class_name]" 

class="generic_db_adapter.[cmdb_class_name]">
<table name="[default_table_name]"/>
<secondary-table name=""/>
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If there is more than one primary key column, add this tag. The convention 
is generic_db_adapter.IdClass[num of primary key 
columns]PK_[cmdb_class_name] 

The following example shows a CMDB attribute name with no prefix:

If you used the id-class tag, add this entity.

In this definition you declare which columns are the primary key columns:

<id-class class="generic_db_adapter.IdClass3PK_[cmdb_class_name]"/>
<attributes>

<id name="id1">
<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id2">

<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id3">

<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>

<basic name="[cmdb_attribute_name]">
<column updatable="false" insertable="false" name="[column_name]"/>

</basic>
<basic name="[cmdb_attribute_name]">

<column updatable="false" insertable="false" name="[column_name]"/>
</basic>
<basic name="[cmdb_attribute_name]">

<column updatable="false" insertable="false" name="[column_name]"/>
</basic>

</attributes>
</entity>
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id1, id2, and id3 must match the corresponding definitions in the entity 
that has this tag.

This is a link entity. The naming convention is 
end1Type_linkType_end2Type. In this example end1Type is host and the 
linkType is container_f.

The target entity is the entity that this property is pointing to. In this 
example, end1 is mapped to host entity.

many-to-one. Many links can be connected to one host.

join-column. The column that contains end1 IDs (the target entity IDs).

<entity class="generic_db_adapter.IdClass3PK_host_card" 
name="IdClass3PK_host_card">

<table name="[default_table_name]"/>
<attributes>

<id name="id1">
<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id2">

<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id3">

<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>
</attributes>

</entity>

<entity name="host_container_f_[cmdb_class_name]" 
class="generic_db_adapter.host_container_f_[cmdb_class_name]">

<table name="[default_table_name]"/>
<attributes>

<id name="id1">
<column updatable="false" insertable="false" name="[column_name]"/>
<generated-value strategy="TABLE"/>

</id>
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referenced-column-name. The column name in the target entity (host) that 
contain the IDs that are used in the join column.

one-to-one. One link can be connected to one [cmdb_class_name].

Naming Conventions

➤ In each entity, the class property must match the name property with the 
prefix of generic_db_adapter.

➤ Primary key columns must have names of the form idX where X = 1, 2, ..., 
according to the number of primary keys in the table.

➤ Attribute names in the multinode entity take the form 
className_attributeName.

➤ If an entity has more than one primary key column, there is a need to add 
an id class as separate entity. The name takes the form 
IdClassXPK_cmdbClassName where X is replaced with the number of 
primary key columns and className is replaced with the entity name with 
which this id class is associated.

➤ Entity names must match class names even as regards case.

➤ Attribute names must match class attributes names even as regards case.

➤ Link name takes the form end1Type_linkType_end2Type.

The reconciliation_rules.txt File

This file is used to configure the reconciliation rules.

<many-to-one target-entity="host" name="end1">
<join-column updatable="false" insertable="false" referenced-column-

name="[column_name]" name="[column_name]"/>
</many-to-one>

<one-to-one target-entity="[cmdb_class_name]" name="end2">
<join-column updatable="false" insertable="false" referenced-column-

name="" name="[column_name]"/>
</one-to-one>

</attributes>
</entity>

</entity-mappings>
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Each row in the file represents a rule. For example: 

The multinode is filled with the multinode name (the CMDB class name 
that is connected to the federated class in the TQL).

This expression includes the logic that decides whether two multinodes are 
equal (one multinode from the CMDB side and the other from the federated 
adapter side).

The expression is composed from ORs of ANDs.  

The convention regarding attribute names in the expression part is 
[className].[attributeName]. For example, attribute ip_address in the ip class 
is written ip.ip_address.

For an ordered match (if the first OR sub-expression returns an answer that 
the multinodes are not equal, the second OR sub-expression is not 
compared), then use ordered expression instead of expression.

Use the control sign (^) sign when you want to ignore case during a 
comparison.

The parameters end1_type, end2_type and link_type are used only if the 
reconciliation TQL contains two nodes and not just a multinode. In this 
case, the reconciliation TQL is end1_type > (link_type) > end2_type.

There is no need to add the relevant layout as it is taken from the 
expression.

The transformations.txt File

This file contains all the converter definitions.

The format is that each line contains a new definition.

multinode[host] expression[^host.host_hostname OR ip.ip_address] end1_type[host] 
end2_type[ip] link_type[contained]
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The Template

entity. The entity name as it appears in the orm.xml file.

attribute. The attribute name as it appears in the orm.xml file.

to_db_class. The full, qualified name of a class that implements the interface 
com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.FcmdbDalTran
sformerToExternalDB. The elements in the parenthesis are given to this class 
constructor. Use this converter to transform CMDB values to database 
values, for example, to append the suffix of .com to each host name.

from_db_class. The full, qualified name of a class that implements the 
com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform. 
FcmdbDalTransformerFromExternalDB interface. The elements in the 
parenthesis are given to this class constructor. Use this converter to 
transform database values to CMDB values, for example, to append the 
suffix of .com to each host name.

For details, see “OOB Converters” on page 446.

The persistence.xml File

This file is used to override the default hibernate settings and to add support 
in database types that are not out of the box (OOB database types are Oracle 
Server, Microsoft MSSQL Server, and MySQL).

If you need to support a new database type, make sure that you supply a 
connection pool provider (the default is c3p0) and a JDBC driver for your 
database (put the *.jar files in the adapter folder).

To see all available hibernate values that can be changed, check the 
org.hibernate.cfg.Environment class.

entity[[cmdb_class_name]] attribute[[cmdb_attribute_name]] 
to_db_class[com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericEnumTransformer(
generic-enum-transformer-example.xml)] 
from_db_class[com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericEnumTransform
er(generic-enum-transformer-example.xml)]
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Example of the persistence.xml File

OOB Converters

The GenericEnumTransformer

This transformer uses an XML file that is given as an input parameter.

The XML file maps between hard-coded CMDB values and database values 
(enums). If one of the values does not exist, you can choose to return the 
same value, return null, or throw an exception.

Use one XML mapping file for each entity attribute.

<persistence xmlns="http://java.sun.com/xml/ns/persistence" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://java.sun.com/xml/ns/persistence
    http://java.sun.com/xml/ns/persistence/persistence_1_0.xsd" version="1.0">
<!-- Don't change this value -->
<persistence-unit name="GenericDBAdapter">

<properties>
<!--  Don't change this value  -->
<property name="hibernate.archive.autodetection" value="class, hbm"/>
<!--The driver class name"/-->
<property name="hibernate.connection.driver_class" 

value="com.mercury.jdbc.MercOracleDriver"/>
<!--The connection url"/-->
<property name="hibernate.connection.url" 

value="jdbc:mercury:oracle://artist:1521;sid=cmdb2"/>
<!--DB login credentials"/-->
<property name="hibernate.connection.username" value="cmdb"/>
<property name="hibernate.connection.password" value="cmdb"/>
<!--connection pool properties"/-->
<property name="hibernate.c3p0.min_size" value="5"/>
<property name="hibernate.c3p0.max_size" value="20"/>
<property name="hibernate.c3p0.timeout" value="300"/>
<property name="hibernate.c3p0.max_statements" value="50"/>
<property name="hibernate.c3p0.idle_test_period" value="3000"/>
<!--The dialect to use-->
<property name="hibernate.dialect" 

value="org.hibernate.dialect.OracleDialect"/>
</properties>

</persistence-unit>
</persistence>
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Note: This converter can be used for both the to_db_class and from_db_class 
fields in the transformations.txt file.

The input file XSD
<?xml version="1.0" encoding="UTF-8"?>
<!-- edited with XMLSPY v5 rel. 3 U (http://www.xmlspy.com) by Nimrod (Mercury Interactive) -->
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" 
attributeFormDefault="unqualified">
<xs:element name="enum-transformer">

<xs:complexType>
<xs:sequence>

<xs:element ref="value" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="db-type" use="required">

<xs:simpleType>
<xs:restriction base="xs:string">

<xs:enumeration value="integer"/>
<xs:enumeration value="long"/>
<xs:enumeration value="float"/>
<xs:enumeration value="double"/>
<xs:enumeration value="boolean"/>
<xs:enumeration value="string"/>
<xs:enumeration value="date"/>
<xs:enumeration value="xml"/>
<xs:enumeration value="bytes"/>

</xs:restriction>
</xs:simpleType>

</xs:attribute>
<xs:attribute name="cmdb-type" use="required">

<xs:simpleType>
<xs:restriction base="xs:string">

<xs:enumeration value="integer"/>
<xs:enumeration value="long"/>
<xs:enumeration value="float"/>
<xs:enumeration value="double"/>
<xs:enumeration value="boolean"/>
<xs:enumeration value="string"/>
<xs:enumeration value="date"/>
<xs:enumeration value="xml"/>
<xs:enumeration value="bytes"/>

</xs:restriction>
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</xs:simpleType>
</xs:attribute>
<xs:attribute name="non-existing-value-action" use="required">

<xs:simpleType>
<xs:restriction base="xs:string">

<xs:enumeration value="return-null"/>
<xs:enumeration value="return-original"/>
<xs:enumeration value="throw-exception"/>

</xs:restriction>
</xs:simpleType>

</xs:attribute>
</xs:complexType>

</xs:element>
<xs:element name="value">

<xs:complexType>
<xs:attribute name="cmdb-value" type="xs:string" use="required"/>
<xs:attribute name="external-db-value" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>

</xs:schema>

Example of Transforming sys Value to System Value

In this example, sys value in the CMDB is transformed to value System and 
value System in the federated database is transformed to sys.

If the value does not exist in the XML file (for example, the string demo), the 
converter returns the same input value it receives.

The SuffixTransformer Converter

This converter is used to add or remove suffixes from the CMDB or 
Federated value.

<enum-transformer cmdb-type="string" db-type="string" non-existing-value-action="return-original" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:noNamespaceSchemaLocation="../META-
CONF/generic-enum-transformer.xsd">
<value cmdb-value="sys" external-db-value="System"/>

</enum-transformer>
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There are two implementations:

➤ com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.AdapterToC
mdbAddSuffixTransformer . Adds the suffix (given as input) when 
converting from federated value to CMDB value and removes the suffix 
when converting from CMDB value to federated value.

➤ com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.AdapterToC
mdbRemoveSuffixTransformer. Removes the suffix (given as input) when 
converting from federated value to CMDB value and adds the suffix when 
converting from CMDB value to federated value.

The BytesToString Transformer

This transformer is used to convert byte arrays from the CMDB side to their 
string representation on the Federated side.

The converter is: 
com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.CmdbToA
dapterBytesToStringTransformer.

Configuration Examples
Use case. A TQL is:

host > (container_f) > host_card 

where:

host_card is the federated entity

host is the CMDB entity

container_f is the link between them

The example is run against the ED database. ED hosts are kept in the Device 
table and host_card is kept in the hwCards table. In the following examples, 
host_card is always mapped in the same manner.

Example of a Single Node Reconciliation

In this example the reconciliation is according to the host_hostname 
property.
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simplifiedConfiguration Definition

The multinode is the host and it is emphasized by the special tag 
cmdb-class.

Advanced Definition

The orm.xml File

Pay attention to the addition of the link mapping. For details, see the 
definition section in “The orm.xml File” on page 438.

<?xml version="1.0" encoding="UTF-8"?>
<entity-mappings xmlns="http://java.sun.com/xml/ns/persistence/orm" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://java.sun.com/xml/ns/persistence/orm 
http://java.sun.com/xml/ns/persistence/orm_1_0.xsd" version="1.0">
<description>Generic db adapter orm</description>
<package>generic_db_adapter</package>
<entity class="generic_db_adapter.host" name="host">

<table name="Device"/>
<attributes>

<id name="id1">
<column name="Device_ID" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-single-node>

<or>
<attribute cmdb-attribute-name="host_hostname" column-name="Device_Name"/>

</or>
</reconciliation-by-single-node>

</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-cmdb-class-

name="host" link-class-name="container_f">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-column="Device_ID"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
</generic-db-adapter-config>
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</id>
<basic name="host_host_hostname">

<column name="Device_Name"/>
</basic>

</attributes>
</entity>
<entity class="generic_db_adapter.host_card" name="host_card">

<table name="hwCards"/>
<attributes>

<id name="id1">
<column name="hwCards_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<basic name="card_class">

<column name="hwCardClass" insertable="false" updatable="false"/>
</basic>
<basic name="card_vendor">

<column name="hwCardVendor" insertable="false" updatable="false"/>
</basic>
<basic name="card_name">

<column name="hwCardName" insertable="false" updatable="false"/>
</basic>

</attributes>
</entity>
<entity class="generic_db_adapter.host_container_f_host_card" name="host_container_f_host_card">

<table name="hwCards"/>
<attributes>

<id name="id1">
<column name="hwCards_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<many-to-one name="end1" target-entity="host">

<join-column name="Device_ID" insertable="false" updatable="false"/>
</many-to-one>
<one-to-one name="end2" target-entity="host_card">

<join-column name="hwCards_Seq" referenced-column-name="hwCards_Seq" 
insertable="false" updatable="false"/>

</one-to-one>
</attributes>

</entity>
</entity-mappings>
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The reconcilialtion_rules.txt File

For details, see “The reconciliation_rules.txt File” on page 443.

The transformation.txt File

This file remains empty as no values need to be converted in this example.

Two Nodes Reconciliation

In this example, reconciliation is done according to the host_hostname and 
ip_address properties with different variations.

The reconciliation TQL is host > (containd) > ip.  

multinode[host] expression[host.host_hostname]
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simplifiedConfiguration Definition

The reconciliation is host_hostname OR ip_address:

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-two-nodes connected-node-cmdb-class-name="ip" cmdb-link-

type="contained">
<or>

<attribute cmdb-attribute-name="host_hostname" column-
name="Device_Name"/>

<connected-node-attribute cmdb-attribute-name="ip_address" column-
name="Device_PreferredIPAddress"/>

</or>
</reconciliation-by-two-nodes>

</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-

cmdb-class-name="host" link-class-name="contained">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-

column="Device_ID"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
</generic-db-adapter-config>
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The reconciliation is host_hostname AND ip_address:

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-two-nodes connected-node-cmdb-class-name="ip" cmdb-link-

type="contained">
<and>

<attribute cmdb-attribute-name="host_hostname" column-
name="Device_Name"/>

<connected-node-attribute cmdb-attribute-name="ip_address" column-
name="Device_PreferredIPAddress"/>

</and>
</reconciliation-by-two-nodes>

</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-

cmdb-class-name="host" link-class-name="contained">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-

column="Device_ID"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
</generic-db-adapter-config>
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The reconciliation is ip_address:

Advanced Definition

The orm.xml File

Since the reconciliation expression is not defined in this file, the same 
version can be used for both OR and AND and for ip_address alone.

<?xml version="1.0" encoding="UTF-8"?>
<entity-mappings xmlns="http://java.sun.com/xml/ns/persistence/orm" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://java.sun.com/xml/ns/persistence/orm 
http://java.sun.com/xml/ns/persistence/orm_1_0.xsd" version="1.0">
<description>Generic db adapter orm</description>
<package>generic_db_adapter</package>
<entity class="generic_db_adapter.host" name="host">

<table name="Device"/>
<attributes>

<id name="id1">
<column name="Device_ID" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-two-nodes connected-node-cmdb-class-name="ip" cmdb-link-

type="contained">
<or>

<connected-node-attribute cmdb-attribute-name="ip_address" column-
name="Device_PreferredIPAddress"/>

</or>
</reconciliation-by-two-nodes>

</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-

cmdb-class-name="host" link-class-name="contained">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-

column="Device_ID"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
</generic-db-adapter-config>
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</id>
<basic name="host_host_hostname">

<column name="Device_Name"/>
</basic>
<basic name="ip_ip_address">

<column name="Device_PreferredIPAddress"/>
</basic>

</attributes>
</entity>
<entity class="generic_db_adapter.host_card" name="host_card">

<table name="hwCards"/>
<attributes>

<id name="id1">
<column name="hwCards_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<basic name="card_class">

<column name="hwCardClass" insertable="false" updatable="false"/>
</basic>
<basic name="card_vendor">

<column name="hwCardVendor" insertable="false" updatable="false"/>
</basic>
<basic name="card_name">

<column name="hwCardName" insertable="false" updatable="false"/>
</basic>

</attributes>
</entity>
<entity class="generic_db_adapter.host_container_f_host_card" name="host_container_f_host_card">

<table name="hwCards"/>
<attributes>

<id name="id1">
<column name="hwCards_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<many-to-one name="end1" target-entity="host">

<join-column name="Device_ID" insertable="false" updatable="false"/>
</many-to-one>
<one-to-one name="end2" target-entity="host_card">

<join-column name="hwCards_Seq" referenced-column-name="hwCards_Seq" 
insertable="false" updatable="false"/>

</one-to-one>
</attributes>

</entity>
</entity-mappings>
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The reconciliation_rules.txt File

For more information, see “The reconciliation_rules.txt File” on page 443.

The transformation.txt File

This file remains empty as no values need to be converted in this example.

Using a Primary Key that Contains More Than One Column

If the primary key is composed of more than one column, the following 
code is added to the XMLS definitions:

multinode[host] expression[ip.ip_address OR host.host_hostname] end1_type[host] 
end2_type[ip] link_type[contained]

multinode[host] expression[ip.ip_address AND host.host_hostname] end1_type[host] 
end2_type[ip] link_type[contained]

multinode[host] expression[ip.ip_address] end1_type[host] end2_type[ip] 
link_type[contained]
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simplifiedConfiguration Definition

There is more than one primary key tag and for each column there is a tag.

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-two-nodes connected-node-cmdb-class-name="ip" cmdb-link-

type="contained">
<or>

<attribute cmdb-attribute-name="host_hostname" column-
name="Device_Name"/>

<connected-node-attribute cmdb-attribute-name="ip_address" column-
name="Device_PreferredIPAddress"/>

</or>
</reconciliation-by-two-nodes>

</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-

cmdb-class-name="host" link-class-name="contained">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-

column="Device_ID"/>
<primary-key column-name="Device_ID"/>
<primary-key column-name="hwBusesSupported_Seq"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
</generic-db-adapter-config>
458



Chapter 12 • Federated CMDB
Advanced Definition

The orm.xml File

A new id entity is added that maps to the primary key columns. Entities that 
use this id entity must add a special tag.

If you use a foreign key for such a primary key, you need to map between 
each column in the foreign key to a column in the primary key. 

For details, see “The orm.xml File” on page 438.

<?xml version="1.0" encoding="UTF-8"?>
<entity-mappings xmlns="http://java.sun.com/xml/ns/persistence/orm" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://java.sun.com/xml/ns/persistence/orm 
http://java.sun.com/xml/ns/persistence/orm_1_0.xsd" version="1.0">
<description>Generic db adapter orm</description>
<package>generic_db_adapter</package>
<entity class="generic_db_adapter.host" name="host">

<table name="Device"/>
<attributes>

<id name="id1">
<column name="Device_ID" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<basic name="host_host_hostname">

<column name="Device_Name"/>
</basic>

</attributes>
</entity>
<entity class="generic_db_adapter.host_card" name="host_card">

<table name="hwCards"/>
<id-class class="generic_db_adapter.IdClass3PK_host_card"/>
<attributes>

<id name="id1">
<column name="Device_ID" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id2">

<column name="hwBusesSupported_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id3">

<column name="hwCards_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>
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</id>
<basic name="card_class">

<column name="hwCardClass" insertable="false" updatable="false"/>
</basic>
<basic name="card_vendor">

<column name="hwCardVendor" insertable="false" updatable="false"/>
</basic>
<basic name="card_name">

<column name="hwCardName" insertable="false" updatable="false"/>
</basic>

</attributes>
</entity>
<entity class="generic_db_adapter.IdClass3PK_host_card" name="IdClass3PK_host_card">

<table name="hwCards"/>
<attributes>

<id name="id1">
<column name="Device_ID" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id2">

<column name="hwBusesSupported_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id3">

<column name="hwCards_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
</attributes>

</entity>
<entity class="generic_db_adapter.host_contained_host_card" name="host_contained_host_card">

<table name="hwCards"/>
<id-class class="generic_db_adapter.IdClass3PK_host_card"/>
<attributes>

<id name="id1">
<column name="Device_ID" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id2">

<column name="hwBusesSupported_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<id name="id3">

<column name="hwCards_Seq" insertable="false" updatable="false"/>
<generated-value strategy="TABLE"/>

</id>
<many-to-one name="end1" target-entity="host">
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<join-column name="Device_ID" insertable="false" updatable="false"/>
</many-to-one>

<one-to-one name="end2" target-entity="host_card">
<join-column name="Device_ID" referenced-column-name="Device_ID" insertable="false" 

updatable="false"/>
<join-column name="hwBusesSupported_Seq" referenced-column-

name="hwBusesSupported_Seq" insertable="false" updatable="false"/>
<join-column name="hwCards_Seq" referenced-column-name="hwCards_Seq" 

insertable="false" updatable="false"/>
</one-to-one>

</attributes>
</entity>

</entity-mappings>

Using Transformations

In the following example, the generic enum transformer is converted from 
values 1, 2, 3 to values a, b, c respectively in the host_hostname column.

The XML mapping file is generic-enum-transformer-example.xsd.

<enum-transformer cmdb-type="string" db-type="string" non-existing-value-
action="return-original" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/generic-enum-transformer.xsd">
<value cmdb-value="1" external-db-value="a"/>
<value cmdb-value="2" external-db-value="b"/>
<value cmdb-value="3" external-db-value="c"/>

</enum-transformer>
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Advanced Definition

There is a change only to the transformation.txt file. Make sure that the 
attribute names and entity names are the same as in the orm.xml file.

<?xml version="1.0" encoding="UTF-8"?>
<generic-db-adapter-config xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="../META-CONF/simplifiedConfiguration.xsd">
<cmdb-class cmdb-class-name="host" default-table-name="Device">

<primary-key column-name="Device_ID"/>
<reconciliation-by-two-nodes connected-node-cmdb-class-name="ip" cmdb-link-

type="contained">
<or>

<attribute cmdb-attribute-name="host_hostname" column-
name="Device_Name" from-cmdb-
converter="com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericE
numTransformer(generic-enum-transformer-example.xml)" to-cmdb-
converter="com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.GenericE
numTransformer(generic-enum-transformer-example.xml)"/>

<connected-node-attribute cmdb-attribute-name="ip_address" column-
name="Device_PreferredIPAddress"/>

</or>
</reconciliation-by-two-nodes>

</cmdb-class>
<class cmdb-class-name="host_card" default-table-name="hwCards" connected-

cmdb-class-name="host" link-class-name="contained">
<foreign-primary-key column-name="Device_ID" cmdb-class-primary-key-

column="Device_ID"/>
<primary-key column-name="hwCards_Seq"/>
<attribute cmdb-attribute-name="card_class" column-name="hwCardClass"/>
<attribute cmdb-attribute-name="card_vendor" column-name="hwCardVendor"/>
<attribute cmdb-attribute-name="card_name" column-name="hwCardName"/>

</class>
</generic-db-adapter-config>

entity[host] attribute[host_host_hostname] 
to_db_class[com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.Generic
EnumTransformer(generic-enum-transformer-example.xml)] 
from_db_class[com.mercury.topaz.fcmdb.adapters.dbAdapter.dal.transform.impl.Gener
icEnumTransformer(generic-enum-transformer-example.xml)]
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External References
JPA spec: 
http://jcp.org/aboutJava/communityprocess/final/jsr220/index.html

The Federated Adapter

Note: 

➤ The term relationship is equivalent to the term link. 

➤ The term CI is equivalent to the term object.

➤ For a glossary of definitions and terms, see “Federated CMDB Reference” 
on page 502.

This section includes the following topics:

➤ “Introduction to Federation Framework” on page 463

➤ “Adapter and Mapping Interaction with Federation Framework” on 
page 466

➤ “Add an Adapter for a New External Data Store” on page 477

➤ “Adapter Capabilities” on page 486

Introduction to Federation Framework
The federated TQL (FTQL) provides two main capabilities: 

➤ Federation on the fly. All queries are run over original data stores and results 
are built on the fly in HP Universal CMDB.

➤ Data Replication. Replicates data (topological data and CI properties) from 
one data store to another.

Both action types require an adapter for each data store, which can provide 
the specific capabilities of the data store and retrieve and/or update the 
required data. Every request to the data store is made through its adapter.
463



Chapter 12 • Federated CMDB
Federation on the Fly

Federated TQL enables data retrieval from any external data store without 
replicating its data. 

A federated query uses adapters that represent external data stores, to create 
appropriate external relationships between different external data store CIs 
and UCMDB CIs. 

The following workflow illustrates federation on the fly:

 1 The Federation Framework splits Federated TQL (FTQL) into several 
subgraphs, where all nodes in a subgraph refer to the same data store. Each 
subgraph is connected to the other subgraphs by a virtual relationship (but 
contains no virtual relationships).

 2 After the FTQL is split into subgraphs, the Federation Framework calculates 
each subgraph's topology and connects two appropriate subgraphs by 
creating virtual relationships between the appropriate nodes. 
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 3 After the FTQL topology is calculated, the Federation Framework retrieves a 
layout for the topology result.

Data Replication

You may need to replicate data if you have several data stores with a large 
amount of data, and another data store that uses a view with data from 
these data stores. 

In data replication, data stores are divided into two categories: source and 
target. Data is retrieved from the source data store, and updated to the target 
data store. The replication is based on query names, which means that data 
synchronized between the source data store and target data store is retrieved 
by a query name in the source data store. For example, in HP Universal 
CMDB, the query name is the name of the TQL. However, in another data 
store the query name can be a code name that returns data. The adapter is 
designed to correctly handle the query name. 

Each query name in the source data store can be defined as an exclusive 
query. This means that the CIs and relationships in the query results are 
unique in the target, and there is no other query that can bring them to the 
target. The adapter of the source data store supports specific queries, and can 
retrieve the data from this data store. The adapter of the target data store 
enables the update of retrieved data on this data store.

The replication process contains the following steps:

 1 Get the topology result with signatures from the source data store.
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 2 Compare the new results with the previous results.

 3 Get a full layout (all CI properties) of CIs and relationships only for changed 
results.

 4 Update the target data store with the received full layout of CIs and 
relationships. If any CIs or relationships were deleted in the source data 
store and the query is exclusive, remove the CIs or relationships in the 
target data store as well.

Adapter and Mapping Interaction with Federation 
Framework
An adapter is an entity in the Federated CMDB that represents external data 
(data that is not saved in HP Universal CMDB). All interactions in federated 
flows with external data sources are performed through adapters. The 
Federation Framework interaction flow and adapter interfaces are different 
for replication and for FTQL. 

Adapter Life Cycle

An adapter instance is created for each external data store. The adapter 
begins its life cycle with the first action applied to it (such as, calculate TQL 
or retrieve/update data). When the start method is called, the adapter 
receives environmental information, such as the data store configuration, 
logger, and so on. The adapter life cycle ends when the data store is removed 
from the configuration, and the shutdown method is called. This means 
that the adapter is stateful and can contain the connection to the external 
data store if it is required.

Adapter Assist Methods

The adapter has several assist methods that help add external data store 
configurations. These methods are outside the adapter life cycle and create a 
new adapter each time the method is called.

➤ The first method tests the connection to the external data store for a given 
configuration. 

➤ The second method is relevant only for the source adapter and returns the 
supported queries for replication.
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➤ The third method is relevant only for FTQL and returns supported external 
classes by the external data store.

All these methods are used when you create new data store configurations.

Federation Framework Flow for FTQL

Federation Framework uses the Mapping Engine to calculate the FTQL. The 
Mapping Engine connects between CIs that are received from different data 
stores and are connected by virtual relationships. The Mapping Engine 
requests reconciliation data from the two data stores for mapping the end 
nodes of the virtual relationship. 

One end of the virtual relationship must refer to HP Universal CMDB. For 
the calculation of the two subgraphs, a virtual relationship can start from 
any end node.
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The following sequence diagram illustrates the interaction between the 
Federation Framework, HP Universal CMDB, the adapter, and the Mapping 
Engine. The FTQL in the example diagram has only one virtual relationship, 
so that only HP Universal CMDB and one external data store are involved in 
the FTQL. We assume that the calculation starts from HP Universal CMDB.

 1 The Federation Framework receives a call for a FTQL calculation.
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 2 The Federation Framework analyzes the pattern, finds the virtual 
relationship, and divides the original TQL into two sub-patterns–one for 
HP Universal CMDB and one for the external data store. 

 3 The Federation Framework requests the topology of the sub-TQL from 
HP Universal CMDB.

 4 After receiving the topology results, the Federation Framework calls the 
appropriate Mapping Engine for the current virtual relationship and receives 
reconciliation data. This reconciliation data defines what data is needed to 
reconcile between the reconciliation CIs and connects between the results of 
the two data stores, as follows:

➤ IdReconcilaitionData. Reconciliation is done by ID

➤ PropertyReconciliationData. Reconciliation is done by properties of 
one CI.

➤ TopologyReconciliationData. Reconciliation is done by topology (for 
example, to reconcile host CIs, the IP address of IP is required too).

 5 The Federation Framework requests reconciliation data for the CIs of the 
virtual relationship ends that were received in step 3 on page 469 from 
HP Universal CMDB.

 6 The Federation Framework calls the Mapping Engine to run the 
reconciliation data on an external data store. In this state, the Mapping 
Engine receives the the reconciliation objects from step 5 on page 469 as 
parameters. The Mapping Engine translates the received reconciliation 
object to the condition on the reconciliation data.

 7 The Federation Framework requests the topology of the sub-TQL with the 
definition of the required reconciliation data from the external data store. 

 8 The Federation Framework calls the Mapping Engine to connect between 
the received results. The Mapping Engine returns a map where External CI ID 
from the first data store (HP Universal CMDB in our case) is mapped to the 
External CI IDs from the second data store.

 9 For each mapping, the Federation Framework creates a virtual relationship.

 10 After the calculation of the FTQL results (only at the topology stage), the 
Federation Framework retrieves the original TQL layout for the resulting CIs 
and relationships from the appropriate data stores.
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Example for Federation Framework Flow for FTQL

In this example, the ServiceCenter data store is the external data store. Use 
case: the ability to see all open incidents on specific hosts. The host 
instances are stored in HP Universal CMDB, and the incident instances are 
stored in ServiceCenter. We assume that to connect the incident instances to 
the appropriate host, the host_name and ip_address properties of the host 
and IP are needed. These are reconciliation properties that identify the hosts 
from ServiceCenter in HP Universal CMDB.

The example workflow uses the following FTQL:

 1 After analyzing the pattern, the Federation Framework recognizes the virtual 
relationship between Host and Incident and splits the FTQL into two 
subgraphs:
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 2 The Federation Framework runs the HP Universal CMDB subgraph to 
request the topology, and receives the following results:

 3 The Federation Framework requests from the appropriate Mapping Engine 
the reconciliation data for the first data store (HP Universal CMDB) that 
contains the information to connect between received data from two data 
stores. The reconciliation data in this case is:
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 4 The Federation Framework creates one node topology query with Host node 
and ID conditions on it from the previous result (host_id in H1, H2, H3), and 
runs this query with required reconciliation data on HP Universal CMDB. 
The result includes Host CIs that are relevant to the ID condition and the 
appropriate reconciliation object for each CI:

 5 The reconciliation data for ServiceCenter should contain a condition for 
host_name and ip_address that is derived from the reconciliation objects 
received from HP Universal CMDB:
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 6 The Federation Framework runs the ServiceCenter subgraph with the 
reconciliation data to request the topology and appropriate reconciliation 
objects, and receives the following results: 

 7 The result after connection in Mapping Engine and creating virtual 
relationships is:

 8 The Federation Framework requests the original TQL layout for received 
instances from HP Universal CMDB and ServiceCenter.
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Federation Framework Flow for Replication

The following sequence diagram illustrates the interaction between 
Federation Framework and the source and target adapters in a replication 
flow:

 1 The Federation Framework receives the topology for the query result from 
the source adapter. The adapter recognizes the query by its name and runs it 
on the external data store. The topology result contains the ID and signature 
for each CI and relationship in the result. The ID is the logical ID that 
defines the CI as unique in the external data store. The signature should be 
modified if the CI or relationship is modified. 

 2 The Federation Framework uses signatures to compare the newly received 
topology query results with the saved ones, and to determine which CIs 
have changed.

 3 After the Federation Framework finds the CIs and relationships that have 
changed, it calls the source adapter with the IDs of the changed CIs and 
relationships as a parameter to retrieve their full layout.

 4 The Federation Framework sends the update to the target adapter. The target 
adapter updates the external data source it represents with the received data.

 5 After the update, the Federation Framework saves the last query result.
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Adapter Interfaces

Use the appropriate adapter interface for each adapter, as follows.

Adapter Interfaces for Replication

➤ SourceDataAdapter. Use for source adapters in replication jobs.

➤ TargetDataAdapter. Use for target adapters in replication jobs.

Adapter interfaces for FTQL

➤ PatternTopologyIdReconciliationDataAdapter. Use if the adapter supports a 
complex query (more than one node) and the reconciliation between data 
stores is done by ID. A complex query relates to the subgraph of the user 
query. This means that after the user query is split into subgraphs, each of 
the queries relates to one data store and the subgraph is a query with more 
than one federated node.

➤ PatternTopologyPropertyReconciliationDataAdapter. Use if the adapter 
supports a complex query (more than one node) and the reconciliation 
between data stores is done by one node properties. A complex query relates 
to the subgraph of the user query. This means that after the user query is 
split into subgraphs, each of them relates to one data store and the subgraph 
is a query with more than one federated node.

➤ PatternTopologyDataAdapter. Use if the adapter supports a complex query 
(more than one node) and the reconciliation between data stores is done by 
topology. A complex query relates to the subgraph of the user query. This 
means that after the user query is split into subgraphs, each of them relates 
to one data store and the subgraph is a query with more than one federated 
node.

➤ OneNodeTopologyIdReconciliationDataAdapter. Use if the adapter supports 
only a single-node TQL and the reconciliation between data stores is 
calculated by ID. A single-node query relates to the subgraph of the user 
query. This means that after the user query is split into subgraphs, each of 
them relates to one data store and the subgraph that relates to the adapter is 
a query with one federated node.
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➤ OneNodeTopologyPropertyReconciliationDataAdapter. Use if the adapter 
supports only a single-node TQL and the reconciliation between data stores 
is done by one CI properties. Single-node queries relate to the subgraph of 
the user query. This means that after the user query is split into subgraphs, 
each of them relates to one data store and the subgraph that relates to the 
adapter is a query with one federated node.

➤ OneNodeTopologyDataAdapter. Use if the adapter supports only a single-
node TQL and the reconciliation between data stores is done by topology. 
Single-node queries relate to the subgraph of the user query. This means that 
after the user query is split into subgraphs, each of them relates to one data 
store and the subgraph that relates to the adapter is a query with one 
federated node.

Note: All OneNode… interfaces are created for simplicity; you can always 
use the PatternTopology… interfaces.

➤ SortResultDataAdapter. Use if you can sort the result CIs in the external 
data store.

➤ FunctionalLayoutDataAdapter. Use if you can calculate the functional 
layout in the external data store. 
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Add an Adapter for a New External Data Store
To add a new adapter to support new external data store, do the following:

 1 Model supported adapter classes for CIs and relationships in the CMBD 
class model.

As an adapter developer, you should have knowledge of the hierarchy of the 
HP Universal CMDB CI types to understand how external classes are related 
to the HP Universal CMDB classes. You should model the external classes in 
the CMDB class model. You should add the definitions for new CI classes 
and their relations. You should define valid relationships in the CMDB class 
model for the valid relationships between adapter inner classes. The classes 
can be placed at any level of the CMDB class model tree. Modeling should 
be the same regardless of federation type (on the fly or replication). For 
details on adding new class definitions to the CMDB class model, see “CI 
Type Manager” in CI Attribute Customization.

 2 Define valid relationships for virtual relationships.

Note: This section is relevant only for the FTQL adapter.

Determine the relationship between your data and the HP Universal CMDB 
data, that is, define your virtual relationships. You can do this by adding a 
valid relationship, where one end of the relationship does not refer to your 
adapter supported classes. A valid relationship for a virtual relationship is 
different from a regular valid relationship only in that it has a qualifier that 
defines a Mapping Engine class implementation.
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In the following example of a valid relationship definition, the relation of 
type history_link between instances of type it_world to instances of type 
HistoryChange is valid. To connect between instances of these types the 
Federation Framework should use the HistoryMappingEngine 
implementation class:

If you have only one Mapping Engine implementation for all virtual 
relationships, you can define it in the adapter configuration and not as a 
qualifier in the valid relationship.

 3 Define an adapter configuration.

Add an XML adapter configuration file that contains the following details:

➤ Adapter ID. A unique ID for the adapter

➤ Adapter name. A fully-qualified Java implementation class name for the 
adapter

➤ Adapter capabilities. Defines the capabilities the adapter supports. For 
details, see “Adapter Capabilities” on page 486.

➤ Fields to connect. Defines the fields that the user must supply to connect 
to the external data store.

➤ Default mapping engine. Defines the default mapping engine for virtual 
relationships. Relevant only for FTQL-supported adapters.

See the schema folder for the schema of the adapter configuration.  

<Valid-Link>
        <Class-Ref class-name="history_link" />
        <End1 class-name="it_world" />
        <End2 class-name="HistoryChange" />
        <Valid-Link-Qualifiers>
            <Valid-Link-Qualifier name="EXTENDED_VALID_LINK">
                <Data-Items>
                    <Data-Item name="mapping_engine_class" type="string"> 
com.mercury.topaz.adapters.CmdbHistoryAdapter.HistoryMappingEngine
    </Data-Item>
                </Data-Items>
            </Valid-Link-Qualifier>
        </Valid-Link-Qualifiers>
    </Valid-Link>
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Example of an adapter configuration definition:

 4 Implement the Adapter.

Select the correct adapter implementation class according to its defined 
capabilities. The adapter implementation class implements the appropriate 
interfaces according to defined capabilities.

<adapter-config adapter-id="CmdbRmiAdapter">
    <class-name>com.mercury.topaz.adapters.cmdb.CmdbRmiAdapter</class-name>
    <adapter-capabilities>
        <support-federated-query>
            <supported-classes>
                <supported-class is-derived="true" all-attributes-supported="true" 
name="hostresource"/>
            </supported-classes>
            <topology>
                <pattern-topology>
                    <functional-layout/>
                </pattern-topology>
                <advanced-capabilities>
                    <calculated-attribute></calculated-attribute>
                </advanced-capabilities>
            </topology>
            <result>
                <sort-result/>
            </result>
        </support-federated-query>
        <support-replicatioin-data>
            <source/>
            <target/>
        </support-replicatioin-data>
    </adapter-capabilities>
    <fields-to-connect>
        <field>host</field>
        <field>customerId</field>
    </fields-to-connect>
    <default-mapping-
engine>com.mercury.topaz.adapters.cmdb.CmdbMappingEngine</default-mapping-
engine>
</adapter-config>
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 5 Implement the Mapping Engine.

If your adapter supports federated query, you should support a Mapping 
Engine implementation for each virtual relationship. The implementation 
class should implement the Mapping Engine interface. 

 6 Add jars required for implementation to the class path.

To implement your classes, add the following classes to your class path:

➤ federation_api.jar

 7 Deploy the adapter.

 a Deploy an adapter package. The package should contain the following 
entities:

➤ New CI type definition (optional):

Used only if adapter supports new CI types that do not yet exist in the 
UCMDB.

The new CI type definitions are located in the class folder inside the 
package.

➤ New data type definition (optional):

Used only if the new CI types require new data types. 

The new data type definitions are located in the typedef folder inside 
the package.

➤ New valid relationships definition (optional):

Used only if the adapter supports the federated TQL.

The new valid relationships definitions are located in the validlinks 
folder inside the package.

The virtual relationship is defined as a valid relationship and can 
include a data item named mapping_engine_class, which defines the 
mapping engine fully-qualified class name.

➤ Adapter configuration definition XML file should be located in the 
adapter folder inside the package.

➤ Descriptor. Defines the package definitions.
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 b Deploy your code:

➤ Create a class that implements all required adapter interfaces.

➤ Implement a mapping engine (if you are writing a federated query 
adapter).

➤ Put your compiled classes (normally a jar) together with all your based-
on *.jar files in the <HP Universal CMDB root directory>
\UCMDBServer\j2f\fcmdb\CodeBase\<adapter> folder. 

Note: The adapter id folder name has the same value as in the adapter 
configuration.

➤ If you create own configuration, you should also use the <HP Universal 
CMDB root directory>\UCMDBServer\j2f\fcmdb\CodeBase\
<adapter> folder as your root folder.

 8 Redeploy the adapter.

The adapter definitions and implementation may become altered as a result 
of external class definition, changes in adapter capabilities, or changes in 
implementation. If this happens, redeploy the definitions or 
implementations.

 a Redeploy an adapter package.

If your external classes definition or adapter definition were altered, 
create an updated adapter package and redeploy it using the package 
mechanism. For details, see “Package Deployment” in Model Management.

 b Redeploy your code.

If your implementation code or private configuration was altered, do the 
following:

➤ Create updated *.jar or configuration files, and place them in the 
<HP Universal CMDB root directory>\UCMDBServer\j2f\fcmdb
\CodeBase\<adapter id> folder.

➤ Call the next JMX with the appropriate customer ID and adapter ID: 
FCmdb Config Services > loadOrReloadCodeBaseForAdapterId.
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Example of Adding a New Adapter

This example illustrates how to add an adapter for ServiceCenter. 

 1 The relevant ServiceCenter entities are Incident, Problem, and RFC. For each 
entity, create the CIT definition. Decide where to place these definitions in 
the HP Universal CMDB class model hierarchy. The entities refer to 
IT processes, so it makes sense to put them under the IT Process CIT. 
Moreover, RFC refers to IT change, so put the RFC class definition under the 
IT Change CIT. There is no relationship between Incident, Problem, and RFC 
CITs, so do not add definitions for such relationships.

 2 Determine to which CITs in HP Universal CMDB you want to relate 
ServiceCenter entities. For the purpose of this example, the only relevant 
entity is Host. Add a valid relationship for each of the following pairs: [Host, 
Incident], [Host, Problem], [Host, RFC]. Each valid relationship should have 
a qualifier with the Mapping Engine implementation class name that 
supports connection between the ends of this relationship. It can be the 
same class for all three cases or three different classes, depending on your 
implementation. 

 3 Define the adapter configuration XML file.

 a Define the adapter ID. 

For this example, assume it is ServiceCenterAdapter and its class 
implementation is adapter.ServiceCenterAdapterImpl. The configuration 
adapter beginning looks like this:

 b Define adapter capabilities. 

➤ In this example, the adapter supports a federation query but not 
replication data. Therefore, its capabilities XML should contain the 
support-federated-query element but not support-replication-data. 

<adapter-config adapter-id=" ServiceCenterAdapter ">
<class-name> adapter.ServiceCenterAdapterImpl </class-name>
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➤ Add the supported classes with supported attribute conditions. 
Suppose all three classes have property status and the system supports 
only the equal condition for this attribute. The supported_classes 
element has the following definition:

➤ Define the topology the ServiceCenter adapter supports. Because there 
are no relationships between the ServiceCenter entities, it is sufficient 
that the ServiceCenter adapter support single-node topology. For 
simplicity's sake, assume that the ServiceCenter adapter has no 
advanced capabilities and cannot calculate the value of calculated 
attributes. The topology element definition is as follows:

 <supported-classes>
                <supported-class is-derived="true" all-attributes-supported="false" 
name="incident">

<supported-conditions>
                                <attribute-operators attribute-name="status">
                                    <operator> EQUEL </operator>
                                </attribute-operators>
                           </supported-conditions>
</supported-class>
<supported-class is-derived="true" all-attributes-supported="false" 
name="change">
<supported-conditions>
                       <attribute-operators attribute-name="status">
                             <operator> EQUEL </operator>
                            </attribute-operators>
                     </supported-conditions>
</supported-class>
<supported-class is-derived="true" all-attributes-supported="false" 
name="problem">
<supported-conditions>
                        <attribute-operators attribute-name="status">
                                    <operator>EQUEL</operator>
                                </attribute-operators>
                          </supported-conditions>
</supported-class>
            </supported-classes>

 <topology>
        <one-node-topolgy/ >
      </topology>
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➤ For simplicity's sake, assume that ServiceCenter does not support 
sorting. Therefore, the capability should not contain the element 
result.

 c Add the element that defines the information required for the 
ServiceCenter adapter to connect to ServiceCenter. Assume this includes 
host, port, and user. Because the password for ServiceCenter can be 
empty, do not define this field as required. However, the ServiceCenter 
adapter checks this field, and if a value exists, it uses the password value 
to connect. The fields-to-connect element has the following definition:

 <fields-to-connect>
        <field>host</field>
        <field>port</field>
        <field>user</field>
    </fields-to-connect>
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The configuration XML definition of the Service Desk adapter is complete. 
The following is the finished definition: 

<adapter-config adapter-id=" ServiceCenterAdapter ">
    <class-name> adapter.ServiceCenterAdapterImpl </class-name>
<adapter-capabilities>
<support-federated-query>
            <supported-classes>
                <supported-class is-derived="true" all-attributes-supported="false" 
name="incident">

<supported-conditions>
                                <attribute-operators attribute-name="status">
                                    <operator> EQUEL </operator>
                                </attribute-operators>
                           </supported-conditions>
</supported-class>
<supported-class is-derived="true" all-attributes-supported="false" name="change">
<supported-conditions>
                       <attribute-operators attribute-name="status">
                             <operator>EQUEL</operator>
                            </attribute-operators>
                     </supported-conditions>
</supported-class>
<supported-class is-derived="true" all-attributes-supported="false" name="problem">
<supported-conditions>
                        <attribute-operators attribute-name="status">
                                    <operator>EQUEL</operator>
                                </attribute-operators>
                          </supported-conditions>
</supported-class>
            </supported-classes>
<topology>
<one-node-topolgy/>

</topology>
</<support-federated-query>
</adapter-capabilities>
  <fields-to-connect>
       <field>host</field>
   <field>port</field>
       <field>user</field>
</fields-to-connect>
</adapter-config>
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 4 Write implementations for the ServiceCenter adapter and Mapping Engine. 
The Mapping Engine implementation should implement the MappingEngine 
interface. The ServiceCenter adapter should implement the 
OneNodeTopologyDataAdapter interface according to its capabilities and the 
fact that the reconciliation is done by topology.

Adapter Capabilities

➤ Support federated query. Included in adapter capabilities if the adapter 
implementation supports FTQL. Federated query capabilities include:

Supported classes. Defines the supported classes in the federated query. The 
supported class definition includes supported class name, whether derived 
classes of this class are also supported, and the possible condition operations 
for class attributes. If derived classes are supported, the condition operation 
for class attributes is also derived. You can ignore definition of supported 
classes in adapter capabilities configuration by implementing the 
getSupportedClasses method of the FTqlDataAdapter interface. This might 
be useful if your supported classes or supported attribute condition 
operators can be changed dynamically.

Topology. Defines whether pattern topology or single-node topology is 
supported, and the federated TQL advanced capabilities. 

Result. Defines whether the adapter can sort the resulting CIs.

➤ Support replication data. Included in adapter capabilities if the adapter 
implementation supports data replication. Next capabilities are part of 
replication capabilities:

➤ Source. Defines that the adapter can be used in a replication job as source.

➤ Target. Defines that the adapter can be used in a replication job as target.
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View KPIs in External Applications

You can retrieve the status and value of HP Business Availability Center KPIs 
when working in an external application. You can view the results in your 
application, or you can use the results in calculations, statistics, and so on.

 1 Create an Adapter Instance
In HP Business Availability Center, in the Data Store, create an adapter 
instance with the BACKPIsAdapter. In the second stage, choose the Real 
Time KPI CIT. For details, see “Data Store Dialog Box” on page 489. 

 2 View the Attributes in the CIT Manager
The following attributes are used by the Real Time KPI CIT:

➤ kpi_name. The name of the KPI, e.g., Availability, Performance. 

➤ kp_source. The origin of the KPIs, e.g., HP Business Availability Center. 

➤ numeric_value. The numeric value of the KPI as calculated by the KPI 
business logic rule. (This value is optional.) 

➤ status. The status of the KPI as calculated by the business logic rule (can be 
one of the following values: OK, WARNING, MINOR, MAJOR, CRITICAL, 
NONE). 

➤ value_units. The measurement unit of the NumericValue field. (This value is 
optional.) 

 3 Create a TQL
Create a TQL using the Real Time KPI CIT. For details, see “Define a TQL 
Query” on page 267. 

 4 Consume KPIs in External Application
Using the API of your external application, send a query to run the relevant 
TQL in HP Business Availability Center, to retrieve the status and value of 
the federated KPIs.

Reference
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Federated UCMDB User Interface

This section describes:

 ➤  Data Store Dialog Box on page 489

 ➤  Data Stores Tab on page 495

 ➤  Federated CMDB Window on page 497

 ➤  Replication Job Dialog Box on page 497

 ➤  Replication Job Statistics on page 498

 ➤  Replication Jobs Tab on page 500
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Data Store Dialog Box

Data Store Properties Dialog Box

Description Enables you to configure an adapter that accesses external 
data sources.

To access: Admin > Universal CMDB > Settings > Federated 
CMDB > Data Stores tab > click Add.

Important 
Information

Mandatory fields are labeled in red.

Included in Tasks “Work with Federated Data” on page 390

Wizard Map Depending on the adapter’s function, use one of the 
following workflows to define a data store:

➤ If the adapter supports federated replication only and can 
be used as a source, fill in the Data Store Properties dialog 
box and the Queries Supported by Adapter dialog box. 
Click Finish.

➤ If the adapter supports federated TQL queries only, fill in 
the Data Store Properties dialog box and the CITs 
Supported by Adapter dialog box. Click Finish.

➤ If the adapter supports both federated replication and 
federated queries, fill in the Data Store Properties dialog 
box, the CITs Supported by Adapter dialog box, and the 
Queries Supported by Adapter dialog box. Click Finish.

➤ If the adapter supports federated replication only and can 
be used as a target, fill in the Data Store Properties dialog 
box. Click Finish. 

Description Enables you to select the type of adapter, and to define the 
connection information for the external data store you are 
defining. 

Important 
Information

Mandatory fields are labeled in red.

Included in Tasks ➤ “Work with Federated Data” on page 390

➤ “View KPIs in External Applications” on page 487
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Adapter Choose the adapter to bring the external data from a data 
store that you configure. The following adapters are 
predefined:

➤ BACKPIsAdapter. Select to define an adapter that enables 
a user to create a FTQL to retrieve, in an external 
application, the status and values of KPIs that are 
connected to CIs. For details on the task, see “View KPIs 
in External Applications” on page 487.

➤ CmdbHistoryAdapter. Select to define an adapter that 
brings data from a CMDB History database. Note: the 
History Adapter does not support replication, that is, you 
cannot use this adapter to define a replication job (to 
bring data from one data store to another one).

➤ CmdbRmiAdapter. Select to define an adapter that uses an 
RMI API to bring data from an external CMDB data store. 
Note: This adapter supports federated replication only by 
default. To support federated queries, contact HP Software 
Support. 
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Adapter 

(cont’d)

➤ CmdbSoapAdapter. Select to define an adapter that uses a 
SOAP API to bring data from an external CMDB data 
store. Note: This adapter does not support federated 
queries and can be used only as a target in federated 
replication.

➤ ServiceDeskAdapter. Select to define an adapter that 
supports the retrieval of data from HP ServiceCenter and 
HP Service Manager. This adapter connects to, and 
receives data from, ServiceCenter/Service Manager using 
the Web Service API. For details on working with this 
adapter, see “The HP ServiceCenter/Service Manager 
Adapter” on page 391.

➤ GenericDBAdapter. Platform for configuring a database 
adapter that integrates with any type of relational 
database and enables running federated TQLs against the 
databases.

Customer ID For Business Availability Center, enter 1. For HP Software-as-
a-Service, enter the customer ID number.

Host Enter the name of the machine to which the adapter must 
connect.

For the BACKPIsAdapter, enter the name of the Business 
Availability Center Gateway server. 

Name Enter a name to identify the data store. The name must be 
unique in the Business Availability Center version.

GUI Element (A-Z) Description
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Next button Click to continue defining the adapter.

Note: If you did not test the connection, it is automatically 
tested when you click Next.

If the adapter does not support a federated query and 
replication as a source (that is, the adapter supports 
replication only as a target, for example, the SOAP adapter), 
the following message is displayed:

Click OK, then click Finish.

Password Enter the password needed to access the external data store 
to which you want to connect.

Port Enter the port through which you are accessing the external 
data store (if required). 

For the BACKPIsAdapter, enter the number of the RMI port. 
The default is 29601. 

Test connection Click to test that you have entered valid information.

URL Use this field to define a specific URL to connect to the 
external data store.

User Enter the user name needed to access the external data store 
to which you want to connect.

GUI Element (A-Z) Description
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CITs Supported by Adapter Dialog Box

Description Enables you to choose which CITs are to be supported by 
the data store. For example, if a federated TQL (FTQL) 
includes a node that represents a specific CIT, the instances 
of this CIT are accepted from this external data store.

Important 
Information

➤ This page is displayed when the selected adapter supports 
federated queries.

➤ A CIT can be used by one data store only. CITs that are 
already being used by a data store are marked as such. 
Hold the pointer over a CIT to display a tool tip with the 
name of the data store that is using the CIT:

Included in Tasks “Work with Federated Data” on page 390
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Queries Supported by Adapter Dialog Box

GUI Element (A-Z) Description

➤ Select/Unselect All. Click to select all CITs in the list and 
click again to clear all CITs.

➤ Expand All. Click to expand the list of CITs and display all 
levels.

➤ Collapse All. Click to collapse the list of CITs and display 
the top level only.

➤ Show Selected. Click to open the Supported CITs dialog 
box that displays a list of CITs in hierarchical format that 
are supported by the adapter.

<List of CITs> This list includes all CITs that are supported by the adapter.

When queried by an FTQL, the CITs you select here are 
configured to bring the data from this external data store.

Select the CITs to be supported by this data store.

For BACKPIsAdapter, select Real Time KPI. 

Description Enables you to choose which queries should be supported 
by this data store for data replication.

Important 
Information

This page is displayed when the adapter is selected that 
supports federated replication and can be used as a source.

Included in Tasks “Work with Federated Data” on page 390
494



Chapter 12 • Federated CMDB
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Data Stores Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

➤ Select/Unselect All. Click to select all queries in the list 
and click again to clear all queries.

➤ Switch Selection. Click to select all non-selected queries 
or to clear all selected queries.

➤ Show Selected Queries. Click to view a list of all selected 
queries.

<List of query 
names>

This list includes all queries that are supported by the 
adapter. During replication job configuration, queries you 
select here are visible.

Select the queries to be included in the configured data 
store.

Visible. The query is visible in the Replication Job dialog box 
for the current data store.

Description Enables you to create a data store.

To access: Admin > Universal CMDB > Settings > 
Federated CMDB > Data Stores tab. 

Included in Tasks “Work with Federated Data” on page 390

GUI Element (A-Z) Description

Add a data store.

Edit an existing data store.
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Delete a data store.

Synchronizes federation configuration, such as defined 
adapters, data stores, and replication jobs.

Filter the list to display only those data stores in which 
you are interested:

Click the Filter button to open the Customize Filter 
dialog box. Build a query by choosing a condition and a 
value.

To enter a regular expression, click the button and 
enter the text in the Editing dialog box.

Clear the filter to display all data stores.

Select to display or hide columns and to change the order 
of the columns in the table. Opens the Columns dialog 
box.

<List of Defined 
Adapters>

Name. The name you give to the data store.

Adapter. The type of adapter for this data store.

Host Name. The name of the host to which the adapter 
connects.

Port. The port to which the adapter connects.

<Right-click menu> Duplicate Data Store. Select to clone a data store. Give a 
new, unique name to the new store and make any 
changes as are necessary. 

GUI Element (A-Z) Description
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Federated CMDB Window

Replication Job Dialog Box

Description Enables you to define external data stores and create 
replication jobs.

To access: Admin > Universal CMDB > Settings > Federated 
CMDB. 

Important 
Information

➤ For details on creating Data Stores, see “Data Stores Tab” 
on page 495.

➤ For details on creating Replication Jobs, see “Replication 
Jobs Tab” on page 500.

Description Enables you to replicate data between two data stores.

To access: Admin > Universal CMDB > Settings > Federated 
CMDB > Replication Jobs. Click the Add button.

Important 
Information

For successful replication, if you use CMDB adapters for 
replication (SOAP or RMI), the CIT class model in the target 
(the machine to which the data is imported, to be federated) 
must be identical to the class model in the source (the 
machine from which the data is exported).  

Included in Tasks “Work with Federated Data” on page 390
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Replication Job Statistics

GUI Element (A-Z) Description

Name Enter a name to identify the replication job.

Replication Job 
Queries

➤ Active. Select to use this query in the replication job.

➤ Name. The query name.

➤ Description. The description of the query.

➤ Permit Deletion in Target. Permits deletion of CIs and 
relationships on the target machine if they have been 
deleted in the source query result.

Source Data Store The data store for the data that is to be brought over and 
replicated to the data on the target machine.

Only data stores that have adapters that support replication 
and can be used as a source are displayed here.

Target Data Store The data store to which the data that is brought in from the 
source machine should be replicated.

Only data stores that have adapters that support replication 
and can be used as a target are displayed here.

Description Enables you to view statistics for a selected replication job 
to verify whether replication is successful.

To access: Admin > Universal CMDB > Settings > 
Federated CMDB > Replication Jobs tab. Select a 
replication job and click the Statistics icon in the toolbar.

Important 
Information

Click a row to view error messages for a specific 
replication job.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Ad hoc Yes. The replication job was run by Scheduler or by the 
user clicking the Ad hoc icon in the Replication Jobs tab.

Full replication Yes. The user chose to bring all appropriate data in the 
source to the target, without taking the last run of the 
replication job into consideration.

Job Name Name given to the replication job.

Replication Job 
Statistics per Query

➤ Query Name. The name of the query that is used for 
replication.

➤ Status. Can be SUCCEEDED or FAILED. If the status is 
FAILED, click the query to display the Replication Job 
Error dialog box that contains the reason for the 
failure. For more detailed information, look at the 
fcmdb.synchronizer.log file, located in the <Business 
Availability Center root directory\fcmdb\ folder.

➤ Replication Start Time. The time the replication job 
started running replication for the current query.

➤ Replication Stop Time. The time the replication job 
stopped running replication for the current query.

➤ Updated. The number of CIs and relationships that 
were updated in the target data store during the last 
replication job.

➤ Added. The number of CIs and relationships that were 
added in the target data store during the last 
replication job.

➤ Removed. The number of CIs and relationships that 
were removed in the target data store during the last 
replication job. Note: The CIs and relationships are 
removed from the target only if Permit Deletion in 
Target is selected in the Replication Job definition.

➤ Has Error. Yes. Click to open the Replication Error 
dialog box that displays the reason for the failure.

Source Data Store The ID of the source data store.
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Replication Jobs Tab

Status Can be SUCCEEDED or FAILED.

Target Data Store The ID of the target data store.

Description Enables you to define the replication jobs that contain 
the source data store, target data store, and queries, 
whose results should be replicated.

To access: Admin > Universal CMDB > Settings > 
Federated CMDB > Replication Jobs tab. 

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to add a replication job. For details, see “Replication 
Job Dialog Box” on page 497.

Click to edit an existing replication job. For details, see 
“Replication Job Dialog Box” on page 497.

Click to delete a replication job.

Click to test that replication is successful:

➤ Ad hoc diff replication. The result from the source data 
store is compared to the result from the last run of the 
replication job; only changes are sent to the target 
data store.

➤ Ad hoc full replication. All appropriate data in the 
source is brought to the target, without taking the last 
run of the replication job into consideration.

Note: This feature is useful when testing a replication job 
as you are developing it. During production, you should 
use the Scheduler to run the replication job. For details, 
see “Scheduler User Interface” on page 378.

Click to view replication job statistics about the selected 
replication job. For details, see “Replication Job Statistics” 
on page 498.

Synchronizes federation configuration, such as defined 
adapters, data stores, and replication jobs.

Filter the list to display only those replication jobs in 
which you are interested: Click the Filter button to open 
the Customize Filter dialog box. Build a query by 
choosing a condition and a value.

To enter a regular expression, click the button and enter 
the expression in the Editing dialog box.

Clear the filter to display all replication jobs.
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Federated CMDB Reference

The following definitions are used in Federated CMDB (FCMDB).

Adapter. A component in FCMDB responsible for retrieving and updating 
data in a data store. The adapter is aware of how specific data in the data 
store is modeled and knows the vendor-specific protocol for communication 
with the data store.

Data Store. Any data storage system, such as CMDB, database, and so on, 
where external CIs and relations are located. 

External Class. A class defined in the HP Universal CMDB class model whose 
instances are stored in external data stores and not in HP Universal CMDB. 

Federated TQL (FTQL). A TQL that includes external CITs in its definition.

Mapping Engine. A component that identifies links between CIs from 
different data stores that have virtual relationships between them. The 
identification is performed by reconciling HP Universal CMDB CIs and 
external CIs.

Reconciliation. The process of resolving data from two or more sources, 
either by resolving to a common naming schema or resolving data overlap 
differences within the records to a single answer.

Select to display or hide columns and to change the order 
of the columns in the table. Opens the Columns dialog 
box.

<right-click menu> Duplicate Replication Job.  

Tasks Table Name. The name you give to the replication job.

Source Data Store. The ID of the source data store.

Target Data Store. The ID of the target data store.

Queries. The queries that are used for replication in this 
replication job.

GUI Element (A-Z) Description
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Signature. The state of properties in the CI. If changes are made to property 
values in a CI, the CI signature must also be changed. The CI signature helps 
detect whether a CI has changed without the need to retrieve and compare 
all CI properties. Both the CI and CI signature are provided by the 
appropriate adapter. The adapter is responsible for changing the CI signature 
when the CI properties are altered.

Virtual Relationship. A relationship between two graph nodes that come 
from different data stores. The instances of these relationships do not exist 
in any data store and are created during FTQL calculation.

Troubleshooting and Limitations

This section includes troubleshooting and limitations for the Federated 
CMDB functionality.

➤ When changes are made in View Manager and these changes affect the 
results of a TQL, federated CIs in the view are not updated. This is because 
federated TQLs are calculated ad-hoc only and are not updated when a view 
is recalculated. To update the federated CIs, select the view in View Explorer 
and click the Rebuild View button. (Note that the recalculation may take a 
long time.) For details, see “Browse Mode” in Model Management.

➤ When configuring a local UCMDB data store, if your RMI adapter also 
supports federated queries, do not choose CITs in the CITs Supported by 
Adapter dialog box. (You should add an adapter for the local UCMD data 
store only if you want to use it for replication jobs). 

➤ Do not choose a CIT to be supported by an external data store if instances of 
this CIT exist in the local UCMDB, as this can lead to state inconsistency. 
For example, if there are instances of the CPU CIT in the local UCMDB, you 
must not choose the CPU when defining an external data store, even if the 
selected adapter supports it. 

➤ When using the RMI adapter, the version of the CMDB running on the 
configured host must be the same as the version of the UCMDB.

➤ When configuring a replication job between two CMDBs, verify that the 
class model is the same in the two CMDBs.
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State Manager

This chapter provides information on State Manager.

This chapter includes:

Concepts

 ➤  State Manager Overview on page 505

Tasks

 ➤  Define an Attribute State on page 506

Reference

 ➤  State Manager User Interface on page 506
Concepts

State Manager Overview

A state is based on an Enumeration definition, which is designed to be used 
as a severity value list by states.

The State Manager contains two default states — Change and Operation. 
Each one is based on its own severity list. States are necessary for retrieving 
Correlation results in Topology View Application. For details, see “Topology 
View Application” on page 511. To retrieve Correlation results, you must 
create a Correlation rule in the Correlation Manager. A Correlation rule is 
based on a state that exists in the State Manager. For details, see “Correlation 
Manager” on page 167. You can use a default state, or if required, create one 
based on a severity list (Enumeration definition) that is more relevant to 
your needs. For details on creating Enumeration definitions, see 
“Create/Update List/Enumeration Definition Dialog Box” in CI Attribute 
Customization.
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Note: It is not recommended to define states without first consulting HP 
Software Support.

Tasks

Define an Attribute State

Enter a unique name and description for the state. Then select an 
Enumeration definition that can be used to define an attribute type. The 
Type Definition list displays the Enumeration definitions that are defined in 
the System Type Manager. For details, see “System Type Manager Dialog 
Box” in CI Attribute Customization.

You can also click the New Enumeration button to create a new 
Enumeration definition. For details, see “State Manager Dialog Box” on 
page 507.

Alternatively, you can create an Enumeration definition in the System Type 
Manager. The Enumeration definition you create in the System Type 
Manager appears in the State Manager.

Reference

State Manager User Interface

This section describes:

 ➤  State Manager Dialog Box on page 507
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State Manager Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a state based on a severity list 
(Enumeration definition).

To access: Admin > Universal CMDB > Settings > State 
Manager. 

Important 
Information

➤ The Change and Operation states are default states 
that cannot be edited.

➤ It is not recommended to define states without first 
consulting with HP Software Support. 

Included in Tasks “Define an Attribute State” on page 506

Useful Links “Enumeration Definition” on page 39

GUI Element (A-Z) Description

Add an attribute state.

Delete an attribute state.

Create an Enumeration definition. Opens the Create 
Enumeration Definition dialog box. For details, see 
“Create/Update List/Enumeration Definition Dialog Box” 
in CI Attribute Customization.

Description (Optional) Click in the row and enter a description of the 
state.

Name Click in the row and enter a unique name for the state.

Type Definition Click in the box to display a list of the Enumeration 
definitions that can be used to define an attribute type. 
Select the required Enumeration definition or create one 
that is more relevant to your needs.

Note: The Type Definition list only displays the 
Enumeration definitions (and not List definitions) that 
are defined in the System Type Manager.
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Topology View Application

This chapter provides information on the Topology View application.

This chapter includes:

Concepts

 ➤  Topology View Overview on page 512

Tasks

 ➤  Retrieve Correlation Results - Scenario on page 512

 ➤  Take a Snapshot of a View on page 521

 ➤  Print and Save a Topology Map to File on page 522

Reference

 ➤  Topology View Application User Interface on page 522
Concepts
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Topology View Overview

Topology View displays the CIs of the currently selected view in graphical 
format. Topology View includes the same functionality as IT Universe 
Manager, however their context menu options differ. For information on 
the Topology Map, see “Topology Map” on page 627.

The following tasks represent the basic functionality of the Topology View 
application:

➤ Get Correlation results. Topology View enables you to run the Correlation 
rules you defined for that view to simulate how certain defined changes 
impact your system, and to discover the root causes of the changes. For 
more information about Correlation rules, see “Correlation Manager 
Overview” on page 167. You can run the Correlation rule you defined in the 
Correlation Manager. For details, see “Retrieve Correlation Results - 
Scenario” on page 512.

➤ Take a snapshot of a view. HP Business Availability Center enables you to 
display the status of a view in one snapshot by comparison with its status 
taken at a different time. For details on how to take snapshots, see “Take a 
Snapshot of a View” on page 521.

Tasks

Retrieve Correlation Results - Scenario

Correlation Manager enables you to create a Correlation rule that allows you 
to simulate the impact certain infrastructure changes have on your system. 
The results of the Correlation rule are displayed in the Topology View 
application. The Correlation results in this task describes how a change in 
CPU usage affects the Host node to which it is connected.

Note: To retrieve the required Correlation results, you must follow each step 
in this task.
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This task includes the following steps:

➤ “Create an Enumeration Definition” on page 513

➤ “Define a State” on page 514

➤ “Define a Correlation TQL Query” on page 515

➤ “Define a Correlation Rule” on page 516

➤ “Create a TQL of the Type View in Query Manager” on page 518

➤ “Create a View in View Manager” on page 518

➤ “Get Correlation Results” on page 518

 1 Create an Enumeration Definition
To retrieve Correlation results, you must create a Correlation rule in the 
Correlation Manager. A Correlation rule is based on a state that exists in the 
State Manager (for details, see “State Manager” on page 505). 

Note: This step is optional. You can use the default Enumeration definitions 
that appear in the System Type Manager.

A state is based on an Enumeration definition. Enumerations are designed to 
be used as severity value lists by states. You can either base a state on an 
existing Enumeration definition in the State Manager or, if required, create 
one by clicking the New Enumeration button. For details on creating 
Enumeration definitions, see “Create/Update List/Enumeration Definition 
Dialog Box” in CI Attribute Customization.

Note: Alternatively, you can create an Enumeration definition in the System 
Type Manager. For details, see “System Type Manager” in CI Attribute 
Customization. The Enumeration definition you create appears in the State 
Manager.
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Example

Select Admin > Universal CMDB > Settings > State Manager to open the 
State Manager. In the bottom-right corner, click the New Enumeration 
button to open the Create Enumeration Definition dialog box.

The following Enumeration definition creates a severity list that represents 
CPU usage of 10%, 20%, and 50%.

 2 Define a State
When you create a Correlation Rule, you select the state on which the 
Correlation condition is based. The State Manager contains two default 
states — Change and Operation. Each one is based on its own severity list. 
You can use a default state, or if required, create one based on a severity list 
(Enumeration definition) that is more relevant to your needs.

Note: This step is optional. You can use the default State that appear in the 
State Manager.
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To define a new state, select Admin > Universal CMDB > Settings > State 
Manager to open the State Manager. For details on defining a new state, see 
“State Manager Dialog Box” on page 507.

Example

A new state called cpu_usage is defined in the State Manager. Its Type 
Definition is based on the Enumeration definition called cpu_usage defined 
in the previous task.

 3 Define a Correlation TQL Query 
To define a Correlation TQL query, you need to create a Correlation rule and 
then add then add the TQL nodes and relationships that define the query.

To create a Correlation TQL query, select Admin > Universal CMDB > 
Modeling > Correlation Manager. For details about how to add nodes and 
relationships to a query, see “Add Nodes and Relationships to a TQL Query” 
on page 268.
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Example

In this Correlation TQL query, a CPU and a Host node are linked by a 
Container Link relationship.

 4 Define a Correlation Rule
When you define a Correlation rule, you must specify the required causal 
relationship between the nodes. Define one node as the trigger, or the node 
that represents the changes you want to make to the system, and another 
node as the one that is affected. 

Right-click the node you want to define as the trigger node and select Define 
Affected to open the Affected Nodes dialog box. In the Affected Nodes 
dialog box, select the node you want the trigger node to affect. Then click 
the Add button to open the Correlation Definition dialog box to set 
conditions for defining affected nodes. For details about how to define a 
Correlation rule, see “Correlation Definition Dialog Box” on page 177. 

Example

The Conditions area in the Correlation Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Affected Severity area defines the severity of the Correlation impact on 
the affected node.
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The Correlation rule in this example states that when the CPU usage of the 
Host node to which the CPU node is connected does not equal 10%, the 
Host node is automatically assigned the 50% load status, which in this case, 
is the color red according to the severity list.

In the resulting TQL query, an upward arrow appears next to the node 
defined as the trigger node and a downward arrow appears next to the node 
defined as the affected node.
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 5 Create a TQL of the Type View in Query Manager
The Correlation TQL query created in the Correlation Manager appears in 
Query Manager as the type Correlation.

In Query Manager (select Admin > Universal CMDB > Modeling > Query 
Manager), right-click the query in the TQLs pane and save it as the type 
View. For details, see “Query Manager Window” on page 230.

 6 Create a View in View Manager
Create a view in View Manager (select Admin > Universal CMDB > Modeling 
> View Manager) based on the TQL query of the type View you created in 
Query Manager in the previous task. For details, see “Create New View/View 
Properties Dialog Box” on page 143.

 7 Get Correlation Results
Select Application > Universal CMDB > Topology View and select the 
required view in View Explorer. To get Correlation results, you need to run 
the Correlation rule on a CI instance in the topology map that is a trigger. 
Right-click a trigger CI and select Run Correlation to open the Run 
Correlation dialog box. For details on how to run a Correlation rule, see 
“Run Correlation Dialog Box” on page 524.

Important: In the State box, you must select the state you used to define the 
Correlation rule in the Correlation Definition dialog box. In the Triggers 
Severity box, you must choose a severity that is other than what you 
selected in the Value Comparison box in the Correlation Definition dialog 
box. For details, see “Correlation Definition Dialog Box” on page 177.
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Example

A TQL Correlation query is created containing a CPU and Host node 
connected by a Container Link relationship. The CPU node is defined as the 
trigger node and the Host node is defined as the affected node.

The following Correlation rule is defined for the query.

In Topology View, select the required view, right-click a CPU CI, and select 
Run Correlation to open the Run Correlation dialog box. In the State box, 
select cpu_usage, as this was the state on which the Correlation rule was 
based. The trigger severity selected is other than the one assigned to the 
trigger node in the Value Comparison box.
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To see results, click one of the following:

➤ Show in Views. This assigns a status to all the CIs in the view. Only the Host 
CI connected to the CPU CI (whose severity was changed), becomes affected 
and turns red because CPU usage of the Host node no longer equals 10%. 
According to the Correlation rule, the Host node is automatically assigned 
the 50% load status, which in this case, is the color red according to the 
severity list. If the other CIs were not affected, so they remain green (10% 
load according to the Enumeration definition).

The trigger CPU CI turns light olive because 20% load was assigned the color 
light olive in the Enumeration definition.
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➤ Show Map. A map appears in a separate window containing only the trigger 
CPU CI and the Host CI it affected. The relationship connecting the two CIs 
contains the name of the Correlation rule defined in the Correlation 
Manager. 

➤ Generate Map. Generates an Impact Analysis report that displays a list of 
CIs that are impacted in the system as a result of the simulated changes. For 
details, see “Run Correlation Dialog Box” on page 524.

Note: Optionally, you can generate an Impact Analysis report by building a 
URL that opens an Impact Analysis report directly in your browser. For 
details, see see “Generate an Impact Analysis Report Using a URL” in 
Reference Information. 

Take a Snapshot of a View

You can take a snapshot of a view in Topology View application, save it, and 
then compare snapshots of the same view taken at different times using 
Compare Snapshots in Application > Universal CMDB > Compliance > 
Compare Snapshots. For details on how to take a snapshot of a view, see 
“Save Snapshot Dialog Box” on page 527. For details on how to view actual 
differences in the compared views, see “Compare Snapshots Window” on 
page 544.
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Print and Save a Topology Map to File

You can print the content of any topology map and then save it to file. 
Before printing, it is recommended to define your print settings and arrange 
the contents of the topology map according to your requirements. For 
details on how to define print settings, see “Print Setup Dialog Box” on 
page 653. For details on how to preview the content of the topology map 
before printing see “Print Preview Dialog Box” on page 652. For details on 
how to print the content of a topology map, see “Print Dialog Box” on 
page 652. For details on how to save a topology map to file, see “Run 
Correlation Dialog Box” on page 524.

Reference

Topology View Application User Interface

This section describes:

 ➤  Correlation Rules Window on page 523

 ➤  Run Correlation Dialog Box on page 524

 ➤  Save Snapshot Dialog Box on page 527

 ➤  Topology View Window on page 528
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Correlation Rules Window

The Correlation Rules window includes the following elements (listed 
alphabetically):

Description Opens a window that displays the statuses of the trigger 
CI as well as all statuses of the CIs that are affected by it. 
The relationships in the map represent the Correlation 
rules. The name of the relationship is the name of the 
Correlation rule you defined in the Correlation Manager.

To access: In the Run Correlation Dialog box, click Show 
Map.

Important 
Information

➤ You can only see Correlation results if you defined a 
Correlation rule for that view in Correlation Manager. 
For details, see “Correlation Manager” on page 167.

➤ To view information about specific CIs that are 
triggered or affected by the Correlation rule, 
double-click the relationship connecting the CIs. A 
map is displayed.

Included in Tasks “Retrieve Correlation Results - Scenario” on page 512

GUI Element (A-Z) Description

<Relationship> The relationships represent the Correlation rule you 
defined in the Correlation Manager. For details, see 
“Correlation Definition Dialog Box” on page 177.

<The statuses and 
the colors that 
represent each one>

The statuses that appear and the colors that represent 
each status are the ones that are defined in the severity 
list for that state in the System Type Manager. For details, 
see “Create/Update List/Enumeration Definition Dialog 
Box” on page 41.
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Run Correlation Dialog Box

Description Enables you to run the Correlation rule you defined in 
Correlation Manager for that view.

You can:

➤ Display in a new window all the CIs that are affected 
by the trigger CI. The relationships in the map 
represent the Correlation rules. The name of the 
relationship is the name of the Correlation rule you 
defined in the Correlation Manager. For details, see 
“Show Map” on page 526.

➤ Simulate how the statuses of the affected CIs are 
impacted. For details, see “Show in Views” on 
page 525.

➤ Generate a report that displays a list of CIs that are 
impacted in the system as a result of the simulated 
changes. For details, see “Generate Report” on 
page 525.

To access: Select Application > Universal CMDB > 
Topology View. Right-click a trigger node in the Topology 
Map and select Run Correlation.

Important 
Information

This dialog only appears if a Correlation rule is defined 
for that view. For details, see “Correlation Manager” on 
page 167.

Included in Tasks “Retrieve Correlation Results - Scenario” on page 512
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The Run Correlation dialog box includes the following elements (listed 
alphabetically):

GUI Element (A-Z) Description

Generate Report Generates an Impact Analysis report, which displays 
information that is divided as follows:

➤ Impacted CIs by CIT. All the impacted CIs (the CIs that 
are impacted in the system as a result of the simulated 
changes), sorted by CIT.

➤ Impacted CIs by Application. All the impacted CIs that 
belong to a specific business service. For details, see 
“Link Nodes to Application CI” on page 134.

➤ Trigger CIs. The CIs that represent the changes you 
want to make to the system.

Notes:

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Troubleshooting 
and Limitations” in Reports. (If the default values do 
not suit your needs, and must be modified, contact 
Customer Support.) 

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reports.

Show in Views Simulates how the statuses of the affected CIs are 
impacted for the selected state. The Topology Map 
displays the statuses of the trigger CIs as well as all 
statuses of the CIs that are affected by it.

The Topology Map also displays the Correlation 
indicators:

➤ A trigger CI is marked by this  indicator.

➤ A CI that is both an affected and a trigger CI is marked 
by this  indicator.

➤ An affected CI is marked by this  indicator.

Note: The statuses that appear here and the colors that 
represent each status are defined in the severity list for 
that state in the System Type Manager. For details, see 
“Create/Update List/Enumeration Definition Dialog Box” 
on page 41.
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Show Map Enables you to select a Correlation rule, and then display 
in a new window, a simulation of all the CIs that are 
affected by the trigger CI for the selected state. If only one 
Correlation rule is defined for this CI, the Correlation 
Rules window is displayed directly. For more details, see 
“Correlation Rules Window” on page 523. 

The relationships in the map represent the Correlation 
rules and the name of the relationship is the name of the 
Correlation rule you defined in the Correlation Manager.

Note: Show Map enables you to view the results of 
multiple triggers.

State Select the required State. For details about States, see 
“State Manager” on page 505.

Triggers Severity Select the required severity. 

Note: The severity list was defined for the state in the 
System Type Manager. For details, see “System Type 
Manager” in CI Attribute Customization.

For example, you can create a Correlation rule in the 
Correlation Manager (see the “Correlation Definition 
Dialog Box” on page 177), that defines the severity of the 
trigger node as other than No Change. If you select a 
severity other than No Change, for example, Plan, the 
condition is met and the simulated changes in the system 
are triggered.

GUI Element (A-Z) Description
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Save Snapshot Dialog Box

The Save Snapshot dialog box includes the following elements (listed 
alphabetically):

Description Enables you to take a snapshot of a view and save it.

To access: Click the Save Snapshot button in View 
Explorer.

Important 
Information

You can compare snapshots of the same view taken at 
different times using Compare Snapshots in Application 
> Universal CMDB > Compliance > Compare Snapshots. 
For details, see “Compare Snapshots Window” on 
page 544.

Included in Tasks “Take a Snapshot of a View” on page 521

GUI Element (A-Z) Description

Description A description of the snapshot (optional).

Note A note about the snapshot (optional).

View Name The name of the view as it appears in View Explorer. This 
field cannot be edited.
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Topology View Window

Description Displays the CIs of the currently selected view in 
graphical format and enables you to run the Correlation 
rule you defined in the Correlation Manager.

To access: Select Application > Universal CMDB > 
Topology View.

Important 
Information

The Topology View window contains the following 
panes:

➤ View Explorer (CI Selector). Displays the CIs of a 
selected view. You can select the view from a 
drop–down list. For details, see “View Explorer” on 
page 615.

➤ Topology Map. Displays the CIs of a selected view.

➤ Information Pane. Displays properties and history for 
the selected CI.

Note: The Topology View window shares the same 
functionality as the IT Universe Manager topology map, 
with the exception of the context menu options and 
some toolbar options.

Included in Tasks “Retrieve Correlation Results - Scenario” on page 512

“Take a Snapshot of a View” on page 521

Useful Links “Save Snapshot Dialog Box” on page 527

“Set View Parameters/Set View Element Parameters Dialog 
Box” on page 155
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The Topology View window includes the following elements (listed 
alphabetically):

Context Menu

The Topology View window includes the following elements (listed 
alphabetically) available by right-clicking a CI in the View Explorer pane or 
the Topology Map:

GUI Element (A-Z) Description

<Node> The nodes in the topology map represent CIs.

Hold the pointer over a node to display its tooltip which 
describes the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, 
which describes the type of the relationship.

<Toolbar> For details, see “Toolbar Options” on page 654

GUI Element (A-Z) Description

CI History Displays the CI/Relationship History dialog box for the 
selected CI. For details, see “CI/Relationship History 
Dialog Box” on page 77.

Properties Displays the Properties dialog box for the selected CI. For 
details, see “Properties Dialog Box” on page 96.

Note: The Properties dialog box is not editable from the 
Topology View Application.

Run Correlation Enables you to run the Correlation rule you defined in 
the Correlation Manager. Displays the Run Correlation 
dialog box. For details, see “Correlation Manager” on 
page 167.

Note: You can only see Correlation results if you defined 
a Correlation rule for that view in Correlation Manager. 
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Show Impact Enables you to select a CI, which is defined by a 
Correlation rule as a root cause CI, and to display all the 
CIs that are affected by it, and their statuses, in a separate 
window.

This option appears only after the following has 
occurred:

➤ You defined a Correlation rule for the selected view in 
the Correlation Manager (for details, see “Correlation 
Manager” on page 167).

➤ You clicked Show in Views in the Run Correlation 
dialog box. 

➤ Correlation results appear in the Topology Map.

For example, suppose a Correlation rule is defined for an 
IP CI, which specifies that the rule affects hosts, ports, 
and client-servers that are linked to the IP.

By using the Show Impact option, you can display all CIs 
that are affected by the IP CI.

GUI Element (A-Z) Description
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Show Root Cause This option enables you to retrieve root cause 
information for CIs that are affected by a chain of 
Correlation rules. The output of Show Root Cause 
displays a logical map that describes a chain of 
trigger/affected CITs that affect the CI.

The root cause CI is displayed in a separate window. If 
only one Correlation rule is defined for this CI, the 
Correlation window is directly displayed.

This option appears only after the following has 
occurred:

➤ You defined a Correlation rule for the selected view in 
the Correlation Manager (for details see, “Correlation 
Manager” on page 167).

➤ You clicked Show in Views in the Run Correlation 
dialog box. 

➤ Correlation results appear in the Topology Map.

A window, as illustrated below, is displayed containing 
the root cause CI and all the other CITs in the Correlation 
rule chain.

Use the Show Root Cause option on the A CI to view, in 
one step, that the source of the failure is the agents CI. 
The CI that the arrow points to is the affected CI.

To view the information about specific CIs that are 
triggered or affected by the Correlation rule, double-click 
the relationship connecting the CIs. A map is displayed.

GUI Element (A-Z) Description
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CI Lifecycle

This chapter provides information on the main concepts and tasks of the CI 
Lifecycle application.

This chapter includes:

Concepts

 ➤  CI Lifecycle Overview on page 534

Tasks

 ➤  Generate CI Lifecycle Data and Filter the Results on page 534

Reference

 ➤  CI Lifecycle User Interface on page 535
Concepts
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CI Lifecycle Overview

The CI Lifecycle application enables you to view a list of CIs and 
relationships that are candidates for deletion by the aging mechanism. 
When the aging mechanism is enabled for a CI or relationship, it becomes 
marked for deletion if it is not accessed for a specified period of time (by 
default, 14 days). The CI or relationship is actually deleted after a fixed 
period of time since it was last accessed (by default, 28 days). You can set the 
time period before a CI becomes a candidate for deletion or before it is 
actually deleted for each CIT in the CIT Manager. For details regarding the 
aging mechanism, see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.  

Note: The aging mechanism is disabled by default.

The CI Lifecycle results include the Display Label, CI Type, Last Access Time, 
Actual Delete Time and Updated By information for each CI. For 
relationships, CI Lifecycle also displays the CIs at the two ends of the 
relationship. Once you have generated CI Lifecycle data, you can select the 
columns to be displayed and filter the results by any of the columns. You 
can also select specific CIs or relationships and postpone their deletion or 
mark them as deletion-proof. For details, see “CI Lifecycle Window” on 
page 537.

Tasks

Generate CI Lifecycle Data and Filter the Results

This task describes the steps to follow to generate CI lifecycle data and filter 
the results.

This task includes the following steps:

➤ “Generate CI Lifecycle Data” on page 535

➤ “Filter the CI Lifecycle Results” on page 535
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 1 Generate CI Lifecycle Data
To generate CI Lifecycle results, select either the CI tab or the relationship 
tab. Select the time period in which to search, using the drop-down 
calendars in the From and To fields, and click Generate. If no results are 
generated, try extending the time period further into the future. For details, 
see “CI Lifecycle Window” on page 537.

 2 Filter the CI Lifecycle Results
To filter the CI Lifecycle data, click the Filter button to open the Filter dialog 
box. For each column by which you want to filter, select a condition from 
the drop-down list and fill in the value column, either by entering a value, 
selecting from a drop-down list, or using the calendar. Click OK to apply 
your filter. 

To clear the filter and restore the original results, click the Clear button. For 
details, see “Filter Dialog Box” on page 540.

Reference

CI Lifecycle User Interface

This section describes:

 ➤  CI Lifecycle Report on page 536

 ➤  CI Lifecycle Window on page 537

 ➤  Filter Dialog Box on page 540
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CI Lifecycle Report

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to present filtered CI Lifecycle results in 
report format and print or export them.

To access: Click Report Export from the CI Lifecycle 
window.

Important 
Information

The CI Lifecycle report is generated for the period 
selected in the CI Lifecycle window. From the CI 
Lifecycle report dialog box, you can adjust the period 
and regenerate the results within the dialog box.

For details on working with reports, see Working in 
Reports in Reports.

GUI Element (A-Z) Description

Actual Delete Time The date and time when the CI or relationship is deleted.

Configuration Item 
Type

The type of CI or relationship.

End1 The node at one end of the relationship (only relevant for 
relationships).

End2 The node at the second end of the relationship (only 
relevant for relationships).

From Indicates the beginning of the period for the generation 
of the report. Click on the link to open a calendar which 
enables you to change the date and time.

Generate Click Generate to generate the data for the selected 
period.

Label The name of the CI or relationship as it appears in the 
Topology Map.

Last Access Time The last time the CI or relationship was accessed, whether 
it was updated or just discovered by the DDM process.
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CI Lifecycle Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To Indicates the end of the period for the generation of the 
report. Click the link to open a calendar that enables you 
to change the date and time.

View Sets the time period of the report from the beginning 
time. Select a time period from the drop-down list.

Updated By The administrator or process that updated the CI or 
relationship.

Description Enables you to filter CIs and relationships which are 
candidates for deletion.

To access: Select Application > Universal CMDB > CI 
Lifecycle.

Included in Tasks “Generate CI Lifecycle Data and Filter the Results” on 
page 534

GUI Element (A-Z) Description

Click Postpone Deletion to delay the deletion of a CI. It 
disappears from the list of candidates for deletion.

Click Mark as Deletion Proof to prevent a CI or 
relationship from being deleted. It disappears from the 
list of candidates for deletion.

Click Delete to delete a selected CI or relationship.

Click Select/Clear All to select or clear all rows of data on 
the current page.

Click Refresh to update the data displayed.

GUI Element (A-Z) Description
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Click Set Rows Per Page to define the number of rows of 
data per page.

Click to navigate through the results page by page or to 
jump to the first or last page.

Click Filter to open the Filter dialog box, which enables 
you to customize the filter. For details, see “Filter Dialog 
Box” on page 540.

Click Clear to clear the filter and display the full results.

Click Customize Columns to open the Select Columns 
dialog box, which enables you to change the display 
order of the columns, hide a column, or display a hidden 
column. For details, see “Select Columns Dialog Box” in 
Reference Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Actual Delete Time The date and time when the CI or relationship is deleted.

CIs tab Select to see lifecycle results for CIs.

CI Type The type of the CI or relationship.

Display Label The name of the CI or relationship as it appears in the 
Topology Map.

End1 The node at one end of the relationship (only relevant 
for relationships).

End2 The node at the second end of the relationship (only 
relevant for relationships).

From Use the drop-down calendar to select the beginning date 
and time for the CI Lifecycle report.

Generate Click Generate to generate the data for the selected 
period.

Last Access Time The last time that the CI or relationship was accessed, 
whether it was updated or just discovered by the DDM 
process.

GUI Element (A-Z) Description
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The following options are available by right-clicking a CI or relationship in 
the results table (listed alphabetically):

Relationships tab Select to see lifecycle results for relationships.

Report Export Click Report Export to open the CI Lifecycle Report 
dialog box, which presents the data in the format of a 
report.

Select Click the box in the Select column for a CI to select a CI 
or relationship before performing an operation on it 
(such as Delete or Postpone Deletion).

To Use the drop-down calendar to select the end date and 
time for the CI Lifecycle report.

Updated By The administrator or process that updated the CI or 
relationship.

Menu Item Description

CI/Relationship 
History

Opens the CI/Relationship History dialog box. For details, 
see “CI/Relationship History Dialog Box” on page 77.

Properties Displays the Properties page for the selected CI. For 
details, see “Properties Dialog Box” on page 96.

GUI Element (A-Z) Description
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Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to customize the filter.

To access: Click Filter from the CI Lifecycle screen.

Included in Tasks “Generate CI Lifecycle Data and Filter the Results” on 
page 534

GUI Element (A-Z) Description

Condition Click in the Condition column and select one of the 
options from the drop-down list.

Display Name The attribute columns displayed for the CIs or 
relationships.

Value Click in the Value column to set a value for the selected 
attribute. Depending on the attribute selected, you can 
select a value from a drop-down list, select a date and 
time from the calendar, or click the ellipsis button  to 
open an editing dialog box where you can enter a value.

When the conditions Like or Like ignore case are selected 
in the Condition column, you can use a wildcard (%) 
before and after the string you are searching for.

Note: You must select a condition for a given attribute 
before entering a value.
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Compare Snapshots

This chapter provides information on Compare Snapshots.

This chapter includes:

Concepts

 ➤  Snapshot Comparison Overview on page 541

Tasks

 ➤  Snapshot Comparison on page 542

Reference

 ➤  Compare Snapshots User Interface on page 543
Concepts

Snapshot Comparison Overview

Compare Snapshots displays the status of a view in one snapshot by 
comparison with its status taken at a different time. You can compare a 
current snapshot to a previous snapshot or two snapshots both taken in the 
past. For details, see “Compare Snapshots Window” on page 544.

Tasks
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Snapshot Comparison

This task describes how to take a snapshot of a view, and then compare two 
snapshots of a specific view taken at different times.

 1 Take a Snapshot of a View
Select Applications > Universal CMDB > Topology View. In View Explorer, 
right-click the required view and select Save Snapshot to take a snapshot of 
a view and save it. For details, see “Save Snapshot Dialog Box” on page 527.

 2 Save Snapshots on a Periodic Basis
Optionally, you can schedule snapshots to be taken of a certain view at 
specific times by defining a task. For details, see “Job Scheduler Window” on 
page 385.

 3 Compare Snapshots

Compare the snapshots of a view taken at different times. Select Applications > 
Universal CMDB > Compliance > Compare Snapshots to open the Compare 
Snapshots dialog box. For details on how to compare snapshots taken at 
different times, see “Compare Snapshots Window” on page 544.
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Example

In the following example, the Deleted Item icon next to the CI 16.59.58.45 
in the right pane, indicates that the CI has been deleted in the newer view.

Reference

Compare Snapshots User Interface

This section describes:

 ➤  Compare Snapshots Window on page 544

 ➤  Find CI by Label Dialog Box on page 549

 ➤  Snapshots of <View> Dialog Box on page 550
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Compare Snapshots Window

Description Enables you to compare two snapshots of a specific view 
taken at different times. This feature enables you to 
visualize the differences between the views by comparing 
the statuses of the view at the times the snapshots were 
taken.

You can compare a current snapshot to a previous 
snapshot or two snapshots both taken in the past.

To access: 

➤ Select Applications > Universal CMDB > Compliance > 
Compare Snapshots.

or

➤ Click View Snapshot in a Change report if a snapshot 
was taken of that view. For details, see “View 
Snapshot” on page 575. Only views with changes that 
reflect the differences between two snapshots, one 
taken before the From date and another snapshot 
taken before the To date in Change Report (for details, 
see “Change Report” on page 573), appear in the 
report.

Important 
Information

➤ You can also define a schedule that takes snapshots of 
a specific view and saves them on a periodic basis. For 
details, see “Scheduler” on page 375.

➤ Snapshots of views that are marked as Track Changes 
(for details, see “Track Changes” on page 146), are 
created on a daily basis.

Included in Tasks “Snapshot Comparison” on page 542
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Expand the entire hierarchical tree structure of the CIs 
you selected.

Collapse the hierarchical tree structure of the CIs you 
selected.

Search for a CI within the selected view whose label 
contains the searched text. Opens the Find CI by label 
dialog box.

Find the next occurrence of an item marked as changed.

Find the previous occurrence of an item marked as 
changed.

Show the difference between two configuration files. 
Compare what the configuration file looked like at the 
time each snapshot was taken.

Click Select Snapshots to compare and select a view that 
contains a CI of the CIT configfile. Select a CI of the CIT 
Configuration File. A window opens displaying the 
differences in the configuration files, which are marked 
in blue.

Select a view that contains a CI of the CIT Configuration 
File and click Select Snapshots to compare. Select two 
snapshots and click Compare. Select a CI of the CIT 
Configuration File. 

Note: This button is only enabled if you selected a CI of 
the CIT Configuration File from the tree.

 Display the selected CI’s attributes. For details, see 
“Properties Dialog Box” on page 96.

Note: The Properties functionality is sometimes displayed 
in a window and not in a tab.
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The Contains an Updated Item icon indicates that either 
a new child CI was created for a CI or an existing child CI 
was updated or deleted.

For example, the 16.59.56.0 CI in the figure below has a 
Contains an Updated Item icon due to the child CIs that 
were added to it.

The Deleted Item icon indicates that a CI has been 
deleted from the view. For example, the figure below 
shows that the CI 10.168.128.1 has been deleted from the 
view.

GUI Element (A-Z) Description
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The New Item icon indicates that a new CI has been 
added to the view. The example below shows that a Host 
and two IP CIs were added to the 16.59.56.0 Network CI.

The Updated Item icon indicates that the attribute value 
of a CI has changed. For more information, see the 
Example on page 548.

<At top of panes> The Compare Snapshots window is divided into two 
panes. Each side displays an hierarchical tree structure of 
all the CIs in the Topology Map for that snapshot version. 
The left side always represents the newer of the two 
versions. When you select a CI on one side, the 
corresponding CI on the other side is automatically 
selected (provided the Synchronize Selection check box is 
selected).

CIT The name of the CIT to which the CI belongs as defined 
in the CI Type Manager, as described in CI Attribute 
Customization.

Name The name of the CI as defined in the CI’s label.

Properties pane Displays the attributes of the selected CI.

The Properties pane contains the following fields:

➤ Property. Displays the attributes for the selected CI.

➤ Value. Displays the attribute value for the currently 
selected CI.

GUI Element (A-Z) Description
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Example

The Updated Item icon indicates that the attribute value of a CI has 
changed. For example, the figure below shows that the CI 
labn2am09.devlab.ad has the Updated Item icon because it was updated 
with a new Host DNS Name value (see the Property and Value columns in 
the bottom panes underneath the tree structure).

Select Snapshots to 
compare

Select the two snapshots you want to compare. Opens the 
Snapshots of <view> dialog box. 

Select View Name Displays the name of the view whose snapshots you want 
to compare.

Note: Only views for which snapshots have been taken 
are available.

Synchronize 
Selection

Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default for the Synchronize Selection check box is 
selected. Clearing this check box allows you to select two 
different CIs from each of the two trees. This allows you 
to compare two different CIs and see their different 
properties.

GUI Element (A-Z) Description
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Find CI by Label Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Search for a CI within the selected view whose label 
contains the searched text. You can specify a whole word 
or part of it. If a match is found, it selects the CI in the 
hierarchical tree structure in the Compare Snapshots 
window.

To access: Click the Find  button in the Compare 
Snapshots window. 

Included in Tasks “Snapshot Comparison” on page 542

GUI Element (A-Z) Description

Backward Do a backward search.

Case Sensitive Distinguish between uppercase and lowercase characters. 
When you select Case Sensitive, search results only find 
those instances in which the capitalization matches the 
text you typed in the Text to find box.

Forward Do a forward search.

Text to find Enter the text of the CI you want to find. You can specify 
a whole word or part of it.
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Snapshots of <View> Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description This dialog box contains a list of all the different 
snapshots taken of the selected view.

To access: Click Select Snapshots to compare in Compare 
Snapshots window.

Important 
Information

This dialog box opens only if you have taken snapshots 
of the view in the “Save Snapshot Dialog Box” on 
page 527. 

Included in Tasks “Snapshot Comparison” on page 542

GUI Element (A-Z) Description

Description The description you wrote for the snapshot in “Save 
Snapshot Dialog Box” on page 527.

Note The note you wrote for the view in “Save Snapshot Dialog 
Box” on page 527.

Owner The name of the user who took the snapshot.

Size The number of CIs that were in the view when the 
snapshot was taken.

Time The time at which the snapshot was saved.
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Overview Reports

This chapter provides information on Overview reports, located in 
Applications > Universal CMDB > Overview Reports.

This chapter includes:

Concepts

 ➤  Overview Report Overview on page 551

Reference

 ➤  Overview Reports User Interface on page 552
Concepts

Overview Report Overview

Overview reports consist of charts and tables that help you track and 
analyze the health of your monitored environment.

Overview reports enable you to view and assess performance data collected 
by HP Business Availability Center and stored in the CMDB. When 
generating reports, you can specify various report settings, such as time 
range or location, as well as drill down to see further information.

Note: You must have Adobe Flash Player version 8.0 or later installed on your 
machine to view Overview reports. For details, see “Viewing Reports with 
Adobe Flash Player” in Reports.

Reference
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Overview Reports User Interface

This section describes:

 ➤  Changed Applications Report on page 553

 ➤  Changed Views Report on page 555

 ➤  CMDB Utilization Report on page 556

 ➤  Database Breakdown Report on page 557

 ➤  Delete Candidates Overview Report on page 559

 ➤  Host OS Breakdown Report on page 561

 ➤  Major Application Type Breakdown Report on page 562

 ➤  Network Device Breakdown Report on page 564

 ➤  Number of Changes Report on page 566
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Changed Applications Report

Description This report displays a bar graph showing the number of 
detected changes in applications within a defined period.

Each bar represents a different application type. The 
colors in each bar represent the different types of changes 
that occurred in the application. Each color in the legend 
at the right of the bar graph represents a different type of 
change. The CI type of each application is displayed 
under the bar.

You can display the number of each type of change that 
occurred by moving the cursor over the related color. The 
tooltip that appears displays the relevant number of 
changes that occurred.

Click the relevant color in the bar to drill down to see a 
Show CI Instances report displaying the application 
instances that represent the changes.

To access: Select Applications > Universal CMDB > 
Overview Reports > Changed Applications.
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Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.
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Changed Views Report

Description This report displays a bar graph showing the number of 
changes that occurred in a specific view within a defined 
period.

Note: Only views with changes that reflect the differences 
between two snapshots, one taken before the From date 
and another snapshot taken before the To date in Change 
Report appear in the report.

Each bar represents a different view. The bar graph 
displays up to ten views with the largest number of 
changes. The view name is displayed under the bar. The 
legend at the right side of the bar graph shows which 
color represents the type of change that occurred. You 
can display the number of each type of change by 
moving the cursor over the relevant color. The tooltip 
that appears displays the name of the view and the 
number of changes that occurred.

Click a bar to open the Save Snapshot window and 
display the differences between the views. For details, see 
“Compare Snapshots” on page 541.

To access: Select Applications > Universal CMDB > 
Overview Reports > Changed Views.
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CMDB Utilization Report

Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.

Useful Links ➤ For details on how to work with reports, see “Working 
in Reports” in Reports.

➤ For details on Change reports, see “Change Report” on 
page 573.

Description This report displays general CMDB statistics.

For example, the statistics can contain the number of 
Correlation rules created, how many CIs there are in the 
CMDB, or how many snapshots have been taken.

To access: Select Applications > Universal CMDB > 
Overview Reports > CMDB Utilization.

Important 
Information

You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.
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Database Breakdown Report

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.

Description This report displays a pie chart showing the breakdown of 
database types and versions. You can view all databases 
deployed in the system or databases at a certain location.

To view the available databases at a specific location, 
select the required country, state, and city in which the 
hosts that the databases are connected to are located.

To verify the database types, use the legend below the pie 
chart.

Click a segment to view a specific database type sorted by 
version.

To verify the database versions, use the legend below the 
pie chart. You can display the number of each database 
version by moving the cursor over the related color. The 
tooltip that appears displays the relevant number.

Click a pie slice to drill down to see a Show CI Instances 
report for each database version.

To access: Select Applications > Universal CMDB > 
Overview Reports > Database Breakdown.
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Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.
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Delete Candidates Overview Report

Description This report displays a bar graph showing the CITs and 
relationships that were deleted within a defined period, 
and the ones that are about to be deleted.

Each bar represents the CIT of a CI or a relationship. The 
legend at the right side of the bar graph shows which 
color represents the CIs and relationships that were 
deleted and which color represents those that are about 
to be deleted. The CI type of each CI or relationship is 
displayed under the bar.

You can display the number of CIs and relationships that 
were deleted and the ones that are about to be deleted by 
moving the cursor over the related color in the bar. The 
tooltip that appears displays the relevant number.

Click a bar to drill down to see a Show CI Instances report 
displaying the CITs and relationships that were deleted.

To access: Select Applications > Universal CMDB > 
Overview Reports > Delete Candidates Overview.
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Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.
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Host OS Breakdown Report

Description This report displays a breakdown of operating systems. 
You can view all deployed operating systems or you can 
view data for operating systems at a certain location or 
running on a certain subnet.

You can display the number of operating systems of each 
type by moving the cursor over the related color. The 
tooltip that appears displays the relevant number.

Click a pie slice to drill down to see a Show CI Instances 
report for each operating system.

To access: Select Applications > Universal CMDB > 
Overview Reports > Host OS Breakdown.

Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.



Chapter 17 • Overview Reports

562

Major Application Type Breakdown Report

Description This report displays a breakdown of major applications 
and their versions. Major applications are CITs that have 
been assigned the MAJOR_APP class qualifier. For details, 
see “Qualifiers Page” in CI Attribute Customization.

You can view data for all applications deployed in the 
system, or only those at a specific location. Choose the 
country, state, and city for which you want to view 
application breakdown data, or select All to show the 
entire application breakdown.

➤ Use the legend below the pie chart to verify an 
application.

➤ Click a segment to view a specific application sorted by 
version.

➤ Use the legend below the pie chart to verify the 
different versions.

➤ Click a pie segment to drill down to see a Show CI 
Instances report for each application version.

To access: Select Applications > Universal CMDB > 
Overview Reports > Application Breakdown.
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Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.
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Network Device Breakdown Report
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Description Displays a breakdown of network devices. Only the 
network devices that meet the following conditions 
appear in the report:

➤ The CIT of the network device has been assigned the 
qualifier NETWORK_DEVICES. For details, see 
“Qualifiers Page” in CI Attribute Customization.

➤ The network device is connected to an IP CI.

➤ The network device is defined with the following 
attribute condition: Host is complete = True. For 
details, see “Attribute Tab” on page 318 .

You can view all network devices deployed in the system 
or at a certain location. Choose the country, state, and 
city for which you want to view network device 
breakdown data, or select All to show the entire network 
device breakdown.

Each color in the pie chart represents a different network 
device. The legend underneath shows which network 
device each color represents. You can display the name 
and number of each network device by moving the cursor 
over the related color. The tooltip that appears displays 
the relevant information.

Click a segment to view a specific network device sorted 
by manufacturer.

Click a segment to generate a Show CI Instances report, 
displaying the details of the CI instances of that network 
device for that manufacturer. 

To access: Select Applications > Universal CMDB > 
Overview Reports > Network Device Breakdown.

Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.
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Number of Changes Report

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.

Description This report displays a bar graph showing the number of 
detected changes in a CIT within a defined period.

Click the bar to view the breakdown of the types of 
changes that occurred for the CIT and its child CITs. 

To access: Select Applications > Universal CMDB > 
Overview Reports > Number of Changes.

Important 
Information

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add Portlets 
Dialog Box” in My BAC.

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details, see “Viewing Reports with Adobe Flash 
Player” in Reports.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reports.
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Sample Change Type Breakdown Report

This example displays the breakdown of the types of changes that occurred 
for a CIT and its children.

Each bar represents a different CI type. The CI type is displayed under the 
bar. Each color in the legend at the right of the bar graph represents a 
different type of change. You can display the number of each type of change 
by moving the cursor over the related color. The tooltip that appears 
displays the relevant number of changes that occurred.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.
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Asset Report

This chapter provides information on Asset reports.

This chapter includes:

Concepts

 ➤  Asset Report Overview on page 569

Reference

 ➤  Asset Report User Interface on page 569
Concepts

Asset Report Overview

Asset reports display a list of all the CIs in a specified view, their attribute 
values, as well as their child CI’s in the CMDB. You use Asset reports to view 
and analyze the contents of the view and focus on the data which is of 
interest to you. For example, an Asset report can display a list of all the 
servers that are part of a specific application contained in the view.

Reference

Asset Report User Interface

This section describes:

 ➤  Asset Report Page on page 570
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Asset Report Page

Description An Asset report displays a list of all the CIs in a selected 
view and their attribute values, as well as their child CIs 
and their attribute values in the CMDB.

The report contains only the attributes whose Asset Data 
check box was selected in the Attributes tab in the CI 
Type Manager. For more details, see “Add/Edit Attribute 
Dialog Box” in CI Attribute Customization.

You can generate a list from a specific view or from the 
CMDB.

When you generate an Asset report from a specific view, 
the report retains the same hierarchical structure as the 
relevant view in the Topology Map.

To access: Select Applications > Universal CMDB > 
Reports > Asset Report.

Important 
Information

➤ Make sure that popups are not blocked in your 
browser.

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reports.

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Publishing a 
Report” in Reports. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

CMDB Include information from the selected view as well as 
information about the child CIs and their attribute values 
in the CMDB.

By choosing this option, the report includes CIs that are 
connected by the Container link relationship to the CIs in 
selected view. For example, the report would include the 
CPU and memory of a server that is contained in the 
view.

Selected view Select the required view.

Views Includes only information about the CIs and their 
attributes contained in this view.
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Change Report

This chapter provides information on Change reports.

This chapter includes:

Concepts

 ➤  Change Report Overview on page 573

Reference

 ➤  Change Report User Interface on page 574
Concepts

Change Report Overview

Change reports enable you to view and analyze the actual changes made to 
a specific CI and its children, or to a specific view. This can help with 
possible troubleshooting issues related to this CI. For example, seeing the 
changes that occurred to a CI might enable you to conclude that these 
changes are the cause of the problem. By the same token, the 
troubleshooting issue could have been caused by the fact that no changes 
occured to the CI when they were actually supposed to have occurred.

Scheduling Change reports to run periodically also enables you to monitor 
the changes that are made to the system and verify that all the changes are 
in line with your organization’s planning. For details, see “Create a 
Schedule” in Reports. 

Reference
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Change Report User Interface

This section describes:

 ➤  Change Report Page on page 574

 ➤  CI History Report Page on page 578

Change Report Page

Description Displays information about the changes made to the CIs 
whose properties are marked as either Change Monitored 
or Comparable. For details, see “Add/Edit Attribute 
Dialog Box” in CI Attribute Customization.

The report displays:

➤ Changes that occurred in a selected CI and all its 
children, which are defined with the CONTAINER 
qualifier. For information about qualifiers, see 
“Qualifiers Page” in CI Attribute Customization.

➤ Changes that occurred in all CIs in the selected view. 
In addition, this page displays any CIs that were added 
or deleted during the defined time frame according to 
snapshots taken of that view.

➤ CIs with a Container link relationship that were added 
to or removed from a CI.

➤ CIs whose relationship was defined with a 
TRACK_LINK_CHANGES qualifier, that were added to 
or removed from a CI. For information about 
qualifiers, see “Qualifiers Page” in CI Attribute 
Customization.

To access: Select Applications > Universal CMDB > 
Reports > Change Report.

Note: You can also access Change report using the 
Change Rule right-click option for any CI with changed 
properties in relevant views in Dashboard. For details, see 
the “Change Rule” option in Dashboard Administration.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reports.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

The generated report includes the following elements (listed alphabetically):

GUI Element (A-Z) Description

Select CI/View Select the required CI or view. Opens the Select CI/View 
dialog box. For details, see “View Explorer” on page 607.

Use results on CMDB The report displays the changes that occurred to the CI 
and its children in the entire CMDB.

Note: This option is available only if you selected a CI 
and not a view.

Use results on View The report displays the changes that occurred to the CI 
and its children in the selected view.

Note: This option is available only if you selected a CI 
and not a view.

GUI Element (A-Z) Description

View Snapshot Opens the Compare Snapshots dialog box. Enables you to 
perform a snapshot comparison. For details about 
snapshots, see “Compare Snapshots” on page 541.

Note: This option is displayed only if, for the relevant 
view context, a snapshot was saved before the From date 
and another snapshot was saved before the To date, and 
there was a difference between them.

View Statistics The statistics include the following:

➤ The number of CIs that were added to the view

➤ The number of CIs that were removed from the view

➤ The number of relationships that were added to the 
view

➤ The number of relationships that were removed from 
the view
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The Change Report page includes the following areas:

➤ “CI Changes Area” on page 576

➤ “Relationship Changes Area” on page 577

CI Changes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Change Date & Time The date and time at which the change occurred.

Changer The name of the user that manually modified the CI’s 
property, or the name of the Discovery and Dependency 
Mapping (DDM) Probe that automatically discovered a 
change made to the CI’s property.

CI Attribute The name of the CI attribute that was changed.

CI Label The label of the path from the root to the CI.

Note: A backslash (\) in a CI name indicates a parent-
child relationship with the format: 
<parent_CI>\<child_CI>. For example, the entry 
16.59.63.0\Windows provides change information for the 
Windows CI which is the child of the 16.59.63.0 CI.

Note: Click to view the change history of a specific CI. 
For details, see “CI History Report Page” on page 578.

CIT Name The name of the CIT (internal).

New Value The new value of the CI attribute.

Old Value The previous value of the CI attribute (before the change).

Type The type of change that occurred.

<view other pages> To view other pages, use the left and right arrows. The 
number between the left and right arrows indicate which 
pages are currently being displayed. For example, 1 - 2 of 3 
means that the 1st and 2nd pages out of 3 are being 
displayed.
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Relationship Changes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets)::

GUI Element (A-Z) Description

Change Date & Time The date and time at which the update was performed.

Changer The name of the user that manually modified the CI’s 
property, or the name of the DDM probe that 
automatically discovered a change made to the CI’s 
property.

Container Label The label of the path from the root to the container CI.

A backslash (\) in a CI name indicates a parent-child 
relationship with the format: <parent_CI>\<child_CI>. 
For example, the entry 16.59.63.0\Windows provides 
change information for the Windows CI which is the child 
of the dancer.hp.com CI.

Note: Double-click an item to view the change history of 
the container CI. For details, see “CI History Report Page” 
on page 578.

Event type You can have one of the following values:

➤ Added CI. A contained CI was added to the container 
CI using a Container link relationship.

➤ Removed CI. A contained CI that was linked to a 
container CI using a Container link was removed.

Related label The label of the path from the root to the contained CI.

Note: Double-click an item to view the change history of 
the related CI. For details, see “CI History Report Page” on 
page 578.
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CI History Report Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view all the changes in the properties of a 
specific CI or for CIs linked by a Container link 
relationship, from the time they were created.

To access: 

➤ In the CI Changes area, click one of the links in the CI 
label column for the required CI.

or

➤ In the Relationship Changes area, click one of the links 
in the Container label or Related label columns for the 
required CI.

Important 
Information

Make sure that popups are not blocked in your browser.

GUI Element (A-Z) Description

Change Date & Time The date and time when the update was performed.

Changer The name of the user that manually modified the CI’s 
property, or the name of the DDM probe that 
automatically discovered a change made to the CI’s 
attribute.

CI Attribute The name of the CI attribute that was updated.

New Value The new value of the CI attribute.
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Comparing CIs

This chapter provides information on Compare CIs.

This chapter includes:

Concepts

 ➤  CI Comparison Overview on page 579

Tasks

 ➤  CI Comparison on page 580

Reference

 ➤  Compare CIs User Interface on page 581
Concepts

CI Comparison Overview

Compare CIs enables you to compare the hierarchies of two compound CIs. 
A compound CI is a CI that is linked to another CI by a Container link 
relationship.

You can display the compared CIs and their child CIs that appear in a 
selected view or in the CMDB. 

Change indicators denote:

➤ A CI on one side does not match any corresponding CI on the other side.

➤ A CI has a match but one of its children does not have a match.
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You can only see differences in the attributes of the CI whose values have 
been defined as Comparable in the CI Type Manager. For information, see 
“Add/Edit Attribute Dialog Box” in CI Attribute Customization. For example, 
a comparison might show a difference in the operating system or disk 
capacity. For details on how to compare CIs, see “Compare CIs Window” on 
page 582.

Tasks

CI Comparison

This task explains how to compare the hierarchies of two compound CIs, 
view a CI’s configuration file, and show the difference between two 
configuration files.

 1 Select the Required CIs
Select the two CIs you want to compare. The hierarchies of the two 
compound CIs are compared in the Compare CIs window. You can choose 
to compare two CIs that appear in a selected view or in the CMDB. For 
details, see “Select CI Dialog Box” on page 585.

Example

The following example displays the No Matching CI icon next to the CIs doc 
and doc1 because the CI on one side does not match the corresponding CI 
on the other side. The reason they do not match is the difference in 
document size. The value for Document Size for the doc CI on the left side is 
10 while the Document Size for the doc CI on the left side is 20. 
580



Chapter 20 • Comparing CIs
This example also illustrates that the Document group CI has a Has a Non-
Matching Child icon because they have different child CIs.

 2 View a CI’s Configuration File
Select a CI of the CIT Configuration File and view the configuration file. For 
details, see “Compare CIs Window” on page 582.

 3 Show the Difference Between Two Configuration Files
Select two CIs of the CIT Configuration File and view the difference between 
the two configuration files. For details, see “Compare CIs Window” on 
page 582.

Reference

Compare CIs User Interface

This section describes:

 ➤  Compare CIs Window on page 582

 ➤  Find CI by Label Dialog Box on page 584

 ➤  Select CI Dialog Box on page 585
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Compare CIs Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Compare the hierarchies of two compound CIs. A 
compound CI is a CI that is linked to another CI by a 
Container link relationship.

The Compare CIs window is divided into two panes. Each 
side displays an hierarchical tree structure of the CIs you 
selected. When you select a CI on one side, the 
corresponding CI on the other side is automatically 
selected, provided the Synchronize Selection check box is 
selected. 

To access: Select Applications > Universal CMDB > 
Compliance > Compare CIs.

Important 
Information

You can compare only two CIs of the same CIT or one of 
the CIT’s descendants in the hierarchy.

Included in Tasks “CI Comparison” on page 580

GUI Element (A-Z) Description

Expand the entire hierarchical tree structure of the CIs 
you selected.

Collapse the hierarchical tree structure of the CIs you 
selected.

Search for a CI within the selected view whose label 
contains the searched text. Opens the Find CI by label 
dialog box.

Find the next occurrence of an item marked as changed. 
For information on the change indicators, see “No 
Matching CI” on page 583 and “Has a Non-Matching 
Child” on page 583.
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Find the previous occurrence of an item marked as 
changed. For information on the change indicators, see 
“No Matching CI” on page 583 and “Has a Non-Matching 
Child” on page 583.

 Show the difference between the content of the two 
configuration files. Configuration files use the .xml, .txt 
or .ini extensions.

Select a CI of the CIT Configuration File in both panes 
and click the Show Differences button. A window opens 
displaying the differences in the configuration files, 
which are marked in blue.

View the content of a Configuration File CI. Select a CI of 
the Configuration File CI and click the Open button.

Note: This button is only enabled if you selected a CI of 
the CIT Configuration File from the tree.

Display the selected CI’s properties. For details, see 
“Properties Dialog Box” on page 96.

No Matching CI Indicates that a CI on one side does not match any 
corresponding CI on the other side.

Has a Non-
Matching Child

Indicates that the child of the CI does not have a 
matching child on the other side.

<At top of panes> Displays the CIs you selected in the Select CI dialog box.

<Left and right 
panes>

Displays a tree of the compared CIs and their child CIs 
that appear in the selected view or in the CMDB, 
depending on whether you selected the View or the 
CMDB options.

CIT The CIT (as defined in the CI Type Manager) of the 
selected CI at the top of the pane. For details, on the CI 
Type Manager, see CI Attribute Customization. 

CMDB Display the selected CIs and their child CIs that appear in 
the entire CMDB.

Name The name of the selected CI as defined in the CI’s label.

GUI Element (A-Z) Description
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Find CI by Label Dialog Box

Property Displays the attribute name for the selected CI, which 
was marked as Comparable in the CI Type Manager. For 
details, see “Create Configuration Item Type Wizard” in 
CI Attribute Customization.

Select Select the two CIs you want to compare. Opens the Select 
CI dialog box. The CI you select from the Select option 
on the left is displayed in the left pane and the CI you 
select from the Select option on the right is displayed in 
the right pane.

Synchronize 
Selection

Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default for the Synchronize Selection check box is 
selected. Clearing this check box allows you to select two 
different CIs from each of the two trees. This enables you 
to compare two different CIs and see their different 
properties.

Value Displays the attribute value for the currently selected CI.

View Display the selected CIs and their child CIs that appear in 
a specific view.

Description Search for a CI within the selected view whose label 
contains the searched text. You can specify a whole word 
or part of it. If a match is found, it selects the CI in the 
hierarchical tree structure in the Compare CIs window.

To access: Click the Find  button in the Compare CIs 
window. 

Included in Tasks “CI Comparison” on page 580

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select CI Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Browse Tab

GUI Element (A-Z) Description

Backward Do a backward search.

Case Sensitive Distinguish between uppercase and lowercase characters. 
When you select Case Sensitive, search results only find 
those instances in which the capitalization matches the 
text you typed in the Text to find box.

Forward Do a forward search.

Text to find Enter the text of the CI you want to find. You can specify 
a whole word or part of it.

Description Select the required CI for comparison from the 
hierarchical tree or search for a CI for comparison.

To access: Click Select CI in the Compare CIs window.

GUI Element (A-Z) Description

Browse tab Select the required CI for comparison from a hierarchical 
tree. For details, see “Browse Tab” on page 585 below.

Search tab Search for a CI for comparison. For details, see “Search 
Tab” on page 586.

Description Search for and display a view, and browse through the 
view to locate a particular CI.To access: Click Select CI to 
open the Select CI dialog box and click the Select CI tab.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Search Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Refresh the list of CIs (if new CIs have been added to a 
view).

Refresh the View list (if views have been newly defined).

Click to open the Select View dialog box. Select the view 
from which you want to select a CI.

Enables you to move to the next or previous result of the 
search for the string entered in the Find box.

<Hierarchical CI tree> Displays the CIs from the selected view. 

Find Enter a CI name or a portion of a CI name in the Find box 
to locate a CI in the CI tree.

View Select the required view from the list.

Description Search for a CI either in the entire CMDB. You can also 
filter the list of CIs that is displayed.

To access: Click Select CI to open the Select CI dialog box 
and click the Search tab.

GUI Element (A-Z) Description

Click this to view the search results. The search results are 
displayed at the bottom of the Search tab.

Filter the list of CIs that is displayed. Click the Select CITs 
to search in button to open the hierarchical tree structure 
of the CI Type model. Select the required CIT.
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CI Type Search for a CI of a specified CI type. Click the  button 
to the right to open the hierarchical tree structure of the 
CI Type model. 

Search for Enter the name of the CI (or part of the name) you want 
to find.

GUI Element (A-Z) Description
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Gold Master Report

This chapter provides information on Gold Master reports.

This chapter includes:

Concepts

 ➤  Gold Master Report Overview on page 589

Reference

 ➤  Gold Master Report User Interface on page 589
Concepts

Gold Master Report Overview

A Gold Master report compares the configuration of a Gold Master CI to 
other CIs of the same CI type, or a descendant of the CI type. The report 
contains the results of the Gold Master report definition defined in the 
Report Manager. For details, see “Gold Master Report Pane” on page 208.

Reference

Gold Master Report User Interface

This section describes:

 ➤  Gold Master Report Page on page 590
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Gold Master Report Page

Left Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Specifies which of the selected CIs are configured 
differently from the Gold Master CI.

To access: Select Applications > Universal CMDB > 
Compliance > Gold Master.

Important 
Information

➤ Verify that popups are not blocked in your browser.

➤ For details on how to work with reports, see “Working 
in Reports” in Reports.

Description Select the required Gold Master report definition you 
want to generate.

GUI Element (A-Z) Description

Definitions tab Displays a hierarchical tree structure of the Gold Master 
reports defined in the Report Manager. For details, see 
“Gold Master Report Pane” on page 208.
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Results tab The Gold Master report you select in the Definitions pane 
is automatically selected in the Results pane.

If you have defined a task in the Scheduler that generates 
and saves a Gold Master report on a periodic basis, you 
can produce a Gold Master report that was generated at a 
specific time or a by a specific user. For details on how to 
schedule a task, see “Scheduler” on page 375.

From the:

➤ Report list, select the required Gold Master report.

➤ Date list, select the required time.

➤ User list, select the required user.

Note: For details on how to customize columns and 
divide a table of data or a list of reports into pages, see 
“Working in Reports” in Reports.

GUI Element (A-Z) Description
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Right Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Compares the attribute values of the CIs in the Gold 
Master CI subgraph to the attribute values of the CIs in 
the subgraph of the Compared CI in the CMDB.

Note: Only attributes that have been assigned the 
Comparable qualifier in the CIT Manager (for details, see 
“CI Type Manager” in CI Attribute Customization), can be 
compared.

Each section of the report contains a table comparing the 
attribute values of the Gold Master CIs to the attribute 
values of the Compared CI of the same CIT. 

Note: The Gold Master report only displays a CI attribute 
comparison if the values are different.

If a section is empty, it means that all attribute values of 
the Gold Master CIs and the Compared CIs for that CIT 
are identical. In such a case, the attributes in the next 
layer in the subgraph are compared, and the next one, 
and so on. 

Once the compared CIs in a layer is found to have 
different attributes, the Gold Master report does not 
continue to compare the layers in the subgraph for 
differences.

For a sample of a Gold Master report, see “Sample Gold 
Master Report” on page 593.

Important 
Information

For details on how to work with reports, see “Working in 
Reports” in Reports.

GUI Element (A-Z) Description

# in Compared CI The number of CIs for that element type (CIT) the 
Compared CI subgraph contains.

# in Gold Master The number of CIs for that element type (CIT) the Gold 
Master CI subgraph contains.
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Sample Gold Master Report

The sample Gold Master report shows the following:

➤ The Gold Master CI labm1ccm14 is being compared to the Compared CI 
labm1mam13.

➤ Windows attribute values in the Gold Master subgraph are being compared 
with the Windows attribute values in the Compared CI subgraph.

➤ There is one Windows CI in the Gold Master subgraph and one Windows CI 
in the Compared CI subgraph.

Attributes The CI attribute.

Compared CI The display name of the Compared CI.

Element Type The CIT of the CI.

Label The display label of the Gold Master CI.

Report Date The time and date the report was generated.

Value in Compared 
CI

The value of the attribute in the Compared CI.

Value in Gold Master 
CI

The value of the attribute in the Gold Master CI.

GUI Element (A-Z) Description
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Host Dependency Report

This chapter provides information on Host Dependency reports.

This chapter includes:

Concepts

 ➤  Host Dependency Report Overview on page 595

Reference

 ➤  Host Dependency Report User Interface on page 596
Concepts

Host Dependency Report Overview

Host Dependency reports are based on TQL queries created in the 
Enrichment Manager, which use the relationship of the type Dependency. 
Dependency reports list all the relationships of the type Dependency that 
connect between servers in the selected view, or between the servers in the 
CMDB and the servers within the selected view.

The report includes relationships that:

➤ Exist between databases and clients

➤ Exist between clients and servers

➤ Are created as a result of an MQ connection
Reference
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Host Dependency Report User Interface

This section describes:

 ➤  Host Dependency Report Page on page 596

Host Dependency Report Page

The Host Dependency report page includes the following elements (listed 
alphabetically):

Description Enables you to generate a list of all the relationships of 
the type Dependency that connect between servers in the 
selected view, or between the servers in the CMDB and 
the servers within the selected view.

To access: Select Applications > Universal CMDB > 
Reports > Host Dependency.

Important 
Information

➤ You can create new TQLs in Enrichment Manager 
using the Dependency relationship to describe the 
connection between hosts. Every new Dependency 
relationship that is used appears in the Dependency 
report.

➤ Make sure that popups are not blocked in your 
browser.

➤ For details on how to work with reports, see “Working 
in Reports” in Reports.

GUI Element (A-Z) Description

CMDB Display all the servers in the CMDB that are dependent 
on the servers in the selected view.

Selected view Select the required view.

Views Display all the dependencies between the servers in the 
selected view..
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Clients The list of clients that are linked to the servers.

Counter The number of clients to which the server is connected.

Host The servers in the selected view.

Relationship The display label of the relationship in the Topology 
Map.
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System Report

This chapter provides information on System reports.

This chapter includes:

Concepts

 ➤  System Report Overview on page 599

Reference

 ➤  System Reports User Interface on page 599
Concepts

System Report Overview

A System report is based on a specific Report TQL query, defined in the 
Report Manager. It gives you information about the selected Report nodes in 
the TQL on which it is based.

You can customize the way the report is displayed. The information that 
appears in the report, including the order in which Report nodes are listed 
and their placement relative to other Report nodes, and how the 
information within each Report node is sorted, is defined in the Report 
Manager. For details, see “Report Manager” on page 191.

Reference

System Reports User Interface

This section describes:

 ➤  Set Parameter Values Dialog Box on page 600
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 ➤  System Report Page on page 601

Set Parameter Values Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to edit the predefined parameterized values 
of node conditions defined for the selected Report 
definition in the Report Manager.

The dialog box displays all the conditions for the selected 
Report definition. For each element, every condition 
appears on a separate line.

To access: Click the Set parameter values link in the 
System Report page.

Important 
Information

The Set parameter values link appears only if you defined 
a node condition using parameterized values in the 
Attribute tab in the Node Condition dialog box in Report 
Manager. For details, see “Attribute Tab” on page 318.

GUI Element (A-Z) Description

Element name The node for which the condition was defined using 
parameterized values.

<Attribute> The attribute used for the attribute condition definition.

<Operator> The operator used for the attribute condition definition.
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System Report Page

The System Report page includes the following panes:

➤ “Left pane” on page 601

➤ “Right pane” on page 602

Left pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description A System report is based on a specific Report TQL query 
defined in the Report Manager. Each report is customized 
to display specific information, as defined in the relevant 
Report TQL. For details, see “Report Manager” on 
page 191.

To access: Select Applications > Universal CMDB > 
Reports > System Report.

Important 
Information

➤ For details on how to work with reports, see “Working 
in Reports” in Reports.

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Publishing a 
Report” in Reports. 

Description Select the required System report definition you want to 
generate.

GUI Element (A-Z) Description

Definitions tab Displays the hierarchical tree structure of the System 
reports defined in the Report Manager. For details, see 
“Report Manager” on page 191.
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Right pane

Results tab The System report you select in the Definitions pane is 
automatically selected in the Results pane.

If you have defined a task in the Scheduler that generates 
and saves a System report on a periodic basis, you can 
produce a System report that was generated at a specific 
time or a by a specific user. For details on how to schedule 
a task, see “Scheduler” on page 375.

From the:

➤ Report list, select the required System report.

➤ Date list, select the required time.

➤ User list, select the required user.

Note: For details on how to customize columns and 
divide a table of data or a list of reports into pages, see 
“Working in Reports” in Reports.

Description Contains the information that was defined in the Report 
Manager to be included in the report. This includes 
which Report nodes should appear in the report, the 
parameter defined for each Report node, and the 
function you want to use to calculate the results on the 
report’s columns. For details, see “Report Manager” on 
page 191.

Important 
Information

For details on how to work with reports, see “Working in 
Reports” in Reports.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Set parameter values A link that opens the Set parameters valuesdialog box. 
Enables you to edit the predefined parameters of node 
conditions.

Note: This link appears only if you defined a node 
condition using parameterized values in the Attribute tab 
in the Node Condition dialog box in the Report Manager. 
For details, see“Attribute Tab” on page 318.

Set view-specific 
report

(Optional) Enables you to generate a report of the 
selected Report TQL query based on a certain view rather 
than the entire CMDB. Select the view on which you 
want to base the report.

Note: Click Clear to run the report based on the entire 
CMDB.
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View Explorer

This chapter provides information on View Explorer.

Note: In IT Universe Manager and the Topology View Application, View 
Explorer is called CI Selector.

This chapter includes:

Concepts

 ➤  View Explorer Overview on page 608

Tasks

 ➤  Display a View in Browse Mode on page 609

 ➤  Search for CIs in Search Mode on page 610

 ➤  Modify View Explorer Display Options on page 613

Reference

 ➤  View Explorer User Interface on page 615

Troubleshooting and Limitations on page 623
Concepts
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View Explorer Overview

View Explorer presents the elements of the IT universe model in HP Business 
Availability Center through the medium of views. HP Business Availability 
Center displays View Explorer in the left pane of applications and pages, for 
example, Dashboard, Service Level Management, and IT Universe Manager.

When you select a view in View Explorer, the configuration items (CIs) 
contained in the view are displayed in a hierarchical tree format according 
to the relationships defined between the CIs. A view may be empty if no CIs 
have been added to it (for an instance view), or if no CIs were found 
matching the TQL query (for a pattern view). For details on pattern and 
instance views, see “Instance Views and Pattern Views” on page 124.

You can use View Explorer to select views and to locate CIs. You can select a 
view and browse through the list of CIs, or you can search for a CI if you do 
not know in which view the CI is included. 

The interaction between the View Explorer pane and the information 
presented in the right pane varies, according to the context. For example, in 
IT Universe Manager, information is presented for the CI selected in View 
Explorer; in Dashboard, information is presented for the view selected in 
View Explorer; in Service Level Management, and in other dialog boxes, CIs 
can be selected in View Explorer and added to the right pane. The context 
menu options also vary with the context.

Note: The functionality available for searching and browsing in View 
Explorer in IT Universe Manager and Topology View is different from the 
functionality in other applications.

For information on the components of View Explorer, see “View Explorer 
User Interface” on page 615.

Tasks
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Display a View in Browse Mode

When View Explorer is set to Browse mode, you can display the contents of 
a selected view. For details on the View Explorer user interface in Browse 
mode, see “Browse Mode” on page 617.

This task includes the following steps:

➤ “Prerequisites” on page 609

➤ “Select a View to Display” on page 609

➤ “Modify the CI Tree Structure” on page 609

 1 Prerequisites
In the View Explorer pane, select Browse mode. (In IT Universe Manager or 
Topology View, select View Browser.)

 2 Select a View to Display
Click the ellipsis button to open the Select view dialog box and select the 
view you want to display. The name of the selected view is shown in the 
View box. The CIs in the view appear in the CI tree in the lower part of the 
View Explorer pane. The view remains selected when you move to other 
applications in HP Business Availability Center.

 3 Modify the CI Tree Structure
View Explorer enables you to customize the structure of the CI tree of the 
view (this option is not available in IT Universe Manager or Topology View):

➤ Select Related CIs tree structure to display the CI tree by layers within 
the view.

➤ Select CI type tree structure to display the CI tree by CI type.
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Search for CIs in Search Mode

The View Explorer search tool enables you to find the CI you need, so that 
you can shift the focus, in the application in which you are working, to that 
CI. You can set up searches based on any combination of the filter criteria 
described in the task. For details on the View Explorer search tool user 
interface, see “Search Mode” on page 620.

This task includes the following steps:

➤ “Prerequisites” on page 610

➤ “Search by CI Name” on page 610

➤ “Filter the Scope of the Search” on page 611

➤ “Search by Related Configuration Item” on page 611

➤ “Search by Configuration Item Type” on page 612

➤ “Run the Search and Sort the Results” on page 612

 1 Prerequisites
In the View Explorer pane, select Search mode. (In IT Universe Manager or 
Topology View, select CMDB Search.)

 2 Search by CI Name
When searching for CIs by name, you enter a string in the Search for box, 
representing the name of the CI, or part of the name. The search returns all 
CIs that contain the entered string somewhere in the name (within the 
boundaries of the other search criteria that you define).

When using this search option, note the following:

➤ The search by CI name option is not case sensitive.

➤ You can use the wildcard character asterisk (*) as follows:

➤ If you enter serv, all CIs containing the string serv are returned.

➤ If you enter serv*, only CIs with names beginning with serv are returned.
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Note: The wildcard character asterisk is not relevant in search mode in 
IT Universe Manager or Topology View.

 3 Filter the Scope of the Search
All searches in View Explorer must specify the locations in which to search 
(this option is not available in IT Universe Manager):

➤ The current view only. This option includes the view currently selected in 
Browse mode.

➤ All views. This option searches in the most recently accessed views. It does 
not include any views that are unavailable in the current application. For 
information on unavailable views, see “Unavailable Views and CIs” on 
page 623.

➤ The entire CMDB. This option enables you to find CIs that are not included 
in any view, or that are part of a view that is unavailable in IT Universe 
Manager. This option is only available if you are working in Change Report 
or in the Instance View Editor in View Manager.

Note: In IT Universe Manager, the search is always run on the entire CMDB.

 4 Search by Related Configuration Item
You can search for CIs using the Related to box (this option is not available 
in IT Universe Manager or Topology View). This search returns CIs that have 
defined relationships to the CI specified in the Related to box. 

Click the ellipsis button to open the Select Configuration Item dialog box 
and select the required CI. You cannot manually enter a CI in the Related to 
box. 
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Note: The results list includes only those relationships that exist in the 
CMDB and are included in a view.

After defining a CI in the Related to box, HP Business Availability Center 
remembers your selection until you move to a different application, or until 
you define a different value. The selection is shown inactive: you activate it 
again for a search by selecting the check box.

 5 Search by Configuration Item Type
You can search for CIs using the CI type box. This search returns CIs that are 
of the type specified in the CI type box.

Click the ellipsis button to open the Select Configuration Item Type dialog 
box and select the required CI type. You cannot manually enter a CIT in the 
CI type box. 

After defining a CI in the CI type box, HP Business Availability Center 
remembers your selection until you move to a different application, or until 
you define a different value.

 6 Run the Search and Sort the Results
Run the search. The results are listed in the lower part of the View Explorer 
pane, showing the CI name and the name of the view that the CI appears in, 
for each entry. In IT Universe Manager and Topology View, the results 
display the CI name and the CI type. You can sort the search results by 
clicking the appropriate heading.

When you select the required CI from the results list, the right pane displays 
details for the CI you selected, in the context in which you are working. To 
see a CI in the context of its view, right-click the CI and select Locate CI in 
View. View Explorer reverts to Browse mode and displays the view that 
contains the CI, with the CI selected in the view tree.
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In IT Universe Manager and Topology View, when you select a CI in the 
search results, the CI appears in the topology map with its related CIs in the 
CMDB.

Modify View Explorer Display Options

You can modify the display options for View Explorer. These options are 
configured in the Infrastructure Settings Manager. 

Important: Many of the settings in the Infrastructure Settings Manager 
should not be modified without first consulting HP Software Support or 
your HP Professional Services representative. Modifying certain settings can 
adversely affect the performance of HP Business Availability Center.

This task includes the following steps:

➤ “Prerequisites” on page 613

➤ “Modify Selected Settings” on page 613

 1 Prerequisites
Access the Infrastructure Settings Manager by selecting Admin > Platform > 
Setup and Maintenance > Infrastructure Settings. Select the Foundations 
context and choose View Explorer from the list.

 2 Modify Selected Settings
The following settings can be modified:

➤ Immediate Children Count. Number of children immediately displayed 
when expanding their parent’s node in View Explorer.

➤ Maximal Children Count. Maximum number of children displayed under 
their parent’s node in View Explorer.

➤ Maximal search results size. Maximum number of CMDB instances that can 
be returned in one search operation.
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➤ Recently Used Views List size. Maximal number of recently used views to 
store per user.

Note: Some of the settings are not relevant in IT Universe Manager and 
Topology View.

Reference
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View Explorer User Interface

This section describes:

 ➤  View Explorer on page 615

View Explorer

Description Enables you to select views and to locate CIs.

To access: Appears in the left pane of the window, for 
example, the left pane of the IT Universe Manager 
window, the left pane of Dashboard, and the left pane of 
Service Level Management.

Note: in IT Universe Manager and Topology View, View 
Explorer is called CI Selector.
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Important 
Information

The interaction between the View Explorer pane and the 
information presented in the right pane varies, 
according to the context. For example, in IT Universe 
Manager, information is presented for the CI selected in 
View Explorer; in Dashboard, information is presented 
for the view selected in View Explorer; in Service Level 
Management, and in other dialog boxes, CIs can be 
selected in View Explorer and added to the right pane.

View Explorer consists of two functional formats: 
Browse mode and Search mode.

➤ In Browse mode you can search for and display a view, 
and browse through the view to locate a particular CI. 
You can also perform operations for the CI from a 
context menu. In IT Universe Manager, you access 
this mode by selecting View Browser from the drop-
down window.

➤ In Search mode you can search for one or more CIs in 
the views or the CMDB, search for all occurrences of a 
CI, or filter the list of CIs that is displayed. In 
IT Universe Manager, you access this mode by 
selecting CMDB Search from the drop-down window.

Included in Tasks “Display a View in Browse Mode” on page 609

“Search for CIs in Search Mode” on page 610
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Browse Mode
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Refresh button to refresh the list of CIs (if new 
CIs have been added to a view) or to refresh the View list 
(if views have been newly defined).

Note: In IT Universe Manager and Topology View, only 
the CIs are refreshed.

Click Rebuild View to rebuild the view by performing a 
full recalculation.

Note: The recalculation may take a long time.

Note: This button only appears in IT Universe Manager 
and Topology View.

The Set View Parameters button is only active if at least 
one node in the selected view has a parameterized node 
condition. Displays the Set View Parameters dialog box 
where you can edit the parameter of each condition. For 
details, see “Set View Parameters/Set View Element 
Parameters Dialog Box” on page 155.

Note: This button only appears in IT Universe Manager 
and Topology View.

Opens the Save Snapshot dialog box, which enables you 
to save a snapshot of the view. For details, see “Save 
Snapshot Dialog Box” on page 527.

Note: This button only appears in IT Universe Manager 
and Topology View.

Click Go to View Definition to go directly to View 
Manager for the current view.

Note: This button only appears in IT Universe Manager.
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Click Asset Report to open the Asset report for the 
selected view. For details, see “Asset Report Overview” 
on page 569.

Note: This button only appears in IT Universe Manager 
and Topology View.

The Related CIs tree structure button displays the CI 
tree by layers within the view.

Note: This button does not appear in IT Universe 
Manager or Topology View.

The CI type tree structure button displays the CI tree by 
CI type.

Note: This button does not appear in IT Universe 
Manager or Topology View.

Click the Menu option button to display a 
context-sensitive menu containing the options you can 
perform on a selected CI. You can also display the menu 
by right-clicking a CI.

Note: This button does not appear in IT Universe 
Manager or Topology View.

Click the Close/Open button to hide or display the View 
Explorer pane.

Note: This button does not appear in IT Universe 
Manager or Topology View.

Click the Select view from the folder tree button to the 
right of the View box, to open the Select View dialog 
box. You can browse through the folder tree to locate 
the view you want to display.

Enables you to move to the next or previous result of the 
search for the string entered in the Find

Note: This feature only appears in IT Universe Manager 
and Topology View.

<CIs> The CIs contained in the currently selected view.

GUI Element (A-Z) Description
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<Tooltip> Hold the cursor over a CI to display a tooltip with the 
relevant CI type.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the CI tree. The search only works 
for layers that have previously been. expanded. CIs in 
sublayers that have not been expanded in the tree are 
not included in the search.

Note: This feature only appears in IT Universe Manager 
and Topology View.

View The View box displays the currently selected view. To 
select a view to display, click the down arrow on the 
right side of the View box; this displays an abridged list 
of views, containing the most recently accessed views. 
Click the arrow at the bottom of the list to scroll 
through the entire list. (In IT Universe Manager, the 
recently accessed views appear at the top of the drop-
down, above the dividing line. The complete list of 
views appears below the line.)

Alternatively, place the cursor in the list and begin 
typing the view name. HP Business Availability Center 
completes the view name, if the first few letters that you 
type match an existing entry. If the names of several 
views begin with those letters, all matching views are 
displayed in the list.

GUI Element (A-Z) Description
619



Chapter 24 • View Explorer
Search Mode
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

In the Related to window, click to open the Select 
Configuration Item dialog box, where you select the 
required CI.

In the CI type window, click to open the Select 
Configuration Item Type dialog box, where you select 
the required CIT to search for.

Note: This is not relevant in IT Universe Manager or 
Topology View.

Enables you to move to the next or previous result of the 
search for the string entered in the Find field.

Note: This feature only appears in IT Universe Manager 
and Topology View.

<Search results> After you run the search, the results are listed in the 
lower part of the View Explorer pane. The results are 
shown in two columns:

➤ Name. Contains the name of the CI.

➤ View. Contains the name of the view in which the CI 
appears.

(In IT Universe Manager, the search results columns 
shown are Name and CI Type.)

If the CI or view name is abbreviated, hold the pointer 
over the entry to see the full name. You can sort the 
search results by clicking the appropriate heading.

CI type To search for CIs related to a specified CI type, click the 
ellipsis button to select a CI from the Select 
Configuration Item Type dialog box and select the CI 
Type check box (the check box is not relevant in 
IT Universe Manager).

In IT Universe Manager, you can search incrementally 
by typing the first few letters of the required CI type.
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Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the search results.

Note: This button only appears in IT Universe Manager 
and Topology View.

Name filter box Enter a CI name or part of a name in the filter box under 
the Name column of the results and press Enter to filter 
the results by name.

Note: This is not relevant in IT Universe Manager or 
Topology View.

Related to To search for CIs of a specified CI, select the Related to 
check box and click the ellipsis button to select a CI 
from the Select Configuration Item dialog box.

Note: This is not relevant in IT Universe Manager or 
Topology View.

Search Click to run the search. The search results are displayed 
in the lower part of the View Explorer pane. 

Search for In the Search for box, enter the name of the CI (or part 
of the name). For more information, see “Filter the 
Scope of the Search” on page 611.

Search in Specify the scope of your search. You can limit your 
search to the current viewor search in the most recently 
accessed views (by selecting All views). In Change Report 
and in the Instance View Editor in View Manager, you 
also have an option to search the entire CMDB. The 
default option is Current view. Select the required 
option.

For more information, see “Filter the Scope of the 
Search” on page 611.

Note: This is not relevant in IT Universe Manager or 
Topology View.

GUI Element (A-Z) Description
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Context Menu Options

Search results count The Search results count below the Find box displays the 
total number of CIs found in the search.

Note: This feature only appears in IT Universe Manager 
and Topology View.

View filter box Enter a view name or part of a name in the filter box 
under the View column of the results and press Enter to 
filter the results by view.

Note: This is not relevant in IT Universe Manager or 
Topology View.

Menu Item Description

<Context sensitive 
menu options>

The View Explorer context menu contains different 
options in each of the windows in which it appears. For 
example, in Dashboard you can open reports for the CI, 
and in IT Universe Manager you can attach new CIs to 
the CI.

For details on the context menu options specific to a 
particular application, see the User Interface Help for 
that application.

Locate CI in View When this is selected for a CI, View Explorer reverts to 
Browse mode and displays the view that contains the CI, 
with the CI selected in the view tree.

Note: 

➤ This option is only available in Search mode.

➤ This option is not available in IT Universe Manager.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

Unavailable Views and CIs
The View list in View Explorer may not display all views in the CMDB, or it 
may not display the contents of a view, for any of the following reasons:

➤ The View list includes only the views for which you have the necessary 
permissions. To set permissions, select Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For more 
information, see “Assign Permissions” in Platform Administration.

➤ When using View Explorer in IT Universe Manager, Dashboard, or Service 
Level Management, the View list includes only those views that are assigned 
to that application. 

➤ Views that are currently inactive appear in red in the View list, but they 
cannot be selected. In IT Universe Manager, inactive views appear in faded 
text.

➤ Out-of-the-box views for which you do not have a license may appear in the 
View list, but these views do not contain CIs. For information on the out-of-
the-box views, see “Predefined Folders and Views” on page 125.

Properties Opens the Properties page for the selected CI. For details, 
see “Properties Dialog Box” on page 96.

Show Related CIs When this option is selected, View Explorer changes to 
Search mode and displays a list of the CIs that have a 
relationship to the original CI. This is the same as 
defining the original CI in the Related to box when 
performing a search in all views.

Note: This option is not available in IT Universe 
Manager.

Menu Item Description
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Note: After deleting one or more nodes from a TQL, it can take time for 
changes to be updated to the view; meanwhile, the removed CIs appear in 
the view. If you select one of these CIs before it is updated, an error message 
is displayed. Use the Refresh button to update the view.
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Topology Map

This chapter provides information on Topology Map.

This chapter includes:

Concepts

 ➤  Topology Map Overview on page 627

 ➤  Handling Large Views on page 628

Reference

 ➤  Topology Map User Interface on page 628
Concepts

Topology Map Overview

The Topology Map provides a graphical display of a view. All the CIs in a 
given layer of the view are represented by icons and the connecting lines 
represent relationships. You can select a CI in the Topology Map or in View 
Explorer in the left pane. You can also drill down in View Explorer to display 
different layers of the view in the Topology Map.

If an icon appears with a downward arrow in the Topology Map, it means 
that there is an additional CI layer beneath it, created by a parent or child 
folding rule.

The toolbar and Main Menu above the Topology Map enable you to zoom 
in, change the layout of the Topology Map, and print the Topology Map. 
Additional functionality is available from the context menu by right-
clicking a CI in the Topology Map or in View Explorer.
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Handling Large Views

The Topology Map cannot display a view with more than 900 CIs in a single 
layer. When you select a view which contains a layer with more than this 
number of CIs, the Topology Map appears empty. 

To solve this problem, use one of the following solutions:

➤ Change the TQL query in the view definition in View Manager by adding 
conditions to redefine the view. For details, see “Refine Node Type Dialog 
Box” on page 328.

➤ Define different folding rules or Group By rules for the view to redistribute 
the CIs among the view’s layers. For details on defining folding rules, see 
“Add Folding Rules to Relationships” on page 141.

➤ Reset the maximum number of CIs allowed in the configuration parameters. 
Select the Foundations context in Infrastructure Settings Manager. Select the 
Max Object Count GUI for TS parameter under UCMDB common – Viewing 
Settings. However, be aware that increasing the maximum number of CIs 
per layer may significantly slow down the redrawing of the Topology Map.

For details regarding Infrastructure Settings Manager, see “Infrastructure 
Settings Manager - Overview” in Platform Administration.

Reference

Topology Map User Interface

This section describes:

 ➤  Export Map to Image Dialog Box on page 629

 ➤  Layout Properties Dialog Box on page 630

 ➤  Main Menu on page 650

 ➤  Print Dialog Box on page 652

 ➤  Print Preview Dialog Box on page 652

 ➤  Print Setup Dialog Box on page 653

 ➤  Toolbar Options on page 654
628



Chapter 25 • Topology Map
Export Map to Image Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to save a topology map to a file.

To access: From a topology map, select Operations > 
Export Map to Image.

Included in Tasks “Print and Save a Topology Map to File” on page 522

GUI Element (A–Z) Description

Move the indicator left or right to set the required quality 
of the printed map on the scale. 100 means that the 
quality is excellent.

Actual Size Save the view so that the node sizes are at maximum.

Current Zoom Level Save the view as you see it on the topology map. For 
example, if you have used the Interactive Zoom mode to 
decrease the view magnification, the nodes also appear 
smaller in the saved view. For details, see “Interactive 
Zoom” on page 659.

Custom Specify the size of the view you want to save in the Width 
and Height boxes.

Draw Grid Draw a grid in the graph.

File Name Specify the required file name and location (or click 
Browse to search for the file and location).

Fit in Canvas Expand or shrink the view so it fits in the window.

Image Quality (0-
100)

Enter a value to set the required quality of the printed 
map on the scale. 100 means that the quality is excellent.

Selected Objects 
Only

Saves only the nodes/CIs and their relationships that you 
selected in the map.

Type Select the required file format.

Visible Window Only Saves only the part of the graph that appears in the 
window.
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Layout Properties Dialog Box

Circular Tab

Description Enables you to customize the layout of a specific layer in 
a view, to achieve the clearest presentation possible and 
to better understand and monitor the managed data.

You define the layout of a view’s layers by assigning 
logical positions for the nodes and relationships that 
appear in a layer. You customize the layer layouts by 
modifying the default values.

Note: You set layout definitions for a specific layer only. 
The definitions cannot be saved for a different layer or a 
different view.

To access: Select Layout > Layout Properties.

Important 
Information

Parameter values are in pixels.

Description Enables you to group a graph’s nodes into groups or 
clusters based on the grouping options you select. It is 
particularly suited for visualizing ring and star network 
topologies, and for link analysis. 

The Circular tab has the following areas:

➤ Clustering area. Specifies the ratio between the average 
cluster size and the number of clusters as well as the 
minimum and maximum number of clusters in a layer.

➤ Cluster Layout Style area. Displays clusters either in a 
symmetric or circular layout style.

➤ Layout Quality area. Adjusts the quality of the layout 
produced to fit your application’s needs. The quality 
reflects the number of steps or the method used to 
produce the layout. For example, high quality is 
sharper but takes more time to set the layout.

➤ Spacing area. Sets the spacing around each node 
within the same cluster and between clusters.

To access: Click the Circular tab in the Layout Properties 
dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Circular Displays clusters in a circular layout style.

Cluster Spacing Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing.

This illustration shows larger cluster spacing.

Cluster Size 
Multiplier

Specifies the ratio between the average cluster size and 
the number of clusters. The size of a cluster is defined as 
the sum of the weights of all nodes in the cluster. You can 
assign a weight value to each node.

Draft Sets the layout to draft quality.

Default Sets the layout to default quality.

Max Number of 
Clusters

The maximum number of clusters in a layer.

Min Number Of 
Clusters

The minimum number of clusters in a layer.
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Node Spacing Sets the spacing around each node within the same 
cluster. The larger the spacing, the more nodes there are 
on the cluster boundary. 

Default value: 10

This illustration shows smaller node spacing.

This illustration shows larger node spacing.

Proof Sets the layout to proof quality.

Symmetric Displays clusters in a symmetric layout style.

GUI Element (A–Z) Description
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Disconnected Tab 

Description Enables you to define general layout parameters for 
disconnected nodes and connected components. 

➤ A disconnected node is a node that is not connected to 
any other node.

➤ A disconnected component is a component that is not 
connected to any other component. It contains a set of 
nodes that can be connected to each other.

This illustrates a connected component with five nodes:

This illustrates a connected component with two nodes:

This illustrates four disconnected components, each 
made up of a single, disconnected node:

The Disconnected tab has the following areas:

➤ Aspect Ratio area. This setting affects the placement of 
components with respect to each other only, and not 
the layout of each individual component. The setting 
has no effect if the graph is connected.

➤ Components area. The spacing between the 
components in a disconnected graph consists of both 
a constant value and a proportional value based on the 
sizes of the components.

➤ Disconnected Nodes. The spacing between the nodes 
in a disconnected graph consists of both a constant 
value and a proportional value based on the sizes of 
the nodes.

To access: Click the Disconnected tab in the Layout 
Properties dialog box. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Automatic The layout is performed automatically.

Custom Sets a specific aspect ratio.

Default value: 1.0

Constant Spacing Set constant spacing (horizontal and vertical) around 
each disconnected component. 

Default value: 20

Detect Components Select this option to view the disconnected components. 
You can specify that all components be laid out together 
or individually, regardless of the other components. If 
the grouping for components is selected, each 
component is laid out, and the resulting components are 
packed together.

Detect Disconnected 
Nodes

Select this option to view the disconnected nodes. You 
can specify that disconnected nodes be grouped into one 
component or laid out individually.

Proportional Spacing Set spacing (horizontal and vertical) that is proportional 
to the size of the component around each disconnected 
component. 

Default value: 0.05
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Hierarchical Tab

Description Shows the precedence relationships that can represent 
organizational or information management system 
dependencies, as well as process models, software call 
graphs, and work flows. The hierarchical layout 
emphasizes dependencies by placing the nodes at 
different levels.

The Hierarchical tab has the following areas:

➤ Backward Edges area. Specifies how backward 
relationships are displayed in the hierarchical layout. 

➤ Horizontal Spacing area. Enables you to set the 
minimum horizontal distance between two 
neighboring nodes at each level.

➤ Layout Quality area. Enables you to adjust the quality 
of the layout produced to fit your application’s needs. 
The quality reflects the number of steps or the method 
used to produce the layout. For example, high quality 
is sharper but takes more time to set the layout.

➤ Level Alignment area. Enables you to set the way 
nodes are vertically aligned.

➤ Orientation Routing area. Enables you to set the 
orientation of the hierarchy.

➤ Polyline Routing area. Routes edges as one or more 
straight line segments with arbitrary angles. Polyline 
routed edges are prevented from overlapping by 
adding extra segments.

➤ Routing area. Enables you to set the type of 
relationship between CIs. This option is useful when 
layers have nodes with a very large number of 
connecting relationships.

➤ Vertical Spacing area. Enables you to set the minimum 
vertical distance between two neighboring nodes on 
different levels.

To access: Click the Hierarchical tab in the Layout 
Properties dialog box. 

Important 
Information

Orthogonal Routing is currently not supported.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Bottom This illustration shows that the bottom of the nodes at 
the same level of the hierarchy are aligned.

Bottom To Top The children are located below the parent (in the 
example, Alignment = Center).

Center This illustration shows that the center of the nodes at the 
same level of the hierarchy are aligned.

Default Sets the layout to default quality.
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Draft Sets the layout to draft quality.

Left To Right The children are located to the left of the parent (in the 
example, Alignment = Center).

Minimum Backward 
Edges

Sets the number of number of backward relationships 
displayed in a layer to a minimum.

Optimize For 
Feedback Flow

Sets the number of number of backward relationships 
displayed in a layer to a maximum. This mode is more 
appropriate for flow charts.

Orthogonal For orthogonal lines between nodes/CIs.

GUI Element (A–Z) Description
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Polyline For straight lines between nodes/CIs.

Proof Sets the layout to proof quality.

Right To Left The children are located to the right of the parent (in the 
example, Alignment = Center).

GUI Element (A–Z) Description
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Spacing Between 
Edges (in the 
Horizontal Spacing 
area)

This setting is available only when you select Routing > 
Orthogonal. It sets a horizontal space between edges in 
the graph.

Default value: 12

This illustration shows smaller edge spacing.

This illustration shows larger edge spacing.

Spacing Between 
Edges (in the Vertical 
Spacing area)

This setting is available only when you select Routing > 
Orthogonal. It sets a vertical space between edges in the 
graph.

Default value: 12

Spacing Between 
Nodes (in the 
Vertical Spacing 
area)

Sets a vertical space around each node in the level. 

Default value: 28

GUI Element (A–Z) Description
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Spacing Between 
Ends (in the 
Horizontal Spacing 
area)

This setting is available only when you select Routing > 
Polyline. Polyline routing routes edges (connecting lines) 
as one or more straight line segments with arbitrary 
angles. Path nodes are added automatically to prevent 
the edges (connecting lines) from overlapping.

Default Value: 12

GUI Element (A–Z) Description
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Spacing Between 
Nodes

Sets a space around each node horizontally in the layer. 
Default value: 20

This illustration shows smaller node spacing.

This illustration shows larger node spacing.

GUI Element (A–Z) Description
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Top This illustration shows that the top of the nodes at the 
same level of the hierarchy are aligned.

Top To Bottom The children are located above the parent (in the 
example, Alignment = Center).

GUI Element (A–Z) Description
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Orthogonal Tab

Undirected Layout Edge direction is not used to build the levels of the 
hierarchical drawing.

Variable Level 
Spacing

Variable level spacing adjusts the spacing between pairs 
of neighboring levels according to the density of edges 
between the levels. 

If the drawing’s edges are orthogonally routed, this 
ensures the desired vertical spacing between horizontal 
edges (in a top-to-bottom or bottom-to-top layout) 
routed between levels. 

If the routing is polyline, variable level spacing makes it 
easier to distinguish among edges in very dense 
drawings.

Description Enables you to set orthogonal layout route relationships 
horizontally and vertically. This results in relationships 
bending at 90-degree angles only.

The Orthogonal tab has the following areas:

➤ Aspect Ratio area. Enables you to set the layout’s 
proportions. This only affects the placement of 
components with respect to each other, not the layout 
of each individual component. The layout’s 
proportions have no effect if the graph is connected.

➤ Horizontal Spacing area. Enables you to set the 
minimum horizontal distance between nodes.

➤ Layout Quality area. Enables you to adjust the quality 
of the layout produced to fit your application’s needs. 
The quality reflects the number of steps or the method 
used to produce the layout. For example, high quality 
is sharper but takes more time to set the layout.

➤ Vertical Spacing area. Enables you to set the minimum 
vertical distance between nodes.

To access: Click the Orthogonal tab in the Layout 
Properties dialog box.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The Fix Node Sizes option is currently not supported.

GUI Element (A–Z) Description

Automatic The layout is performed automatically.

Custom Specify the aspect ratio.

Default value: 1.0

Default Set the layout to default quality.

Draft Set the layout to draft quality.

Disabled Disables the aspect ratio.

Proof Set the layout to proof quality.

Spacing Between 
Edges (in the 
Horizontal Spacing 
area)

Set a space between elements in the layer.

Default value: 12

Spacing Between 
Nodes (in the 
Horizontal Spacing 
area)

Set a space around each node in the layer.

Default value: 20

Spacing Between 
Edges (in the Vertical 
Spacing area)

 Set a space between elements in the layer.

Default value: 12

Spacing Between 
Nodes (in the 
Vertical Spacing 
area)

Sets a space around each node in the layer.

Default value: 20
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Routing Tab

Description Enables you to produce drawings that leave nodes 
essentially where they are, and reroute the lines 
orthogonally.

The Routing tab has the following areas:

➤ Horizontal Spacing area. Enables you to set the 
horizontal space around each node.

➤ Vertical Spacing area. Enables you to set the vertical 
space around each node.

To access: Click the Routing tab in the Layout Properties 
dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Fix Node Positions Maintain the position of all the nodes in the display. 
Clear this option for the layout to move the nodes if it is 
necessary to improve the layout. The movement is 
minimal, avoids overlaps, and minimizes bend points.

Fix Node Sizes Maintain the size of a node. Clear this option if you want 
the layout to increase the size of a node if it is necessary 
to maintain the specified relationship spacing when 
more than one relationship is attached to the same node 
side.
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Spacing Between 
Edges (in the 
Horizontal Spacing 
area)

Sets the horizontal space between any two neighboring 
parallel lines. Line spacing can also affect the size of a 
node to which many lines are attached, unless the node 
is set to remain fixed at its current size. The settings for 
line spacing are constant values.

Default value: 12

The following illustrates smaller line spacing:

The following illustrates larger line spacing:

Spacing Between 
Edges (in the Vertical 
Spacing area)

Set the vertical space between any two neighboring 
parallel lines. Spacing between lines can also affect the 
size of a node to which many edges are attached, unless 
the node is set to remain fixed at its current size. The 
settings for edge spacing are constant values. 

Default value: 12

GUI Element (A–Z) Description
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Spacing Between 
Nodes (in the 
Horizontal Spacing 
area)

Sets the horizontal space around each node in the layer.

Default value: 20

The following illustrates smaller node spacing:

The following illustrates larger node spacing:

Spacing Between 
Nodes (in the 
Vertical Spacing 
area)

Set the vertical space around each node in the layer. 

Default value: 20

GUI Element (A–Z) Description
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Symmetric Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a clear representation of complex networks. The 
symmetric layout emphasizes the symmetries that may 
occur in a graph.

This tab consists of the following areas:

➤ Layout Quality area. Adjusts the quality of the layout 
produced to fit your application’s needs. The quality 
reflects the number of steps or the method used to 
produce the layout. For example, high quality is 
sharper but takes more time to set the layout.

➤ Spacing Options area. Enables you to adjust the 
spacing around each node in the layer.

To access: Click the Symmetric tab in the Layout 
Properties dialog box.

GUI Element (A–Z) Description

Default Set the layout to default quality.

Draft Set the layout to draft quality.
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Main Menu

Node Spacing Allows you to set constant horizontal and vertical 
spacing around each node in the layer. The value you 
specify is a guideline for the layout, so that it is possible 
that the spacing for a particular pair of nodes might be 
different from the one you specified. The larger the node 
spacing, the farther apart the nodes are spaced in the 
final layout.

Default value: 10

The following figure illustrates smaller and larger 
spacing.

Proof Set the layout to proof quality.

Description Contains the options for working with the topology map.

Important 
Information

The specific options contained within the Main Menu 
drop-downs are detailed in “Toolbar Options” on 
page 654.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Edit Contains selection options for the topology map.

Layout Contains options for changing the layout of the topology 
map.

Map Item Contains the topology map context menu options for the 
current manager.

Operations Contains options for printing or exporting the topology 
map.

Resources Contains the left pane context menu options for the 
current manager.

Note: In IT Universe Manager, this drop-down is called 
Configuration Items and in CI Tipe Manager it is called CI 
Types.

View Enables you to hide or display the different panes of the 
topology map.
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Print Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Print Preview Dialog Box

Description Enables you to print the contents of the topology map. 

To access: Select Operations > Print.

Important 
Information

The results of printing a topology map is similar to a 
screen capture. Therefore, before printing, it is 
recommended to:

➤ Define your print settings and arrange the contents of 
the topology map according to your requirements. For 
details, see “Print Setup Dialog Box” on page 653.

➤ Arrange the contents of the topology map for print. 
You can use the Layout option and Layout Properties. 
For details about the layout options, see “Layout” on 
page 659.. For details about layout properties, see 
“Layout Properties Dialog Box” on page 630..

Included in Tasks “Print and Save a Topology Map to File” on page 522

GUI Element (A–Z) Description

Number of copies Enter the number of copies you want to print.

Properties Define document properties as required.

Description Enables you to preview the content of the topology map 
before printing.

To access: Select Operations > Print Preview.

Included in Tasks “Print and Save a Topology Map to File” on page 522
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The Print Preview dialog box includes the following menu options (listed 
alphabetically):

Print Setup Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Menu Item Description

Fit in Canvas Fit the complete view in the window.

Print Print the map. For details, see “Print Dialog Box” on 
page 652.

Print Setup Define the print settings for the map. For details, see 
“Print Setup Dialog Box” on page 653.

Zoom Focus on specific details of the map. For details, see 
“Interactive Zoom” on page 659.

Description Enables you to define the print settings for a topology 
map.

To access: Select Operations > Print Setup.

Included in Tasks “Print and Save a Topology Map to File” on page 522

GUI Element (A–Z) Description

Actual Size Print the view as it really is.

Color Set the text color.

Font Set the required font.

Page Setup Set the printer settings.

Pages Divide the map into rows and columns and print each 
section separately. Enter the number of columns and rows 
in the Page Columns and Page Rows boxes.

Print Background Print the background behind the view.
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Toolbar Options

The following table contains a description of each Topology Map toolbar 
option, organized alphabetically.

Print Border Print the map with a border. Click Color to select the 
required border color.

Print Caption Enter the caption in the text area and click Font to select 
the required custom font.

Print Crop Marks Print the crop marks.

Print Current 
Selection

Print the selected nodes and their relationships.

Print Current 
Window

Print the part of the view that appears in the window.

Print Entire Drawing Print the complete view.

Print Page Numbers Print the page numbers.

Position Select the position of the caption from the Position list.

Zoom Level Print the view at the current zoom level.

GUI Element (A–Z) Description
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Note: These toolbar options are relevant for Universal CMDB applications.

Button Option Name Use This Option to...

Add 
Background 
Image

Add a background image to a view. For details, see “Add 
Background Image Dialog Box” in Model Management.

To access: Select Layout > Add Background Image.

Note: This option is only active in IT Universe Manager and the 
Topology View application.

Additions 
Count

Enables you to calculate the number of instances that are 
created as a result of an Enrichment Rule. The number of TQL 
node instances and relationships that are created appear next to 
the Enrichment nodes/relationships, as seen in the figure below.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Calculate TQL 
Result Count

Calculate the number of instances found for each TQL 
node/relationship.

Candidates 
for Deletion

Identify the CIs in the current view which are candidates for 
deletion.

Note: This option appears in the toolbar in the Topology View 
application only.
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Change Label 
Length

Enter the maximum number of characters that the labels should 
contain.

To access: Select Layout > Change label length.

Change 
Timeframe

Open the Change Timeframe dialog box, which enables you to 
set the period for the display of added or changed CI indicators.

Note: This option appears in the toolbar in Topology View 
application only.

CI Types Tree Toggle between hiding and displaying the CI Type Selector at 
the right of the screen.

To access: Select View > CI Types Tree.

Clear 
Correlation

Clear the Topology View of the statuses of the trigger and 
affected CIs for the state Change. CI statuses appear only after 
using the Run Correlation dialog box to run an Impact Analysis 
report on a set of existing Correlation rules. For details, see “Run 
Correlation Dialog Box” on page 524. For details on Correlation 
rules, see “Correlation Manager User Interface” on page 175.

Note: This option appears in the toolbar in the Topology Map in 
the Topology View application only.

Create 
Relationship

Create a relationship between two existing TQL nodes. For 
details, see “Add Nodes and Relationships to a TQL Query” on 
page 268.

Create a relationship between existing CIs. For details, see 
“Attaching Existing CIs” on page 66. 

Delete 
Selected 
Item(s)

Delete a CI from IT Universe Manager, a node from View 
Manager, a TQL node from Query Manager, Correlation 
Manager, Report Manager, or Enrichment Manager. 

Drag Map Drag the view.

To access: Open the drop-down menu in the Mode box or select 
View > Drag Map.

Button Option Name Use This Option to...
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Drill Down 
One Layer

Move down one level in the topology map. This option is 
enabled only if there is an additional CI layer below it, created 
by a parent or child folding rule as defined in View Manager. For 
details on folding rules, see “Adding Folding Rules to 
Relationships” on page 68. 

Note: This option appears only in IT Universe Manager and the 
Topology View application.

Entities Tree Toggle between hiding and displaying the manager specific 
entities tree at the left of the screen.

To access: Select View > Entities Tree.

Export Map 
to Image

Save the topology map to a file. For details, see “Export Map to 
Image Dialog Box” on page 629.

To access: Select Operations > Export Map to Image.

Filter DB 
Results

Opens a dialog box which displays the number of related CIs by 
type. Select the CI type you want to appear in the Topology Map 
results.

Note: This option appears only in IT Universe Manager and the 
Topology View application.

Fit to 
Window

Fit the complete map in the window.

Generate 
Related CIs 
Report

Display the Get Related CIs Report for the selected CI. For 
details, see “Get Related CIs Report” on page 78.

Note: This option appears only in IT Universe Manager and the 
Topology View application.

Go Up One 
Layer

Move up one level in the topology map. This option is enabled 
only if there is an additional CI layer above it, created by a 
parent or child folding rule as defined in View Manager. For 
details on folding rules, see “Adding Folding Rules to 
Relationships” on page 68. 

Note: This option appears only in IT Universe Manager and the 
Topology View application.

Button Option Name Use This Option to...
657



Chapter 25 • Topology Map
Hide All 
Inheritance 
From Map

Toggle between showing and hiding Inheritance_f relationships 
and their connecting node.

To access: Select Layout > Hide All Inheritance From Map.

Note: This option is only active in the toolbar in CI Type 
Manager.

Hide All Node 
Labels

Toggle between showing or hiding the CI/CIT/node/pattern 
labels.

To access: Select Layout > Hide All Node Labels.

Hide All 
Relationship 
Labels

Toggle between showing or hiding the relationship labels.

To access: Select Layout > Hide All Relationship Labels.

Hide All 
Relationships

Toggle between showing and hiding the relationships in the 
displayed map.

To access: Select Layout > Hide All Relationships.

Hide 
Panes/Restor
e Panes

Toggle between the regular display and a full-screen display of 
the topology map.

Information 
Pane

Toggle between hiding and displaying the Information Pane at 
the bottom center of the screen.

To access: Select View > Information Pane.

Insert CI Define a new unrelated CI. For details, see “Working with CIs” 
on page 57.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Insert CI and 
Relate

Define a new related CI. For details, see “Working with CIs” on 
page 57.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Button Option Name Use This Option to...
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Interactive 
Zoom

➤ Decrease the view magnification by clicking and pushing the 
pointer upwards.

➤ Magnify the view by clicking and pulling the pointer 
downwards.

To access: Open the drop-down menu in the Mode box or select 
View > Interactive Zoom.

 Layout 
Properties

Define the view’s layer layout, by assigning positions for the 
nodes and relationships of the view. For details, see “Layout 
Properties Dialog Box” on page 630. 

To access: Select Layout > Layout Properties.

Layout Select the layout display from the list. The options are:

➤ Hierarchical. Enables you to display the precedence relations 
in the topology map.

➤ Symmetric. Enables you to display clear representations of 
complex networks.

➤ Circular. Groups a graph’s nodes into groups or clusters.

➤ Manual. Enables you to display the changes you have made 
manually to the topology map. 

➤ Orthogonal. Enables you to display views of outstanding 
clarity that are achieved by employing only horizontal and 
vertical edge routing.

Note: Click Save Layout to save the selected layout.

For further details about each of the options, see “Layout 
Properties Dialog Box” on page 630. 

Map 
overview

Open a small window with a copy of the topology map. This is 
useful in large views when zooming in.

To access: Select Layout > Map Overview.

Button Option Name Use This Option to...
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Navigation Take the pointer to the next connected CI/CIT/TQL node in a 
clockwise direction.

➤ Left-click to move in a clockwise direction.

➤ Right-click to point to the next CI/CIT/node/pattern in a 
clockwise direction. 

To access: Open the drop-down menu in the Mode box or select 
View > Navigation.

Note: You can use this option only on CI/CIT/nodes/patterns 
that are connected by relationships.

Place in 
Center

Places the selected CI/node/CIT/pattern in the center of the 
map.

To access: Select Layout > Place in Center.

Print Print the contents of the topology map. For details, see “Print 
Dialog Box” on page 652.

To access: Select Operations > Print...

Print Preview Preview the contents of the map before printing.

To access: Select Operations > Print Preview.

Print Setup Define print settings for printing the topology map. For details, 
see “Print Setup Dialog Box” on page 653.

To access: Select Operations > Print Setup...

Rediscover 
View Content

Rediscover all the CIs in a selected view by manually starting the 
DDM jobs that originally discovered them.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Remove 
Enrichment 
Results

Remove the instances created from an Enrichment rule from the 
CMDB.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Button Option Name Use This Option to...
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Save Layout Save changes to the layout. To retrieve the layout you have 
saved, select Manual Layout. 

To access: Select Layout > Save Layout.

Note: This option appears in the toolbar in IT Universe Manager 
and Topology View application only.

Select Select a CI/CIT/TQL node or multiple CIs/CITs/TQL nodes.

To access: Open the drop-down menu in the Mode box or select 
View > Select.

Select All Select all the CIs and relationships in a selected layer.

To access: Select Edit > Select All.

Select All 
Nodes

Select all the nodes in a selected layer.

To access: Select Edit > Select All Nodes.

Set Number 
of Hops

Open a dialog box which enables you to set the degree of 
separation of the related CIs to appear in the Related in DB 
selection.

Note: This option appears in the toolbar in IT Universe Manager 
and Topology View application only.

Show 
Changes in 
Map

Display an indicator next to each CI that was added or changed 
within the selected period as follows:

➤  Indicator for an added CI

➤  Indicator for a changed CI

You can toggle between hiding and displaying the indicators by 
clicking the button. When the indicators are displayed, you can 
double-click on the indicator to open the CI History dialog box, 
which displays the history for the CI over the selected period.

For details on selecting the period, see “Change Timeframe” on 
page 656.

Note: This option appears in the toolbar in Topology View 
application only. 

Button Option Name Use This Option to...
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Show 
Schedule Info

Display the scheduling information for the selected job. For 
details, see “Discovery Scheduler Dialog Box” in Discovery and 
Dependency Mapping Guide.

Note: This option appears in the toolbar in the Dependency 
Map tab of DDM. For details, see “Dependency Map Tab” in 
Discovery and Dependency Mapping Guide.

Straighten All 
Selected 
Relationships

Straightens any selected relationship between two nodes that 
has angles. 

To access: Select Layout > Straighten All Selected Relationships.

User 
Preferences

Opens the User Preferences dialog box which enables you to 
reset warning message preferences. For details, see “User 
Preferences Dialog Box” on page 339.

To access: Select Edit > User Preferences.

Zoom Zoom in on a specific section of the topology map by clicking 
and drawing a selection rectangle around the part to magnify. 
The area you select is displayed at the highest percentage that 
fits in the topology map.

To access: Open the drop-down menu in the Mode box or select 
View > Zoom.

Button Option Name Use This Option to...
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Source Manager

This chapter provides information on Source Manager.

This chapter includes:

Concepts

 ➤  Source Manager Overview on page 666

 ➤  Source Adapter Activities on page 667

 ➤  Source Adapter Templates on page 667

 ➤  Dynamic Node Factory Resource on page 668

 ➤  Predefined Monitoring Service Views on page 668

 ➤  Customize the Source Adapters on page 669

 ➤  When to Use Generic EMS on page 669

 ➤  When to Use the XML File Source Adapter on page 670

 ➤  Business Process Monitoring Source Adapter Details on page 671

 ➤  Real User Monitor Source Adapter Details on page 679

 ➤  SiteScope Source Adapter Details on page 692

 ➤  Generic EMS Source Adapter Details on page 696

 ➤  XML File Source Adapter Details on page 698

Tasks

 ➤  Configure a Source Adapter – Workflow on page 700

 ➤  Work with the SiteScope Source Adapter – Workflow on page 703

 ➤  Modify an Adapter Template on page 708
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 ➤  Modify Relationships on page 718

 ➤  Define Selectors on page 720

 ➤  Customize Dynamic Node Factory Definitions on page 722

 ➤  Change the Decay Timeout Value on page 723

Reference

 ➤  Source Manager User Interface on page 724
Concepts

Source Manager Overview

Source Manager enables you to define and manage the source adapters used 
by HP Business Availability Center. 

Source Manager predefined definitions provide all the tools required to 
harness data from the data sources used by HP Business Availability Center. 
You use the received information to build views for the HP Business 
Availability Center applications. 

The source adapters format the data arriving from the external data sources 
(collected by HP Business Availability Center data collectors, or supplied by 
other external resources) using predefined templates.

The template for each source adapter defines the information needed for 
creating configuration item (CI) in the configuration management database 
(CMDB), and defines the relationships to be created between the CIs in 
order to build the CI hierarchies. The CI definitions include the KPIs, 
business rules, selectors, and so on, that are needed to present the real-time 
monitoring data received from the data sources in a meaningful way in 
Dashboard and Service Level Management. The templates define the 
mapping between the external source objects and the HP Business 
Availability Center CIs, so that the incoming data samples are mapped to 
the appropriate CI. 
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Source Manager contains default source adapters that are preconfigured to 
work immediately with the data collected by the HP Business Availability 
Center data collectors (Business Process Monitoring, Real User Monitor, 
Diagnostics, and SiteScope) and generic source adapters (Generic EMS 
Source Adapter Details or XML File Source Adapter Details).

Default source adapters that are automatically preconfigured and activated 
when HP Business Availability Center starts, using a default template for 
each source adapter.

Source Adapter Activities

A source adapter performs the following steps:

➤ Imports system hierarchy information from System Availability 
Management, and, if applicable, from an external system. An external 
system can be, for example, the data source’s database, a file system, or an 
API.

➤ Maps components from the hierarchy to predefined CIs in HP Business 
Availability Center.

➤ Creates CIs and relationships for the imported information and stores them 
in the CMDB.

Source Adapter Templates

The source adapter templates define all necessary information needed to 
present aggregated data from the various data sources. 

Each source adapter uses a template that maps the entities in the data source 
to the CIs stored in the CMDB and defines the resources to be used in CMDB 
for a CI, such as KPIs, and business rules.
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Advanced Users
You can customize the source adapter templates, or you can modify the 
KPIs, rules, and selector definitions in the Dashboard Administration 
Repositories page, in order to meet your organization’s needs. To customize 
a source adapter template, click Admin > Universal CMDB > Source 
Manager. To access the Dashboard Repositories, click Admin > Dashboard > 
Repositories. To access the Service Level Management Repositories, click 
Admin > Service Level Management > Repositories.

HP Professional Services offers best practice consulting; it is recommended 
that you use this service before making any changes to the templates or 
repositories. For information on how to obtain this service, contact HP 
Software Support. 

Dynamic Node Factory Resource

Some adapter templates include a Dynamic Node Factory resource. When a 
Dynamic Node Factory CI is included in a view, HP Business Availability 
Center dynamically builds a hierarchy for the source in run time, under the 
Dynamic Node Factory CI. For more information on the Dynamic Node 
Factory resource, see “Working with Dynamic Node Factory Overview” on 
page 105.

Predefined Monitoring Service Views

For each source adapter, predefined monitoring service views display the 
created CI hierarchies for the monitored sources. When data is received over 
the bus for a defined source, you can open the relevant view in Dashboard 
and view status information for the CIs. You can use the configuration item 
(CI) hierarchies created in the predefined monitoring views as the building 
blocks for defining your own customized views.
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Customize the Source Adapters

Source Manager provides you with the ability to modify and add to the 
majority of the adapter definitions, enabling you to customize the data 
sampling, the way the hierarchies are constructed, the parameters used for 
calculations, and the way the data is presented in the applications. This 
allows you to present the aggregated source data in a way that is relevant for 
your organization’s needs.

Integration with Third-Party Source
It is recommended to work with the EMS Integrations application for each 
new integration of the following third-party sources: BMC PATROL, 
CA Unicenter, Compaq Insight Manager (CIM), Hewlett-Packard (HP) 
OpenView, HP OpenView Service Navigator, HP Systems Insight Manager 
(HP SIM), and Tivoli TEC. You can still edit those third-party source adapters 
if they were created before version 7.0.

To access the EMS Integrations application, select Admin > EMS 
Integrations.

When to Use Generic EMS

It is recommended to use the Generic EMS source adapter when you want to 
perform an EMS integration that sends samples with the Event type. The 
Generic EMS source adapter is useful for demos, or to view which EMS 
source adapters have been enabled. 

When the Generic EMS source adapter and other EMS source adapters are 
enabled, two or more views are created: the Generic EMS view and the 
view(s) corresponding to the other EMS source adapter(s).

The Generic EMS view displays information about each EMS source adapter 
in a hierarchy where each CI above the monitor CI level is represented by an 
EMS Group type CI. In addition, separate view(s) are created for each one of 
the other EMS source adapter(s) using that source adapter’s specific 
hierarchy.
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The top level of the Generic EMS source adapter view displays the EMS 
source adapters present in the system. The hierarchy appearing below that 
level is specific to each EMS source adapter but each one of them has the 
EMS Group type except for the monitor CI level. Some additional EMS 
Group type CIs might be created to fill in the different levels of the Generic 
EMS hierarchy. 

In the Generic EMS view, the rules and KPIs applied to each CI level (except 
the measurement CI level) are the rules and KPIs attached to the EMS Group 
type CI. In the other EMS source adapter views, the rules and KPIs applied to 
each CI level (except for the measurement CI level) are the rules and KPIs 
defined for the relevant CI type.

The samples that are caught by the Generic EMS DNode and by a specific 
EMS source adapter DNode do not create the same monitor CIs (the CIs are 
duplicated in the CMDB) though their values are updated from the same 
sample. 

To check the status of a specific CI in Dashboard, it is recommended to go to 
the view appropriate for the EMS source adapter as the Generic EMS source 
adapter view might display a different status appropriate for its view but 
that might not represent the appropriate status. In the same way, if you 
want to use one of the EMS source adapter CIs in a specific view, make sure 
to use the CIs from the view appropriate for the EMS source adapter and not 
the CIs from the Generic EMS source adapter.

When to Use the XML File Source Adapter 

Use the XML File source adapter when you want to create a hierarchy that is 
different from the hierarchies offered by the other source adapters. 

The user with the appropriate permissions who creates an XML File source 
adapter must know how the data is stored in the CMDB (using the CI Type 
manager). 

For an example, see “Example - Create an XML File” on page 710.
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Business Process Monitoring Source Adapter Details

The Business Process Monitoring source adapter sets the decay timeout and 
the duration of the rules according to the Business Process Monitor and 
rules scheduling, set in “Business Process Monitor Administration” in Using 
End User Management. 

You can customize some of the source adapter parameters, as explained in 
“New/Edit Source Adapter Dialog Box” on page 724.

This section includes the following topics:

➤ “Hierarchies” on page 672

➤ “Template Elements” on page 675

➤ “Relationships” on page 678

➤ “Selectors” on page 679
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Hierarchies
Depending on the options and parameters you selected when defining a 
source adapter or editing it, the following hierarchies are created in the 
CMDB:

Note: Business Process Step and Location CIs use the same instance of the 
Business Process Monitor transaction with location. 

➤ End User Locations View. The End User Locations View TQL is as follows:

If you select the Regular hierarchy structure, the view displays only the 
Business Process Group CIs.
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If you select the Transaction/Location hierarchy structure, the view displays 
the following CIs.

The End User Locations View provides relevant information (apart from a 
list of Business Process Group CIs) only if you select the 
Transaction/Location hierarchy structure.
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➤ End User Monitors View. The End User Monitors View TQL is as follows:

If you select the Regular hierarchy structure, the End User Monitors View 
displays the following hierarchy.

Note that the Business Process Transaction from Location CIs do not display 
the location information.

If you select the Transaction/Location hierarchy structure, the view displays 
the following CIs:
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The Business Process Transaction from Location CIs display location 
information.

Template Elements
The Business Process Monitoring source adapter template uses the following 
elements:

entity id basicEntity contextmenu dimension (KPI)
logic 
(business rule)

diagnostics
Transaction

bpm_tx_from_
location

diagnostics
MenuForBPM

1075 – Application 1075 – 
Diagnostics for 
J2EE/.Net 
General

7 – Availability 
(Dashboard)

5 – Transaction 
Availability 
Rule

6 – Performance 
(Dashboard)

13 – 
Transaction 
Performance 
Rule 

transaction bpm_tx_from_
location

txMeasurement
Menu – 
Transaction 
Measurement 
Menu

7 – Availability 
(Dashboard)

5 – Transaction 
Availability 
Rule

6 – Performance 
(Dashboard)

13 – 
Transaction 
Performance 
Rule 

crossProfile
Location

location txgroupMenu – 
Group Menu

7 – Availability 
(Dashboard)

1 – Worst Child 
Rule

6 – Performance 
(Dashboard)

1 – Worst Child 
Rule

profileLocation bp_group
_location

txgroupMenu – 
Group Menu

7 – Availability 
(Dashboard)

1 – Worst Child 
Rule

6 – Performance 
(Dashboard)

1 – Worst Child 
Rule
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baseline
Transaction
Location

bpm_tx_from
_location

txMeasurement
Menu

7 – Availability 
(Dashboard)

5 – Transaction 
Availability 
Rule

6 – Performance 
(Dashboard)

101 - 
Transaction 
Performance 
Status Average 
Rule

customer – Not 
in use

Group groupMenu – 
Group Menu

7 – Availability 
(Dashboard)

1 – Worst Child 
Rule

6 – Performance 
(Dashboard)

1 – Worst Child 
Rule

profile bp_group txgroupMenu – 
Group Menu

7 – Availability 
(Dashboard)

1 – Worst Child 
Rule

6 – Performance 
(Dashboard)

1 – Worst Child 
Rule

transaction
Group

bp_step txgroupMenu – 
Group Menu

7 – Availability 
(Dashboard)

1 – Worst Child 
Rule

6 – Performance 
(Dashboard)

1 – Worst Child 
Rule

baseline
Transaction

bpm_tx_from
_location

txMeasurement
Menu

7 – Availability 
(Dashboard)

5 – Transaction 
Availability 
Rule

6 – Performance 
(Dashboard)

101 - 
Transaction 
Performance 
Status Average 
Rule

entity id basicEntity contextmenu dimension (KPI)
logic 
(business rule)
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diagnostic
Transaction
Group

bp_step txGroupMenu
WithLayers
View

1075 – Application 1 – Worst Child 
Rule

7 – Availability 
(Dashboard)

1 – Worst Child 
Rule

6 – Performance 
(Dashboard)

1 – Worst Child 
Rule

Diagnostics
Profile

bp_group txGroupMenu 1075 – Application 1 – Worst Child 
Rule

7 – Availability 
(Dashboard)

1 – Worst Child 
Rule

6 – Performance 
(Dashboard)

1 – Worst Child 
Rule

diagnostics
Transaction
Location

bpm_tx_from
Location

diagnostics
MenuForBPM

1075 – Application 1075 – 
Diagnostics for 
J2EE/.Net 
General

7 – Availability 
(Dashboard)

5 – Transaction 
Availability 
Rule

6 – Performance 
(Dashboard)

13 – 
Transaction 
Performance 
Rule 

transaction
Location

bpm_tx_from_
location

txMeasurement
Menu – 
Transaction 
Measurement 
Menu

7 – Availability 
(Dashboard)

5 – Transaction 
Availability 
Rule

6 – Performance 
(Dashboard)

13 – 
Transaction 
Performance 
Rule 

entity id basicEntity contextmenu dimension (KPI)
logic 
(business rule)
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Note: When you use the Baseline auto modes to calculate thresholds, the 
baselineTransaction and the baselineTransactionLocation entities are used 
instead of the transaction and transactionLocation entities, which are used 
when you set up thresholds manually. For details about the Baseline feature, 
see “Baselines” in Using End User Management.

The table headers in the Template Elements sections represent the tags used 
for specifying the entities, CIs, context menus, KPIs, and rules in the 
template (for more information about the tags, see “CI Definition 
Parameters” on page 729). 

For details on how to modify the template, see “Modify an Adapter 
Template” on page 708.

Relationships
The Business Process Monitoring source adapter template uses the following 
elements:

The table headers in the Relationships sections represent the tags used in the 
template for specifying the relationship information. For more information 
about the tags, see “Modify Relationships” on page 718.

For details on how to modify the relationships or add new relationships, see 
“Modify Relationships” on page 718.

dest_obj_type src_obj_type type weight

bp_group_location location Mercury:depends_on 1

bp_step bp_group Mercury:depends_on 1

bp_group_location bp_group Mercury:parent 1

bpm_tx_from_location bp_step Mercury:monitored_by 1

bpm_tx_from_location bp_group_
location

Mercury:monitored_by 1
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Selectors
To modify or add selectors, see “Define Selectors” on page 720.

Real User Monitor Source Adapter Details

The Real User Monitor source adapter retrieves real-user data information 
from Real User Monitor engines, and hierarchy information from System 
Availability Management. The hierarchy includes applications, containers, 
pages, transactions, end-user, server, global statistic data, user sessions, and 
so forth.

You can customize some of the source adapter parameters, as explained in 
“New/Edit Source Adapter Dialog Box” on page 724.

This section includes the following topics:

➤ “Hierarchies” on page 680

➤ “Template Elements” on page 682

➤ “Relationships” on page 690

➤ “Selectors” on page 691
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Hierarchies
The Real User Monitor adapter builds hierarchies that are displayed in the 
following views:

➤ All RUM Monitors view. This view includes all of the view hierarchies listed 
below.

➤ Real User Applications view

➤ Real User End Users view
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➤ Real User Locations view

➤ Real User Servers View

For more details about the Real User Monitor views, see “About Real User 
Monitor Views” in Using End User Management.
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Template Elements
The Real User Monitor adapter template uses the following elements:

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)

eum_app_
group

Mercury:eum_
app_group

rumGroup
Menu – RUM 
Group menu

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

rum_
unconfigured_
end_user_group
_monitor

Mercury:rum_
end_user_group
_monitor

RUMEndUser
GroupMenu

1050 – Volume 77 – RUM End User 
Session Statistics 
Monitor Volume Rule 

1077 – Latency 82 – RUM Latency Rule

7 – Availability 57 – RUM End User 
Session Statistics 
Monitor Availability 
Rule 

6 – 
Performance

67 – RUM End User 
Session Statistics 
Monitor Performance 
Rule 
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rum_end_user_
root

Mercury:rum_
end_user_group

RUMEndUser
GroupsMenu – 
RUM End User 
Group menu

1050 – Volume 74 – Sum of Volume 
Rule

1077 – Latency 83 – Average Latency of 
Weighted Volume

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

rum_tx_
monitor

Mercury:rum_
tx_monitor

RUMTrx
MonitorMenu – 
RUM 
Transactions 
Monitor menu

1050 – Volume 71 – RUM Transaction 
Monitor Volume Rule

7 – Availability 51 – RUM Transaction 
Monitor Availability 
Rule

6 – 
Performance

61 – RUM Transaction 
Monitor Performance 
Rule 

rum_http_error
_monitor

Mercury:rum_
http_error_
monitor

RUMHttpError
MonitorMenu – 
RUM HTTP 
Error Monitor 
menu

1050 – Volume 73 – RUM Event 
Monitor Volume Rule 

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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rum_
unconfigured_
end_user_group
_with_
breakdown

Mercury:rum_
end_user_group
_factory

RUMEndUser
Group
Container
Menu – RUM 
End User Group 
menu

1050 – Volume 74 – Sum of Volume 
Rule

1077 – Latency 83 – Average Latency of 
Weighted Volume 

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

rum_page_
monitor

Mercury:rum_
page_
monitor

RUMPage
MonitorMenu – 
RUM Page 
Monitor menu

1050 – Volume 70 – RUM Page 
Monitor Volume Rule

7 – Availability 49 – RUM Page 
Monitor Availability 
Rule

6 – 
Performance

60 – RUM Page 
Monitor Performance 
Rule 

rum_non_usa_
unconfigured_
eu_location

Mercury:rum_
locations

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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rum_usa_
configured_eu_
location

Mercury:rum_
locations

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

rum_errors Mercury:rum_
errors

RUMErrorMenu 
– RUM Errors 
menu

1050 – Volume 74 – Sum of Volume 
Rule

rum_usa_
unconfigured_
eu_location

Mercury:rum_
locations

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

rum_info_
events

Mercury:rum_
info_events

RUM
Informational
Events Menu – 
RUM 
Informational 
Event Monitor 
menu

1050 – Volume 74 – Sum of Volume 
Rule

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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bp_step Mercury:bp_
step

RUMGroup
Menu – RUM 
Group menu

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average Latency of 
Weighted Volume

6 – 
Performance

63 – Average of 
Converted 
Performance Results in 
% 

rum_non_usa_
location

Mercury:rum_
locations

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance 

64 – Average 
Performance of 
Weighted Volume in %

rum_info_event
_monitor

Mercury:rum_
info_event_
monitor

RUM
Informational
EventMonitor
Menu – RUM 
Informational 
Event Monitor 
menu

1050 – Volume 73 – RUM Event 
Monitor Volume Rule

rum_servers Mercury:rum_
servers

RUMServers
Menu – RUM 
Servers menu

54 – Bandwidth 30 – Summary of 
Values Rule

53 – 
Component 
Availability

1 – Worst Child Rule

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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rum_app_error_
monitor

Mercury:rum_
app_error_
monitor

RUM
Application
ErrorMonitor
Menu – RUM 
Application 
Error Monitor 
menu

1050 – Volume 73 – RUM Event 
Monitor Volume Rule

rum_end_user_
group_
container

Mercury:rum_
end_user_group
_container

RUMEndUser
Group
Container
Menu – RUM 
End User Group 
Container 
menu

1050 – Volume 74 – Sum of Volume 
Rule

1077 – Latency 83 – Average Latency of 
Weighted Volume 

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

logical_
application

Mercury:logical
_
application

RUM
Application
Menu

7 – Availability 1 – Worst Child Rule

6 – 
Performance

1 – Worst Child Rule

rum_end_user_
group_no_
breakdown

Mercury:rum_
end_user_group

RUMEndUser
Group
Container
Menu – RUM 
End User Group 
Container 
menu

1050 – Volume 74 – Sum of Volume 
Rule

1077 – Latency 83 – Average Latency of 
Weighted Volume 

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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rum_usa_
location

Mercury:rum_
locations

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

rum_app_
session_
monitor

Mercury:rum_
app_session_
monitor

RUMSession
MonitorMenu – 
RUM Session 
Monitor menu

1050 – Volume 76 – RUM Application 
Session Statistics 
Monitor Volume Rule

7 – Availability 56 – RUM Application 
Session Statistics 
Monitor Availability 
Rule

6 – 
Performance

66 – RUM Application 
Session Statistics 
Monitor Performance 
Rule

rum_non_usa_
configured_eu_
location

Mercury:rum_
locations

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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bp_group Mercury:bp_
group

RUMGroup
Menu – RUM 
Group menu

1050 – Volume 74 – Sum of Volume 
Rule

7 – Availability 55 – Average 
Availability of 
Weighted Volume

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

rum_end_user_
group_monitor

Mercury:rum_
end_user_group
_monitor

RUMEndUser
Group
Container
Menu – RUM 
End User Group 
Container 
menu

1050 – Volume 77 – RUM End User 
Session Statistics 
Monitor Volume Rule 

1077 – Latency 82 – RUM Latency Rule 

7 – Availability 57 – RUM End User 
Session Statistics 
Monitor Availability 
Rule

6 – 
Performance

67 – RUM End User 
Session Statistics 
Monitor Performance 
Rule

rum_end_user_
group_with_
breakdown

Mercury:rum_
end_user_group
_factory

RUMEndUser
Group
Container
Menu – RUM 
End User Group 
Container 
menu

1050 – Volume 74 – Sum of Volume 
Rule

1077 – Latency 83 – Average Latency of 
Weighted Volume

7 – Availability 55 – Average 
Availability of 
Weighted Volume 

6 – 
Performance

64 – Average 
Performance of 
Weighted Volume in %

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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The table headers in the Template Elements sections represent the tags used 
for specifying the entities, CIs, context menus, KPIs, and rules in the 
template (for more information about the tags, see “CI Definition 
Parameters” on page 729). 

For details on how to modify the template, see “Modify an Adapter 
Template” on page 708.

Relationships
The Real User Monitor adapter template uses the following elements:

dest_obj_type src_obj_type type weight

rum_end_user_group rum_end_user_group_
container

Mercury:depends_on 1

rum_end_user_group_
factory

rum_end_user_group_
container

Mercury:depends_on 1

rum_end_user_group_
container

rum_end_user_groups Mercury:depends_on 1

bp_step bp_group Mercury:depends_on 1

rum_page_monitor bp_step Mercury:monitored_by 1

rum_errors logical_application Mercury:depends_on 1

rum_http_error_monitor rum_errors Mercury:monitored_by 1

rum_end_user_group_
factory

rum_end_user_groups Mercury:depends_on 1

bp_group eum_app_group Mercury:depends_on 1

bp_group bp_group Mercury:depends_on 1

rum_app_error_monitor rum_errors Mercury:monitored_by 1

rum_info_event_monitor rum_info_events Mercury:monitored_by 1

rum_app_session_monitor logical_application Mercury:monitored_by 1

rum_end_user_group_
monitor

rum_end_user_group Mercury:monitored_by 1
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The table headers in the Relationships sections represent the tags used in the 
template for specifying the relationship information. For more information 
about the tags, see “Modify Relationships” on page 718.

For details on how to modify the relationships or add new relationships, see 
“Modify Relationships” on page 718.

Selectors
To modify or add selectors, see “Define Selectors” on page 720.

rum_end_user_group
_container

rum_end_user_group
_container

Mercury:depends_on 1

rum_end_user_group rum_end_user_groups Mercury:depends_on 1

eum_app_group logical_application Mercury:depends_on 1

rum_info_events logical_application Mercury:depends_on 1

bp_step eum_app_group Mercury:depends_on 1

rum_tx_monitor bp_step Mercury:monitored_by 1

dest_obj_type src_obj_type type weight
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SiteScope Source Adapter Details

Note: The SiteScope source adapter is deprecated from HP Business 
Availability Center version 7.50. It should be used only for backward 
compatibility purposes. The KPI assignment mechanism of the SiteScope 
assignment group is used to create the appropriate topology. For details, see 
“SiteScope KPI Assignment Group Overview” in Using Dashboard.

The SiteScope source retrieves system information from a SiteScope system, 
and builds a hierarchy that includes the machines, SiteScope groups, 
monitors, and measurements. 

You can customize some of the source adapter parameters, as explained in 
“New/Edit Source Adapter Dialog Box” on page 724.

This section includes the following topics:

➤ “Hierarchies” on page 692

➤ “Template Elements” on page 693

➤ “Relationships” on page 695

➤ “Selectors” on page 696

Hierarchies
Depending on the parameters you selected when defining a source or 
editing it, the following hierarchy is displayed.
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The curved arrow indicates that the hierarchy element is recursive; the CI 
type is the child of the level above in the hierarchy, but it can also be a child 
of the CI type itself. For example, a SiteScope Group CI type is the child of a 
SiteScope Profile CI type, but can also be the child of a SiteScope group CI 
type.

Template Elements
The SiteScope source adapter template uses the following elements:

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)

Siebel
Measurement
Regular

Mercury:
sitescope_
measurement

ssMeasurement
Menu – 
SiteScope 
Measurement 
Menu

300 – Siebel 1108 – SiteScope 
Vertical Rule

group Mercury:
sitescope_group

ssGroupMenu – 
SiteScope 
Group Menu

1 – System 1 – Worst Child Rule

target Mercury:
sitescope_
target

ssGroupMenu – 
SiteScope 
Group Menu

1 – System 1 – Worst Child Rule

SiebelTasks
Measurement
Complex

Mercury:
sitescope_
measurement

ssMeasurement
Menu – 
SiteScope 
Measurement 
Menu

301 – Tasks in 
Error

1108 – SiteScope 
Vertical Rule

monitorEvent
Measurement

Mercury:
sitescope_
monitor

ssMonitorMenu 
– SiteScope 
Monitor Menu

1 – System 0 – EMS Simple Rule

profile Mercury:
sitescope_
profile

ssGroupMenu – 
SiteScope 
Group Menu

1001 – 
SiteScope 
Availability

35 – SiteScope Profile 
Rule

1 – System 1 – Worst Child Rule
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measurement Mercury:
sitescope_
measurement

ssMeasurement
Menu – 
SiteScope 
Measurement 
Menu

1 – System 3 – SiteScope 
Measurement Rule 

monitor
Measurement

Mercury:
sitescope_
monitor

ssMonitorMenu 
– SiteScope 
Monitor Menu

1 – System 4 – SiteScope Monitor 
Rule 

SOAMonitor
Measurement

Mercury:
sitescope
_monitor

ssMonitorMenu 
– SiteScope 
Monitor Menu

7 – Availability 1300 – WS Operation 
Availability Rule

1 – System 4 – SiteScope Monitor 
Rule

6 – 
Performance

1304 – SiteScope WS 
Operation Performance 
Rule

SAPMonitor Mercury:
sitescope_
measurement_
group

ssGroupMenu – 
SiteScope 
Group Menu

1 – System 1 – Worst Child Rule

SiebelMonitor Mercury:
sitescope_
measurement_
group

ssGroupMenu – 
SiteScope 
Group Menu

1 – System 1 – Worst Child Rule

SiebelSession
Measurement
Complex

Mercury:
sitescope_
measurement_
group

ssMeasurement
Menu – 
SiteScope 
Measurement 
Menu

304 – Sessions 1108 – SiteScope 
Vertical Rule

SAP
Measurement
Regular

Mercury:
sitescope_
measurement

ssMeasurement
Menu – 
SiteScope 
Measurement 
Menu

1 – System 3 – SiteScope 
Measurement Rule

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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The table headers in the Template Elements sections represent the tags used 
for specifying the entities, CIs, context menus, KPIs, and rules in the 
template (for more information about the tags, see “CI Definition 
Parameters” on page 729). 

For details on how to modify the template, see “Modify an Adapter 
Template” on page 708.

Relationships
The SiteScope source adapter template uses the following elements:

monitor Mercury:
sitescope_
measurement_
group

ssGroupMenu – 
SiteScope 
Group Menu

1 – System 1 – Worst Child Rule

SAP
Measurement
Complex

Mercury:
sitescope_
measurement

ssMeasurement
Menu – 
SiteScope 
Measurement 
Menu

305 – SAP 1108 – SiteScope 
Vertical Rule

dest_obj_type src_obj_type type weight

sitescope_group sitescope_profile Mercury:depends_on 1

sitescope_measurement_
group

sitescope_group Mercury:depends_on 1

sitescope_monitor sitescope_group Mercury:monitored_by 1

sitescope_measurement sitescope_measurement_
group

Mercury:monitored_by 1

sitescope_monitor sitescope_target Mercury:monitored_by 1

sitescope_group sitescope_group Mercury:depends_on 1

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)
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The table headers in the Relationships sections represent the tags used in the 
template for specifying the relationship information. For more information 
about the tags, see “Modify Relationships” on page 718.

For details on how to modify the relationships or add new relationships, see 
“Modify Relationships” on page 718.

Selectors
To modify or add selectors, see “Define Selectors” on page 720.

Generic EMS Source Adapter Details

The Generic EMS source adapter retrieves a generic hierarchy for enterprise 
management systems (EMS), through SiteScope. You use this source adapter 
when your site includes more than one third-party source, thus enabling 
you to integrate the hierarchies of all sources.

You can also use this adapter when performing an EMS integration that 
sends samples with the Event type.

This section includes the following topics:

➤ “Hierarchies” on page 697

➤ “Template Elements” on page 697

➤ “Selectors” on page 697

sitescope_measurement_
group

sitescope_target Mercury:depends_on 1

sitescope_target sitescope_group Mercury:depends_on 1

dest_obj_type src_obj_type type weight
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Hierarchies
When you select this source adapter and enable it, the relevant CIs 
hierarchy is created in the CMDB. You can then view the hierarchy in the 
Generic EMS view in View Manager tab in CMDB Administration.

Template Elements
The Generic EMS source adapter template uses the following element:

The table headers in the Template Elements sections represent the tags used 
for specifying the entities, CIs, context menus, KPIs, and rules in the 
template (for more information about the tags, see “CI Definition 
Parameters” on page 729). 

For details on how to modify the template, see “Modify an Adapter 
Template” on page 708.

Selectors
To modify or add selectors, see “Define Selectors” on page 720.

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)

Dnode Mercury:node_factory groupMenu – 
Group Menu

1 – System 1 – Worst Child 
Rule
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XML File Source Adapter Details

The XML File source adapter retrieves topology information from an XML 
file produced by an external system. The XML file contains the definition of 
the CIs. This source includes a predefined generic adapter. You use this 
source adapter if you need to create a hierarchy that is different from the 
hierarchies of the other source adapters.

A detailed example of XML File creation is provided in “Example - Create an 
XML File” on page 710.

This section includes the following topics:

➤ “Template” on page 698

➤ “Template Elements” on page 699

➤ “Selectors” on page 699

Template
The XML File source retrieves information from an XML file produced by an 
external system that you define. 

An XML File example is provided in <HP Business Availability Center server 
root directory>/CMDB/adapters/templates/tivoli.config.xml

For details on how to modify the template, see “Modify an Adapter 
Template” on page 708.
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Template Elements
The XML File source adapter template uses the following elements:

The table headers in the Template Elements sections represent the tags used 
for specifying the entities, CIs, context menus, KPIs, and rules in the 
template (for more information about the tags, see “CI Definition 
Parameters” on page 729). 

Selectors
To modify or add selectors, see “Define Selectors” on page 720.

Tasks

entity id basicEntity contextmenu
dimension 
(KPI)

logic 
(business rule)

Group Entity Mercury:bp_group txgroupMenu 7 – Availability 1 – Worst Child 
Rule

6 – 
Performance

1 – Worst Child 
Rule

External Entity 
Type

Mercury:bpm_tx_from
_location

6 – 
Performance

13 – 
Transaction 
Performance 
Rule 
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Configure a Source Adapter – Workflow

Add source adapters when you want to:

➤ Receive hierarchy information from a third-party source adapter (not 
Business Process Monitoring, Real User Monitor, or SiteScope).

➤ Use different hierarchies from a single data source. In such a case, you can 
define more than one source adapter based on a single third-party or on a 
default source adapter. Each new source adapter represents a different 
instance of the adapter used as a base, receiving hierarchy information from 
a single source.

Use Source Manager to add new source adapters or edit existing source 
adapters.

This task includes the following steps:

➤ “Set Up the Permissions” on page 700

➤ “Make a Default Source Adapter Available For Defining a Custom Source 
Adapter” on page 701

➤ “Add Third-Party Source Adapters or Default Source Adapters” on page 701

➤ “Modify an Adapter Template” on page 701

➤ “Customize Dynamic Node Factory Definitions” on page 702

➤ “Limitations When Working With the XML File Source Adapter” on 
page 702

 1 Set Up the Permissions
You must have at least the Superuser or Administrator role to have access to 
the CMDB Administration. If you have the Superuser role, you have full 
viewing and editing rights for all of the CMDB Administration, including 
the sources. If you have the Administrator role, you can only view/edit 
views for which you have permission and you cannot edit, add, or view 
sources. To access the Permissions page, select Admin > Platform > Users and 
Permissions. For details, see “Understanding Permissions Resources” in 
Platform Administration.
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Note to HP Software-as-a-Service customers: You must have at least the 
Superuser, Operator, Customer Super User, or Customer Administrator role 
to have access to the CMDB Administration. If you have the Customer 
Administrator role, you can only view/edit views for which you have 
permission, and you cannot edit the sources. 

 2 Make a Default Source Adapter Available For Defining a 
Custom Source Adapter
If required, the default source adapters are available for defining new custom 
source adapters when you have configured Source Manager to include them. 
In this case, the default source appears in the list of available custom source 
adapters when you create a new source adapter.

To make a default source adapter available for defining new source adapters, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, select Sources Configuration, and locate the relevant 
source type entry (for example, Add Business Process Monitor Sources) in 
the Sources Configuration - Sources table. Modify the value to true. The 
change takes effect when the server is restarted.

 3 Add Third-Party Source Adapters or Default Source Adapters
You can add source adapters based on supported third-party source adapters 
or on default source adapters. For details on how to add such source 
adapters, see “New/Edit Source Adapter Dialog Box” on page 724.

 4 Modify an Adapter Template
You must then customize the newly-created source adapter, by defining the 
parameters required by the adapter to receive data from the appropriate 
source. For details on modifying an adapter template, see “Modify an 
Adapter Template” on page 708.
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 5 Customize Dynamic Node Factory Definitions
For advanced users only. Where required, you can open the default adapter 
template for the source, to edit the template instance according to your 
organization’s specific needs. This may be necessary if you define a new 
source adapter based on one of the generic template types (Generic EMS or 
XML File). For details, see “Customize Dynamic Node Factory Definitions” 
on page 722.

 6 Limitations When Working With the XML File Source Adapter
Some of the CMDB configuration item types cannot be configured in the 
XML file used by the XML adapter because their ID is randomly generated, 
and the XML adapter cannot synchronize it. An example of such a CIT is 
Line of Business.

To find the internal name of a CIT, select Admin > Universal CMDB > 
Modeling > CI Type Manager, select the appropriate CIT in View Explorer 
and click the Details tab, and view the name of the CIT in the Name box. 

Click the Configuration Item Type Qualifier tab to see whether the CI ID is 
randomly generated as follows:
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Work with the SiteScope Source Adapter – Workflow

Note: The SiteScope source adapter is deprecated from HP Business 
Availability Center version 7.50. It should be used only for backward 
compatibility purposes when working with SiteScope versions prior to 9.50. 
The KPI assignment mechanism of the SiteScope assignment group is used 
to create the appropriate topology. For details, see “Work with the SiteScope 
Assignment Group – Workflow” in Using Dashboard.

This task describes how to work with the SiteScope source adapter.

This task includes the following steps:

➤ “Set the SiteScope Monitor to Report to HP Business Availability Center” on 
page 703

➤ “Synchronize the SiteScope Profile” on page 704

➤ “Prevent CIs in Dashboard from Changing Status to Decay” on page 704

➤ “Backward Compatibility Workarounds” on page 705

➤ “SiteScope Host Discovery” on page 706

➤ “Enable the Creation of Relationships Between Hosts and SiteScope 
Monitors” on page 707

➤ “Select or Clear the Enable host topology reporting Option” on page 708

 1 Set the SiteScope Monitor to Report to HP Business Availability 
Center
When you set SiteScope to report to HP Business Availability Center for the 
first time, and you have defined monitors for SiteScope, the status of each 
SiteScope monitor is automatically changed to Do not report to HP Business 
Availability Center. Use this option when you do not want the SiteScope 
monitor and measurements for the subject monitor to be transferred to 
HP Business Availability Center. Select another logging option for the 
monitors whose information you need. For details about this option, see 
“Common Monitor Settings” in Using System Availability Management.
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 2 Synchronize the SiteScope Profile
After you have defined a SiteScope profile and connected to the profile of a 
SiteScope monitor, in System Availability Management, the SiteScope 
configuration remains in the CMDB until the SiteScope profile is deleted 
and the next synchronization has been performed (manually or 
automatically, by default, every 60 minutes). To synchronize the SiteScope 
profile, select Admin > System Availability Management, select the 
appropriate SiteScope preferences folder, and use one of the following 
options located in HP Business Availability Center Preferences: 

➤ Re-Synchronize. SiteScope re-sends all its configuration data to Business 
Availability Center. This data includesf all the group and monitor 
definitions. 

➤ Hard Re-Synchronize. SiteScope re-sends all its configuration data to 
Business Availability Center. It also deletes the existing monitor and group 
data in Business Availability Center for this SiteScope. 

For details about the HP Business Availability Center Preferences, see 
“Integration Preferences User Interface” in Using System Availability 
Management.

 3 Prevent CIs in Dashboard from Changing Status to Decay
When SiteScope does not work in Data reduction mode, and you use 
Dashboard to view SiteScope data, the default decay (timeout) period for a 
CI in Dashboard is 15 minutes. If a SiteScope monitor has a schedule longer 
than 15 minutes, the status of the corresponding CIs in Dashboard changes 
to decay status, until the SiteScope monitor runs again and updates 
HP Business Availability Center.

When SiteScope works in Data reduction mode, and you use Dashboard to 
view SiteScope data, the status of the CIs in Dashboard changes to decay 
status after an hour and 15 minutes, until the SiteScope monitor runs again 
and updates HP Business Availability Center.
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To avoid this, you can do one of the following:

➤ Set run schedules for the monitors in SiteScope or in System Availability 
Management for less than 15 minutes in the Frequency parameter. For 
details, see Frequency in System Availability Management or in SiteScope. 
For details about this option, see “Common Monitor Settings” in Using 
System Availability Management.

➤ For each SiteScope item in Dashboard, change the decay timeout period 
parameter to a value greater than the schedule for the SiteScope monitor by 
modifying the No Data Timeout parameter for the appropriate rule. For 
details on changing the parameter value for each rule, see “Modify the Rule 
Parameters or the Rules Global Parameters” in CI Attribute Customization.

➤ In the rule parameters for the SiteScope source adapter template in 
Dashboard, change the decay timeout parameter to a value greater than the 
schedules used for the SiteScope monitors. For details, see “Change the 
Decay Timeout Value” on page 723.

You can also set the decay timeout parameter to -1 (minus 1), meaning no 
decay timeout. This is the required value if the SiteScope monitor is event-
based (meaning that data is sent to the HP Business Availability Center bus 
only when the monitor reports a change in status), but is not recommended 
for monitors sending data according to a schedule.

 4 Backward Compatibility Workarounds
When you select the Include Measurements and Include Machines options 
in the SiteScope source adapter definition in the previous version, these 
options stay selected when you upgrade to version 7.50. The Include 
Measurements option includes the measurement level for SiteScope 
monitors in the hierarchy. The Include Machines option includes the 
machine level (the monitor target) in the hierarchy.
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If, after the upgrade, you clear any of these options, you cannot select them 
again. To obtain the information that was displayed when those options 
were selected, the following alternatives are available:

➤ To get information corresponding to the Include Measurements option, 
select a view in the Console tab or in the Filters tab in Dashboard, right-click 
the appropriate CI, select Go to report, and select the Cross-Performance 
report. 

For details about the Cross-Performance reports, see “Cross-Performance 
Report” in Using System Availability Management.

➤ The information corresponding to the Include Machines option is 
automatically available as explained below.

 5 SiteScope Host Discovery
The Enable host topology reporting option is enabled by default for all 
SiteScope monitors (select Admin > System Availability Management, select 
the appropriate SiteScope preferences folder – the option is located in the 
HP Business Availability Center Preferences). This means that the host CIs 
for the monitored hosts in SiteScope are sent to the HP Business Availability 
Center CMDB. All the data necessary for creating a CI based on that host, 
including the DNS name, is then forwarded to HP Business Availability 
Center from the SiteScope, whenever a monitor is created or edited, or when 
SiteScope is restarted.

The SiteScope source adapter creates a CI for each monitor.

In addition, when performing discovery, the discovered hosts CIs are created 
in the CMDB. Automatic host reconciliation is performed when the 
discovered host CI and a SiteScope host CI represent the same host. 

CMDB enrichment rules create a Monitored by relationship between the 
host CIs and the monitor CIs. These rules run every 30 minutes when the 
Host DNS Name attribute of the discovered Host CI and the Target Host 
attribute of the SiteScope Monitor CI have the same value. This process 
works when there is only one Host CI for every instance of an actual host. If 
more than one Host CI is discovered for an actual host, the Host 
Reconciliation process reconciles the Host CIs. For details about host 
reconciliation, see “Reconciliation of Hosts” in Solutions and Integrations.
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Note: Creating the Monitored by relationship between the two CIs in the 
CMDB may take up to 90 minutes after a SiteScope monitor has been 
created or modified.

You can view the host information in the Monitored Hosts view.

To access the enrichment rules, select Admin > Universal CMDB > Modeling 
> Enrichment Manager, and expand SiteScope. The enrichment rules are: 
SiteScope Hosts and Monitors and Disconnect Hosts from SiteScope 
Monitor. The SiteScope Hosts and Monitors scheduler job located in Admin 
> Universal CMDB > Settings > Scheduler, schedules when the enrichment 
rules are run.

 6 Enable the Creation of Relationships Between Hosts and 
SiteScope Monitors
If you are using the Include Measurements option, and you want to enable 
the creation of relationships between hosts and SiteScope monitors 
(SiteScope measurement groups), perform the following procedure:

➤ Select Admin > Universal CMDB > Settings > Scheduler, edit SiteScope Hosts 
and Monitors scheduler job, edit the Run Enrichment rule, and add the 
SiteScope Hosts and Measurement Groups enrichment rule.

➤ Select Admin > Universal CMDB > Modeling > Enrichment Manager, expand 
SiteScope, and activate the Disconnect Hosts from SiteScope MGroup 
enrichment rule.

If you are using HP Business Availability Center for SAP Applications or 
HP Business Availability Center for Siebel Applications you cannot use the 
above capability.
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 7 Select or Clear the Enable host topology reporting Option
If you use the Enable host topology reporting option, you must use 
discovery processes that discovers the host DNS names.

To clear the Enable host topology reporting option, select Admin > System 
Availability Management, select the appropriate SiteScope preferences 
folder, select BAC Preferences, and clear the option. In this case, no host 
topology data is forwarded to HP Business Availability Center and the 
corresponding host CIs are not created in the CMDB. 

Modify an Adapter Template

Most of the templates used by the source adapters follow a basic format, 
with variations for each adapter. The Dynamic Node Factory templates are 
somewhat different. For details, see “Customize Dynamic Node Factory 
Definitions” on page 722.

Each source adapter uses a template that maps the entities in the data source 
to the configuration items (CIs) stored in the CMDB and defines the 
resources to be used in CMDB for a CI, such as KPIs, and business rules. The 
template is used to create the source adapter’s XML file.

You can modify an adapter template by changing the XML code used to 
specify:

➤ The mapping of source entities to CIs.

➤ The rules to be applied to the appropriate CIs/KPIs data before it is displayed 
in the views. The business rules resources are defined in the Dashboard 
repositories.

➤ The context menus to be used for the CI in the Dashboard application

➤ The KPIs assigned to each CI. The KPIs are defined in the repositories. For 
details about the repositories, see “Repositories – Overview”in CI Attribute 
Customization.
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Note: When editing an adapter template in Source Manager, if you add a KPI 
definition to any CI template, the KPI is attached to all CIs generated by that 
template, but does not propagate up to the parents of the generated CIs. A 
KPI that is manually attached to a CI in the KPIs page located in Admin > 
Dashboard > KPIs, does propagate up to the parent CI.

➤ The selectors required by each business rule to identify and catch the 
appropriate samples that relate to the relevant CIs and KPIs.

Group CIs (groups or machines for example) have the simplest level of 
definitions. The monitor CIs use a higher level of definitions and require 
selectors to check data samples from the source and to present the data from 
the bus as KPI status in Dashboard.

➤ The predefined Dynamic Node Factory CIs included in the adapter 
templates, that you add to your view to generate a hierarchy that fits your 
organization’s needs. For details, see “Customize Dynamic Node Factory 
Definitions” on page 722.

➤ The new Dynamic Node Factory CIs. For details, see “IT Universe Manager – 
Dynamic Node Factory” on page 105.

➤ The relationships between CIs. For details, see “Modify Relationships” on 
page 718.

Note: It is recommended to perform a backup of the source before you 
modify it as follows: access the <HP Business Availability Center root 
directory>\CMDB\adapters\adapters directory, find the file that 
corresponds to the adapter you want to back up, copy that file to another 
directory (not under <HP Business Availability Center root directory>). 
When you want to restore the original source, copy the original file back to 
the <HP Business Availability Center root 
directory>\CMDB\adapters\adapters directory and restart HP Business 
Availability Center.
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To modify an adapter template, access the Edit Source dialog box for the 
appropriate source adapter and click Edit Template. For details, see 
“New/Edit Source Adapter Dialog Box” on page 724.

Example - Create an XML File

You want to create a hierarchy and a view that includes hosts and monitors 
as follows:

The hierarchy is as follows:

The view is as follows:
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To create such a hierarchy, do the following:

➤ Create an XML File template. For details, see “Step 1 – Write the XML File 
Template” on page 711.

➤ Create a configuration file. For details, see “Step 2 – Write the Configuration 
File” on page 713.

➤ Create the XML File source adapter. For details, see “Step 3 – Create an XML 
File Source Adapter That Monitors Hosts and Monitors” on page 717.

Step 1 – Write the XML File Template

Use the following XML File template:

<adapterTemplate>
  <description>Customized XML Adapter</description> 
  <type>XML File</type> 
  <logicType>User Experience</logicType> 
<classPath>com.mercury.topaz.tdm.adapters.XMLFileAdapter.XMLFileAdapterImpl</cl
assPath> 
  <autoMapEntities>true</autoMapEntities> 
<autoMappingEntities>
<entity id="monitor">
  <basicEntity>Mercury:sitescope_monitor</basicEntity> 
  <contextmenu>ssMonitorMenu</contextmenu> 
<dimensions>

<dimension id="1">
<logics>
  <logic id="4" /> 
  </logics>
<selectors type="AND">
  <selector key="sampleType" operator="EQ" value="ss_monitor_t" dataType="String" 
readOnly="true" /> 
  <selector key="u_iConnectionId" operator="EQ" value="" dataType="Long" 
reference="true" referencedProperty="monitor_id" /> 
  <selector key="u_iSessionId" operator="EQ" value="" dataType="Long" 
reference="true" referencedProperty="session_id" /> 
  </selectors>
  </dimension>
</dimensions>
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The template maps the following elements:

The monitor entity has the following selectors:

 </entity>
<entity id="machine">
  <basicEntity>host</basicEntity> 
  <contextmenu>groupMenu</contextmenu> 
<dimensions>
<dimension id="1">
<logics>
  <logic id="1" /> 
  </logics>
  </dimension>
  </dimensions>
  </entity>

 </autoMappingEntities>
<autoMappingLinks>
  <link type="Mercury:monitored_by" src_obj_type="host" dest_obj_type=
"Mercury:sitescope_monitor" weight="1" /> 
  </autoMappingLinks>
  <displayNameMapping /> 
  </adapterTemplate>

entity id basicEntity contextmenu dimension (KPI)
logic 
(business rule)

monitor Mercury:
sitescope_
monitor

ssMonitorMenu 
– SiteScope 
Monitor Menu

1 – System 4 – SiteScope 
Monitor

machine host groupMenu – 
Group Menu

1 – System 1 – Worst Child

<selectors type="AND">
  <selector key="sampleType" operator="EQ" value="ss_monitor_t" dataType="String" 
readOnly="true" /> 
  <selector key="u_iConnectionId" operator="EQ" value="" dataType="Long" 
reference="true" referencedProperty="monitor_id" /> 
  <selector key="u_iSessionId" operator="EQ" value="" dataType="Long" 
reference="true" referencedProperty="session_id" /> 
  </selectors>
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The following relationships are defined:

Step 2 – Write the Configuration File

Use the following xmlFile.xml file where one host is monitored by two 
monitors:

<autoMappingLinks>
  <link type="Mercury:monitored_by" src_obj_type="host" 
dest_obj_type="Mercury:sitescope_monitor" weight="1" /> 
  </autoMappingLinks>

<?xml version="1.0" encoding="UTF-8" ?> 
<extSysGraph> 
<generalData> 
<properties /> 
</generalData> 
<entities> 
<entity type="monitor"> 
<name>Monitor 1</name> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="123" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 
<children /> 
<parents> 
<idProperties> 
<property dataType="String" key="host_key" value="mymachine" /> 
</idProperties> 
</parents> 
</entity> 
<entity type="monitor"> 
<name>Monitor 2</name> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="456" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 
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<children /> 
<parents> 
<idProperties> 
<property dataType="String" key="host_key" value="mymachine" /> 
</idProperties> 
</parents> 
</entity> 
<entity type="machine"> 
<name>mymachine</name> 
<idProperties> 
<property dataType="String" key="host_key" value="mymachine" /> 
</idProperties> 
<properties> 
<property dataType="String" key="host_dnsname" value="mymachine.mydo-
main.com" /> 
<property dataType="String" key="host_hostname" value="mymachine" /> 
</properties> 
<children> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="123" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="456" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 
</children> 
<parents /> 
</entity> 
</entities> 
</extSysGraph>
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The guidelines to create a configuration file are as follows:

➤ You must write this file in such a way that each CI type has at least one 
unique property in its idProperties definition (so that it is unique in the 
CMDB). For details, see “CI Type Manager” in CI Attribute Customization. 

For example, for Monitor1 the idProperties are monitor_id=123 and 
session_id=1:

For example, for Monitor2 the idProperties are monitor_id=456 but the 
session_id is the same as for Monitor1: session_id=1:

➤ Regular properties (between the <properties> and </properties> tags) can 
have similar values. For example, for the mymachine host, the properties are: 
host key, host dsname, and the name of the host, as follows:

<entity type="monitor"> 
<name>Monitor 1</name> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="123" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 

<entity type="monitor"> 
<name>Monitor 1</name> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="456" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 

<idProperties> 
<property dataType="String" key="host_key" value="mymachine" /> 
</idProperties> 
<properties> 
<property dataType="String" key="host_dnsname" 
value="mymachine.mydomain.com" /> 
<property dataType="String" key="host_hostname" value="mymachine" /> 
</properties> 
715



Chapter 26 • Source Manager
➤ You must specify the parent for each item, if any. It is recommended to also 
write the reverse relation, that is, to specify the children of each item.

For example, you specify that the parent of entity Monitor1 is: mymachine 
(host_key=mymachine):

You must also specify that the entity machine has the following children: 
Monitor1 (monitor_id=123) and Monitor2 (monitor_id=456):

You must do the same for entity Monitor2.

<entity type="monitor"> 
<name>Monitor 1</name> 
...
<parents> 
<idProperties> 
<property dataType="String" key="host_key" value="mymachine" /> 
</idProperties> 
</parents> 

<entity type="machine"> 
...
<children> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="123" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 
<idProperties> 
<property dataType="Long" key="monitor_id" value="456" /> 
<property dataType="Long" key="session_id" value="1" /> 
</idProperties> 
</children> 
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Step 3 – Create an XML File Source Adapter That Monitors Hosts and 
Monitors

To create an XML File source adapter that monitors hosts and monitors, you 
must modify the default source adapter template, save the configuration file 
in the appropriate location, and you must create a view.

To create an XML File source adapter that monitors hosts and monitors, 
proceed as follows:

 1 Access the New Source dialog box. For details, see “New/Edit Source Adapter 
Dialog Box” on page 724.

 2 In the New Source dialog box, select the XML File source adapter in the Type 
box, and click Edit Template. The dialog box expands to display the adapter 
template in the Template box.

Note: In the Template box, use the dialog box scrollbar and the Template 
box scrollbar to display the areas of the template you want to modify. You 
can also highlight the text, copy it to a text editor, make the appropriate 
changes, and copy the text back into the Template box.

 3 Copy the first part of the XML File template provided in the example above 
from <autoMappingEntities> to </autoMappingEntities> (tags included) 
and insert it in the XML File template between 
<autoMappingEntities bac-version="BAC 7.5"> and </autoMappingEntities> 
and erase the rest of the file.

 4 Copy the second part of the XML File template provided in the example 
above from <autoMappingLinks> to </autoMappingLinks> (tags included) 
and insert it in the XML File template after </autoMappingEntities> 
(included).
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 5 Save the xmlFile.xml file (shown above) in a specific location; for example:
<HP Business Availability Center server root directory>\
CMDB\adapters\templates\xmlFile.xml and enter the path in the Path box 
in the source adapter definition.

 6 Create a pattern specific for the structure that is used in the xmlFile.xml file. 
For details, see “Working with Pattern and Instance Views in IT Universe 
Manager” on page 53.

Modify Relationships

Attaching one CI to another CI creates a hierarchical relationship between 
them, so that one CI may be dependent on or influenced by the other. 

In all adapter templates, except for the XML File adapter template, only the 
depends on or monitored by types of relationships are used; for example:

The automapping code is usually located at the end of the template file.

In the XML File template you can use all of the available types of 
relationships, as defined in CI Type Manager. For details, see “CI Type 
Manager” in CI Attribute Customization. 

Note: If you add or remove a relationship, you might have to modify the 
corresponding view in View Manager, to reflect the change. For details, see 
“View Manager Window” in Model Management.
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 1 Modify the Relationship
In the XML template, modify the relationships between the relevant CIs.

Each relationship may include the following information:

Example

The following example shows the relationships used in the SiteScope 
adapter template definition:

Template Element Description

dest_obj_type Identifies the configuration item type (CIT) that is 
the higher level in a relationship; for example, a 
monitor. When you want to add a new relationship, 
you must use the CIT internal name in the code. For 
details on how to find out the internal name of a 
CIT, see below.

src_obj_type Identifies the CIT at the lower level of the 
relationship; for example a group. When you want 
to add a new relationship, you must use the CIT 
internal name in the code. For details on how to 
find out the internal name of a CIT, see below.

type The type of relationship. For details, see “CI Type 
Manager” in CI Attribute Customization. 

Type can be depends_on or monitored by.

weight The weight assigned to the relationship. For details, 
see “Percentage Rule” in CI Attribute Customization.

<autoMappingLinks bac-version="BAC 7.0">
    <link dest_obj_type="host" src_obj_type="sitescope_group"
        type="Mercury:depends_on" weight="1"/>
</autoMappingLinks>
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 2 Find the Internal Name of a CIT
When you define a new relationship between CITs you must specify the 
internal name of the CITs.

To find the internal name of a CIT, select Admin > Universal CMDB > 
Modeling > CI Type Manager, select the appropriate CIT in View Explorer 
and click the Details tab, and view the name of the CIT in the Name box. 

Define Selectors

For monitor CIs, the adapter template includes the selectors required by the 
business rule to identify and catch the samples in the HP Business 
Availability Center bus that relate to the CI and KPI. 

This task includes the following steps:

➤ “Build Complex Logical Expressions in the Selector Definitions” on 
page 720

➤ “Define Your Own Selectors” on page 721

 1 Build Complex Logical Expressions in the Selector Definitions
You can build complex logical expressions in the selector definitions using 
AND and OR logical operators. The principles for defining selector blocks 
using the logical operators are the same as described for defining selectors 
for individual KPIs. For details, see “Define Selectors” in Dashboard.

The selector definitions in the adapter template contain additional 
information that is not viewed in the Selector areas when configuring 
individual KPIs. 
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The following example shows the selectors used in the adapter template 
definition for the Performance KPI of a Business Process Monitor 
measurement:

For details about the parameters, see “Selector Parameters” on page 732.

 2 Define Your Own Selectors
If you want to define your own selectors in an adapter template, you should 
first use the default definitions to create the hierarchy; you can then use the 
properties from the samples caught in the bus as a reference for the new 
selectors. Note that all selector fields and values are case sensitive and must 
be defined exactly as they are used in the samples, or the selector fails. The 
recommended method is to open the samples log and take the fields and 
values from there. The samples log is located in 
<HP Business Availability Data Processing server root directory>
\log\mercury_online_engine\TrinitySamples.log.

Note that the samples are written to this log at the debug log level, while 
the default log level is error, meaning that only log entries of level error and 
above are displayed. Therefore, to view the sample entries you must change 
the log level, as described in the following procedure.

<selectors type="AND">
<selector dataType="String" key="sampleType"

operator="EQ" readOnly="true" reference="false"
referencedProperty="sampleType" value="trans_t"/>

<selector dataType="Long" key="u_iTransactionId"
operator="EQ" readOnly="false" reference="true" 
referencedProperty="tx_id"/>

<selector dataType="Long" key="u_iSessionId"
operator="EQ" readOnly="false" reference="true"
referencedProperty="session_id"/>

</selectors>
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To change the samples log level, open the file:
<HP Business Availability Data Processing server root directory>\
conf\core\Tools\log4j\mercury_online_engine\bleOnline.properties and 
look for the following line:
log4j.category.Trinity.BLE_SAMPLES=${loglevel}, trinity.samples.appender
and change the line to:
log4j.category.Trinity.BLE_SAMPLES = DEBUG, trinity.samples.appender
Save and close the file. The change takes effect after about one minute.

Customize Dynamic Node Factory Definitions

Advanced users can customize the Dynamic Node Factory (DNode) 
definitions included in some adapter templates, to generate a hierarchy that 
fits your organization’s needs. You can also add and customize Dynamic 
Node Factory CIs directly in your views. For details, see “IT Universe 
Manager – Dynamic Node Factory” on page 105.

A Dynamic Node Factory source does not have a fixed topology; its topology 
is built from the samples themselves. The template defines the way the 
samples are matched to each CI created by the Dynamic Node Factory.

You can modify the mapping to the samples that create the hierarchy, the 
rules, and logic used to import the data, and present it in Dashboard. For 
more information about customizing a Dynamic Node Factory template, see 
“DNode Definition Key Property” on page 110.
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Change the Decay Timeout Value

When using HP Business Availability Center Dashboard to view SiteScope 
data, the default decay (timeout) period for a CI in Dashboard is 15 minutes. 
If you have a SiteScope monitor with a schedule longer than 15 minutes, the 
corresponding CIs in Dashboard has time to change to decay status until the 
SiteScope monitor runs again and updates HP Business Availability Center. 

In the rule parameters for the SiteScope source adapter template in 
Dashboard, change the No data timeout parameter to a value greater than 
the schedules used for the SiteScope monitors. To modify the decay timeout 
value in the template, add the following in the relevant <logic> section after 
the logic ID (the value is in seconds, 900 is the default):

For example:

Reference

<parameters>
<param key="No data timeout" value="777" 

dataType="Long" reference="false"/>
</parameters>

<logic>
        <id>4</id>
        <parameters>
<param key="No data timeout" value="777" 

dataType="Long" reference="false"/>
        </parameters>
    </logic>
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Source Manager User Interface

This section describes:

 ➤  New/Edit Source Adapter Dialog Box on page 724

 ➤  Source Manager Page on page 733

New/Edit Source Adapter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets), depending on the selected source adapter:

Description Enables you to define a new adapter or edit an existing 
adapter. You must customize the newly-created source 
adapter, by defining the parameters required by the adapter 
to receive data from the appropriate source. 

Edit a source adapter to customize the view adapter to 
change the path to a template file, to modify the 
corresponding view’s hierarchy in the application where the 
view appears, and so on.

To Access: Click New Source in the Source Manager window 
or click the Edit button for an existing adapter.

Included in Tasks “Configure a Source Adapter – Workflow” on page 700

Useful Links “Source Manager Overview” on page 666

GUI Element (A-Z) Description

Basic 
Authentication 
password

The password of the user you use to access HP Business 
Availability Center.

Note: Displayed only when you select Diagnostics in the 
Type box.

Basic 
Authentication 
user name

The name of the user you use to access HP Business 
Availability Center.

Note: Displayed only when you select Diagnostics in the 
Type box.
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Edit Template Click to open the Template box.

The template enables you to edit the template instance 
according to your organization’s specific needs, for example, 
when defining a new source adapter based on one of the 
generic template types (Generic EMS or XML File). The 
template:

➤ Maps the entities in the data source to the configuration 
items (CIs) stored in the CMDB. For details about the CI 
parameters used in the template definition, see “CI 
Definition Parameters” on page 729.

➤ Defines the resources to be used in the CMDB for a CI, 
such as KPIs and business rules

➤ Creates the source adapter’s XML file

Enable Enables communication between the adapter and the 
external system.

Enable breakdown 
of location to end 
users subrange 
monitors

Select this option to view data collected for all end users 
(configured and non-configured) accessing the server(s) 
being monitored. The data is broken down by location. It 
can be drilled down to the end users subrange monitors. 

Select this option only when Show unconfigured users on 
the dashboard and Enable end users breakdown to 
subrange monitor are also selected.

Note: Displayed only when you select Real User Monitor in 
the Type box.

Enable end users 
breakdown to 
subrange monitor

Select this option to view data collected for configured end 
users accessing the server(s) being monitored. By default, 
only this parameter is set. 

Note: Configured end users are the users belonging to End 
User Groups. For details about End User Groups, see 
“New/Edit End-User Group Page” in Using End User 
Management. 

Note: Displayed only when you select Real User Monitor in 
the Type box.

GUI Element (A-Z) Description
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Exclude profiles Enter the list of SiteScope profiles you want to exclude from 
display in the CMDB. Use commas as delimiters.

Because the CMDB may include a large number of SiteScope 
profiles, you can restrict the display by excluding some of 
those profiles.

Note: You cannot exclude a SiteScope profile whose name 
includes a comma (,). 

Note: Displayed only when you select SiteScope in the Type 
box.

GUI Element (A-Z) Description
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Hierarchy 
Structure

Select one of the options to create different hierarchies:

➤ Regular. (Default) The hierarchy structure excludes the 
location breakdown information from the transaction 
with location CIs. You can view business process profile 
locations in the Triage report. For details, see “Triage 
Report” in Using End User Management.

➤ Transactions/locations. The hierarchy structure includes 
the transaction with location CIs. Use this option to view 
hierarchies organized by Business Process profile location. 
Use this option with caution as it creates additional CIs in 
the CMDB, which may cause capacity and performance 
issues.

If you change the hierarchy structure from 
Transaction/Location to Regular after attaching BPM 
transaction from location CIs to other views (not to End 
User Locations View, or End User Monitors View), the 
following occurs:

➤ The Location CIs are deleted from the CMDB. 

➤ The BPM Transaction from location CIs attached to 
parent CIs are deleted and then recreated. They still 
appear in the views where you attached them under their 
parent CIs but no longer include location information.

➤ The BPM Transaction from location CIs attached to 
Location CIs are removed together with the Location CIs.

Note: When Business Process Monitor is working in 
Transaction/Location hierarchy structure, Location CIs are 
added to the Business Process Monitor hierarchy displayed 
in the End User Locations view. If you require the same 
geographical location for all transactions from a location, set 
the geographical location for the Location CI; the location is 
automatically propagated to all BPM Transaction from 
Location CIs in all profiles that fall under the Location CI. 
Set the geographical location in the Properties tab on the 
Admin > Universal CMDB > Modeling > IT Universe Manager 
page.

Note: Displayed only when you select Business Process 
Monitor in the Type box.

GUI Element (A-Z) Description
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Name The name of the new source. By default it is Generic EMS for 
the Generic EMS source adapter and XML File for the XML 
File source adapter.

Note: The name must be unique.

Path Generic EMS. The path to the location of the Generic EMS 
XML file. Do not change the default path: 
<Business Availability Center server root directory>\
CMDB\adapters\Dnodes. 

For example, for this adapter, the path can be: 
D:\<Business Availability Center server root directory>\
CMDB\adapters\Dnodes\Generic_EMS.xml 

XML File. The path to the location of the user-defined XML 
file. The file describes the data topology.

Server URL The URL of the Gateway Server.

Note: Displayed only when you select Business Process 
Monitor in the Type box.

Show 
unconfigured 
users on the 
dashboard

Select this option to view data collected for all end users 
(configured and non-configured) accessing the server(s) 
being monitored. 

If Enable end users breakdown to subrange monitor is not 
selected the single monitor for all non-configured end users 
is displayed. 

Note: Selecting the Show unconfigured users on the 
dashboard option greatly increases the number of CIs 
included in the views using the Real User Monitor source. 
This can mean delays while a view hierarchy is rebuilt after a 
change is made to the configuration in Real User Monitor, 
and may cause other performance issues in HP Business 
Availability Center. 

Note: Displayed only when you select Real User Monitor in 
the Type box.

GUI Element (A-Z) Description
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CI Definition Parameters
An adapter mapping definition includes some of the following information:

Sync Interval The interval (in minutes) between each automatic 
synchronization of the adapter with the external system. 
The default value is 60 minutes.

Type To create a new source adapter, select one of the following:

➤ Generic EMS

➤ XML File

Hold the cursor over the query icon to view the description 
of the source adapter in a tooltip.

When you edit one of the default source managers, its type 
is listed in the box.

Note: Business Process Monitor, HP Diagnostics, Real User 
Monitor, or SiteScope source adapters are listed when you 
have configured them to be custom source adapters. For 
details, see “Work with the SiteScope Source Adapter – 
Workflow” on page 703.

Element Description

basicEntity The name of the configuration item (CI) in 
HP Business Availability Center. The CIs are defined 
in the IT Universe Manager tab in CMDB 
Administration, described in “IT Universe Manager 
Overview” on page 52.

contextmenu The internal name of the context menu to be used 
for the item in the Dashboard application. To list 
the context menu names and their internal name, 
select Admin > Dashboard > Repositories > Context 
Menus.

dimension The ID of a KPI to be used for the CI. If you change 
the KPI, check that the KPI is applicable for the item 
class. To list the KPI ID numbers, select Admin > 
Dashboard > Repositories > KPIs.

GUI Element (A-Z) Description
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dnodeAwareDimension Set to false for definitions not using the Dynamic 
Node Factory. For details, see “Customize Dynamic 
Node Factory Definitions” on page 722.

entity id The name of the source item.

logic The ID of a business rule to be used with the KPI. If 
you change the rule, you should ensure that the 
rule is applicable for the KPI. To list the business 
rule IDs, select Admin > Dashboard > Repositories > 
Business Rules.

Note: In a source adapter, you can assign to a KPI 
only a leaf rule and not a group rule. You can assign 
a group rule to a KPI only in the repositories. For 
details, see “KPIs Repository Page” in CI Attribute 
Customization.

parameters Additional parameters for the CI’s KPI, or parameter 
values to override the parameter values defined for 
the business rule.

removeDimensionIf
Obsolete

Set to true so that KPIs for the CI are removed from 
the view if they are no longer in use. Do not modify 
the value of this parameter (it should remain set to 
true).

selectors (For monitor CIs only) use the selectors to build 
complex logical expressions using AND and OR 
logical operators. Those logical expressions are used 
to catch the appropriate samples brought in by the 
adapter, for the item. For more details, see “Define 
Selectors” on page 720.

Element Description
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Example

The example shows the mapping of an entity named measurement to a CIT 
named Mercury:sitescope_measurement in the CMDB.

<entity id="measurement">
        <basicEntity>Mercury:sitescope_measurement</basicEntity>
        <contextmenu>ssMeasurementMenu</contextmenu>
        <dimensions>
            <dimension>
                <id>1</id>
                <logics>
                    <logic>
                        <id>3</id>
                    </logic>
                </logics>
                <selectors type="AND">
                    <selector dataType="String" key="sampleType"
                        operator="EQ" readOnly="true" reference="false"
                        referencedProperty="sampleType" value="ss_t"/>
                    <selector dataType="Long" key="u_iMeasurementId"
                        operator="EQ" readOnly="false" reference="true" referencedProperty="measurement_id"/>
                    <selector dataType="Long" key="u_iSessionId"
                        operator="EQ" readOnly="false" reference="true" referencedProperty="session_id"/>
                </selectors>
                <removeDimensionIfObsolete>true</removeDimensionIfObsolete>
                <dnodeAwareDimension>false</dnodeAwareDimension>
            </dimension>
        </dimensions>
    </entity>
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Selector Parameters

Note: If you want to modify selectors, contact HP Software Support.

Each selector may include the following information:

Parameter Description

dataType The type of data can be: Long, Integer, Boolean, 
String.

key The field to be checked in the sample from the data 
source.

operator The relational operator used by the selector 
expression when checking the value in the key field, 
for example, EQ or IN.

readOnly This flag is set to true if the value for this selector is 
fixed (defined in the selector value field), false if the 
value can change.

reference Indicates whether the selector should use the 
referenced property or not. The selector uses the 
referenced property if the reference flag is set to 
true, and ignores the referenced property if the 
reference flag is set to false.

referencedProperty The value of the entity specified for this parameter 
is compared with the value of the field specified in 
the key parameter. This parameter is used only 
when the reference parameter is set to true. 

value The fixed value to be used by the selector.
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Source Manager Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure the source adapters that map 
source data to objects used by HP Business Availability 
Center.

To Access: Select Admin > Universal CMDB > Source 
Manager.

Important 
Information

To perform actions on two or more source adapters at once, 
select the check box to the left of each source adapter and 
click the buttons that appear under the source adapters area. 

Included in Tasks “Configure a Source Adapter – Workflow” on page 700

Useful Links “Source Manager Overview” on page 666

GUI Element (A-Z) Description

Custom Source 
Adapters

Select the appropriate custom source adapter. 

For details, see “Generic EMS Source Adapter Details” on 
page 696.

Default Source 
Adapters

Lists the preconfigured source adapters for HP Business 
Availability Center tools. They are automatically activated as 
soon as you start HP Business Availability Center. 

For details, see “Template Elements” on page 675.

New Source Enables you to add custom source adapters.

To make a default source adapter available for defining new 
source adapters, select Admin > Platform> Setup and 
Maintenance > Infrastructure Settings, choose Foundations 
and select the Sources Configuration, and locate the 
appropriate entry in the Sources Configuration - Sources 
area. Modify the setting for the relevant source type. For 
example, change Add Business Process Monitor Sources to 
true.

The change takes effect when the server is restarted.
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Default and Custom Source Adapters Sections

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Opens the Edit Source dialog box where you can edit the 
source adapter. 

Note: You cannot edit a source while its status is 
Synchronizing.

Deletes the source adapters from the list of source adapters 
in the Source Manager and deletes all the CIs (that were 
created by the source adapter) from the CMDB.

Note: You cannot delete default source adapters. 

Disables communication between the CMDB sources and 
the external system, so that hierarchy data is not updated.

Note: When the button is pressed, the icon toggles to 
Enable.

Enables communication between the CMDB sources and the 
external system, so that hierarchy data is updated.

Note: When you click the button, the icon toggles to 
Disable.

Sync now prompts the Source Manager to poll the 
appropriate system for updated hierarchy data. Use this 
button after making changes to the external source or to the 
source information in System Availability Management, 
in order to synchronize the information in the CMDB with 
the information in the external system. You can also wait for 
the automatic synchronization to take place.

Hard sync prompts the Source Manager to re-import the 
complete hierarchy data. Use this button if you suspect 
other changes have been made since clicking the Sync Now 
button or since the last automatic synchronization. 

Note: The Hard Sync replaces only those CIs that have 
changed since the last Hard Sync.
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CI Count The number of CIs in the hierarchical tree for the source 
(groups, monitors, and so forth), as received from the 
external system. 

Note: A Dynamic Node Factory CI is counted as a single CI.

Last Update The start date and time of the last update (synchronization) 
to the source CIs in the CMDB from the data sources. 

Name Name defined for the source adapter.

Next Update The scheduled date and time for the next update to the 
source CIs in the CMDB from the data sources.

Status Current status of the communication link with the external 
system. Possible statuses include:

➤ Enabled. Communication between the HP Business 
Availability Center and the external system is enabled, so 
that Source Manager retrieves updates to the hierarchy 
data.

➤ Disabled. Communication between the CMDB and the 
external system is disabled and no new hierarchy data is 
retrieved.

➤ Synchronizing. Polling the external system for 
configuration data. While this status holds, the entry 
cannot be edited or deleted.

➤ Failed. Synchronization with the external system failed 
and the configuration data is not updated.

Sync Duration The time taken to perform the update.

Type The type of adapter used for the source.

GUI Element (A-Z) Description
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